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Chapter 1. Getting Started

Welcome

Welcome to the Pulsonix electronic design system. The system is built on an integrated design
environment providing all the tools required to capture a schematic and simulate it using the Spice
based A/D mixed mode simulator, through to the design and layout of the printed circuit board (PCB)
which is aided with a powerful shape-based auto router.

Pulsonix appeals to all users, from the casual to the full time user because of its simplicity and
straightforward approach. Pulsonix is structured in such a way that its menu structure and options
naturally leads you through the design sequence, that in turn means you don't 'jump' about within the
product hunting for functionality.

About this Manual

The contents of this manual

Like all aspects of Pulsonix, the Users Guide has been written to be as usable as possible with the
least amount of effort. It has been produced in a manner that will get you started in the quickest time
possible by describing functionality based on the logical steps of a practical design cycle. Even if
your design cycle doesn't follow the exact path in this manual you can get your questions answered by
turning to the relevant sections. The manual does not take you through every detail but will guide you
through the essentials to produce a design. The on-line help provides further information in context
about each option. It is directed at users who understand the fundamentals of designing PCBs; it is not
intended as a course in designing PCBs.

Where to find additional information

Additional information and help located in the accompanying HTML on-line help system. Once the
Pulsonix product has been installed and is running, you can call help at any time by locating the Help
index from the Help menu and selecting one of the options available.

System Requirements

Hardware required

To run Pulsonix your PC hardware will need to conform to the following requirements:

® A Pentium class processor (i5 minimum or i7 or better recommended)

®  Microsoft Windows 10 or 11 recommended *

® Atleast 8Gb of RAM minimum

®  Graphics to support DirectX 10

®  1.4Gb of hard disk space for the all files supplied, including libraries and run time files

® 3 button mouse with wheel is recommended although any mouse will work

* It is highly recommended that the most up-to-date Windows operating systems are always used.
Please check our web site for the Pulsonix operating system support policy.
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Program security

The Pulsonix design system is protected by a security key or network address, plus an accompanying
license code. The key is attached to the USB port for a node-locked system; you may also use a
Network Address to replace the security key. If using this protection, a key would not have been
supplied. For ‘floating” network license systems the license resides on a server system, this will also
be paired with a MAC address or USB key.

If updating or upgrading your program from an earlier version you may require a new license. You
will be supplied a new license if needed and you will be informed of the procedure to use it.

Installation

For new users (normal installation)

To install any of the Pulsonix products, as a standard precaution we recommend that you first close all
other applications, saving your work if necessary.

This procedure is used for any ‘client’ installation, that is, an installation which is not using a network
license scheme and for which the dongle resides on the same machine. For floating network licensing
refer to the Network Licensing Installation Guide.

USB Key Driver

You must NOT connect the USB key (dongle) before installation is attempted. Once Pulsonix has
been installed you will need to connect it. The Setup program will install a special HASP USB Key
driver to use. Once Pulsonix is installed and the USB key attached, Windows will automatically
detect the key and will use the new supplied driver. You cannot use the standard Windows Plug &
Play driver.

Licensing

Normally, the license file will be supplied to you by email with the name license.lic or

key _number.lic This license file includes any products and cost options purchased. Create a suitable
folder and save it into this on your hard drive. During installation you will be asked to browse to it.
You can use this location if changing from a Trial system to the licensed product once purchased.
You can also use the License Manager to browse to the location of the license file if switching
between the trial system and an evaluation license.

MAC Address License

A license may also be supplied to you that is locked to your computer’s MAC address. This is an
alternative to using a USB key security mechanism. The procedure for installation will be exactly the
same as with the USB key detailed above.

Installation from a download

If you have been provided with a download link to install Pulsonix from the Pulsonix web site, click
on the link provided. This download a packed executable file which will run once setup has been
double clicked. The setup pages will direct you through the install. Follow the instructions provided.

Installation from the CD

Insert the CD-ROM into the CD drive and wait for a short time. The default setup will start the Setup
program. If your system has the autorun facility disabled, or it simply hasn't worked, select Run from
the Start menu, and type D:\intro.exe (replacing the D: with the actual CD drive letter if yours is
different), then press <Enter>.
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From the Setup page, select Pulsonix Application from the menu.

The Pulsonix Setup Wizard will guide you through installation of the software. Follow the steps
displayed on-screen and press the <Next> or <Back> buttons to move through each stage. If you need
to, you can abandon the installation at any time by clicking on the Cancel button -and then Exit.

The setup procedure is fully described in the Startup Notes booklet supplied or available on the
installation CD under \Documents.

If you have installed Pulsonix from an electronic download, all the users guides and additional
information supplied on the CD is available from the Pulsonix.com web site.

Moving the Installation

If you wish to move Pulsonix from one machine to another, you cannot simply copy the installation,
you must use the installation CD or download executable file to re-install it. The Setup program must
be used in order to install the required registry entries.

Updating Pulsonix from the web

Pulsonix can be automatically updated through our web site with the latest fixes that become
available from our development centre. This facility is available for all users with a current
maintenance contract and a login account.

To check and access the latest patches from the web site, from within Pulsonix, go to the Help menu
and select Check For Updates... When selected, a dialog is displayed, this allows you to set up when
you want to check for updates and where to check. It also allows you to force a check now. This will
automatically direct you to the Pulsonix Updates page from where you can login and download the
latest patch available.

Check For Updates X

(O Onee a day as I start the program

O Every time I start the program Cancel
(®) Don't check automatically, only from this dialog

When To Check

Where To Check

| hitp: /jwww. pulsonix. com

Use Default
Recent
Mot chedked

Check For Updates Mow...

If a patch isn’t available, the dialog will report that none are available at this time. Before installing a
new patch, ensure that Pulsonix isn’t running, if it is, it must be closed.

You can also save the executable file to your local disk if you wish to install it at a later time or on
another machine or over a local intranet network onto several machines.

Floating Network Licensing

Floating network licensing is the ability to run any number of licenses from one central server without
the need for a dongle on each machine to run the product. This type of licensing effectively floats on
the network until booked out by Pulsonix and used. Pulsonix supports this as a cost option to the
regular product.
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For installation instructions, an installation guide is supplied on the product CD or from the download
page of our web site. Please refer to the Network License Installation notes for further information.
These are also available as a PDF file on the installation CD supplied.

Uninstalling Pulsonix

To uninstall the product from your hard drive you should use the Remove option from the Setup
program. For product updates or upgrades you do not need to uninstall existing product first
regardless of its version.

Contacting Technical Support Resources

Access to our support engineers is available via the internet, e-mail and telephone (Monday to Friday
10:00am to 5:00pm in the UK). Outside this location please contact your local support centre.

Email: support@pulsonix.com
Phone: +44 (0)1684 296 570

Support is limited to: Installation assistance and questions regarding Pulsonix usage, design,
manufacturing and library design, all answered in context of how to use the features. Consultancy is
also available, for more information about this service, please contact our international sales office.
After your free support has expired, extended support options can be purchased from our sales office.

Whenever our technical desk is contacted, you will need to have your contact details (phone and
email address) available, plus the product version number. It helps us and speeds up the process if any
problems can be reproduced on our demo designs supplied.

Please note that we can only support the current major version, especially when attempting to
reproduce problems.
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Chapter 2. Using Pulsonix

Introduction to Pulsonix

Starting Pulsonix

The start location of the program can be set using the Folders option on the Setup menu. Please refer
to the Setting up The Design Chapter, Using Folders and Files.

The Pulsonix Desktop

When you run Pulsonix, the main application window appears. Pulsonix operates a multiple
document interface (MDI), so you can open any number and combination of different Pulsonix
designs types, as well as libraries and additional tools.

Docked Auto-hide
Menu toolbar  Menu Sub-menu toolbar World-view dockable
windows
14 pulsonis - [PCE Design: PC3-UDILI ROUTED] - o X
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D e  coore Kerpaznaal MLz mHES ame sk |
Soiponent tuy B « | Component Bin TR X
i Database Bar T e
& Design Browser b World View x EEEE - e
“ DRC Errors Bar O T L| 0E R
1 Find Bar csF | ) = = WL.OOgaip ; B
A= S > K ]
o Layers Bar ctri+L = S s ercprazEes I
o Select Mask Bar i i ) 2
7 ek FRFFFFFEFF <
& [&y Inspector Bar ' : s @
B @ Togot s e ] R =——ai g
A a HHde Connectors: H
Part Browser Ctrl=B =G| 5 LB L] -- CONNI [6] - DINA1612-PLG-64 |~
&l Rule Spreadsheet Bar H H E‘"i
& 1 shape Information Bar o - i &
i | Warld View w l.. J: Pin12 o
E [ Pin13 4
A ew e i l — Pin63 i
Al Mark View ) @ setwie z
5 Power Plane v 2 swap View shift=5
3D View B, GoTo View ol els
3 avad B2 I} |
a T onas b
tererigsd mo monm—
& High speed design l! RoutingDemo7 | B RoutingDemol ", [ inter:Progessing * 547
[&: Dpatabas
Store curent vie Grid: <Werkng> 25.00]|Abs|[10506.77}][12055.00+] thou
Workbook  Design window Floating toolbar Status bar Component bin
‘mode’ (maximised)

Pulsonix Menu Options

The Menu bar contains options relevant to each application open within Pulsonix. The menus are set
out logically to be used as you move through the design cycle starting from the left and moving right.
This methodology is only applicable if you are following this basic principle. The basic principle still
applies regardless of where you start in your design cycle. The menus are logical and intuitive to
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understand. The menu bar is similar to a toolbar in that it can be 'docked' in place or left 'floating' on
the screen as you wish.

Using Multiple Screens
Pulsonix can be used with more than one screen to provide you with Schematics on one and PCB on
the other, for example. By default, Pulsonix is setup to use just the one screen but can be easily
switched to use two.

» To enable multiple screen usage
1. If you wish to use more than one screen, from the Tools menu, select Options.

2. From the Multi-Screen tab, select the Enable Multi-Screen Support check box.

8 Options - Multi-Screen

Design Backups Enable Multi-Screen Support
Displ
|st Y Windows for each type of design file
Edit Shape
Edit Track Window for SCM and PCE designs Window for other file types
File Extensions < swap > @ () Any Window
Find (O Window #1
W W
General Window#1 Window#2 @ Window 2
In-Place Names
Interaction Other Settings
Macros Open all windows on application startup
Move BExit in one window means Bxit in all
g Multi-5creen
Online DRC System Information:

Resolve Met M
esolve ames System has one monitor

Select

Synchronisation Generic PnP Monitor

Tooltips AMD Radeon HD 7000 series
P 19201080 32bit 60 Hz

Track Length Limits

Warnings Defautt Monitar

AMD Radeon HD 7000 series
Appears to have no display attached
Defautt Monitar

AMD Radeon HD 7000 series
Appears to have no display attached

3. With this enabled, two instances of the application will work together to arrange your files so you
can easily work on Schematic designs on one screen, and PCB designs on the other. Each
instance will have its own menus and toolbars and work independently, but will share
information when they need to.

4. Options on this page allow you to organise which screen is used for each program type.
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The Status Bar

The status bar appears across the bottom of the Pulsonix framework. The bar contains two sets of
information; the Prompt / Message box displays useful information about the current activity and
also provides basic instruction to its use. If an option doesn't behave as expected this area should be
checked first to see what the system is expecting you to do, a prompt message is displayed in this
area.

[Select itemis). Use ‘Shift+Click”  [Board [Style: Board [width: 12.00 [Layer: <Thiough Boards [Abs (2237500 [22050.00  [thau ¢|

| | I (I

Prompt / Message Froperties Co-ordinates  Units

The Prompt/Message box is a single instruction box, the box to the right of this contains display
Property information about any design items selected. The information in these boxes is not
exhaustive but does contain commonly required information about the item selected. For more
detailed information about any selected item, right click and click the Properties command from the
context menu.

The status bar displays Co-ordinate information about the position of the cursor within the design as
an X and Y co-ordinate value. These co-ordinates are shown as either absolute [Abs] or relative
[Rel] depending on the mode selected. The current design Units are also shown on the status bar.

When viewing the X,Y co-ordinates on the status bar you will notice that they sometimes display a +
or - sign after the each of the co-ordinate numbers. This indicates that the value shown cannot be
represented using the current units precision.

16647.5+||23706.5+

The minus sign (-) (when displayed) indicates that the number is slightly less than the last digit
shown, whereas the plus sign (+) indicates that the number is slightly more than the number shown.
With the precision set in the Units dialog and the available space in the co-ordinate boxes this
notation allows you to see instantly whether the number is precise or not.

If using Relative co-ordinates, the status bar shows the co-ordinates relative to the relative origin.
This will only return back to co-ordinates relative to the design origin if the system is swapped back
to an Absolute co-ordinate system. Use the Design Properties dialog located on the Edit menu to
switch modes and change the relative origin.

The furthest box to the right displays the current design Units.

Active Status Bar

The Status bar is also active. This means that by double-clicking on a pane within it, relevant
information can be modified. For example, clicking on the Abs word will toggle between Absolute
and Relative modes. Other modes, such as Grid: will display the Grids dialog where a change can be
made. The active Status bar includes:

® Layer, Layer Span, Net, Style (text style, pad style, line style) also editable by clicking on Width,
Size, Line Width, Side, Delta X, Delta Y, Angle and Radius (for arc)

®  Units (double-click on coords when not editing/moving item), Toggle Units (mm < > thou toggle)

® Typed coordinatess (double-click on coords)

®  Absolute/Relative coords (toggle)

®  Current Grid

®  Variants
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The On-line Help System

Pulsonix provides an on-line help system with detailed information about every item within the
product. You will also find help on general ‘topics’ as well as feature items.

At any time, you can press the F1 key to access help in context of the current action, or run help from
the Help menu and selecting Help.

@ Pulsanix Help

& AR
Hide  Back Home  Font

Cortents  Index  Search  Favorites

Type in the keyword to find:

||wnr|d

Colours

Copy Out

Copy Out Design tem

Copy Out Library ftem

Designs to Vault

Ertter Next Vault Revision

Erter Vault tem to be Replaced

& &

Print  Options

World View ~

The World View window provides an additional view of the whole of your current design. it also
provides full Pan and Zoom functionality to allow you to easily select the exact area of your
design in which you wish to work.

Shortcuts

Toolbar: None

Default Keys: W

Default Menu: View > Dockable Windows >
Command: World View

Folder Name:
Folders The World View Window
Getting Started
Groups The World View displays a simplified overall wie
Installation up to date as vou proer-
Vikrmrine 4n a0
Index Mavigation Pane Topic Pane
Entries

The help window is split into two main sections. The left hand navigation window displays the
Contents list, the help Index, a word Search facility and a Favourites selection for retaining pages
'marked' by you. The right hand Help window provides you with the context help pages. These pages
are located from one of the options on the left hand window or by using the F1 key to obtain context
help on each dialog. To view any of the topics that appear in the Index or Contents sections, double-
click the mouse while over the item required. Alternatively, select the item and click the Display
button.

When using the Search facility you can search for word strings by encapsulating the string in double
quotes, e.g. “Free Angle”

Customising Pulsonix

Overview

Pulsonix provides you with the ability to customise the user interface with your own Toolbars
containing option buttons that allow instant access to tools within the program. You also have a
complete command set of all the options within Pulsonix which can be assigned to a shortcut key
from the keyboard. Other aspects of Pulsonix can also be customised such as the application look and
and how the menus are revealed when you select them.

Light and Dark Ul

Pulsonix can be run in Dark mode. By default, Pulsonix is installed as a new installation using the
‘light’ mode. If you wish to change this, use the Tools menu and Customise option, then Application
Look tab and select the ‘Dark’ radio button.



Chapter 2 — Using Pulsonix 21

Customise X

Commands Toolbars Tools Menu  Keyboard Application Look  Options

Application Look ‘Workbook Tab Location
(®) Standard (O Top of Design Area
[ 5tatus Bar Borders (®) Bottom of Design Area

[[Legacy lcons
(O Dark

lcons

Show Menu lcons
Hide Menu lcons

Toolbar lcon Scale: 1.00

By selecting the Dark mode radio box and then pressing Apply Changes or the Close button,
Pulsonix will then switch to using the dark interface for the application and all dialogs.

Toolbars

Toolbars in Pulsonix can be set to be both 'docked' and ‘floating'. They can also be customised to
contain your own choice of options and can be named for instant recognition for particular tasks, for
example named Edit Connection, for use in Schematics that might contain connection editing and
naming options.

Below is an example of a docked toolbar. The toolbar is docked below the Menu bar in the horizontal
position. This is the default position but can be moved as required.

#+4 Pulsonix - [PCE Design: ILFBE09E |

Gripper E File Edit View Insert Setup Ufiities Tools
Bars > DB HEI& < @06 &R NN

Ik ‘

In docked mode, a toolbar is fixed along any of the four borders of the main window framework in
either a horizontal or vertical position and will have a Gripper bar across the top or down the left.
You cannot modify the size of a toolbar when it is docked.

1 Pulsonix - [PCB Design: ILFBEQS
File Edit View Insert

) PSR S o @,

The toolbar can be moved by selecting the window border and 'dragging’ it away from its current
location. By dragging it, it becomes detached from the framework. When the toolbar is then moved
over another area of the framework to which it can be attached, it changes shape to indicate it can be
docked there. You can also make it floating by Double-clicking on the window Gripper bar or in the
toolbar area itself, but avoiding the buttons that will select an option.

The toolbars can also be floating. This means the toolbar can be moved into free space on the design
and outside the framework. This toolbar can now be reshaped to make it fatter or thinner by dragging
the outer edge in or out. The toolbar can be shaped to be one tool wide or long by as many tools as are
loaded on the toolbar in the opposite direction. By selecting the outer framework edges of the toolbar
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a small arrow 'handle’ will appear to indicate that the toolbar can now be reshaped. Drag the handle
until you have the shape you require.

Uth Ut
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3 & o 3
I,\\) f; E c - (-]
Same s L
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[me] -
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You can restore the toolbar to its last docked position by double-clicking on the name caption on the
toolbar.

To move a floating toolbar, select and drag any part of the toolbar framework. The toolbar will move
dynamically with the mouse movement. Release the mouse button to release the toolbar.

How to customise toolbars

Toolbars can be customised to contain the buttons (and underlying options) of your choice. Pulsonix
provides a default set of toolbars that cover different design types and some designs tasks, such as
editing etc.

You can create toolbars for any task that appears on the menu or context menus.

To edit or create your own toolbars you must use the Customise option on the Tools menu. Once in
this dialog you can move tools on existing toolbars or add/create your own. Other than in this dialog,
you cannot add or remove tools from toolbars but buttons can be moved by pressing the Alt key and
dragging the button from one toolbar to another or off the toolbar to remove it altogether.

» To create a new toolbar

1. On the Tools menu, click on Customise. Click on Toolbars. The Customise option is also
available by clicking the right mouse button on the Pulsonix framework.

Customise X

Commands Toolbars Tools Menu Keyboard Application Look  Options

Toolbars:

O ~ =
[ Analeg

[ Analog Behavioural Reset All
[ Define Pad Shape

[ Digital Mew. .
[ Digital Generic

[ Dockable Views Rename...
Edit

[Macros Delete
[IMagnetics

Menu Bar

[IMiscelaneous ] [ Show text labels

The process for adding a new toolbar and adding tools to it would be:
2. Click on the New button.

3. Type in the name that you wish to use for the toolbar (this is the caption name that appears as the
toolbar title), and click OK.
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This name now appears in the list of available toolbars and is, by default, already selected at the top
of the toolbar list. You will also be able to see the toolbar in the design window. You will now need
to add the required commands to the toolbar.

4. Click on the Commands tab.
Customise >

Commands  Toolbars Tools Menu Keyboard Application Look  Options

Categories: Commands:

[EET ~ Change Block Port "
Doc Symbols | ELiE 2T o

Edit Change Branch Point

Fil

F;:d Change Bus

Help

Insert Change Default Style

Macros Change Doc Symbol

Output

Part Edit v Change Layer v
Db

Description:  Change the block port used by the selected item

The Categories are arranged in the same order as the menus themselves. By clicking on each of the
names in the Categories list you will see the buttons for the options found on those menus displayed
in the Commands section next to it. You can also view all of the available commands by clicking on
All Commands in the Categories list.

5. Click on a command from the Commands list.

You will see a brief description of the function of that button in the Description: box. These buttons
can now be dragged onto a toolbar. Once the toolbar is populated with the tools you require, click the
OK button to close the Customise dialog.

» To remove a button from a toolbar

1. On the Tools menu, click on Customise.

2. With the toolbar on which the tool to remove resides visible, select the tool button and drag it off
the toolbar and into 'free' space. That is, space that is not part of this or any other toolbar.

3. Once complete, click on the OK button to make the changes permanent.

In addition to using the Customise option from the Tools menu, you can also use a more convenient
method through a right mouse shortcut.

The context menu is available when the cursor is hovered over any of the toolbars, menu bar or status
bar.

Commands and Shortcuts

As well as the toolbars, Pulsonix has the ability for you to programme your keyboard for commonly
used options or commands. This means that once programmed, you can press a key or key
combination to enter a function or option. For experienced users, this makes the program's operation
far more efficient.

When Pulsonix is first installed, you will find a set of shortcuts already defined for you. These are
only a default set and can be modified to your own preference through the Shortcuts dialog. Almost
all of the keys on a standard keyboard can be utilised giving you extensive coverage of shortcuts.
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» To create a shortcut

1. On the Tools menu, click on Shortcuts.
Customise >

Commands Toolbars Tools Menu Keyboard  Application Look  Options

Category: Filter

All Commands w | |
m Anphe

Opn A o

Open Page

(Open PCE Design Assigned Shortcuts:

Optimal Position .
Optimal Rotation Ciri+0 Remaove
Optimisation Mode

Optimisation Mode Continuous hd Reszet Al
Description: Press New Shortcut:

Open an existing document |:| Assign

Assignment Report:
By Command By Key

Each of the currently Assigned Shortcuts is displayed when the command of the same name is
selected. It is possible to assign more than one shortcut to a command if required.

2. Select the option you wish to change and click the mouse in the Press New Shortcut window
and then click the key(s) you wish to assign to it.

3. Click the Assign button and that key combination will be assigned to the function chosen.

4. If the key has already been used, a message will be displayed informing you that it is already
assigned allowing you to overwrite it or Cancel.

5. Before any shortcut keys are assigned ready for use you must exit the Shortcuts dialog by
pressing OK. Simply, assigning the shortcut is not enough.

A full report of all the assigned keys can be obtained from this dialog or can be run from the Reports
option on the Output menu. Use the Shortcut Keys Report to generate the report.

Selecting a Category from the list of categories at the top left of the dialog causes the command list
to show the commands in that category. The <All Commands> category shows all available
commands. The Description box displays a brief description of what the currently selected command
does. These are categorised using in-build categories and cannot be changed.

The Find Key and Filter options allow you to locate other shortcut keys.

Dockable Windows and Browsers

Overview

As part of the design suite, you have a number of dockable windows and Browsers that can be used to
view specific design information. These windows are available through the View menu, through
Shortcut keys and through the popup toolbar/window menu. Each individual window can be
specified to Allow Docking (enabled through the context menu for each window or browser). This
means that if not allowed, regardless of where the window is placed, it will not 'attach' itself to the
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framework. If you require it to be docked, the Allow Docking option must be checked (with the 'tick’
showing as in the example below).

Floating

Docking
Auto Hide
Hide

Show Design Extents
Show Board Extents
Show Working Area

Component Bin B
Design Browser D
Part Browser
DRC Errors Browser
@4 Find Bar Cer+F
¥ | awars Rar rrlal

Component Bin

The Component Bin is provided to store and view unplaced components in the PCB design editor,
and unused gates in the Schematic design editor.

When used in Schematics it contains unused symbol Gates not yet placed. For example, if a 4xXNAND
gate is loaded into the design but only one gate placed, the other three gates are placed into the
Component Bin ready for subsequent use.

If used in the PCB design editor, the Component Bin is used to hold unplaced components. The
Component Bin can be used as an integrated part of the auto place functionality. The components are
automatically taken from the Component Bin and placed on the design, this can be a two way process
for removal of components from the design.

=

— Preview window

11 - D1SF-90 < i
U11 - ISPLSI1032-80LT Component bin

The Component Bin is a dockable toolbar. It can be left 'floating or 'docked' on one of the sides in the
design area. To move it, simply click and drag an edge of the Bin to the desired location. The
Component Bin will move while being dragged, as soon as you release the mouse button it will
remain in its present location until moved further.

The Component Bin contains two sets of information.

The Component Bin Preview window shows the Component currently selected in the bin, along
with its terminal/pad numbers and names. This updates automatically as each Component within the
Bin is selected.

The Component Bin window lists the components currently in the bin. This shows the Component
reference name, the Component name and Component type and is sorted alphabetically on the
Component reference name. For a schematic design and for a multi-gate Component, the gate name
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and symbol name are listed for each gate of the Component. The components (or gates) are selected
by clicking in this list.
Using the Component bin

Components can be placed in the Bin directly from Insert Component, from Translate to PCB or by
dragging them manually into the Bin from the design. You can also select components in the design
and send them to the Bin using functionality from the context menu. Any PCB Components within
the Component Bin retain all connectivity but loose track information if previously routed in the
design. You are warned that track information is lost before the move to the Bin can be made.

Any Schematics gates moved to the Component Bin become completely unconnected (unused).
Components within the Bin can be moved from it in a number of ways:

You can select and drag a Component from the Preview window or from the Component list. This is
the most basic mode but aids fast manual placement by making the design 'clutter' free during the
placement phase.

If you select Place Around Board and components are in the Component bin, they will be placed on
the design around the board outline.

Auto place (if authorised) can move components to and from the Component Bin automatically.

Further selections in the Component bin

By right clicking in the Component Bin you are presented with a number of choices:

Add to Bin will open the Insert Component dialog from where you can draw components and add
them directly to the Bin without exiting this option or mode.

Delete from Bin will allow you to delete individual components from the bin. This is only available
in PCB if the PCB Safe Mode is not active in the Options dialog (available from the Settings menu).
If active, you will not be able to add (Insert) or remove (Delete) items from the bin.

Empty Bin will remove any whole unused components from the bin. If any gates or Connector pins
are already in use in the design they will not be removed.

Place Around Board From Bin will place selected components from the bin to around the board
outline, provided one exists.

Component Bin x
1C1
Flaating
I I I Docking

iy | -

Add ko Bin

Delete from Bin

- Emply Bin
Q2-50T23
R1-R % Place Around Board From Bin
U1 - 744C110000
| world view W
E Design Browser o]
“F Dark Pramcar

The other browsers are also available for selection on the context menu.

The Component Bin is discussed in more detail as it is used throughout this manual.
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Part Browser

The Part Browser provides a convenient way to add commonly used Parts to your design.

Part Browser X

Floating
Docking
Auto Hide
Hide

Change Part Categories...
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Insert Component  Shift+C
Vault: )
Part: i Add Component To Bin
- Manufacturer (69428) View Symbol Extents
(- <No Mfrs g Edit Symbol In Library
- 3M
=- A_ctel
-- Ad

£ AS4SX
AS4SH0BA-TQ144
AS545X084A1-TQ100
AS4SX0BAF-TQ100
L A545K16A-TQ144
- APA

- D5
[ eX64
£

[

H- eX128

- X256

- AD

[+ Altera hd

Adding components to the current design

You can add components to your design by selecting a Part in the browser and dragging it into the
design, with the left mouse button held down. You will then have a Component on your cursor that
you can place by releasing the mouse button. After the first Component is added, more copies of the
Part are interactively added to the design until you cancel the current command, or begin a different
command (including dragging another Part from the browser).
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Configuring the Part browser

The browser presents a list of Parts organised according to a category attribute. The list can be
hierarchical by specifying an appropriate separator character to split the attribute value into a path.
You can change the attribute used and the separator character by selecting the Change Part
Categories on the context menu in the browser.

[ Shaw Unsatisfied

Part Category Tree:

or Branch Attribute Split Character Add
Category !
Delete
Up
Doven
“hich Parts:
or Filter Attribute Filter Type Filter Add
Delete
Mumnber OFf Pins: l:l
Cancel

Use Name Branch Attribute Split Character Filter Attribute Filter | No. Pins
[#] | Manufacturer <Multiple Branches>
[] : Part Number <Part Famiby= ! Category Ind*
[ ] : category Category !
Edit Part Category *
Mame; |Category | [& blank Mame will uze a generated description in the browser)

You can select more than one Category to list in the Parts Browser. This uses a grid where each row
defines a category name. This also allows you to Filter the Parts using wildcards on an attribute value,

or specify the required Pin Count (No. Pins).

0K

Cancel

Mew...
Copi...

Edit...

Delete

Up

Down

Once the OK button on the Part Browser Categories dialog is clicked, the Part Browser will be

updated with the new selection.

These attributes are the ones currently in your library indexes, to change this list you must regenerate
the library indexes using the Index option on the Parts Library Manager dialog.
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World-view

The world-view is a miniature view of the complete design with some detail included for co-
ordination. This world view is used to navigate around the design, and because you can see the whole
design you do not need to resize the design first.

World View X

N gy e

IEEEE:

A

Board outline

" oes

L T Y

A

. )
NI Current view

LERLEL LY

Design items

This browser can be used docked or floating (shown above as floating). Not only does it provide a
view of the design but can also be used for navigating the design as well. The Zoom in/out, Pan and

Fame View commands are all operative in this view and are highlighted by the white Current View
box.

Options are also available on the context menu by clicking the right mouse in the window.

By right clicking in the World View you are presented with three choices of the view to show: Show
Design Extents, Show Board Extents and Show Working Area.

The picture below shows the World View with the view set to Working Area. You can see all of the
design area with the design represented within it.

‘World View X

Waorld view ——
Current view —-]

Board outlin

Other selections on the context menu will display the browser options also available.

Design Browser

The Design Browser is displayed as a configurable Dockable Window containing a list of all the
currently open PCB and Schematic designs, technologies and profiles. For a Schematic, a tree
showing all the pages in the design is shown, including any hierarchical blocks. The name of the
design/page whose view is currently active in the main window is shown in bold typeface. A dimmed
page icon indicates schematic pages that are not open as a view in the main design window.
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Design Browser ® I
Job2022
Floating
Display Docking
= TOP
+ CTRL [Controlle
=4 LD1 [7 Segment Hide:
Pagel
=¥ LDz [7 Seament Open Page
Pagel Close Page
= LDS [7 S k
E P[ag:lgmen Delete Page
= J LD4 [7 Seament Rename Page
+- 48 LDS [7 Seqment Mave Page Up
+- i LDG [7 Segment
5 E LD7 [7 Segment Maove Page Down
+- i LD [7 Segment Mew Page
& Jobzozz
B Close
0 whineld Wisi W

As well as being a visual guide, the Design Browser is fully functional and provides access to a range
of design level operations via its context menu.

» To show/hide the Design Browser
1. From the View menu, select Design Browser, this will toggle the visibility of the Design
Browser window. Alternatively a shortcut key can be defined using the Customise option.
Using the Design Browser

From within the Design Browser:

®  Double-click on a PCB design to make that the active view within the main design window.

®  Double-click on a Schematic design or one of its pages to make that the active view within the
main design window.

® Double-click on an already active Schematic to hide/show its pages.
®  Double-click on an unopened Schematic page to open it.
®  Click on any design or page to make that the currently selected Design Browser item.

® Right click anywhere in the Design Browser window to display the context menu that provides a
set of design/page level commands applicable to the currently selected item. Commands such as
Close, New, Delete and Rename operations are available.

DRC and ERC Error Browsers

These browsers are used to view the design error markers that have been created by the Electrical
Rules Checker, by the Design Rules Checker or by the on-line design rules checking options. The list
is displayed in an 'active' browser. You can use a double click on one of the items in the list to locate
the error marker in the design. This browser can be un-docked as a modeless dialog or docked as part
of the Pulsonix framework. Use the right hand mouse button to make this selection.

Before using the Errors Browsers you must first run a design rules check from the Tools menu to find
and 'mark’ the errors. Errors found during the on-line DRC/ERC processes will also be displayed in
this list.

The browser is categorised in hierarchical order of ‘rank’ starting with Design (number of DRC
errors), then Layer, then Error type, then the Marker itself.
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Layers

Floating

Docking

Hide:
ERC Errors

=l DRC errars: 2

[}

Clear &ll Errors

n 180 Flash Errors
=I- Pad to Track Error (P-T) el
=I-Layer: Top ]‘& Design Rule Check. ..
Pad to Track Error {P-T) Mets " and 'Gnd', Required 0,25 Actual 0. DRC Errors Report

Toggle Sort Order

@ World View W

R amnanank Rin R

Each error marker is shown as an X,Y co-ordinate within the design. You can locate an error marker
by double clicking on the co-ordinate.

An error marker is a code used to denote a spacing or design rule violation and is created by the
design rules checker. Design rules errors are created when two design items violate their respective
spacing or design rule. A report can also be obtained for all of the error markers in the design by
using the right hand mouse context menu when in the browser.

Any error markers in the design should be cleared by running the design rules checker again. This
will be an iterative process and you may need to be run the DRC option more than once or until all
errors have been satisfactorily removed.

The Layers browser allows a fast display and switching of layers without using the Colours dialog.
This modeless dialog is displayed as a configurable Dockable window containing a list of all the
layers in the design. The checked layers are currently visible in the display window.

Layers x
a

[~ W Sikscreen Top ~
[ M PesteMask Top
[~ W Scider Mask Top

M Tep
[ W 22 Ground
[ 2 Inner 3
2 Innerd
[Z W Irner s
2 Inner
& o @ Prwes Floating
[ 1 Rrttrm Docking
[ Scider Mask Bottem Auto Hide
[ B Pazste Mask Battom
[ W Silzcreen Eottam Hide
= wrec Bettam All Layers On
[ PinMames Balton)
[ W] D ocumentalion Al Layers Off
[# M Cenatruction Lincs This Side On
he This Side Off
Hide << Show Fick (2 Switch Displayed Side
dreas (] Set As Default Track/Copper Layer
Compenents: ] Show Item Layers
Connections f] 7] N o
Constricts [ Set Togale Layers...
Copaer [ &5 Technology T
Padz [
Rruing 2] Colours
Terplar: [ 4 Load Colours
Pin Mame in Pads: [] ﬁ Save Colours
| ke Iberns:
# Winrd Viaws W
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From the context menu you can also select options from the context menu. These further enhance the
selection of layers and layer combinations.

Switch Displayed Side is used to switch to the set of layers for the opposite side of the board, e.g. All
Top or All Bottom. This is also available as a command from the Run Command option on the Edit
menu.

With an item selected in the design, the Show Item Layer will be displayed. You can then switch off
all other layers other than that one.

Double-clicking on one layer name will switch off all other layers.

Active Layers

The colour squares within the Layers bar can have a black square outline around both the default
electrical and documentation layers. Click on the square itself to set that layer as the default. If there
is no common default (i.e. all categories do not have their default set to the same layer) the black
outline is not drawn.

[ ]l Sikzcreen Top
[ ] M Solder Mazk Top

[]1 Paste Mask Top
[] PinMames

1] Tap

When starting a new track or adding a new doc shape, the default layer defined here will be used.
On the context menu within the Layers bar, the selections for the default layer change depending on
the layer type selected (Electrical or Documentation Layers):

Al Layels U Hi Layois UIT

This Side On This Side On
This Side Off This Side Off
< Switch Displayed Side 0 Switch Displayed Side
Set As Default Track/Copper Layer Set As Default Documentation Layer

Shrr TF Jvar
Show Irem Layers Show Item Layers

Set Tnanla | awars | Set Tnnrln tovarg, .,

Showing and Hiding Powerplane Layers

Powerplane layers (Layers nominated as a Bias of Powerplane in the Technology file) are indicated
by a small white thermal pad icon to the right of the layer colour square.

Ly 1 P
q - ﬁplit Paower Plane
-

P e | Plasme Ve

If the powerplane is being displayed (using the View Powerplane mode), the icon is in negative.
Click on the icon to display or hide the powerplane. The icon changes to a positive format to indicate
the powerplane is active.

B B Splt Power Plane

The functions to display, regenerate and hide the powerplane are also on the Layers bar context
menu.
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Find

[0 Pinames
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W 2 B
. ':‘5 No Floating
OmsM Docking
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E. Elt?p Auto Hide
attan
M Siks] ~ Hide
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E P:st: All Layers On
[ Docu Al Layers Off

Hide << This Side On

This Side Off
22 Switch Displayed Side

Set As Default Track/Copper Layer
B Display Power Plane |

Show Ttem Layers

More>> and <<Hide buttons

The list at the bottom of the Layers bar contains other dockable bars that you may wish to use. If you
click on one of these, it will become visible and replace the Layers On/Off bar. This allows you to use
a dockable area for just 2 bars (for example) and keep replacing them with the next bar you wish to
use.

The Find item browser is available as a dockable bar. Using the shortcut key <Ctrl-F>, you can find
and select design items using the drop down list box.

Find (0 items found) x

W % L ) e A

Area
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Atribiute Position
Eranch Paint
Compatiett
Connection
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Differential Pair
Do Symbal

Crill Size

Error
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Group
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Line Style
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Pad Style

Part

Serpenting
Signal Path
Star Poirt
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Testpoaint
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Track
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The dialog presents you with a list of items from which to choose.

The list will show named items of the selected type in the design. In the example above, components
are shown. If the item type does not have names (e.g. Copper) then a list of nets containing items of
the chosen type will be shown. If the item type is Errors, a list of the possible error codes is shown. If
the item type is Attribute, a list of the used attribute names is shown (see below).

Click on a named item to find it in the design. It will be highlighted (or optionally selected) and
optionally centred in the display window. If the list contains a list of nets, click on the required net or
use <Search entire design>. The first item of the required type on the chosen net (or entire design)
will be found.

On the browser bar are two additional sets of icons. The set on the left side are permanent and are
used to find components, Nets and X,Y positions. The second set on the right side is item sensitive
and are not enabled for every item type.

Find (42 items found)
L> HNEE @5 l
Mt l_]

The ‘pin’ icon on the left hand side is for ‘latching’ this browser if ‘floating’ and is discussed below.
The three other icons are for Finding the First item in the list, Finding for Next item and Finding
for Previous item.

Once items have been found (using any conditions from the Filter options, if filtering), the Find First
will then start the search on the first item. Next and Previous will toggle through the list of found
items if there is more than one item found.

The Find context menu

From the Find Browser you also have options available on the context menu to find and display
found items.

= P |

Find (42 items f —

L] E Docking

Het Auto Hide

DRWE |  Hide

Include Default Nets

EEE pe Select Found Item

Laow_spee ZI Flash Found Item

Egl Centre View on Found Ttem
Eg? Z‘ Add Found Item to Favourites
Egg Refresh Find Bar

Eg]g Count Found Itermns

unnn *% Select All Find Ttems

*;. Select Visble Find Items Chri+A

Remowve Highlights

Deselect Al

A lArA Ve iy
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The flashing of items is controlled by the Options dialog and Find page.

Action On Found fem

Select It

Highlight

[ Brighten & (Dim all other tems)
Flash It

Centre View On It

[ Allow Find Under Sliding Bar
Add To Favourites List

Flashing ttems

Flash For: seconds

Schematics Search

(®) Al Pages
() Open Pages
(") Curent Page

Variants

Search In All Variants

The Item Filter in Browser Windows

Finding Mets

Include Default Nets

Finding Emor Markers
Include Locked Emors
[A Only List Errors In The Design

Finding Drill Size

Use Drill Table Units

Finding Components

Allow Drag to Fetch Component

Fawvourites List

Maximum tems In List:

Dimn itemns in colour

Ciim Bright

I Reset

Some of the browser windows have a Filter mechanism so that item searches can be made on

specified criteria.

To use this option, click on the Use Filter or Change Filter button if you want to further define the
search criteria and reduce the number of items to find. If the button has the text Change Filter, then a
filter is currently being applied to the list. When the button is selected a set of extra filter controls will
appear to use, these are detailed below. When the Hide Filter button is selected, these filter controls

will disappear.

Check the Filter Names checkbox to enable the name filter control. If the Find list contains a list of
named items (e.g. components) or net names, type the filter string containing wildcard characters '*'
and '?' into the control underneath the Filter Names checkbox. Use the drop down list to obtain filter

strings previously used for this item type. When the filter string has been changed the Apply button

will be enabled. Press Apply to apply the filter string to the list of names.

Hide Filter <<

Apply
Filker Hames

I

Attribute:

<Companent Height> ~

Is: | matching

2mm X

II

Further filtering of items can be done using an attribute condition. Check the Attribute: checkbox to
enable the attribute condition controls. Use the dropdown list underneath the Attribute checkbox to
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choose the attribute name you wish to use. Next use the Is dropdown list to select the type of test to
apply to the attribute value. Then, in the remaining edit box, type in a string representing the
condition to test against.

Press Apply to reduce the items to be found to items that satisfy the attribute condition. The attribute
filter applies to unnamed items as well as named items.

The ‘pin’ status of Dockable bars

The pin on some Dockable bars is used to show whether the dialog is latched or not. In an unlatched
status (shown in the picture below but only applicable if ‘floating”) once an item is selected from the

list, the dialog dismisses itself. If the pin is latched, the dialog is persistent and always displayed until
closed by you.

Selection Mask Window

{42 items found Find (42 items found

wwg (@) o

The Selection Mask toolbar allows you to choose design items that are selectable within the design
and save the mask for subsequent reuse.

This option is available from the View menu and from the custom menu enabled by right clicking on
any of the Pulsonix framework (enabled the same way as the Design Browser, Part Browser, World
View etc.). It can also be enabled by right clicking on any of the existing open Browser windows and
selecting it from the context menu.

Selection Masks v 1 X
Save || New

Enable Select Mask
<Default> w |

Area
Attribute
Bitmap
Board
Bond Pad
Breakout Ly
Component ||:|Wire |

Connection
Construction Line [] Addtional Mask Parameters:
Copper —
Dimension ne Style:
Doc Shape |
Doc Symbal

Embedded View Attribute:
E"'D"_ |cNet Mame: v|
Junction

Mounting Hole
Origin

Pad |GhD NES
Teardrop
EOvenide Select Options:
Testpaint
%e:ék ||f Inside Frame v|

:“;::_3 [ Select Tight Groups
ire
[] Do Net Pick Locked tems

s |matching v |

Frame Select:

OO OO O]

Additional Mask Parameters:
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Using the browser dialog

You can use the Selection Mask on a task by task basis or you may prefer to create a selection mask
and save it for subsequent use.

You can create a list of selection masks that can be defined and saved. You might create a number of
selection masks for all Track and Pads for example.

To activate the Selection Mask and start to use it, select the Enable Select Masking check box.
Without this selected, nothing happens. Initially, the <Default> selection mask is shown. This is the
selection of check boxes in the list as currently set. If you change the selections and press the Save
button, this then becomes the new <Default> selection. However, you may wish to be more specific
about your choices and to reuse them.

You can save multiple named selections by pressing the New button. When this button is pressed, the
Create New Selection Mask dialog is displayed. When the Create button is pressed, the selection
mask is saved. Using the Copy Current Selection Mask will enable you to make the selections, then
save them. You could also use this to make slight modifications to an existing selection mask and
save it to another named selection.

Create Mew Selection Mask *
Mame: | Compoent & Pads | | Create |
[] copy Current Selection Mask Cancel

The drop down list on the Selection Mask dialog displays all previously saved Selection Masks

2 M hat BEE

BN sclection Masks * 1 X é
Save | New S
Enable Select Mask g
| &IE
<Default> =]
T - 3

—_ | [ Attrbute
[] Bitmap —~

Check box options on the Selection Mask Dialog

There are additional filters to enable refinement of the selection. With Pads selected, selecting the
Additional Mask Parameters enables the Pad Style drop down list from where you can choose a pad
style. This can a specific pad style or can be a wildcard name. The Wildcard wizard helps you create

the name.
ﬁTe:ctl
[ Track
[via
Cwire =
[] Additional Mask Parameters:
Pad Style:

I Rect (0.2mm x 1.5mm)1 ~ | | 3

With a Pad style selected, you can then only choose pads that match that style.

Inspector Bar (Dynamic Properties)

The Inspector Bar acts as a dynamic Properties windows, however, it is different.
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Accessed by right clicking on the Pulsonix framework and selecting Inspector off the list of bars
available, or access it from the View menu and selecting Inspector Bar. Generally speaking, the
Inspector Bar would be left either docked open or floating so that it is accessible instantly.

With an item selected, the Inspector Bar will display Properties for that item, for example, a selected

Component in PCB:
Inspector * Inspector
Selection . Selection n
Componert: IC4 {ATMEGA16LU2-MU} Connection {+5V}
Lock n Lock n
Locked O Locked O
Transform N Net n
Position |15'-5'35' | |3"1-?5'E | Source All Nets In Design
Angle [s0.0 | Mame 5V »
Mimored O Sub Net Only
Layer -
e
Layer <Top Side>
| Own Calour [
Explore Net =
Explore Net i
Component - Met
Mame |IC4 | Mame +5V
Patt [ [ATMEGAT6U2-MU || Change... Class
Description O |Ev-b'rt Microcontrollers - MCLI AVR USB 8K FLA.S| Nodes ol ~
ca2
Part Family O | Altemate... Cc122
Footprint [ |FN50P500X500%100-33N [~] 1101
LCD-PINT.2
Pin Names O R2.1 W
Pin Logic Names [ ] Component
Auto Footprints Mame
Part 22-27-2061
Component Attributes - Nets 15
Name Value Visible | Source ~ z} é
<STEP Filename= |ATMEGA18UZ-MUs [ ] Part 533
‘Alled_Number ] Part
DatasheetLink | http:ifww i microchi ] Part Gnd
Height 1 ] Part hd A

Context Menu Options
By right clicking on the Inspector Bar, you can access additional commands:

Change Group Order

Select Change Group Order to rearrange the ordering of the 'groups’ or sets of properties displayed
in the Inspector Bar.

Use the Up and Down arrows to move the selected group up or down in the Inspector Bar list.
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Groups can be shown or hidden in the Inspector Bar using the check boxes next to the group or by

using Show All/Hide AllL

B " Change Group Order

Selection
Lock

[ Transform
Layer

Net

Component
Line Style
[ Text Style
[1 Pad Stvle

Explore Met

W

Cancel

Up

Down

Show All

Hide: All

Explore Net

The group Explore Net enables you to see the nodes on a selected net and the nets on the component
(if the node is from a component). This functionality also works in reverse, so for a selected
component, the Inspector Bar will show all nets on that component.

Selecting a node or net from one of the lists in the group will update the other list (Net or Component
or vice-versa), allowing the connected nets and nodes to be traversed (or explored).

Explore Net
MNet

Name +5V

Class Power

3

Nodes 71
caz
C12.2
J1041
LCD-PIN1.2
R2.1
Component

MName

Part

Nets

Single Clicking to Navigate Nets & Nodes

Single click will ‘navigate’ net and nodes, using a double click will highlight net.

Find Options

This offers the same finder functionality as the Find Bar, with the Find Bar options being used here
as well. These options can be viewed and changed from the Inspector Bar by right-clicking anywhere

on the bar and hovering over the Find Options context menu.
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Floating

Docking

Tabbed Document
Auto Hide

Hide

Select Found Item
ZI Highlight Found Item
ZI Erighten Found Item

Dim Items In Colaur
Flash Found ltem

Centre View on Found Item

Add Found Item to Favourites

Close All Groups
Open All Groups

Change Group Order

Other Browser Bars Available

Other browser bars are available but are are only briefly described here:

Shape Information/Editing Bar

The Shape Information Bar appears as a dockable window accessible from the View menu and by
right clicking on the Pulsonix framework. This displays detailed information about the currently
selected shape in a grid format that also updates on the fly. It is available to use when editing PCB
and Schematic designs, Symbols and Technology files. The text in the grid describes the shape details
that may be edited allowing precise modifications to be made.

Shape Information x

=& | Paints | Pl
Auta

e
Layer: | <Through Board:

Locked[ | Closed Filled

Type X Y ~

Start Point 63.2860
Clockwise To 65.7860

With Centre At | es.7880
Clockwise To 68.2860

With Centre At | es.7880
Line To 131.5720
Anti Clockwise To 133.0960

With Centre At | 1315720
Line To 133.0860
Line To 132.5880
Line To 127.2540

Toggle Layers Bar

The dockable Toggle Layers Bar allows you to activate any of your defined layer toggles on the fly,
while in design. This is available from the View menu and by right clicking on the Pulsonix
framework.
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Toggle Layers X
A

Toggle Top
Toggle Bottom
Show Electrical Top, Bottom

The Setup button will take you to the Setup Toggle Layers dialog from where you can define the
Toggle Layers.

Colours Files Bar

This browser is used for displaying and selection of Colour files that you have saved previously. By
selecting a file name, the colour settings within that file will be quickly applied to you design.

Colour Files X
.W

pch bottom side

pcb bottom silke

pch pastel colours
pchb top side

pcb top silk

pcb vivid colours

pch white background

Attribute Editor

The Attribute Editor option presents all the attributes currently in a design (or library) using a
‘spreadsheet style’ table, this is available as Attributes... from the Edit menu, or the Attributes
button on the Libraries dialog.
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® 7 Edit Attributes O x
Attributes of: | Components o ‘
‘ Apply
Cancel
Add Name. .
Name Part Name Family Footprint <Component Height> | Category | » Rename...
Cc1 C Generic/CAP | COB0S 1.2mm Capacitor/G Beeie o
c2 C ‘Generic/CAP | C0805 1.2mm ‘Capacitor/G
Cc3 C Generic/CAP | C0B05 1.2mm ‘Capacitor/G
[ C Generic/CAP | CO8D5. 1.2mm CapacitoriG Edit
05 C Gener!:fCAP C0805 1.2mm Capac!torfG Do e
C6 C Generic/CAP | C0B05 1.2mm ‘Capacitor/G
C7 C Generic/CAP | C0603 1.2mm Capacitor/G
[ C Generic/CAP | COB05 12mm CapacitoriG Eopy Tags
[=:] C Generic/CAP | C0B05 1.2mm Capacitor/G Copy
ci10 C Generic/CAP | C0805 1.2mm Capacitor/G
C1i G Generic/CAP| C0B0S 1.2mm Capacitor/G Paste
C12 C Generic/CAP | C0B05 1.2mm Capacitor/G
c13 cP CAPP3V Revert
C14 CP CAPP3V
Cis [ CAPFEV Show
C16 C Generic/CAP | CO805 e
(el 3527 Generic/SMC| C3527 Capacitor/G
Cc18 3527 Generic/SMC| C3527 ‘CapacitoriG Colours...
C19 C3527 Generic/SMC| C3527 Capacitor/G
] [ BenericiSME| G357 CapacitoriG Save Columns
c21 3527 Generic/SMC| C3527 ‘CapacitoriG Calumn Yisio
01 o Generic/DIO0| DIOD03 DiodeiGene
02 D Generic/DIOD| DIOD03 DiodelGene
03 i) Generic/DIOD| DIDDOS DiodeiGene (G T
D4 D ‘Generic/DIOD| DIOD0O3 DiodeiGene Export CSV...
D5 D Generic/DIOD| DIOD03 DiodelGene | ey
05 D Cenenc/DIOD| DIODO3 DiodeiGene L
D7 D ‘Generic/DIOD| DIODO3 DiodeiGene: .,
< >

You can use this editor to not only view all the attributes and values in use but also to manage
attributes such as adding, removing and editing them.

Attributes for different design items can be designated using the Attributes of: drop down list. The
types of items available will depend on the type of design or library from where you have invoked
this dialog.

87 Edit Attributes

Aftributes af:

Ditferential Pairz

etz
Pins
Signal Paths
Sub Mets
Name Part Name Family Footprint <Component Heigh
Ci1 C Generic/CAP [ COB0S 1.2mm
cz C Generic/CAP | C0B05

If an attribute has already been assigned to an item (along with a value), other items can also have a
value assigned to them by simply editing the appropriate cell. Editing attribute values can be done
directly in the grid, just like working with a spreadsheet. They can also be modified using the function
buttons provided.

Cells in the grid are coloured depending on their 'state', indicating for example whether a particular
item has the attribute defined but empty, or defined but hidden, or defined and visible.
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The order in which items are displayed in the dialog can also be changed. Right-clicking on the
column heading will display a context menu from which to Sort the Column. You can also use this to
edit the name or add a new name (attribute) column heading.

Add Mame...
Footprint | <C-—=====4t=imte [ s Trannector | pa A Rename...
Add Name...

| Co805 12 Diedete Hame
\P| coaos 12 Rename...
\P| coos 12
| cosos 12 DEEims Edit..
WP C080S 12 Sort Column Delete
\P| Co805 12 .
Tl Co803 15 Mowe Column Right
P cozos 1 3mm "Capacitor/G. £ Copy Tags
P| cogos 1.2mm | Capacitor/G: Copy

The columns are initially sorted alphabetically looking from left to right but the order can be modified
to be user definable. Again, using the context menu, use the Move Column Right option. You also
have the ability to Show and Hide Columns and to control their visibility using Column Visib
button.

As well as entering values directly, you can also Copy and Paste values between cells (or ranges of
cells) in the grid or from an external source such as an Excel spreadsheet. Ranges can be copied and
pasted using the buttons or by using standard Windows commands, Ctrl-C, Ctrl-V for Copy and
Paste respectively.

Use the Revert button if you have accidentally modified the wrong cells but don't want to cancel the
whole dialog. Pressing Revert will return the selected cells to their original values, leaving other cells
untouched. This button will only be enabled if one or more of the selected cells have been modified.

Mouse Operation

The mouse is used extensively throughout the use of Pulsonix, not only for menu and option selection
but also for interaction within the design.

The standard left and right mouse buttons provide selection and context menu functionality
respectively (these can be reversed using the mouse controls built into the Control Panel).

Before using the 3-button wheel mouse, you may need to install a mouse driver that enables the wheel
to be used. Use the Control Panel and Mouse control to setup and enable the mouse driver. Consult
the manual that accompanies the mouse and driver if you are unsure about setup details.

As well as the shortcut keys, Pulsonix has been equipped with the Pan and Zoom functions on the
mouse wheel and wheel button, (e.g. available on the Microsoft® Intellimouse). This feature is only
available when the wheel mouse is enabled using its own software, and if the wheel mouse pointing
device is attached.

Microzoft (R) Intelimouse
[recammended)

‘Wheel rolled backwards
= Foom Out

Wheel pressed down and
released = Single Pan
Wheel pressed doven and
held while moving mouse
= Dymanic Pan

Wheel rolled forvwards
= Zoam In
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When the wheel is pressed down and released, a single Pan is performed centralising the design to
cursor position, (the same as the <P> key). Keeping the wheel button pressed down will enable
panning of the design until released.

When the wheel is rolled forwards (without being pressed) a Zoom In is performed to the current
cursor position (the same as the <Z> key). If the wheel is rolled backwards (again, without being
pressed), a Zoom Out is performed to the current cursor position, (the same as the <U> key).

3D STEP Preview

When using the 3D STEP Preview option in Pulsonix, you can also use the 3DConnexion
SpaceMouse. This should be installed suing the appropriate mouse driver. Pulsonix will support the
mouse buttons in 3D mode.

A special note too about mouse operation within the 3D Preview — the right mouse buttom press
requires the Ctrl key to also be pressed to enable a view rotation of the whole design.

Viewing the Design

With the advanced graphics of Pulsonix there are a number of methods of moving around the design
and zooming in and out. You can use menu commands, Shortcut keys, the World View, and the
Mouse Wheel button to achieve the same results.

As discussed previously, the World View can be used to quickly locate known items or areas within
the design. In normal design practice, the Zoom options will be required more often than not to get
into detail of the design rather than into new locations of the design.

For this discussion we have concentrated on the primary objectives; zooming in and out quickly on
the design using the most accessible methods.

The Zoom and Pan shortcuts

To zoom in and out using the default shortcut keys press <Z> for Zoom In At Cursor and <U> for
Zoom Out At Cursor. These keys will zoom in and out respectively to the current cursor position.

To zoom to the design extents (Zoom Extents), including the board outline and components (and
also including any other design information such as page border etc.) use the <A> key.

To Frame into a design area use the <F> key, click and drag an area around the items required.

The Pan function is available on the <P> key or the middle mouse wheel button. The screen will pan
and centre to the current cursor position, and keep panning if the <P> key remains pressed

View selection allows you to select an item(s) and view just these in the design window without
having to accurately frame the window around them.

You also have the View Board and View Actual Size options. View Board is similar to View All but
it allows you to frame into just the board outline area regardless of any other design items outside
these extents, for example a page border would not be included in the view unless inside the board
outline! There is no shortcut key assigned by default to this option. View Actual Size will enable you
to visualise your PCB designs at a scale of 1:1 if this option is selected. You may need to calibrate
your screen before using this. Do this from the Options dialog, Display page and Calibrate Actual
Screen Width. Details about performing this can be found in the online help.

View All can be used to view all of the design, this includes all drawing borders and text outside the
actual board outline. Useful for viewing everything in a Schematic design as well.
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Design Item Selection

Select Mode

There are a number of ways that items in Pulsonix can be picked and selected.

Select
Single select . / /i.
Ctrl-select Ctrl-select

Ctrl-select (modify) Select \ /
® —e

Shift-zelect again

Shift-select (extend)

. Shitt-select
Ctrl-shift select hsee

The diagram above shows the different modes of selection. The lighter grey shows the selected
segment.

Single Select

A single click of the mouse will make a single selection of any item. By selecting another item, the
first selected item will be deselected. Note that the item may be part of a larger entity, e.g. a single
segment of a track. If you wish to have more than one item selected use the extended select option
(see below). Once a selection has been made, a process or option can be performed on it.

Mouse Drag

A single click of the mouse followed by a move of the mouse but keeping the mouse button pressed
down will enable a 'drag' to be performed. This is often referred to as click and drag. In Pulsonix, this
will perform a Move on an item, or with nothing under the cursor or within the picking tolerance, will
perform a frame selection.

If the Ctrl key is pressed before drag, the item being moved will also be duplicated, in this instance a
new copy of the item will then be moved.

Control (Ctrl) Select

Using the Control (Ctrl) key while making a selection will modify the selected status of the current
item. This means multiple items can be selected whether they are associated with items already
selected or not. Using the Ctrl key will toggle the item to be selected or deselected.

Extended (Shift) Select

Use Shift select to increment the selection to the whole entity. This could be the complete net on any
single page in Schematics, or the complete connection/track for all visible tracks on the net in PCB, or
Component if a pad has been selected. By keeping the Shift key pressed and selecting the item again,
the selection is further increased. This can be shown on a track that spans more than one device. The
complete ‘net' for the track would be selected.

Some examples worthy of note for extended (shift) selection are; for any completely selected cutout
using Shift will select the whole shape, and for a completely selected copper shape associated with a
template using Shift will select all copper shapes on the template.
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Ctrl-Shift Select

The Ctrl and Shift keys together add to the selection and increase the selection to the complete item.
You might use this if attempting to select two track paths for tracks on different nets.

Path Select

An option on the context menu in select mode allows you to select all segments in a shape or a track
path between two selected points. If the selected points are in the middle of segments, they are split.

| Seleck >| Frame Select
Edit 4 Palygon Select
= Cross Probe |f§ Select Path
* At
Select all visibl Chrl+a
[:1? Move *Q elec! isible 1l
Select Al
% Type Coordinate... = Eg eiec
Auko Select
4% Type Offset... Shift+= 1§ Hin 2l
Change Angls To NE Reverse Layer Order Ale+P
De, Rotate By 90 R (%) Set Coordinate Origin
% Rotate One Step Al+R | ) Set Relative Crigin Shift+%
o i M .
Tl Mirror "f\: Select Previous
Lock
] Lo ‘E’ Seleck Mext M
Change Style... 5
Change Testpoint... K Deselect Al
Met 3
ComponentsfSymbols 4

The path select mode can also be accessed by simply dragging along the line or track segment
(provided you have this mode enabled in the Options dialog on Select page under Drag).

The process for inserting segments is to drag along a segment which selects part of the segment, and
then drag the selected segment to create a ‘top hat’ shape as shown below.

S T

)y p

If you wish to select more of the shape, then simply drag further along the shape. Once the drag has
been initiated and the shape segment picked up, the mouse movement will mimic the shape of the
segment without having to follow it accurately.

If you don’t want to drag to select the path, the Select Path option can also be used from the context
menu.
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Possible usage

Uses of this could include:

® Dragging segments in a track or line shape to insert a ‘top hat’

® Unrouting a track between two points

® Necking between two points (using the Select Path command followed by <S> Style to change

the segment thickness)
® Changes layer between two points
Frame and Polygon Select

Frame and Polygon Select are used to make selections based on areas drawn using the mouse. The
difference between the two modes is that Frame Select allows you to draw a rectangular frame
around items, whereas Polygon Select allows you to draw any shape to make the selection.

During Frame/Polygon Select you can also use the shift key to select extended items.

Frame Select is used by clicking and dragging the mouse around the objects required within the area.
This is the default mode but if you wish to use Polygon Select, right click in free space and pick the
Polygon Select option from the context menu.

Both Frame Select and Polygon Select modes will act on individual track segments to facilitate

segment picking. These operate with the check box in Options, Select page, Select if Completely
Framed set to on or off.

Line Select

With nothing selected in the design, right click and the new Line Select selection mechanism will be
available, if something is already selected it will be on the Select sub folder. Use this to define a
straight line to select only items that cross that line.

Enable Select Mask
@ Frame Select
|b Line Select
|E| Palygon Select
[ select Path
*[} Select All Visible Ctri+A
M Select Al
B Auto Select

% Reverse Layer Order Alt+P

Paste Ctri+V

Ranncitinn Nacinn
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Once selected from the menu, draw the line The selection will then be made:
across the items you wish to select.

Like Frame Select, keep the Ctrl key pressed down to alter the selection. Use the Shift key to extend
the selection to whole items.

Line Select is also available from the context menu in Align mode and Latched operations such as
Move when nothing is initially selected.

Double-click Editing

By using double-click on an item you will automatically enter the edit mode. On Schematic
connections and PCB track items this means the segment selected will be edited so that its path can
be changed. On PCB connections the connection will be converted to a copper track ready to have the
path created. This editing mode can also be used for all other shape based items or line editing.

For all other design items the Properties dialog for the selected item will automatically be displayed,
allowing you to make edits based on the contents of the dialog.

Auto-select Mode

Pulsonix has an active architecture, with the database capable of extremely fast selection. To utilise
this fast selection, you have an Auto-select mode of operation available. Auto-select allows you to
move the cursor over items within the design and obtain instant selection without clicking the left
mouse first. Clicking the mouse key now performs the 'Edit' function on the selected item.

Cyclic picking

When attempting to select items within a dense area of the design, it is not always easy to pick the
item required at the first attempt. Under these circumstances Pulsonix has a system of picking that
'cycles' through items in close proximity to aid the selection. This allows you to make a selection,

then toggle through the design items adjacent to it until you select the item required.

The keys used for the commands Select Next and Select Previous can be user defined but by default
the Next command is set to <N>, the Previous command is not set by default.

Select from popup list

Holding down the Alt key and selecting overlapping items, a context menu will list all items at that
position, allowing you to select a specific item based on its description rather than the item. This is an
alternative to selecting the first item, then pressing the <N> key to get the new selected item within
the picking tolerance.
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A

Component D3, Layer <Top Side=
Track Angled, Layer Top, Met Met 4
‘ Track Vert, Layer Top, Met E1
Track Vert, Layer Top, Net E1
Via 27,9400 45,0850, Layer Span <Through Hole>, Met E1

This feature can be disabled in the Select section of the Options dialog and Select page.

Configurable selection flags

In addition to the ability to select the next and previous items in the design using cyclic picking,
Pulsonix also contains a mechanism for enabling and disabling design items. This mechanism is
located on the Colours dialog alongside the Displayed selection. D

B Colours - Attributes

Layers <30 Package> - Layer Displayed | $electable Colour

Elec Shapes <Autoplace Ruless Silkscreen Top ] []
Doc Shapes <Branch Point Name: Top [~ [~]
Pads <Component Height > Solder Mask Top [~ []

Boards & Areas [W:Component Name> | Paste Mask Top 7] []
ias omponent Variant Id> Pin Names [ [
Ted «Cument Varant Description Inner 2 [~ [+
& Attributes <Cumrent Variant > Ground ] []
Highlights <Database Field> Power ] [+7]
Inner 5 -~ ]
Others _ _
Bottom w ]
MNets <Database Table> Silkscreen Bottom ] []
Differential Pairs <Date> Solder Mask Bottor [~] [
Signal Paths «Design Author= Paste Mask Bottom| [~ []
Sub Nets <Diesign Commerts > Pin Names (Bottom ] ]
<Design File Paths Board ] [
<Diesign Name: Construction Lines| [~ [
/] <Design Revision: Documentation ] [~

[ <Desian Subiect >

By making a selection in the relevant check box, you can make individual design items selectable or
not.

'Latch’ Mode

Latch mode is a mode of operation that allows a tool to be pre-selected (latched) and applied to many
items until it is toggled off (unlatched). For example, the Rotate mode can be latched down and
rotations applied to many components in the design in turn.

To exit latch mode, you can either select the option again to unlatch it, or press the <Esc> key on the
keyboard to return to Select mode. You can also use the Cancel option from the context menu after
right clicking the mouse.

Context menus

The right mouse button can be used extensively throughout Pulsonix to reveal context menus, these
are also known as shortcut menus or pop-up menus. These menus can be accessed during an
operation or by direct selection using a ‘right mouse click’, each menu has a set of relevant
commands in 'context' for that option.
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Once familiar with the system, you can access the context menus by right clicking on an item rather
than left mouse clicking to select and then right mouse clicking. By right clicking directly, you can
select the item and display the appropriate context menu.

Select 4
[ Edt M| % cut CtriX
¥ Cross Prabe Copy Ctrl+C
§ Move Paste Ctri+v
Enable Nudge @ﬂ Duplicate Ctrl+D
¥ Type Coordinate... = Replicate...
% Type Offset... Shift+= |3 Delete Delete
5‘9 Scale 7 Unextended Delete Ctr+Delete
B Lock % Extend Delete Shift+Delete

Change Style... S

Change Shape Type...

Do Chama

The example above shows the contents of a typical context menu, this one from the pin item in a
Schematic design. Once displayed, the context menu will remain on the screen until an option from it
is selected or the <Esc> key pressed. The menu options are selected using the left or right mouse
button.

The Design Settings Dialog

Design-based options are defined on the Setup menu in Technology and Design Settings dialog.
These are created for and saved with each individual design, they would also be saved to the

Technology.
B Technology [] - Design Settings — General
=~ Design Se’Ftings ~ All Text Attributes
- Coordinate System [] Adjust To Readable Orientation Substitution Char: E
(when doubled)
[ Multi-Line Text Vertical Align
=) Defaults Matching S
... Area Barming Character: ching Styles
Attribut (when doubled) (®) By Name Only
- Attribute
. () By Name And Value
- Bitrap System Font O By Value Oriy
.. Block alue Onl
[ Proportional Width Digits
- Board CAM/PI Naming Rules
i /Plat

- Branch Point [ Make named styles use naming rules
. Component [ Transform about design extents
- Construction Line STEP Model Alignmert Pad l.Except.lons
.. Copper Snap by: [ Mimor with Component
. Dimension ’
. Dimension Units @® Centre Net Optimise
. Doc Shape O Crigin [ Pads/\Vias connect by centre
EmbEddEd View Use Adiustment Attributes Spacing Rules:
- Errar
Layer [ Enable linking of types
- Mounting Hole

The Options Dialog

Much of the main option customisation is done through the Options dialog on the Tools menu with
some set-up through the Folders option. These are generally options on the tools themselves, such as
being able to set the editing angle of the lines etc.
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There are subtle differences between the Schematic and PCB Options dialogs but these relate mainly
to the Track/Connection editing functionality and general PCB functionality, such as On-line Design

Rules Checking and Move (because of Component Pushing etc.).

Options - General

- Design Backups

- Display

. Edit Shape

.. Edit Track

- File Extensions

- Find

. In-Place Mames

- Interaction

- Macros

. Move

- Multi-5creen

- Online DRC

. Resolve Met Marmes
- Select

. Synchronisation

- Tooltips

- Pan & Zoom

- Track Length Limits
- Warnings

Relative Coordinates
Show relative coordinates in dialogs when used
Default Units:

(®) Imperial () Metric

Cursors:

s

Use Modal Cursors

Snap Cursor to Grid

Sereen Print
[ Mways Print in Black

Environment Variables

Substitute Character:

Importing from Cther Systems

Show Design Browser

Default to Mo Technology

API

Upaon encourtering an emor: (@) Show application

() Ignore and continue

Allegro Extract File Path

| Browse...

Multi-Threading
Enable Threads
Thread Count

8

Undo:
Number OFf Levels: {10 |5

Help:
[ Always On Top

Libraries
[] Floating Manager
Close Dialog On Edit

Recent Files on File Menu

E 3| entries

{Mote : Needs program restart to take effect)

Dialog Grids:
[] Edit on Double-Click only
Open as View Only
Open Schematic designs view only
Open PCE designs view only

[ Ask at program startup

Wault
[ Switch Vault Functionality OfFf

UTF-8
[ Suppress UTF-8 BOM

The tabs are set out so that they are grouped by logical areas of functionality. The General tab
(shown above) is used to set Pulsonix system type information for example.

More detailed information relating to setting up preferences through the Options dialog will be
discussed in each section of the manual relating to particular features.

The Properties Dialog

Each item in the design contains a set of characteristics that can be viewed or edited using the
Properties option. Some items within the design are made up of several parts, each of which is
individually selectable and have its own properties that can be viewed. For example, a Schematic
Component might contain a number of terminals (or pins), some lines that represent the symbol shape
and some text. The terminals will also have their own properties, such as shape and size etc.

In addition to item properties, there are also Design Properties and Document Properties. Design
Properties are used to show design based information, such as Attributes and the Associated Parts.
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Document Properties shows general statistics about the current design being edited, plus you also
have the Inspector Bar to use.

Design item properties can be viewed by selecting the item and clicking on the Properties option
from the context menu. The example below shows the Properties of an SCM Star Point.

B Properties: Star Point - Star Point O X
Star Point | Star Point Attibutes  Vault

[ Locked

Angle: [ Mimored Scale:

Symbol: [Star Pint (3 Signals) | | change..

Drawn on: Thiz Fage Only

Joins Nets:| GND
A_GND
Dig_GND

You can also select the item and click the shortcut key <I> (this is the installed default and can be
changed if required).

From the Properties dialog you can view detailed information about the item selected and can also
use it to make changes, such as the items name, its rotation/mirror status (if relevant), etc. Major item
changes can also be made, such as a change to the footprint style from DIP to surface mount for
example.

Multi-ltem Properties

The Properties dialog is also capable of changing multi items of the same type. Only items of a
similar type can show their Properties together. If the selection includes dissimilar items, Properties
will not be available.

The example design over shows the selection of multiple gates of a Part but one of the gates is
rotated. All of the gates belong to the same device (U1) and all have different Positions in both the X
and Y direction. In the design, only one gate has a different X position because it has been rotated, as
shown by the Angle. The Y position would be different because they are placed in a line. All other
details are the same.

-
X £ £
ULz W) (B}

From this dialog you could now make all the gates the same rotation by changing the Angle: to a set
value, and change their Position: in the Y axis so that they were all aligned vertically with each-other.
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" Properties: Component - Component O X

Component  Comp Attributes ~ Vautt

& e [ Looked

| Position: <Different = |
Angle: CMirored  Scale: [1.000000

Part: |483D106X0010C1 | | change...

[ Description: |CAP 4850 16V TANT CASEC

[ Part Famity: |435' | Altemate...

[ Footprint: [m] Specify Footprint:
BEAD 0.6mm

[ Symbal: |C polarised2 »

[1Pin Names Pin Logic Names

Once this was done, the <Different> indicators would show a value. This would be reflected in the
item changed in the design.

Attributes

Another use of the Properties dialog is for adding attributes to design items. From the Attributes tab
you can assign an attribute name and value, you could add a <Hyperlink> attribute on the Comp
Attributes tab for example.

B Properties: Component - Comp Attributes O X

Component Comp Atributes  Vautt

[Hyperink >=http://www vishay.com/ New...
[J<Part Family>=489
[Category=Capacitor/Radial Lead/Solid Tant/Case C/RoHS Edit...
[ Mfr=Vishay
[In=106 Delete
[ Tol=20%
CJv=18v
Value=10uF

You can also opt to show the attribute on the item by selecting the check box on the left of the
attribute name and value.

Adding Attributes from a file

With the Attribute Properties dialog you can also take an external text file or selected text and
simply drag and drop it onto the attributes page.

The whole text file can be dropped onto the attributes to add new attributes or edit/update existing
values. The format must in attribute=value, such as MFR=Motorola. Partial text values can be cut
and pasted into the attributes page if you prefer not to use the whole text file.
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Chapter 3. General Utilities

Undo/Redo

Pulsonix contains unlimited multi-level Undo and Redo capabilities for use through the product.
Undo can be used to reverse the last operations that have been completed. Undo can be used
sequentially to undo more than one operation. It can also be a useful and flexible tool to interactively
try different iterations of an operation, manual routing for example.

If you use lots of Undo levels, this will use up your memory. In this case, you should either install
more memory or restrict the number of Undo levels.

Undo and Redo steps are only available back to the maximum number of levels set. Not all operations
are available to Undo/Redo, a list of unavailable operations is listed in the on-line help under Undo.

The number of Undo levels is set up in the Tools menu under the Options function and General tab.

Options - General O
- Design Backups Relative Coordinates Undo:
- Display . . P
Show relative coordinates in dialogs when used - =
Edit Shape . Qg Number Of Levels: |10 =5
- Edit Track Defautt Urits: Help:
- File Extensions
 Find @ Imperial () Metric [ Mlways On Top
Cursors: Libraries
- In-Place Names
- Interaction _— i [] Floating Manager

With any Undo level set, say 4, when the fifth Undo step is required it will overwrite the first
operation in the Undo buffer that is then lost. So care needs to be taken if using restricted levels of
Undo.

Using Undo and Redo

Undo and Redo are invoked using the standard Windows shortcut keys <Ctrl-Z> and <Ctrl-Y>
respectively. These have been defined as part of the installed set of default keys but can be changed if
required; these are also available on the Standard toolbar as buttons. Redo is only available once an
Undo has been performed, until then, it remains on the menu but is greyed out as unavailable.

Interactive Operations

Overview

During operational use of Pulsonix there are a number of interactive operations that allow items to be
moved, rotated, mirrored .and edited. The following sections cover this collective set of features and
describes their use and how to set their mode of use where applicable.

Moving ltems

There are two methods of moving objects in Pulsonix. The first and most widely used is the drag and
drop methodology, for use when an interactive move is required. This is modeless in that it can be
used without a mode selected. The second method is the Move mode. This can be accessed from the
Edit toolbar button and from the context menu. It allows you to move items with the mouse button
left up.
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By clicking on any item in the design you can use click and drag to move that item. Depending on
how much of the item is selected depends on what is moved. For example, if a segment of a shape is
selected and dragged, the segment will be 'stretched' until released. If the whole shape is selected, the
whole shape will be moved to a new location. Components are a special case for this type of move.
When a Component is selected and regardless of how much of the Component is selected, the whole
Component is moved. The Component is made up of individual entities 'grouped’ together to form the
Component library shape, thus is acts as a complete unit when moved.

The alternative methods for moving items are to select the item first and click the Move button from
the Edit toolbar, or Move from the context menu. Once in Move subsequent options are the same.

You can also use Move in Latched mode. This means that Move can be selected from the Edit
toolbar first, and then applied to items within the design. This mode will be retained as long at the
Move button is latched. This option can be unlatched by selecting another option or by selecting the
Select button or by pressing the <Esc> key.

When in any move operation, a single click of the mouse will release the item in its
["\-S‘_I_’ current location. During this operation a modal cursor is displayed (this must be
switched on in the Options dialog and General tab).
During any move operation the context menu can be accessed to provide additional options for use,
for example, Rotate, Mirror, Layer, Style etc. The options available depend on the current
application and the item the Move is being applied to.

The context menu example is split in half to show the extensiveness of the optiosn available:

Force Vector
J}' Optimise Selected Mets Shift=L Use No Grid Shift=N
Cancel Move ShomlisckencinLnits Use Taols Grid Shift=W
Finish Here Reposition Cursor Text Use Tools Component Grid
% Type Coordinate... = LselDynamicalign Use Toals Track Grid
% Type Offset... Shift== Z| Online DRC Use Tools Via Grid
DD Type Rotate... ZI Continuous Online DRC Use Tools Testpoint Grid
Change Angle To 3 ZI Display Clearance Use Track Grid
D-él Rotate By 90° R ZI Allow Checking of Multiple Items Use Working Grid
2 Rotate One Step alt-R EuchlMode "l UseTet Grid
7) Change Rotation Step... Push Direction 4 Use 0.5mm Grid
Mirror M EPIIEETES Use Via Grid
Show Placement Origin Free Angle Adjoining Segs Use Component Grid
\\i show Dynamic Cons Only Preserve Attached Segments Use Testpaint Grid
Optimisation Mode D Constrain Orthogonal Segment Use Panel PCB Instance Grid
Optimal Pasition Mave Horizantally Display Grids =G
Optimal Rotation Move Vertically H Grid Step... [
Foree Vector | Change Grid »‘ H’{ Grids.. Alt=G

The context menu above shows typical functionality found when in the Move option. This example is
for the Move Component option.

When using Move, a Grids selection is available from the context menu, please refer to the next
section headed Grids for more information.

Line segments that are Mitred or Curved can also be moved but will retain their size and make the
adjoining segments each side dynamic. To edit or move a Mitre or Curve you should use the edit
facility. This can also be accomplished by double-clicking the mouse on the segment to be edited and
then dragging the segment to the required position.

The ends of straight line segments and corners in general on open shapes can be moved by selecting
the end of the line and dragging it.
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Mirror

v

A small circle appears at the end to indicate that it is the end segment that has been selected. From
this point you can drag the line item to resize it.

Mirror can be used on most items within the design including connections in Schematics. Sometimes
also known as ‘Flip’ but called Mirror in Pulsonix. It is available from the Edit toolbar, using the
shortcut key <M>, and from the context menu when an item is selected or being moved. Mirror is
also available from the context menu within the Item Properties dialog for some items. It is not
available for all selected design items.

Mirror can also be used as part of Move. During the moving of an item Mirror can be selected from
the context menu or from the keyboard using the shortcut key <M>.

Mirror in Schematics

Within Schematics, Mirror will flip a Component or Documentation Symbol using the centre of the
symbols bounding box as the axis point. Text in Schematics cannot be mirrored.

When used with connections, Busses and Shapes within Schematics any dynamic segments can be
mirrored across to their opposite diagonal point. This applies to any two segments but does not apply
to more than two segments or less than two segments.

y

Mirror in PCB

When used in the PCB editor, Mirror has three effects. The first will flip the complete Component,
Documentation Symbol and Text to the other side of the design (if the alternative opposite side is
available). When surface mounted components (with surface mounted pads defined on a surface
layer) the pads will also be mirrored to the other side of the design automatically. The second effect
will work on whole design shapes and will mirror the shape on the same layer. The third mode will
work on any two dynamic segments.
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Mirrored Components

Components and Documentation Symbols are mirrored around their Component origin axis to
maintain their position. The diagram below shows how the Component will look after rotation but has
been moved over to the right for clarity.

The axis points would actually be coincident once mirrored.

0l

Where whole shapes are selected, the shape is mirrored about its origin. This would be the pick point
of the shape; in the example below the axis would be the edge of the shape.

Az point

zhape Mirrared to Here

Where two dynamic segments are being edited, the segments are flipped to their opposite diagonal
corner. The two examples below show the track segments flipping, and the dynamic segments of a

shape flipping.
O O
O
O O
O O

% d

]

Mirror can also be used in Latched mode. To use this, select the Mirror button from the Edit toolbar,
and apply it to each item selected. You must deselect the option by selecting the Select button or
another option before Mirror is unlatched.

% ‘When used in this mode, a modal cursor is available.
H

Rotating Items

Rotate can be used on most items within the design. It is available from the Edit toolbar, using the
<R> key as a shortcut, and from the context menu when an item is selected or being moved. Rotate is
also available from the Item Properties dialog for some items either single or multiple items of the
same type (it is not available for all design item types). This is particularly useful if a number of
components are selected for rotation to the same angle, for example.
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When moving an item, Rotate can be selected from the context menu or from the keyboard using the
shortcut key <R>. For ease of use, rotation steps can be taken from the context menu as steps of 90
degrees, or Rotate One Step to rotate by 90 degrees.

Rotate can also be used in Latched mode. To use this, deselect everything and select the Rotate
button from the Edit toolbar, and apply it to each item in turn. You must exit the option by selecting
the Select button or another option.

% ‘When used in this mode, a modal cursor is available

Rotation steps can be defined down to 1/100,000th of a degree, this level of precision allows accurate
rotation of items when using polar/radial grids. The precision and rotation unit type of Degrees or
Radians can be defined from the Settings menu under Angle Units on the Units dialog.

Technology [] - Units - Units

#- Spacing Rules Length Units:
- Styles )
+ Layers O Impesial: thou
+ Mets (®) Metric: mm -
+- Rules - DFM/DFT
- Rules - High Speed Precision: |3 =
+ Outputs
;--Naming [] Trailing Zeros
#)- Colours Rounding Indicator (+/-)
+- Grids

N Angle Units:
+ Wariants (@) Degrees () Radians
+ Design Settings Precision: E =

- Parameters

7

Trailing Zeros
Rounding Indicator (+/-)

When using the rotation modes, the setup of the angle for which items use is defined from the Tools
menu and Options. From the Interaction tab use Rotation Step to set the default rotation step of
any item rotated.

Rotation steps are always defined in an anti-clockwise (Counter-clockwise) direction but can be
defined in a clockwise direction by specifying the rotation step as a -ve (negative) number, e.g. -90
(degrees). Normally the rotation steps would be specified as a positive number. Rotation steps can be
specified in any value or part value by typing in the number required.

Polar Rotate

Check this box to change the two edit boxes to accept an Angle and Magnitude to define the position
of the selected items using absolute polar coordinates applied about the rotation point. The selected
items will be rotated about the rotation point until their origin is at the required angle and then moved
towards or away from the origin until the distance from the selection origin to the rotation point is
equal to the required magnitude.

Special cases of rotation
Bus Terminals in Schematics
The 45 degree line emerging from a bus is called a bus terminal. This terminal can be setup to be

always Up or Down (and Left or Right on horizontal busses) but can never be mixed to show both Up
and Down (and Left/Right).
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Do

Bus terminal

Bus Connections Left Right

The default direction of the bus terminals is set in the Design Settings dialog, under the Defaults tab.
Once a direction has been set and a bus terminal used on the design, the direction can be changed
using the Rotate option.

Readable Text in Schematics

When any item containing text or any text item is rotated in Schematics, the design can be setup so
that the text is always readable from the bottom or the right of the design page. If the text item is
rotated further than an angle that makes it unreadable it is automatically rotated back to a readable
state. This mode is set in the Design Settings dialog under General and is defined setting the check
box under All Text to Adjust To Readable Orientation.

This mode can be overridden for individual terminals by using the Ignore Readable Orientation
check box in the Text Properties dialog. This is also available in the Attribute Properties dialog.
Selecting this switch disables the effect of the Adjust To Readable Orientation switch (from Design
Settings — General dialog) for that specific text instance..

Properties: Component Attribute — Attribute O X

Aftibute  Text Style Component Metson Pins Comp Attibutes  Variants  Vault

MName: | <Component Name:>

|
Usage: |Part |
Value: [C14 |

41

Position: [ Locked
Angle: [ Mirored

Layer: |Si|kscreen Top v
Text Alignment:

OO Bottom Left
[elole]
®00

| [] lanore Readable Oriertation

Grouped Items

Grouped items (from Frame Select, Polygon Select or Multiple select) can be rotated and done
using the centre point of the group as the rotation origin from where they are rotated. The bounding
box of the group includes any text or origin items as well as any visible or invisible items.

Design Repositioning

The complete design may need to be rotated during the design process. This can easily achieved by
right clicking the mouse in an area of free space on the design. From the context menu select
Reposition Design. You can apply an X and Y positional shift or just apply a Rotation to the design.
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Reposition Design X
shitBy: x (10000 | v [0.00
Botate By:

Cancel

Design Rotation for Output

The complete design may require a rotation from Landscape to Portrait for example, to allow it to
fit on a paper page when plotted. This is not required if this is the sole requirement, the CAM/Plot
output feature enables you to plot the design rotated by the simple use of a Rotate Design check box
on the Plot Positioning tab.

Lock and Unlock

Lock is used to fix design items so that they cannot be moved or edited. Unlock is used to 'release’ or
Unlock the item following a Lock operation.

It is available from the Utilities menu and the Edit toolbar and from the context menu when an item is
selected. Lock is also available from the Item Properties dialog.

Unlock is only available on the context menu after a Lock has been performed on an item.

Lock and Unlock can also be used in Latched mode. To use this, deselect all and select the Lock
button from the Edit toolbar, and apply it to each item then selected. You must exit the option by
selecting the Select button or another option.

Model cursors are available to show the current Lock or Unlock mode being used.

When attempting to perform an operation on an item that is locked you are presented with a warning
dialog from where to make a choice of which action to make:

Operation on Locked ltems X

Before performing the operation, what do you want to do
with the locked items?

Deszelect them (D0 MOT perform operation on them,
(O Urlack them [Perfarm operation on then |

(®) Keep locked [Perform operation on them)
Perform Operation Cancel

This dialog tells you that the item is Locked but also gives you the option of continuing with the
operation requested.

By selecting one of the radio buttons, then the Perform Operation button, the operation can still be
performed but is completely under your control. You also have the opportunity to not perform the
operation, if selected by mistake for example.

Special cases
Importing from other systems
When importing a design from another system using one of the built-in import filters, some items are

automatically locked in place when the design is viewed in Pulsonix. These items can be subsequently
unlocked using the Unlock option.
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Track Locking in the Auto Router

While using the integrated auto router option, you have the ability to lock tracks that already exist in
the design and to lock new tracks added by the auto router. Once subsequently using the interactive
features of Pulsonix you can lock or unlock any tracks as normal anyway.

Track Locking

Tracks can be locked in the PCB design editor. This maybe particularly useful when using 'fanout’
type track patterns on a Component as it will prevent accidental removal of tracks and vias from the
design. If using the auto router, you also have additional control over their removal, see above.

Locking Vias

Vias can be locked in isolation to the tracks that they are connected with. This will prevent their
removal even if connected to tracks that become deleted. You may have critically positioned the via
in the design and allocated it as a Testland. Even with no tracks connected to it, the via still remains
connected as attached to the net.

Cut, Copy, Paste and Duplicate

Cut and Copy are used to copy and remove items from the design and place in the clipboard, or to
take a direct copy of an item and place into the clipboard respectively.

Paste is used after items have been placed in the clipboard (from using Cut or Copy) and adds them
to the design.

Duplicate is used to copy item(s) and paste them into the design. This option is used for direct copies
within the same design.

All of these options can be used on all design items. They are available from the Standard toolbar, as
shortcut keys from the keyboard, and from the context menu when an item is selected. These options
are also available as menu options from the Edit menu.

As a default, the shortcut keys in Pulsonix include the standard Windows shortcuts where available
but these can be redefined if required.

Cut <Ctrl-X>
Copy <Ctrl-C>
Paste <Ctrl-V>
Duplicate <Ctrl-D> and <Ctrl-drag>

As an additional shortcut method to using Duplicate, you can also use <Ctrl-drag> while making a
selection. Instead of moving an item, the item is duplicated and the new copy moved ready for release
in its new position.

These options are available on selected groups of items regardless of whether they are similar or not.
The same rules apply to groups as for individual items or multiple selected items.

Special cases and rules of operation

Paste/Duplicate into the same design will cause the Resolve Net Names dialog to be displayed if the
selection contains any named nets. If the selection only contains default net names the net names are
automatically incremented to the next available in the sequence while being added to the design. Any
Component names within the selection are also automatically incremented to the next available in the
sequence.
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Resohve Net Names *

Mets in this list already appear in the target design.
'Check' thase that shauld merge with the coresponding

et in the target design. Any ‘unchecked' nets will be
renamed according ta the ‘Rename' settings.

+B[Power) A~ Fename
igg; ®) Auto-lncrement
ADD3 () Prefis

ADD4 )
ADDS O Suffix
14006

HSE1

HSEZ

LCI_ENAR

LOCAL

FASDI In 1 v

Select [tems

Cancel

Al Mamed: | |47 | Check

Mone ‘wiith Class - | ~ | Uncheck

Schematics

If the selection contains a portion of a multi-gated device, the unselected gates or unused gates are
added to the Component Bin for later use.

While Duplicate cannot be used across pages, Paste can be used. Selected items can be Cut and
Copied to other sheets if required.

Items being Pasted onto a page are checked across all pages, this applies to both net names and
Component Names.

Safe Mode

When using Pulsonix in Safe Mode, Paste and Duplicate will not be available if it means adding in
new design items that change the netlist in any way. In this mode, if you wish to change or add design
items you must return to the Schematic design and make the changes there before using Synchronise
Design to make the changes to the PCB.

Copy to another shape type
When using Copy/Paste on a shape, the shape can be added to the design as a new shape type.

Before pasting the new shape into the design you put Pulsonix into the Insert Shape mode required
for the new shape. For example, if copying a Board Outline shape to a Template shape, you should
copy the board first, then select Insert Template shape and Paste. The new copied shape will be
exactly the same shape as the board outline but will be a template ready to be placed. While in this
Insert state, more options are available from the right mouse button, change layer, change style etc.
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Grouping ltems

Items in the design can be grouped together for moving etc. When more than one item is selected, the
Group option appears on the context menu. Selecting this option causes all the items to be added to a
new group. If the items are deselected and then one of the items is selected, all other members of the

group become selected.
l’—‘
J_‘Rlﬂ

R1
|::| Select:

Edit

Cross Probe

Move

Type Coordinate, ..
Twpe Offset...
Rotate By 90

o 7 % <« 0o

Rotate One Step

=
=

Mirror

Lock.

EB

Shift+=
R

Alt+R
M

Group

-

|||:IE] Ungroup

byt
o

Show Met Marme

Components)Symbals

Tight Group

E Marne Group. ..

If the group is to be named, select the group and select Name Group from the context menu.

Group Mame

s

MName: | Group!

o

Context: |PCB Design Only

B

Tight Group

Groups can be named and the group and name passed through from Schematics to PCB designs. If the
group is to be translated to PCB, it must be named. Named Groups can be managed using the
Technology dialog and Group Names tab.

Name | Tignt Context
v | Group1 & All Designs
Processor (Support) & All Designs

Groups are created as Tight groups, that is all members of the group act as one. If you want to make
changes to individual members of the group, change the group type to Loose. This can be done by
selecting the group and unchecking Tight Group on the context menu. Any group member when
selected will then act individually. To change back to a tight group, select any member of the group

and check Tight Group.
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Create PCB Group from SCM Block

You can also mark a Block instance (using Block Properties) to Create a PCB Group when in PCB.

The equivalent group is added to the PCB and Synchronise Design will keep them in-line. The group
has the same name as the Block, with an optional prefix (which is defined in the PCB, see below).

® " Properties: Block Instance - Block

Block  Block Ports  Block Instance  Block Instance Attrbutes  Vautt

Mame: |B1 |

O Block:  [Block1 | Change...
Generated Block

[ Description:

Can be Multiply Instanced Create PCE Group <:|

[ Locked Instance
Locked To Vault
Block Name Prefix

If required, set the Block Name Prefix for use in the PCB from the Technology dialog, Design
Settings — General/Defaults and Defaults button. Choose Block and type the name of the Block
Group Name Prefix:

When viewed as a group, the name will look like this, showing the Prefix first, followed by the Block
Name.

Group Name *

Mame: |Block_Blockl —

Context: | PCE Design Only

Tight Group Add To Group

Deleting Items

Delete can be used on almost any item within the design. Some exceptions are detailed in the Special
cases section below. Delete can be used to delete selected item(s), or can be used in latched mode
where the Delete option is selected first and applied to items within the design. When used in latched
mode you can only exit it by selecting the Select button on the toolbar or another option.

The Delete option can be selected by pressing the Del key on the keyboard or by using the Delete
option from the Edit menu, or the Delete button on the Edit toolbar, or the Del option on the context
menu.

There is no confirmation to delete, however the Undo option can be used to recover any deleted
design information, provided an option hasn't been used that removes the Undo levels from memory.

% When Delete is used in Latch mode, a modal cursor is available.

There are 3 different ways to perform delete that are relevant to a Component or Symbol, for all other
item types the Delete function deletes the item.
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®  Unextended Delete will just delete the Symbol leaving any connections ‘dangling’. This can be
used in conjunction with the Auto Weld option in Schematics.

® Extend Delete will delete the Symbol and connections leading from the pins on the Symbol back
to the pin or junction at the other end of the connection.

® The default Delete option behaves as Unextended Delete in Schematics and as Extend Delete in
PCB.

® The default hot key for Delete is the Delete key, with Shift-Delete for Extend Delete and Ctrl-
Delete for Unextended Delete.

Special cases

Schematics

Deleting one gate of a multi-gate Component will not remove the Component completely if one of the
other gates on the Component are still being used. It will put the deleted gate into the Component Bin
as unused. This will happen to each until the last gate of the same Component is removed from the
design, at this point all the gates for that Component will be removed from the Component Bin as
well.
Ui-a
SNFHACTEEN Component Bin X

=1
5 Ul-d
Z SHF4ACTAAN
Ut-k L
-4
13
=
R e UL - SNT4ACTOON
g
b |

In the previous example shown, if four gates of U1, a 7400 device, are placed on the design, when
Ul-b is deleted it appears in the Component bin and Ul-a,c,d remain on the design. Finally, with just
one gate left on the design, Ul-c say, all other gates appear in the Component bin. When Ul-c is
removed, Ul with all four of its gates are removed from the Component Bin and the design.

Safe Mode

In either of the design editors you can run Pulsonix in Safe Mode (by selecting this mode in the
Options, General dialog). This means that the netlist (nets and components) cannot be changed in
that design editor without using the Synchronise Design option. In this mode, you cannot delete any
nets or components that would affect the netlist. Safe mode can be chosen for either the Schematic or
PCB designs deoending on which one you select as your ‘master’ design.

Deleting Nets/Tracks

To remove a connection in PCB you must use the Remove From Net option from the context menu
once the connection has been selected.

Delete on tracks in PCB has the same effect as Unroute Track. If you want to remove the track and
the connection, you must use Remove From Net.
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These modes can be used when the PCB is in context, i.e. either as the master when used with
a schematic design or when being created without a schematic design.

Inserting Text

Single line and multi-line text can be added to both Schematic and PCB designs as well as library
items. The style of the text used in the design is defined in the Technology dialog under the Text
Styles tab.

From the Technology dialog, you can also change the Text Styles to also include TrueType fonts as
an alternative to the standard ‘stick’ system stroke font.

Name | Height Line Width Font Underlined
Adtributes 50.0 5.0 =System Stroke Font= [l
% | Component N: 50.0 5.0 <System Stroke Font= [l
Errors 50.0 Arial =]
Header 30.0 Arial ]
" | Logic Names : 50.0 5.0 <System Stroke Font= [l
[ Met Names 50,0 5.0 <System Stroke Font= =]
Normal 50.0 5.0 <System Stroke Font= [l
| Pin Names 50.0 50 <Syatem Stroke Font= (]
Table 150.0 10.0 <System Stroke Font= [l
Table Small : 100.0 10.0 =System Stroke Font= [l
Title 200.0 200 <System Stroke Font= [l

The Name is used to define the name of the text style when used in the design. The Width and Line
Width define the character width used and the thickness of each line 'stroke' making up the character.
The Font can be defined from the list of installed Windows system fonts and the default <System
Stroke Font>.

As with all styles to be used in the design it is more efficient to define a range of relevant styles for
Text. This will allow you to categorise the text being added into types, this makes it easier to change
all of a type by changing the style values.

You can also define text styles as you insert text into the design using Change Style from the context
menu or pressing <S> on the keyboard.
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Text Style X

Mame; | Component Mames ~

Text Size [] in Points

Height: |7.00 |5

Fort
| Trebuchet M5 i

[ Underline

Cancel

From this dialog you can change the Size and Line Width of the text but will also allow you to
change the style name or use the default style name presented to you. The style presented in this
dialog is added to the Technology dialog under Text Styles. It can only be edited in the Technology
dialog and not in the Text Styles dialog where it was initially added. This feature is in addition to
adding the text style to the Technology dialog directly as part of setting up your design styles. If using
this method you should also remember to alter the Technology file if the styles are required in other
designs. Technology files are described in the next chapter.

In PCB, text that is added to electrical layers becomes an electrical 'block’ that is checked during
Design Rules Checking and On-line DRC, and that has its own (Text) Spacing Rules defined in the
Technology dialog. Text on non-electrical layers is not checked.

The text origin can be changed for each individual text string. Multiple text items can also be selected
and their origins changed together. Once the text items have been selected they can be changed
through the Item Properties dialog on the context menu. You can select from one of nine Text
Alignment positions. By default, the text position is always Bottom Left, this can be changed
through this dialog or by using the Change Text Alignment option from the context menu.

B Properties: Text - Text O X

Text  Text Style Varants

Pulsonibc
BW iss2

Angle: [ Mirrored: [ Locked
Layer: |Si|ksc:reen Top - |
Text Alignmert: [ 0wn Colour
OO Bottom Left
000
®00

You can also change the colour of text items to contain their own colour rather than that defined in
the Colours dialog for Text. Care should be taken when changing the colour of particular text items
so that there isn't confusion identifying the layer for example that the item appears on.

The text font can be changed from the Properties dialog also using the Text Style tab.
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Vertical Text Alignment for Multi-line Text

The switch, Multi-Line Text Vertical Align, in Design Settings, General, under All Text enables
you to set the text position for multi-line text in the vertical axis. When enabled, this causes all multi-
line text to vertical align using the height of all the text, not just the first line alignment. This is a
design setting, so it will change the vertical alignment of all multi-line text in your design so care
must be taken if applying this after already having added multi-line text, especially on electrical
layers.

Al Text Attributes
[ Adiust To Readable Oriertation Substitution Char: fwhen -
doubled) -
| Multi-Line Text Vertical Align |
Baming Character: I:I Matching Styles
{when doubled) (® By Name Crly

() By Name And Value
System Fort
() By Value Only

| I TSR I P Y R

The two images below show the effect of this switch. To clarify where the alignment is taken from,
horizontal and vertical construction lines have been added to the text to show the movement.

The left image is before switch is activated (and as current product), the right-hand image is after:

Multiline text
spread across
different lines
Multiline text showing alignment
spread across
different lines
showing alignment

Special cases
Pulsonix has the ability to cope with special text cases where formatting or style is required.

Force to Upper Case

By defining what text items should be forced to upper case (capitals) it then makes no difference
whether upper or lower case text is typed in, the text will always appears in upper case. This is
particularly useful for Component names that by default are forced to upper case.

This feature is setup in the Technology, Design Settings dialog on the Naming tab. It is
recommended that unless experienced with Pulsonix you should not change it.
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Farce To Upper Case Name Options

[ Component Names [ Case Sensttive Pin Names

[ Gate Mames [ Numeric Gate Mames

[ Met Names Fill-In Gaps In Number Ranges
[ Part Names [Case Sensitive Drill Size Idents
[ Pin Names

[ Test Paint Names

Name Ranges
Default Net Names Range Start: D

Name Stem: Range End: EI
Number Width: Range Separator: l:l

ltem Separator: l:l

Example:  1U1,U[3-6]

Pin Names

Component to Pin

Name Separator: l:l
Case sensitive pin names

The case sensitivity of pin names can be changed using this check box. This means that both upper
and lower case text can be typed in and the system recognises the differences, even if only subtle. For
example, differences such as A1 and al would be understood, even if you typed one of them in by
mistake!

This mode is set in the Design Settings dialog under Naming and is defined by setting the check box
under Pin Names to Case Sensitive.

Adjust text to readable orientation

When any item containing text or any text item is rotated in Schematics, the design can be setup so
that the text is always readable from the bottom or the right of the design page. If the text item is
rotated further than an angle that makes it unreadable it is automatically rotated back to a readable
state. This mode is set in the Design Settings dialog under General and is defined setting the check
box under All Text to Adjust To Readable Orientation.

P To add text to the design
1. From the Insert menu, select Insert Text.

2. Type the required text into the window.
The text can be upper and lower case. Multi-line text can be added by pressing <Enter> at the
appropriate places. You can use all the normal text editing facilities including copy and paste.
The full ISO-Latin-1 character set is supported. You can also add barred text using the barring

character.
The Insert Text dialog changes slightly between the Schematic and PCB design editors shown
below:
Insert Text X Insert Text X
lssue 2 Pulsonix
Crrawvan by B B/ iss?

Lavyer. |Silkscreen Top -

Cancel

Drrawan o
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3. On completion click OK and position the text.
The schematics Insert Text dialog has a drop down list for drawing on All Pages At This Level.
Whenever text common to all pages is edited, the changes are reflected through all the pages.
This is useful within company sheet outlines that are the same on all pages for example.

4. The text will be positioned at the end of your cursor.

5. Use the mouse to position the text at the exact location required. During positioning, you can use
the options on the right hand mouse context menu to: Mirror or Rotate the text and also change
the text Style and Font. The justification of the text string can be altered by selecting the text and
using Properties.

6. To release the text, click the mouse. This will release the current text item and put you back into
the Insert Text dialog. Click the <Esc> key to exit this mode.

Barred text

Barred text can be added to the design (both Schematic and PCB). There are two steps to enable
barred text. The first is for the definition of the barring character in the Design Settings dialog under
the General/Defaults tab.

Al Text Attributes
[ Adjust To Readable Orientation Substitution Char:

(when doubled
[ Mutti-Line Text Vertical Align fwhen doubled)

Barming Character: Matching Styles
(when doubled) (®) By Name Only
(C) By Name And Value
System Fort ) By Value Orly
[ Proportional Width Digits
Maming Rules
CAM/Plot

[ Make named styles use naming rules
[ Transform about design extents

Pad Exceptions

STEP Model Alignment
[ Mimor with Component

Snap by:
(@) Centre Met Optimise
(O Crigin [ Pads/Vias connect by centre

Use Adjustment Attributes

Spacing Rules:

[ Enable linking of types

This by default is the underscore ( __ ) character but can be changed if required. The second is to
enclose the text string to be barred with the barring character. This must be doubled both before and
after the text string to enable the bar.

B Properties: Text - Text O X

Tet  Texdt Style Varants

|_Bamed Text__ Mot Bared | &

In this example the words Barred Text are enclosed with double underscore characters and the
words Not Barred are not enclosed to highlight the differences. There is a subtle space character
between the ending barring character and the word ‘Not’.

When added to the design, the text appears like this:

Barred Text Not Barred
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Mitring and Filleting Corners

Mitres (45 degree corners) and Fillets (curved corners) can be added to any shape or line item,
including PCB tracks and Schematic connections. Mitres can only be added to 90 degree corners on
straight segment lines. There are a number of methods for adding and editing them.

Mitres and Curves behave in the same way and are added and edited the same way.

Basic adding of Mitres

Starting with two orthogonal segments creating a 90 degree corner, a Mitre can be added by double
clicking on the corner. You must double click rather than picking and dragging, the pick drag function
will move the corner and segments rather than adding the Mitre. You can also select the Mitre Corner
option from the context menu if the corner is selected.

[%} When Mitre Corner is used, a modal cursor is displayed.
5

The Mitre is a free moving 45 degree corner on the two orthogonal segments. This snaps to the grid
points of the Track Grid or the Working Grid/Free Grid that has been previously used when inserting
the shape or track. By using a grid rather than leaving the Mitre to be a free grid segment you can
ensure that the corners of the Mitre are always on-grid.

to create the
mitre here or here

Drag this corner
to here

Once inserted, Mitres can be easily edited by double-clicking on the 45 degree segment. To remove a
Mitre, double click on it and drag it out to make it a 90 degree corner again.

For connections in Schematics you cannot used the double-click method, you must first select the
corner and then use the Mitre option from the context menu. If you use the double-click method of
editing an existing corner, the program will attempt to insert a connection and will therefore add a
junction point to the corner instead of editing it.

Fixed Mitre sizes

If you require all Mitres to be the same size, you can set the size and set the snap to this size when the
Mitre is inserted.

The Mitre size is set in the Options dialog under either the Edit Track/Connection tab or the
Interaction tab, depending on what type of item you are editing. Editing options of shape items
except for Tracks and Connections (in Schematics only) are set through the Interaction tab. The
example tab shown below is for Interaction but the information presented is the same for the Track
and Connection tabs as well.

8" Options - Edit Track [m| X

Design Backups

Display Segment Mode:  [Angled (45) <] [Jacply Seq Modeto Tai
Edit Shape Orthogonal Mitre [ Auto Comer

g ot Track Size: Tipe: @ Mire O Filkt Tolerance:
File Extensions
Find
General Show Can Finish' and ‘Has Loop” Markers Remove Loops

In-Place Names Show Legal Completion Path Auto Share Tracks
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The setting used is Under the Orthogonal Mitre and Size. The Size will be set in the current Design
Units. Orthogonal Mitre does not need to be selected for this option to operate. This is only selected if
you require Auto Mitring to be operational, see below for description.

To use this default Mitre size you must first be editing the corner. With the corner selected you can
right mouse click and select Mitre Corner from the context menu, this will edit the corner. If you
immediately right mouse click again you can select Default Mitre Size from the context menu. This
will snap the Mitre to the default size set in the Options dialog.

From the context menu, you also have the option to Fillet corner to make it curved.



74 Chapter 3 — General Utilities




Chapter 4 — Setting Up The Design 75

Overview

Chapter 4. Setting Up The Design

There are a number of features and options that allow you to setup a design prior to starting the actual
design work itself. Some of these features are highly desirable, like setting up the working Units for
example or the interval of the security copies of the design. Others are not essential but preferences,
like changing the colours to your own choice. With the differences between the Schematics and PCB
design editors, only the major differences are discussed and some of the more important subtleties.

Using Folders and Files

Folders

When saving files you can set up the save locations. The Folders option on the Setup menu contains
the path setup information in one dialog of all the options that use paths. By default, during Setup the
paths within the Folders dialog are set to the standard Pulsonix installation paths, these can be
changed by editing the relevant one.

Folders - General O X
% General Startup Folder
CAM/Plot O A start in this fold C:\Users\MAINAD t B
. - Users\MAINY Dacumerts rowse ...
Colour Files ways start in this folder :  C:\Users'\MAIN\Dacumer Er
Design Backups () Remember last folder used when Application closes
Design Reports (®) As defined by Operating System for example, in the Program Shorteut)
Format Files
Libraries a | Fold
Library Reports =aener] roider
Macros C\Users\MAIN'Documents | E Browse ... i
Profile Files
Schematic Blocks Used for any files that have no folder defined forthem. For example,
. reports that are not design based. Leave blank to use the application’s
Scripts curent folder.
STEP Models
Technology Files
Folder Options
[ 5how Folder For Each File {in the file dropdown lists)

The General tab defines the folder the program starts up in and the location that is used for ‘general’
non-design based reports, such as the shortcut keys report.

The choices on this tab allow you to decide the best start-up location, it may be that you wish to start
on a server or a local disk but in a working folder of a particular project etc. There are three options
that give you a selection of start-up choices. This tab will allow you to choose a folder that could
contain your current working design. When Saved, the design will overwritten at its current location.
If Save As is used, the current folder of the design will be displayed and you can change this as
required.

The Design Backups tab is used for specifying the location of Design Security Copy files, Backup
Copies of the design and Restore Points.
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Folders - Design Backups O X
General Folder For Design Security Copies:
CAM/Plot
Colour Files |This Folder below design file: ~ |

g Design Backups
Design Reports
Format Files

|C:"-.Users"-\MAIN"-.Doc:uments"-.Designs"-JobEE"-.Backups |

Libraries . .
Library Reports Folder For Design Backup Copies:
Macros |This Folder: v|

Profile Files

Schematic Blocks |C:"-.Users"-\MAIN"-.Documents"-.Designs"-Job 66"Backups | Browse...

Scripts

STEP Models
Technology Files Folder For Design Restore Poirt Copies:

|This Folder: | w |

|C:"-.Users"xMAIN"-.Documents"-.Designs"-JobEE"-.Bac:kups | Browse...

See below under Security Copies and Backups for details about specifying the format of the files
during save.

The CAM/Plot tab is used for specifying the location of CAM files and for specifying the name
definition used of the CAM file output.

Folder For Output Files:

Design Folder -

Plot

Qutput File Mames Template:

%(DesignMName)&(PRE)}-&(Varant)$(P RENS(PlotName))S(POST) v Design Name
Plot Group
v Plot Name
Plot Device
Mate: I the CAM/Plot falder is based on the design folder but no design folderis | ¥ Design Variant

available, then the General folder defined on the General tab will be used. . .
Design Type (combined plots only)

Start Pre-Text
End Post-Text

You can define the filename and folder name using keywords that will be replaced with the relevant
text when a plot file is created. This allows you, for example, to use the plot group name to separate
plots that are project required as opposed to simple documentation. You can also use this section to
specify that a particular plot type (PDF for example) will use its own folder to this type. Use the This
Folder below design file: and set the folder to $(PlotDevice)

Using the Plot Settings page in CAM Plots, use the Output File Names Template section with a
template edit box and a popup menu button to make the name creation process more convenient when
adding keywords. The popup menu button next to the folder edit box is used to make naming
selections.

Most keywords are obvious, but there are a few that need additional explanation:
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$(PRE) and $(POST) are used to add pre-text and post-text either side of a variable field. For example
“$(PRE)[$(Variant)]$(POST)” will be replaced by “[USA]” for a plot for variant “USA” and will
produce nothing for a plot with no variant.

$(DesignType) is replaced by “pcb” for a pcb design and “sch” for a schematic design.

$(CombinedType) is the same as $(DesignType) but is only used if the filename is a combined output
containing several plots (like pdf).

The Reports tab is used for specifying the location of reports and for specifying the name used of the
report file output. This has a drop down list, Report File Names Template section with a template
edit box and a popup menu button to make it easier to add the keywords. There is also a popup menu
button next to the folder edit box as well.

Report File Names Template:

&{ReportGroup)3({DesignMame) ($(Report Title)) v | Design Name
[ Append To Existing Repart ¥ | Report Group
v Report Title
Design Variant
Note: K the report folder is based on the design folder but no design folden Design Type
available, then the General folder defined on the General tab will be used.
Start Pre-Text
End Post-Text

The “$(Report Group)” keyword will be replaced with the report group the report is in. On the
General Reports page there is a Report Group box to supply the group for each of the standard
reports. User reports can have a report group assigned by including the new Set Report Group
command in their script.

This also has the added check box, Append To Existing Report which can be used to add the current
report to an existing file. This might be useful where an audit trail of events is required.

Libraries, Technology Files, Profile Files, Colour Files, Schematic Blocks and Format
Files

The Libraries, Technology Files, Profile Files, Colour Files, Schematic Blocks and Format Files
tabs all contain default locations for these files. Each of these pages allows the Folder selection and
the enabling or disabling of files within it. Multiple folders can also be chosen from anywhere
accessible by your computer and network.

Folders and Search Order:

[Vautt] Add...

C:\Users\PublictDocuments'\Pulsonix\UserLibraries

C:\Users\PublicDocuments' Pulsonix'\MasterLibraries Edit... Down
Eglore...

Folder Enabled

The Folder and Search Order panel enables you to choose the folders to include in the search. This
mechanism is the same for all four of the file types that appear on this dialog.

The process is to use the Add button to add a new folder and Edit to change an existing folder path. If
unsure where the folder is located or you need to browse to locate it on a network drive, use the
Explore button. The Up and Down buttons allow you to position the folder in the search. This is
important because if there is more than one item of the same name in the libraries or other files, the
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Files

order in which they appear in the search path will be how they are used. The first item required and
found will be used.

The Files Found panel will display any files found on the search path setup in the Folder and Search
Order panel. Each file found is displayed along with its file extension to identify its type, and the
path it was found on.

Files Found: 182

~| s ot Loy
“WUsersPublic’\Documents' Pulsonid\MasterLibraries' Actel pal m
“UsershPublich\Documents'Pulsonix\MasterLibraries \AD pal
“UsersPublic’\Documents' Pulsonix\MasterLibraries " ADSF pal Enabled Enable Al
“Users“PublicDocuments*Pulsonis MasterLibraries \Altera pal
“Users'Public’Documents' Pulsonix' MasterLibraries' Atera2 pal Delete
“Users“Public’Documents"Pulsonix MasterLibraries  AtteraCyclon pal
“Users'\PublicDocuments' Pulsonix' MasterLibraries  AMP pal
“UgershPublic’Documents' Pulsonoc MasterLibraries' Assmann pal
“Users“Public’Documents"Pulsonix\MasterLibraries"Atmel pal
“wUsersPublic’\Documents' Pulsonix' MasterLibraries' Avago pal
“UsershPublich\Documents' Pulsonix\MasterLibrares \AVX pal

5l lmeres Puklic\Dinen imerts' Pulannie Master] ikraies' Bonms nal

Move...

Copy...

AZDODOOOOOOO000

The right hand side of the panel displays the file type when selected, the box below this displays the
file name.

You can enable or disable files to be used within the folder by using the Enabled check box. By
selecting it, the file will be disabled and therefore not used. It does however remain in the search path.

Delete, Move and Copy are used to manage the files within the chosen folder(s). Be warned though,
Delete will erase the file completely from the folder, not just from this search list.

Edit only appears for the folder items that can be edited. The file must be selected from the list in
order for the Edit button to be active. This button appears on the Profile Files, Format Files,
Schematic Blocks and Technology Files dialogs. When a file is selected and the Edit button pressed,
the file is loaded into the respective editor.

Saving files is an essential part of any Windows based product. In keeping to the Windows standard,
Pulsonix provides both Save and Save As, as well as other special save options.

Save allows you to save the current design to its existing name. If exiting the design without first
saving it, you will be prompted to save the design or discard it. An indicator that a design has been
edited but not saved is shown on both the Workbook mode tab and the title of the Pulsonix product as
an asterisk ( * ). Once saved, this indicator disappears.

Save As allows you save the design to a new name using the Save dialog.

Save Technology allows you save the technology information in the design to a Technology File.
This can be subsequently used when creating new designs to give them the same technology data as
this design.

Save Profile allows you save part of a design to a Profile File, for example, the page border or board
outline. This can be subsequently used when creating new designs to provide the same Profile data as
a starting point.

Each of the save options has its own file extension that are predefined depending on the design type
you are saving.
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Saving libraries

When using the Symbol, Footprint or Part editors, the menu contains Save, Save As and Save
Technology as expected, but also Save To Library. Both Save and Save As are used to save the
current symbol to a symbol file not the library. To save the Symbol being edited to the relevant
library you should use Save To Library. If editing an existing Symbol from the Library, the Save
button on the toolbar will allow you to Save To Library where you will be prompted for the library
name and the symbol name when saving.

Security Copies and Backups

Pulsonix has the capability for security copies of your design to be made and you can set the interval
and location of the files.

Although Pulsonix has its own system for security copies of designs, we HIGHLY recommend that
you make regular backups of all Pulsonix designs, libraries, technology files, profile files, reports and
security copies.

If at any time you think you have lost or deleted Pulsonix files DO NOT shut down the Windows
operating system. Call the Pulsonix technical support desk straight away. If you shut down the
operating system there is a much stronger chance of not being able to recover the data because of the
files Windows writes to disk during its shutdown process.

Within the Options dialog on the Design Backup tab is a collection of options to facilitate saving
Backups, Security Copies and Restore Points of the design.

Create Securty Copies

Every minutes

Keep E: copies

Keep Copies In : |This Folder: v|
|C:"-.Users"-.Designs"-JobEE‘-.Backups | Browse...
Filename Format: |Securi'q.r Copy of ${DesignMName) | 3

Create Backup Copy on Save

Keep E: copies

Keep Copies In : |This Folder: ~
|C:"-.Users"-.Designs"-JobEE"—-.Bac:kups | Browse...
Filename Format: |Bac:kup Copy of ${DesignMName) | 3

Design Restore Points

Keep Copies In : |This Folder: v|
|C:"-.Users"-.Designs"-JobEE‘-.Backups | Browse...
Filename Format: |Restore Pairt for $(DesignMName) (${Label)) | 3

User defined format of backup file names

You can create user-defined formats of the backup name by typing fixed text and inserting tags that
will be replaced a when a backup name is generated.
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Design Restore Points
Keep Copies In:  Design Folder -
Browse
Filename Format: Restore Point for $(DesignMame) ($(Label)) v Design Mame

Increment
Decrement

Infinite

v | Restore Point Label

Tags are defined as the design name plus one of three numbering schemes — Increment, Decrement
and Infinite.

So for example, if number of copies is 3, Increment will produce copies 1 2 3 where 3 is the latest,
Decrement - 3 2 1 where 1 is the latest, and Infinite 12 13 14 where 14 is the latest, i.e. it just keeps
getting higher.

For the Design Restore Points section, you can also select Restore Point Label from the context
menu.

Security copies
This section enables you to choose security copy backups of your design that you are editing. They
are automatically generated after a set time interval if the contents of the design file you are editing
has changed. They provide the security of being able to save copies on a regular basis in case data is
lost due to problems with Pulsonix or the operating system.
| Create Security Copies
Every 10 minutes

Keep 1 |3 copies

Keep Copies In:  This Folder: |L|

C:A\DocumentshDesigns'Job66\Security( | Browse. ..

Filename Format: Security Copy of ${DesignMame) IZ|

Backups

These are copies of your design automatically created when you save it. They give you the security of
being able to restore the design to one of the recently saved versions.

| Create Backup Copy on Save

Keep 1 [ copies

Keep Copies In:  This Folder: |L|

C:\Documents'Designs*Job66"Backups | Browse...

Filename Format: Backup Copy of $(Designhame) u

Save and Load Restore Points

There is an additional backup type called a Restore Point; that is saved on request. It is used for
saving a design that is in a known good state before starting on a session of changes.
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Save Restore Point X

Festore Point Label: | Pre-Fouted |

File Mame: |l::\Documents\Designs\JobBB\Backups\Hestole Paint for ILFBED33 [F're-FIouted].pc:b|

Cancel

The saved backup is restored using an option on the File menu named Restore Backup...

From within the Options dialog and Design Backups page, you must provide a label for the restore
point that will be inserted into its name. For this to happen, the name format must contain the label
tag.

Design Restore Points

Keep Copies In :  This Folder: -

ChUsers‘\bob MAIN'\Documents\Desiar | Browse...

Filename Format: Restore Point for $(DesignMame) (${Label)) v Design Mame

Increment
Decrement

Infinite

v Restore Point Label

For example if the name format was “$(DesignName) - $(Label)” then the user could create a restore
point for design “MyDesign.Pcb” after autoplace with the label “Before Routing”, so the backup file
will be called “MyDesign — Before Routing.pcb”.

Restoring Backups

There is an option on File menu named Restore Backup... to restore the contents of a design to be the
same as a chosen backup file. This can be performed on the current design, or you can choose the
design to have its contents restored from. When selected, this displays a list of backup files to choose
from in the dialog.

Restore Backup *
‘Which design do pou want replace:
C t Desi

(®) Current Design Cancel
(O This Design: Browse

‘Wwhich types of backups do you want to chooze from:
Security Copy Backups [On Save] Restare Paints

Chooze backup file to restore contents fram: Include files that do not match backup formats

M ame D ate/Time Size
Announcer [Routed On Four Layers). pcb 04-Dec-2016 16:46:38  232Kb
Announcer [Routed On Two Layers).pch 04-Dec-2016 16:46:07  232Kb

Announcer [Pre-Routed). pch 04-Dec-2016 16:45:37  232Kb
Announcer SECURITY COPY 3.pch 12-Mow-2016 131231 B04Kb
Announcer SECURITY COPY 2.pch 06-Movw-2016 15:3303  BO03Kb

Announcer SECURITY COPY 1.pch 0B-Mow-2016 13:28:15  B03Kb
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Units

Grids

The basic working units can be changed between Imperial and Metric, and between Degrees and
Radians for angle units. These are the units of the co-ordinates and lengths displayed in the dialogs
and edited by you. The Units dialog on the Setup menu is used to define these units and the precision
at which they are displayed.

The design units are stored in an internal database with a precision of 1/100 micron regardless of what
the unit precision is set to.

Technology [] - Units - Units

+- Spacing Rules Length Units:

- Styles )

- Layers O Imperial: thou

- Nets (® Metric: mm w
#- Rules - DFM/DFT

- Rules - High Speed Precision: |3 :

- Outputs

- Maming [ Trailing Zeros

- Colours Rounding Indicator (+/-)
- Grids

Units
Units
- Variants (®) Degress () Radians

- Design Settings Precision: |1 =

- Parameters
Trailing Zeros
Rounding Indicator (+/-)

Angle Units:

£

[

-

Imperial units can be set to Inches, Thou or Mils, Metric units can be set to Millimetres (mm),
Centimetres (cm), Metres or Microns. Angle units can be set to Degrees or Radians. For each type
of units, you can specify a precision. This is the number of decimal places displayed; the value is
simply rounded to the nearest last digit. If you have the Rounding Indicator displayed, a + or - sign
is shown at the end of the value to show that is has been rounded down or up. If Trailing Zeros are
not displayed, the trailing zeros are not shown for values that do not require all the decimal places.

You can quickly toggle between Metric and Imperial units by using the default shortcut keys <Ctrl-
U> or by double-clicking on the unit notation on the Status Bar.

Layer: Top||Met: $2|/Grid: <Working= 25.0 ||Abs|[17473.4- ||20116.04||/thou

Grids are used for both visible reference markers and to define the points or steps to which items will
"snap" when they are placed. There are built-in grid names that can be setup for use with particular
design items, for example, Track grid, Via grid, Component grid, Testpoint grid. You cannot rename
or delete built-in grids.

You can specify the X and Y grid steps and the visibility of grids.

The <Working Grid> is a system grid that you cannot rename or delete. This is used for most of the
interaction of Pulsonix, and is only substituted in particular cases where a specific option grid is
available, for example Component or Testpoint grids.
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Setting up grids

The Grids dialog allows you to add or change the settings for any of the grids in the design. The
Grids dialog is available on the Setup menu and is stored within your Technology. It can also be
accesssed using the Grids button on the Grid Step dialog.

Within the standard Pulsonix PCB Technology files are named grids that have been setup for you
using names that represent possible design entities, such as component, Testpoint, Text etc. these can
be renamed, defined and deleted by you as required.

Name: |‘.‘\|'0rking

Relative to Grid:

<Mot Relative> o

[ Displayable
Colour

=

Global Grid Settings

Name |
* |Component
% |Panel PCB Instance
' |Testpoint
W [Text
N [Track
Y (Via
Y |Working
Used: Step
Basic Step Muttiplier Divisor
B/ E
[ Different X &Y
Draw rith Step Style Origin
(© Dots X Design Certre
Ol:ines
Oomes v Cooninas O
(O) % Crosses
Relative Origin

Display: | Mo Grids

[JApply Origin Settings To All Grids

> |

A set of user defined grids might look more like this:

Name |

0.1mm

0.125mm

0.500mm

25 thou

50 thou

Placement

Defining your own grids

[Palar Grid
Step

:

[Lock

[Lock

[Lock

You can define your own grids by first typing in a name using the New button. The grid Step should
then be typed in and the Multiplier (and Divider if required). Use the Multiplier and Divider entries
to create fractional grids that do not suffer from rounding errors.

Step

[JPolar Grid
Basic Step Muttiplier Divisor Step

R o .

[ Different X &

You can also set its visibility by selecting the Display setting from the drop down list. Selecting OK
will save the grid and display it (if the zoom level allows it).
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Displayable
Colour Draw rnth Step Style
1y ® Dots
() Lines
() Crosses
() X Crosses
Global Grid Settings
Display: | Mo Grids i |

Grids can be defined relative to system origins in the design (System Coordinate Origin, Relative
Origin and the Design Centre).

Origin

X Design Centre [Lock

Y Coordinate Origin| [ |Lock
Relative Origin [Lock

[JApply Origin Settings To Al Grids

Grid Steps

The Grid Step dialog allows you to change the grid step setting in a simple dialog. As well as being
available on the Setup menu, it is also accessible from the keyboard shortcut key <G>.

Change Current Grid X

Current Grid: |D.5mm v| Step: |D.5EIDEI

Cancel Girids...

The Grid Step dialog presents the Current Grid name as defined in the Grids dialog, both system
and user defined, and the grid Step value. The grid step value is always defined in your current units.
To change the Working grid value quickly you can type <G 25> followed by <Enter>. This will
change the working grid to 25 (Units).

Snapping to grid
When moving a design item, you can access the Change Grid option from the context menu.

Shiuwe Flacciiciic Ugin

Change Layer L

Change Style S Use No Grid Shift=N
ids Insert Multiple ltems

Show Track Length Limits

Reposition Cursor Text

Use Tools Grid Shift+wW

Use 25 thou Grid

Use Dynamic Align Use Placement Grid

Use 0.1mm Grid

Online DRC \ Use 50 thou Grid

ZI Continuous Online DRC Use 0.125mm Grid

Z‘ Display Clearance Use 0.500mm Grid
Move Horizontally Display Grids Ctrl+=G
Move Vertically = Grid step G

Change Grid W Hf crids.. Alt=G
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With the context menu you can change the grid of any item at any time. Any selected grid will be
remembered for each type of item being sunsequently move. For example, moving a Component on a
0.1mm Grid, the next time you move a Component, this grid step will be remembered.

Setting grid visibility

To set whether grids are displayed, you can use the Grids dialog or the keyboard shortcut key
<Ctrl-G>. This will display all grids that have their Grids Displayable check box selected to on.

Displayable
Colour Draw rnth Step Style
(® Dots
 e— 1 N
I O Lines
() Crosses
() X Crosses
Global Grid Settings
Display: |N0 Grids v|

Any grids can be displayed but care should be taken if displaying more than two grids at a time as this
can easily lead to confusion as to which grid is being shown.

You can change the display of the grid to draw any number of grid steps using the Draw nth Step
box. This can be useful if the grid is only required every 10 grid points. The Style of the grid can also
be changed between Dots, Lines, Crosses and X Crosses. A mix of each is also allowed for different
displayed grids but the colours used should be chosen carefully.

Dots Lines Crosses X Crosses

X X X X X X
***********
,,,,,,,,,,,
EoE ot 4 b 4+ b+ 4 x x x x x s
***********
,,,,,,,,,,, % x x %X x  x
,,,,,,,,,,,

X X X X X X

***********

Snap Cursor To Grid

There is a check box option on the Options dialog and General page named Snap Cursor to Grid.
Select this option to make the cursor move only on the current grid when in the design area.

Relative Coordinates O .
W, il
Show relative coordinates in dialogs when used s
Recent Files o
Cursors:
20 5| em
| Style: |SITIEI|| Cross |V| Snap Cursorto Grid | (Note : Needs
take effect)
|Use Modal Cursors
e Dialog Grids:

Gridded cursors will still be shown when modal cursors are displayed.

This option can only be used with the three cross cursors, it will not work with the standard windows
cursor.

There is also a command available in the Customise option and Keyboard called Toggle Cursor
Gridding. This can be used to quickly toggle snapping on and off.
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Changing the Design Area Size

The design area is the area that you are allowed to work in. It is useful to have the ability to reduce
the design size to be slightly larger than the maximum extents of the design. This makes the scroll
bars more responsive and prevents you from 'losing' the design. Alternatively, if your design changes
are to be larger than the design area then you may need to increase the size of the design area.

This is achieved using the Design Settings dialog from the Setup menu and the Coordinate system
page.

Coordinate System Origin:
{Offset from the lower left comer of the design area)
Design Area Size:
1Inch
10 Inches

(230 Inches

(®) User Defined:  4000.00 Fit...

[ Show Relative Coordinates on the Status Bar

1968.504- | |2165.354+

The Design Area Size can be created based on a number of predefined and user defined area choices
as well as an automatic choice. The size relates to an area, so 10 inches for example, would be 10x10
inches from the 0,0 System Coordinate Origin point.

1 Inch (1 Centimetre), 10 Inches(10 Centimetres), 30 Inches (1 Metre). This changes depending
on whether you have Imperial or Metric units selected. User Defined where you can specify the
exact design area required. The Fit button will automatically size the design area to fit around the
design. You are provided with a dialog to define the Margin around the design extents for which the
design area is calculated, this is defined in the current design units.

Fit Design Area *

e

Cancel

Once this has been defined the design area is calculated and is shown in the value box. Any changes
made to the design area can be viewed in the World View window that shows you the maximum
design area, the design and the current view of the design.

Changing the Design Origin

The Coordinate System Origin is the point from where all other co-ordinates are shown relative to.
You may wish, for example, to show all coordinates relative to the centre of the design or board.

You have the ability to change the design origin in Pulsonix. The default is the bottom left hand
corner of the working area.
Changing the Design Origin

If you wish to change the design origin you need to move the Coordinate System Origin. This can
be done by using the Design Settings dialog from the Setup menu. You should type in the
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coordinates of the new origin position required. The coordinates are defined as an offset to the lower
left corner of the design area (0,0 origin).

Coordinate System Origin: |D.DD | |D.DD |

{Offset from the lower left comer of the design area)

Design Area Size:

1 Inch

It can also be moved interactively by using the Place Coordinate Origin option on the context menu.
To obtain this context menu, you should right click in free space in the design window.

-’ Ordered Template Pour

) save items To Library...

r-_ﬁj Reload From Library...

? Fetch Component...

i, FindXv..

Insert Attribute... Shift=4
Design Properties...

Place Coordinate Origin

Place Relative Origin

Place PCE Panel Origin

HRERB D

When the option is selected, you can drag the origin to its new location using the coordinates on the
status bar to locate it.

If you wish to reset the origin back to 0,0, select the origin marker and click the <Del> key on the
keyboard.

You cannot frame select any origins so you cannot accidentally move them. The Coordinate System
Origin is locked by default so it cannot be accidentally moved. You can select and override the Move
warning to perform the Move.

Working in Absolute and Relative Modes

Pulsonix allows you to work in both Absolute and Relative modes of operation.

Relative Mode gives you a means of temporarily reporting co-ordinates on the status bar relative to a
defined point. This may be useful, for example, for positioning a group of components relative to a
mounting hole.

Changing the Relative Coordinate origin

The Relative Coordinate Origin can be changed by typing in new co-ordinates using the
Technology, Design Settings dialog. The Relative Coordinates are displayed on the Status Bar by
selecting the check box, this also enables this mode.

(®) User Defined: 188.402 Fi...

Show Relative Coordinates on the Status Bar

You can also interactively move the Relative Coordinates origin by using the Relative Origin At
Cursor command - shortcut keys <Shift-X>.
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This will snap the origin marker to the current position of your cursor and the status bar will now
display Rel for Relative Coordinates as well as displaying the coordinates relative to this origin.

ent| C12 /C||Side: Top |dx: 325.00 | |dy: 0.00)|Grid: <MWorking= 25,00 Rel [325.00 0,00 thou

When editing or moving items the status bar also displays the difference between the current item
position and its previous point, shown as dx: and dy: values. This could be the last corner for a
connection or track, or the position of a moved item relative to its start position. You can reset the
Delta coordinates at any time by assigning a shortcut key to the Reset Delta Coords command. This
can be used in context while moving an item.

The Relative Origin can be reset at any time or while in a 'mode' by pressing <Shift-X>. This will
allow you to obtain a 'measured' distance while using an option if required, otherwise if left in one
location all co-ordinates displayed will be relative to that point.

To differentiate this origin from the System Co-ordinate Origin marker you can change its colour in
the Colours dialog under the Others tab.

If at any time you wish to go to the Relative co-ordinate origin in the design, you can click the <X>
key on the keyboard. This shortcut key is set up by default for the Find Relative Origin command.
This command is also available on the Edit menu under Find and Find Relative Origin. Once Find
has been used, the Relative origin will be highlighted in the Highlight colour. You should use
Remove Highlights to remove this colour. Remove Highlights is located on the Edit menu and on
the context menu.

You can switch between the Absolute and Relative co-ordinate modes by using the Relative Mode
command - shortcut key <Shift-R>, this will toggle between the two modes using the previous
Relative Origin point set and the Absolute co-ordinate origin.

Technology Files

Technology files are like the template files used in other general office products. They are a way of
constraining a design to a specific set of predefined rules or parameters. They are also a quick method
of starting designs based on known characteristics, from defined rule sets or previous designs. This
makes it easier to obtain consistency between designs.

A default set of Technology files have been supplied with Pulsonix that can be used and edited by you
to match your own requirements. Any technology file name selected will be taken from the default
Technology File folders defined in the Folders option.

There are a number of options that allow you to load technology files as part of their process;
anything that is started from new can be started with a Technology file, PCB design or Schematic
design for example. Any library creation or editing of library contents, including the Symbol creation
wizards, and also the Translate To PCB option.

Schematics and PCB both have their own technology files and cannot share information between
them. For example '4 layer.ptf’ (the supplied 4 layer PCB technology file example) can be used on
both PCB footprint libraries and the PCB design, but not for Schematics.

It is advisable to use Technology files, although this isn't necessary because Pulsonix adds styles etc.
when no match can be found when adding components for example.

This section covers the concept of Technology files and the Technology dialog, each facet to the
Technology file is described in more detail as each option is shown as you move through this manual.
There are some special items of the Technology file that have been selected for more attention in this
section.
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The contents of Technology files

The list below shows the items that make up the contents of Technology files:

® All Technology dialog information (Spacing Rules, DFM/DFT Rules, Attributes, Net Names etc.)
® Technology dialog Style and Style Naming rules

® Technology dialog High Speed rules

® Design Setting options including Defaults (but not Options dialog settings)

®  Grids
®  Units
® (Colours

® CAM Plot output settings including Drill Sizes
®  Variants

® Autoplace, Autorouter, Auto Gate & Pin Swap and Auto-Mitre parameters

Creating and saving Technology files

Technology files can be created as a stand-alone process to set these files up, or can be extracted from
existing designs, for example from a Schematic design. Technology files do not hold all the design
information, they only hold a sub-set containing items such as styles, rules, colours, grids and units
etc.

If creating a brand new Technology file you can use the New option on the File menu, use the
Technologies & Profiles tab. If you wish to base your new file on an existing technology file you
can select a Technology file by name provided it exists in the Technology file folder defined in the
Folders option. For example, you may well be creating an 8 layer Technology file by starting with a 4
layer file and adding another 4 more layers.

You can also create a Technology file by extracting technology data from an existing design.

You can save technology files from within all design editor or library editor options except the Parts
Editor. The File menu contains the Save Technology option from where you can save technology file
information.

When editing a technology file, you should use the Save Technology option to save a technology file
to the correct folder.

Introduction to the Technology dialog

Accessed from the Technology option on the Setup menu, the Technology dialog is used to manage
the Styles and Rules of the design. Although it does not contain all of the technology file contents, the
Technology dialog does make up many of the most important facets of the Technology file. Each of
the tabs on the Technology dialog will be discussed in more detail as they are used throughout this
manual. The example dialog shown below is for Attribute Names in a PCB technology:
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B Technology [] - Maming - Attribute Names m] *
Spacing Rules - =
- Styles Name Usage Context Show Name| Show Value ‘l#:zl?rfp Hg:::\k A“B:g:“e Vali i
' :ijm <Pin Package Length Pad Al Designs A
pliEs ) | <Spice Device Anytem  SCW Design Only C] 4 O] L] ]
- Rules - DFM/DFT <STEP Filenames Part PCB Design Gnly il M O] O] O]
- Rules - High Speed <5TEP Offests= Fart FCB Design Gnly [ = O] Ol O Delete
- Qutputs =STEP Rotation> Part PCB Design Only L] ] ] W ]
5} Naming Bob Pad AllDesigns Ol % 0 0 Ol Dedaniliyved
i Attribute Names Y [C Any tem All Designs. ] ] ] ] ]
Group Names W [Category Part All Designs ] [ ] ] ]
... Hatch Style Naming Color Any tem All Designs. : Z : : :
Line Style Namin Y |Connector Type Any ttem All Designs [
— — Contact Finish Anytem Al Designs ) = ] ] ]
i+ Pad Style Naming Contact Finigh Thickness  “Any tem All Designs [] [] ] ] ] DOHh' ShU‘ﬁ‘
§ Text Style Naming D Any tem All Designs: [] [ ] ] [] Used Ertries
i... Track Style Maming  |DataSheet Amy tem All Designs ] - ] ] ]
- Colours Delay Time tpd(1) Max Amy kem All Designs ] [ ] ] ]
- Grids  [Description Part All Designs ] I ] ] ]
- Units ¥ |Digikey Part Number Any tem Al Designs ] [] ] ] ]
Variante ¥ |Features Any ltem All Designs. : Z : : :
Desian Settinas FT Any tem All Designs. ]
- Design 9 Height Above Board Any tem All Designs [] [ ] ] []
Parameters HFE Anytem  AllDesigns ] M C] C] ]
W [Hs1 Pad All Designs ] [ ] ] ]
Ic Amy tem AllDesigns ] [ ] ] ]
Y |Manufacturer Part Humber —Any tem All Designs. ] [ ] ] ]
Y (Mfr Any tem All Designs. ] [~ ] ] ] v
< >
Name: Pin Package Length [ Shaw Name Show Value
Used: [ Use as ToolTip [ Use as Hyperink
Usage: |Pad [ Back Annotate [ Copied
Validation | |
Save Technology... Load Technology... Cancel Apply Help
As you will note, there are differences between each type of Technology dialog. The Schematic
Technology dialog contains Styles entries mainly and some pre-defined names for Nets or Attributes.
Whereas the PCB Technology dialog also contains Styles for the 'physical’ items within the design,
such as Pads, Tracks, Spacing Rules, DFM/DFT Rules and Layers etc. as well as the CAM Plot
outputs. Part Technology files contain a minimal set of Technology is used for setting up pre-defined
signal names and attribute names when creating or editing Parts.
Styles

Styles are used to define how an item will look when displayed in the design. For example, how thick
a line should be, or what shape a pad is and what drill size it contains.

By giving an item or items a style, you can define a group of similar items and give them the same
look, but also be able to change their look by simply editing one corresponding value on the Styles
page. This means that through the Line Style tab on the Technology dialog you could assign a Line
Style of Symbol Outlines the Width of 6 (thou, defined in current units) to all the Component
outlines used in the design (the style being assigned during the Symbol creation process). This would
be a global style for all items that use this same style in the design.
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Current Style =
Symbol Outline

Width of 6
1 [° 4

- 3 - 6
2 X 5 X
pra Ula U1-b
74HC00 74HC00

This could then be changed to 10 thou by editing only the value on the Line Style tab again.

You can also have local styles that are specific styles that only appear on one item. This means the
system is flexible enough to allow small local changes to be made, but also powerful enough to allow
changes throughout the design to be made.

Introduction to Net Items

Within the Technology, there are pages in the Nets section for defining facets that are properties of a
net or multiple nets, Signal Paths, Sub-Nets, Differential Pairs and Chains of Differential Pairs. Each
of these net items can have attributes assigned and rules added to them.

Why and when to use each category

To summarise each category, here is what they are used for in Pulsonix:
Standard net items

Nets — All Nets (Connections) within the design have a Net Name with a Type (see special note
below about Type) and (optionally) a Guard Space. They can also have a set of attributes containing
rules added, for example, a Track Length Rule. They can also have an optional Net Class associated
with them. Net Names can be user defined or default names automatically assigned by Pulsonix.

Net Class — Net Classes have a Net Class Name, a Type and a flag to Mark All Nets As One. It also
contains Net Class based Track Length Rules. A Net Class is an alternative method of ‘grouping’
nets to which the same parameters can be associated. This is a general method for grouping categories
of nets but can be achieved more efficiently using alternative methods. Nets do not require a Net
Class now, all rules can be attached to a single net or multiple nets.

Net Styles — All default [physical] styles (Tracks, Vias etc.) associated with a Net Class or Net
Attribute are defined in the Net Styles dialog. This dialog is also used to define how tracking will
behave on different Layers, within Areas and for Layer Spans.

Net items for the High Speed Design Option

Signal Paths — Signal Paths represent another level of net definition. The path is a named item
containing an ordered list of pads that represent a signal path. You might use this within High-Speed
designs for example where constraints are required. This could be where the overall track length of
the signal path would require a specific defined length rule(s).

Sub Net — These define part of a net which may require special considerations. These are defined in
the Sub Nets dialog using an attribute name and value. Pins on the same net with attributes that
match it are deemed to be in the same sub net. One definition can define sub nets in multiple nets.
You may use this for example, when creating branch lengths or a specific daisy chain order in a High
Speed design.

Differential Pairs — The Differential Pairs dialog is used to define the Differential Pin Pairs and
Differential Pair Chains (see below). All other Differential Pair specific rules such as Pair Gap and
Pair Length are contained in their own dialog under the Rules — High Speed section.
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Differential Pair Chain — A Differential Pair Chain is two or more (existing) Differential Pairs
added to a named list to create an extended list. This is used for associating multiple Differential Pairs
so that lengths or net rules can be defined for the overall ‘path’. This path may be split with a
terminating component for example and will contain different net names. As with Differential Pairs, a
design can contain multiple Differential Pair Chains.

Type — a net always has a Type, this is assigned when the net is introduced to the design. It can be
one of three states; Power, Ground or Signal. Type is used for some net-based options such as
Optimise, Design Rules Checks, ERC and Autoplace.

Net Styles
Net Styles provide a means of defining the default track and via styles to be used when routing PCB
designs.
Net styles enables you to achieve the following:
e  Use wildcard characters in the net class name to reduce the number of duplicate default style
definitions.
e Define different default track styles for layers and areas.
e Define different default via styles to be used for each layer span.
e Define different default track and via styles to be used within specific areas.
You may use the Net Styles dialog to create sophisticated rules on a per-layer or per area basis for
example.
Enable e Match Net Type Arca Track Styles e o Via Styles o New...
Val i i
Name alue Track Side |Track Layer| Def. Track | Alt. Track Min Len span Via Style Protected
Z <Net Name= | ADD* Track (6) Track (8) =Default=
[ i<MetMame :Diff* Inner Track (8) Track (10} <Default= Via (40}
[/] i<Net Mame= :Diff* Track (10)  Track (8) =Default= Via (40} Delete
Up
Down
Where Used:
Selected...
Al
Attribute: |<Net Name> w | Far Nets of Type:
Match: |Drﬁ' w | X Within Areas: | |V|
Define Default Track Styles Define Via Defaults
For Tracks:
Faor Vias with Layer Span: |<Any> ~
On Side: |Inner ~ |
or [ Vias Not Allowed
On Layer | e |
[] Define Via Protection: Delete if not Routed Reduce Span
Defaut Track Style:
aul Track Stle Define Defaut Via Style
Name:  [Track (8) -
Mame: |V|a (40) v|
o

Altemate Track Style

Width:  [1.016 Shape

Nape:  [Track {10) - 1.016 ol [0610-
Width: [ Plated

Fatten/Neck Min Length:
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Rules

What is a rule?

A rule is a collection of specific conditions and characteristics that can be assigned to a net. Whereas
previously these rules were bundled to be set on Net Classes, they are now individual facets that can
be assigned to any net or sets of nets. Rules are attribute driven. Some ‘rules’ are system ‘attributes’

such as <Net Name>, <Net Class> etc. but user defined attributes can be added as well.

User defined attributes would be created when system attributes do not provide enough range for
rules coverage. For example, a Track Length rule might be applied to multiple net names that do not
have a common name format, like CLK, RST, DQ1, ADD3 etc.

What characteristic might a rule have?

Rules can be standard items such as Copper Pour, Thermal connectivity, Teardrops and Net Styles
etc. More advanced rules might include facets such as Track Length, Track Length Match, Serpentine
and Track RF features so mention a few.

What can a rule be assigned to?

Rules can be assigned to any Net, Signal Path, Sub-Net, Differential Pair and Differential Pair Chain.
This means one (or multiple) rules can be applied to multiple net categories. For example, a number
of Thermal rules can be defined and applied to all signal or power style nets. Likewise, a Track
Length Match rule can be applied to multiple sets of Differential Pairs to ensure they are all within
length difference of each other.

Rules may also still be assigned to a Net Class if required but with this style of rules structure is less
likely to be used this way.

In addition to assigning rules to Net items, in the Thermal Rules and Teardrop Rules dialogs, you can
also assign rules to <Pad Style Name>. This means specific rules can be added for pad or via styles
for ranges or specific pads.

Key headers used in the rules dialog

There are some essential headers that are used within the rules dialogs and are highlighted below:

Total Track Length For Nets and Subnets Apply Rule To
| Attribute Hame Match Value . Max Vias X X
Minimum | Maximum Total Track Length Pin To Pin Track Length
TrackLengthRule 1000-1500 20.00000 28.00000 2 |:|

Attribute Name — this is the name of attribute that will define the rule, for example, this could be one
of the system ‘attributes’ such as <Net Name> or <Net Class Name>, or it could be your own user-
defined attribute name, such as TrackLengthRule

Match Value — once an Attribute Name has been defined, you must give it the name of something to
match. This could be a unique Net Name, CLK for example, or a range of Net Names to apply the
rule to, such as ADDO to ADD9. Using Ranges to match the attribute means a single rule can be
applied to multiple instances.
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Creating and applying Rules
Rules can be created and applied using two methods:
Method 1

Create your rules first in the Rules sections (in the Technology dialog under DFM/DFT and High
Speed) and apply them to the net(s) required.

As an example, we’ll show the addition of a Track Length Rule but the principle applies to all rules.
Create the rule by adding an Attribute Name and Match Value, plus your rule values:

B Technology [] - Rules - High Speed - Track Length

Layers ~
L 5 Total Track Length For Nets and Subnets Apply Rule To
ayerapans Attribute Name Match Value . . Max Vias . .
Layer Classes Minimum [ Maximum Total Track Length Pin To Pin Track Length
Materials <Net Name> ADD* 1500000 181.00000 2 ]
23 Mets =Net Name= ALARM 33.00000 44.00000 2 D
VL e cmaio e

On the Nets page, if the new attribute matches the rule, the attribute name and value will be
automatically adopted. If the rule doesn’t match automatically, apply the rule by typing the rule name
in the Attribute field (or selecting it from the drop down list which will be populated from the list of
available rules).

The example below is specific to the Track Length rule as this 'r-Tirectly shown in the Nets dialog:

Check * 7 Track Length Rule
flame | Net Class L= = Same Net | attribute Match Minimum | Maximum

YA Signal Signal 0.00000 ]
Y| ADDM Sig2 Signal 0.00000 ] <Net Name= ADD* 15.00000 81.00000
Y |ADDZ  Sig2 Signal 0.00000 ] <Net Name= ADD* 15.00000 81.00000
Y| ADD3  Sig2 Signal 0.00000 ] <Net Name= ADD* 15.00000 21.00000
Y| ADD4  Sig2 Signal 0.00000 [] <Net Name= ADD* 15.00000 21.00000
| ADDS Sig2 Signal 0.00000 ] =Net Name= ADD® 15.00000 81.00000
Y | ADDE  :Sig2 Signal 0.00000 ] <Net Name= ADD* 15.00000 21.00000

AR_D  Signal Signal 0.00000 ]

ALARM Signal 0.00000 ] =Net Name= ALARM 33.00000 4400000

AXIZZ Signal 0.00000 ]

AXIS3 Signal 0.00000 ]
¥ |B Signal Signal 0.00000 ]

hnh Sinnal Sinnal nnnnan

All rules added to a net-based item are displayed in the relevant dialog in the Rules and Attributes

tabs:
Name |H5 | Rules  Attrbutes
\sed: Track Length Rules: <Net Class Name>=HS [Min: 5.08000 Max 81.28000] A Add. .
Track Match Rules: <MNet Class Name>=HS [Mzx Diff: 12.70000] =
Net Class: |HS v| Met Styles: <Net Class Mame==HS Track Side: "All', Via on any Layer Span [Tr Edt...
Type: Signal Layer Change Length Rules: None
e = Copper Pour Rules: <Net Class Name>=" [Min Island: 1.612%0 "Remove lsolate:
Necked Length Rules: Mone Delete
. Sempentine Rules: <Met Class Name HS [Amplitude Min: 3.17500 Max: 6.350C
Check between tems on same net: [ Tamrrrnn, Dilae: <Nlat Mlase Mamen—" [Chane: Trsnnls® U Snma: G010 Anehe Tr ©
< >
Guard 0.00000

Method 2 — Track Length Rule & Track Length Match Rule

When using the Track Length Rule & Track Length Match Rules, an alternative is to write the
rule directly into the dialog that requires it (Net Name, Net Classes, Signal Paths and Sub Nets). Once
the attribute (Rule) is written, it then becomes a rule within its own right and appears in the relevant
Rules page where it is available for use on other nets.
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To do this: in the Nets dialog, write the rule into the Attribute cell along with the Match and Values
to be used. In the example below, the <Net Name> system attribute has been selected. The typed
Match will be FBO? And values of 22.0 and 27.0 for Min and Max Track Lengths respectively. This
then matches the Net names FB0O1-04 but not FBO11 (? will only match one character).

(1 []

ength Rule
Name | NetClass | Type Coar! Chesk =~ o -
Space | SameMNet | attribute | Match | Minimum | Maximum

Y |FAT Signal Signal 0.00000 ]
Y |FBO1 Signal Signal 0.00000 ] <Met Name= FBO? 22.00000 27.00000
% |FBO2Z Signal Signal 0.00000 ] <Met Name= {FBO? 22.00000 27.00000
% |FBO3 Signal Signal 0.00000 ] <Met Name= {FBO? 22.00000 27.00000
% |FBO4 Signal Signal 0.00000 ] <Met Name= {FBO? 22.00000 27.00000

FBO11 Signal Signal 0.00000 ]

Gnd Power Power : 0.00000 ]

Using Attribute Rules

Once Attribute Rules have been defined, they can be matched on a net item by Rule Value or by Rule
Name depending on which scheme best matches your requirements.

Match the rule value - any item with the rule attached and matching the value. For example
Attribute Name=TrackLength, Match Value=2.0. Where a net then contains an attribute of
TrackLength and a Matched Value of 2.0, the rule will be applied.

Match the rule name - any item with the rule attached, with no value (%# must be used as
the value to show a field with no value), but match by rule (attribute) name.

Rule Matching Examples

Wildcards are a powerful way to create ranges for selection, below shows a selection of wildcard

ranges:
Attribute Name (Rule) Match Value Rule Values Description
<Net Class> Signal XX A specific Net Class name of Signal has the rule
applied (where xx is your rule value)
<Net Name> DQS* XX Any net starting with DQS
<Net Name> DQS%[1:7%] XX Any net between DQS1 to DQS7
<Differential Pair Name> | % {DQS*IDSM*% } XX Any Diff Pair starting with either DQS or DSM
will have the rule applied. The strings are
separated by a pipe (| ) character.
TrackLength 2.0 XX Any net that has the attribute with the name
TrackLength matching a value of 2.0 will have
the rule applied.
TrackLength Blank (will be XX Any net with the attribute name TrackLength
written as %#) with no value will have the rule applied.

Wildcard Wizard

When a wildcard needs to be defined to create name ranges, you can use the Wildcard Wizard. This
allows you to create wildcards, often, complex wildcard strings (or simple ones), that are presented in
non-programming terms.
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On dialogs where wildcards are accepted, there is a button to access the wizard.

Attribute: <Net Class Name> w
Match:  |GND IS
Enclosed Pads Only: [
Min Pad Size:  |0.000 ~
Connect Type: c
|Therrna| Pad W |

Orthogonal Spokes: [

Isclation Gap:

Pressing the button opens up the Wildcard Wizard dialog:

B Wildcard Wizard x

String: |.6m_l,l ~ |

‘wildcard String:

Cancel

Wildcard String expressions are defined from the drop down list:

B Wildcard Wizard X

iy
Beging with

Dioes not begin with

) Endsz with

‘wildcar Does rot end with
Matches

Does not match
Containz

Does not contain
Fange

Does not include range
Empty string

Cancel

On selection of a String, you can type in the value to match. The Wildcard String is shown in the
Wizard dialog.

B Wildcard Wizard X

Stiing: [Does not begin with [~] [pDR3 |

‘wildcard String:

% DDR3 |

When OK is pressed, the wildcard string is shown as the Match value back in the host dialog.

Attribute: |\J"|as v |

%“DDR3" v | @

Match:
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Colours

Pulsonix provides a powerful colours mechanism that enables you to configure the colour,
selectability and true width of each design item type to suite your own preferences. The Colours
dialog is accessed from the Setup menu.

The specifics of each tab on the Colours dialog will be discussed as they are used in each chapter,
this chapter introduces the Colours dialog. The dialog's use and feel are the same throughout
Pulsonix, the main differences being the contents for each application type.

Using the Colours dialog

The Displayed and Selectable check boxes will set whether items in the design can be seen, and
whether they can be selected. Items that cannot be seen in the design cannot be selected, even when
using the Frame Select mode.

¥ Spacing Rules Name Displayed | Selectable | True Width Colour
i Styles Shapes [] [ [~
- Nets Sym. Shapes ] ] [~
- Rules - DFM/DFT Doc.Sym. Shapes = ] ]
(- Rules - High Speed Block Sym. Shapes ] ] ] -
& Outp.uts Block Port Shapes Z Z Z EEEN
s 2o g B omErm
=- Colours
7 .. Attributes Sym. Callouts ] ] [~ =|E|F ||:
- Bus & Connections CDI‘IStI’LIC‘tiDI‘I.LiI'IES z Z Z
i Embedded Views = ~ ] . |— r |—
- Connect Points
. Differential Pairs Other...
- Highlights
... Mets
.. Others
.. Shapes
- Signal Paths
- Sub Nets
.. Text

To change a colour, you select the cell that you wish to change. A drop down colour palette will
appear. On selecting the colour, the cell will change and the palette disappears.

It the colour required does not appear in the standard 20 colour palette, you can use the Other button
to display the standard Windows colours palette to create the colour required. The bottom row of the
drop down colours palette will display the most recent colours used.

Once a colour is set for a cell, that colour can be applied to a row or column by selecting the Apply
to entire Row/Column option form the context menu.

Layer Displayed | Selectable | True Widthl Colour |
Wires Top ] ' — o :
Silkzcreen Top [ Apply to entire Row
Top [/ Apply to entire Column

Solder Mask Top
Paste Mask Top

Pin Names

Bottom

Silkscreen Bottom
Solder Mask Bottom
Paste Mask Bottom
Wires Bottom

Pin Names (Bottom)

e Apply to this side

IR

EIEIEIEIRIEIE]

(BN ENEN| ENJEN RN EN

[IE]
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This method of applying to entire Rows or Columns is the same for the Displayed and Selectable
check boxes. Any selections made in these check boxes can also be applied to each Row or Column
using the context menu.

The main differences between the Schematic and PCB Colour dialogs is that the PCB dialog is
‘layers’ based, whereas the Schematic is ‘flat’.

Loading new Colour Schemes

Complete Colour schemes can be loaded using the Load Colours from the Colours dialog, the Load
Colours option from the Setup menu and from the Colour Files Bar.

All files listed have been found in the search path setup in the Setup, folders option.

® ' Load Colours m] *

PCE bottom silk, | 0K |

C:AUserstPublichDocumentsiPulsonizt Colours C |
PCE black background ancel
PCE bottom side
FCE baottann silk
PCE pastel colours
PCE top side

PCE top silk

Colours are an integral element within the Technology File and as such can also be loaded as part of
this file. During Load Technology, you can select to only load the Colour elements of the design,
ignoring any other elements. This enables you to load or reload the Display flag of any item(s), or the
Selectability, or the Colour of an item(s) within the design.

Changing the Colours in Properties

There are some colour items that can be changed independently of the Colours dialog, e.g.
Documentation Shapes and Text. Generally, these items can be changed in the Item Properties dialog
for each item. When available, the Own Colour check box will be enabled and the local colour can
be changed. The example dialog below shows a Doc Shape Properties dialog:

" Properties: Doc Shape - Shape [m| X

Segment Shape Lline Style Doc Shape Attibutes

Layer: |Si|kscreen Top ~

Closed Filled [ Locked
[T Hatched

Cross Hatched

Own Colour
Fill Colour

I —

Load Technology

The Load Technology option is used to load or reload, all or part of an existing Technology file
contents into the current design. You should use this if your current design does not contain
technology elements that appear in another technology file. For example, a double sided PCB design
may need to be increased to 4 or 6 layers, these additional layers can be loaded using this option (a
simple example, obviously you could just add the extra layers quickly anyway!).

Once loaded and a new mix of technology files obtained, this 'set' of elements can be Saved to
another new Technology filename for use on another design. Use the Save Technology File option
from the File menu to do this.
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You can only use Technology files that are relevant to that design type, Schematics Technology files
can only be used in the Schematics designs and not in the PCB designs etc.

Using the Load Technology dialog

The dialog is run from the Setup menu, using the Load Technology option.

You select the Technology File to load from the drop down list, choose the Technology Elements to
apply and start the process using Load. You are able to choose not to load items that don't already
exist in the design or to load them if they are required using the Add if not already in the design
check box.

Below shows the Load Technology dialog used when editing a Schematic design:

B Load Technology O *

Technalogy File:

Multi Instance

Apply These Technology Elements:
Technalogy

=[] Spacing Rules

; Design Level Spacings Uncheck Al
=] Styles

>

LCheck Al

Altribute M ames
PFin Types + Rules
=) [] Colours
- [A] Colaurs
Dizplayed
- [] Selectable
- [ True width
- [] Settings

- [] Design Settings
- [] Defaults
oordinate Origing
- .G:”E'S v

[ &dd if ot aleady in design Beplace all rules in design with selected rules
Bepaort... Cancel

The Check All and Uncheck All buttons are used to make complete selections of the Elements check
boxes. Quite often, it is easier to use the Check All button and deselect the items not required, or vice
versa.

The Report button will generate a report for you containing a list of all the technology items that will
be updated in the design when the Load button is pressed.
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Profile Files

Profile files are files that can be loaded to create a design or to add to a design. They can contain
drawing blanks, page borders and title blocks or the board outline (in PCB), Component pre-
placement and assembly information (in PCB).

Profile Files can be used to load predefined 'documentation’ information into a design. They differ
from Technology files in that they only contain the documentation information rather than rules,
styles, colours etc.

Profiles files combined with Technology files can provide a giant step into getting a design started
quickly, especially if using an existing set of files created from previous designs that may be similar.
Using these files you can combine design facets from different designs, and even designs from
different systems once imported.

By default, the supplied Profile files are installed into the folder, Pulsonix\Profiles. This location can
be changed or additional folders included using the Folders option and Profile Files dialog.

Schematic Profile Files or Drawing Profiles

Schematic Profile Files are actually called Drawing Profiles. They are normally used for drawing
blanks and title blocks, rather than to predefine design information that is how PCB Profile Files are
normally used.

All Profile items that appear on Pagel of the design and items marked as Common to All Pages will
appear on other pages as well.

PCB Profile Files

Board Profiles are stand-alone design files that contain data describing standard board types that you
can use as a starting point when designing a PCB board of that type.

They contain a board outline that has the shape and size required for manufacturing rather than just
describing the outer edge of the board as an indicator. Pulsonix profiles also contain mounting holes,
documentation and annotation required to manufacture the finished board.

Loading Profile Files

Once created, Profile files would normally be loaded when creating a new design but you can still
load one using the Load Profile or the Load Drawing Profile options from the Setup menu. They
are the same options for both Schematic and PCB editors but are named slightly differently. The
Profiles can be loaded into a design the same as any other design item.

When a PCB already contains a board profile and Load Profile is used, the old board will be replaced
for the new one (board and associated Component pre-placement). This is the same principle for
Schematic Drawing Profiles, one is replaced the new one being added.
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B Load Profile m} X
| 0K |
[Mone] ~ Cancel
C:AUzershPublich Documents\PulsonixiProfiles

AL andecape
A2-Landscape
A3-LandscaEe

E-Landscape

C-Landscape

eurob464s

euroG464:l

PCl-LongCard3-32

PCl-LongCard3-64

PCl-LongCard5y-32

PCl-LongCard5y-E4

PCI-ShortCardy-32 v
Pr.Chort™ard R4

You can also use other options to pre-load the Profile files during the initial design creation process.
You can use New - Schematic and PCB Design, and Translate To PCB from within the Schematic
design editor.

Creating and Saving Profile files

Profile can be created as a stand-alone process (from new) or can be extracted from existing designs
by saving items from to a Profile file. Not all of the design can be saved to a Profile file but the
program will save what is required. Use the Save Profile option from the Setup menu to do this.

If creating a brand new profile you can use the New option on the File menu, use the Technologies &
Profiles tab. If you wish to base your new Profile on an existing profile you can select it by picking it
by name provided from the list.

If using an existing design, when you use Save Profile in the PCB design editor, you are presented
with a dialog from where to choose the Component name(s) to save into the file. Once the names are
selected, you are presented with the standard Save dialog in which to enter the location and filename
of the file.

Save Profile x

Choosze components ta save in the prafile:

T2 Cancel
Select
All
Naone
Selected

Design Defaults

When adding new items to a design (schematic or PCB) and to create symbols, the option being used
will take styles and layers etc. from a central source. This source is defined as part of your
Technology and is loaded when you use a Technology file on a new design.

All of these defaults are stored in the Technology, Design Settings dialog on the Settings menu.
Within this dialog are the Default pages. The example below shows the Bus defaults used in the
Schematic editor. Schematic and PCB defaults are different in that they contain different entities.
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Line Style: | Bus v |

Name Style: | Normal - |

Bus Teminal Offset: 100,000

Bus Teminal Direction:
Up {on vertical bus segments)
Right {on horizontal bus segments)

In Dialogs - Apply Styles to All Connected or Same Name Busses

Working With Attributes

What is an Attribute?

An attribute is textual information attached to an item in the design, or to the design itself. This
information can be provided by the system e.g. Last Saved Date, or entered by you. Some attributes
are automatically added to items by the system e.g. Pin Names, others are inserted by yourself.
Attributes can be optionally displayed and plotted, or hidden away to be used later in reports or
outputs to drive third party tools.

An attribute can also be attached to a net to provide a mechanism for which to associate particular
rules created within the Technology file, such as Thermal Rules, Copper Pour rules, Teardrop Rules,
or in the case where the High Speed option is available, high speed rules such as Track Length Rules
or Serpentine Rules.

An attribute has the following properties:

® Attribute Name — Attributes provided by the system are identified by having angled brackets
around them e.g. <Part Name>. All attribute names provided by you are collated together and
presented in the Technology dialog. These names are also presented in a list when adding
attributes, to make it easier to add common attributes to different items. If you have some
attributes that are always used in your designs it is a good practice to add these names to your
Technology files so they are always available when creating new PCB, Schematics or Part
designs.
You can make attribute names specific to certain types of item setting the Usage parameter. For
example, a name can have usage Pin that means it can only be added to Component pins e.g. Pin
Order.
In the Colours Dialog you can set up each attribute name’s colour, whether they are displayed
and, if displayed, whether they are selectable. This is a quick way of altering the appearance of all
attributes using the same name.

Name Displayed | Selectable | True Width Colour
<Block Author= [~] [] []
<Block Description= [] [] [~
<Block Instance Name= ] [~ []
<Block Name= [] ] []
<Block Original Name= [] [] [~
<Branch Point Name= [] [~] [~]
<Component Height= [] [] [
<Component Name= [] [] [~]
=Component Variant ld= [] [] [~
<Current Variant Description= [] [~] [~

® Attribute Value — This is a text string either supplied by the system e.g. Date ‘12/3/99’°, or
supplied by you indirectly when performing certain operations e.g. Component Name ‘U1’ or
inserted by you directly when adding an attribute e.g. Part Value ‘2K’. The value can be left
blank if the attribute is only being used to ‘mark’ an item.
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® Attribute Position — Each attribute is capable of having its value string displayed in the design.
The visible attribute is known as an ‘attribute position’. When displayed you can move, rotate,
and mirror the attribute position, and allocate its text style and layer (if in a PCB design). An
attribute can have more than one attribute position, to display it on more than one layer for
example.

®  Owner — Every attribute is attached to an owner item. This can be an item within a design, an
item within a footprint or part, or attached to the design, footprint or part itself. Attributes cannot
be attached to Text, other Attributes, Connections, Tracks, Dimensions or Origins.
Moving a displayed attribute will highlight its owner.

System Attributes

System attribute names are predefined as they represent information that is provided from the system
or from data already within the design.

These system attribute names are not presented in the Technology dialog, but can be used to add
attribute positions to items in order to display the relevant information.

The system attribute information, or value, is added to items during the various stages of their
creation, and can be ultimately displayed on the owner item. On some of these attributes, you can
make them displayed and define their attribute position before the value has been provided.

An example of this is the <Component Name> attribute. This is the reference name of the
Component when added to the design e.g. IC44 or R21. When using this attribute in the Schematic
design, it can also be used to identify individual Gates if setup in the Design Settings dialog under
Naming. This attribute can be initially added and positioned within the footprint library item.
Because the value is only added when the footprint is added to a PCB design, it is displayed in the
footprint as an ‘unsatisfied attribute position’, also known as an ‘attribute place holder’. It is drawn as
the attribute name enclosed within curly brackets e.g. {<Component Name>}.

{ <Component Name>}

As soon as the Component is added to the PCB design and assigned the name ‘1C44’, the visible
attribute position is changed to the correct value.

User Defined Attributes

In addition to the system provided attribute names you can add your own. These can be added directly
through the Technology dialog so that they are available for use when adding attributes later, or they
can be created whilst inserting attributes.

When adding attribute names to the Technology dialog you should use the Attribute Names tab:
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B Technology [] - Maming - Attribute Names m] *
Spacing Rules P M
Use as Use as Back Iew.
. Et)de; Name Usage Context Show Name| Show Value ToolTip Hyperlink | Annotate Vali
ayers — — — — —
Neyt <Pin Pacrage Length=___| Pad All Designs =
- Nets ; ¥ |<Spice Devices ‘Any tem :SCM Design Only ] 4 ] ] ]
Rules - DFM/DFT SETEP Filenames Part FCB Design Only ] ¥ C] C] [
- Rules - High Speed <ETEP Offsetss Part PCB Design Only [] ] C] [l [] Delete
Qutputs <STEP Rotation= Part PCB Design Only [] [ ] ] ]
=} Naming Bob Pad All Designs. [] [ ] ] ] Delete Lpuzed
i Attribute Mames Y|C Any tem All Designs. ] [ ] ] ]
;--Gmup Names ¥ |Category Part All Designs. : z : : :
.. Hatch Style Naming Color Any kem All Designs [ : ] [ [
Line Style Mamin Y |Connector Type Any tem All Designs ]
. 9 Contact Finish Amy kem All Designs ] [ ] ] ]
~-Pad Style Naming Contact Finish Thickness - Any kem All Designs. [] [ ] ] ] DOnly Show
="TE’¢ Style Naming D Any tem All Designs. ] ] ] ] ] sz ez
i.. Track Style Maming  |DataSheet Any tem All Designs ] [ ] ] ]
- Colours Delay Time tpd(1) Max Any tem All Designs [] [] ] ] []
. Grids ¥ | Description Part All Designs. ] ] ] ] ]
- Units % | DigiKey Part Number Any kem All Designs [] [+ ] ] []
- Variants Y |Features Any tem All Designs [ : L] L] []
Design Setti FT Any ttem All Designs. [
- Lesign Jettings Height Above Board Amy tem AllDesigns ] [ ] ] ]
- Parameters HFE Any tem AN Designs [ ¥ C] C] [
¥ [Hs1 Pad All Designs. [] = ] ] ]
Ic Any tem All Designs. ] [~ ] ] ]
¥ |Manufacturer Part Number *Any tem All Designs. ] [ | | ]
W [Mfr Any tem All Designs. [] [] ] ] ] v
< >
Name: Pin Package Length [ Shaw Name Show Value
Used: [ Use as ToolTip [ Use as Hyperiink
Back Annotate Copied
Usage:  Pad O B Cor
Cores
Validation |
Save Technology. Load Technology. Cancel Apply Help

Attribute names and values can be selected for display using the Technology dialog and Attribute
Names. You can choose to display the attribute Name (Show Name) or Value (Show Value).

Your own attributes can be added to items in the design using one of the following options:

® Insert Attribute, this is used to attach and attribute name and value to an item.

® Insert Attribute Position, this is used to attach an attribute name to an item. The value would
then be populated at a later point. For example, on a resistor, Value might be ?. When used in the
design, this would be edited to provide a ‘real’ value, such as 10K

Both features are defined below:

Insert Attribute

Use the Insert Attribute option from the Insert Menu to add an attribute to an item by picking it in
the design, then choosing or typing an attribute name and typing an attribute value. This allows you to
interactively place the attribute position, choosing its style and layer as well.
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Insert Component Attribute x

Altribute Mame: | <Component Height> | w |

Usage: Any ltem

Abtribute Value: | [ - | =

Substitute Attribute. .

Use Defaults Wisible Attribute W alue
Layer, Sikscreen Top
Shyle: | TextStyle35.0-3.0

Text Alignment:

Battamn Left

Cancel

Add Attribute To - Only provided if a design item was NOT pre-selected. Use to specify the type of
item you are adding the attribute to. This makes it easier to pick the item and restricts the list of
attribute names you can use. Choose Design to add design level attributes.

Attribute Name — Type in your own new name, or pick from a list of system attribute names or
attribute names already added to the system.

Attribute Value — Type the value for the attribute and choose whether it is to be visible. If this is a
system attribute, this field is disabled and the value provided by the system is displayed.

Use Defaults — Check this box if you wish to use the Attribute defaults defined in the Design
Settings dialog under Attributes. If you wish to override them with local attribute settings, uncheck
the box and define your own.

Adding the Attribute

If no item was pre-selected and you are not adding the attribute at design level, you will enter a

‘picking’ phase to choose the item to add the attribute to.

k When Insert Attribute is used with an attribute that can be attached to multiple
= items a modal cursor is displayed.

If the attribute is visible you will enter a phase enabling you to manually place the attribute position.

Insert Attribute Position

The Insert Attribute Position option offers the same functionality as Insert Attribute except it is
only used for placing the attribute. The attribute value cannot be typed, so it’s only really used
making existing attributes visible, or adding a ‘place holder’ attribute position on items that do not as
yet, have the attribute value, but want it to be positioned and visible when it is added later.



106 Chapter 4 — Setting Up The Design

Insert Component Attribute Position X

Altribute Mame: | <Component Heights ~

Uszage:  Any ltem
Usze Defaults
Layer. Silkscreen Top
Style: TextStyle35.0-3.0

Text Alignment:

Bottorn Left

Cancel

This is used mainly in PCB Footprints and Schematics Symbols to add place holders for items like
Part Names, Values, Pin Names etc. where you want a specific position to be used. The attribute
values are fulfilled from the Part and ‘applied’ to the attribute positions when the Part and
Symbol/Footprint are added to a design as a Component.

Properties

Properties can be used from the context menu once an item is selected. Choose the attributes tab
applicable to that item, for example if picking a Component Pad on a net, you have a Pad Attributes
tab, a Component Attributes tab and a Net Attributes tab. This example shows the Comp
Attributes tab after picking a Component.

B Properties: Component - Comp Attributes O X

Component Netson Pins  Comp Attibutes  Variants  Vault

[Eategory=Connectors : FFC, FPC (Flat Flex) - Connectors - Board Mourt | MNew ..
[Connector Type=Bottom Contacts
[ DataShest=http:/www molex.com/pdm_docs/sd/514412493 _sd pdf Edit...
[ DigiKey Part Number=51441-2453-ND

[Features=Zero Insertion Force (ZIF) Delete
[IManufacturer Part Number=51441-2433
[IMounting Type=Surface Mourt, Right Angle
[INumber of Positions=24
[JPackaging=Tape & Reel (TR}
[Pitch=0.020

[Quantity Available=0

[ Series=Easy-Ona, ¢ 51441
[IVendor=Malex Waldom Electronics Corp

The list shows all current attributes on the item, and whether they are currently displayed. Use the
New... button to add a new attribute to the item selected.

Design Properties
The Design Properties option has a similar interaction to the Properties option, but available on the
Edit menu. Use the Attributes tab to add design level attributes.

Part Attributes in the Part Editor

You can insert Part level attributes within the Parts dialog on each of the pages using an interactive
method or by using the Part Attribute Editor (this is discussed later on in this section).
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Aftributes

Part Name Manually Name Parts 1008C5-100XGLC
Aftributes Mfr Coilcraft

L 10nH

Freq SO0MHz

TOL 2%

Qmin S0@S00MHz

SRFmin 4100MHz

DCRmax 0.08

Irms 1000ma

<Hyperlink> www.coilcraft. com

—Component Feight S

Category Inductor/Coilcraft 1008
M 4 » w Details » Parts and Attributes /4 Fins / Gates 4 Assoc Parts

The attributes will be saved to the library with the Part, and added to components inserted into PCB
or Schematics designs. See the Changing Attributes section below for details of how to ‘over-ride
these part attribute values with local Component ones.

s

Footprint Attributes in the Footprint Editor

You can insert attributes for the PCB Footprints within the Library Manager on the PCB
Footprints tab using the Attributes button or by adding attributes from within the Footprint editor.
Libraries - PCB Footprints X

Folders  Schematic Symbols  Schematic Doc Symbols  PCE Footprints  PCB Doc Symbols  Pats 3D View  STEP Models

Current Library: | BGA =

Atributes New Library.

Preview

Report Index
Conterts

3M Texdtool BGAZES A
21-0073E_25X25

21-0073E_27X27 Edit

[

<Component Mames)
21-0082K_B36-1
21-0082K_B36-2
21-0082K_B36-3
21-0082K_B36-4
21-0090C
21-0093L_B3%1

Delste

Bename

Hyperlink Attributes

Any attribute or text string can be a hyperlink. This feature is enabled through the Technology file
and Attribute Names page. Select the Attribute Name and click the check box Use as Hyperlink.

Name Usage Context i:?““; i’;?: #zjl.;l_fp Hﬁ:::r?iik Al?:zrate Validation | Copied
<Component Height= Any ltem : PCB Design Only ] [] ] ] ] []
<Hyperiink- | Any ttem : All Designs [] [] [] [] [] []
<Pin Package Length= Pad All Designs ] =] ] ] ] [
<Spice Device» Any ftem | SCM Design Only ] ] ] ] ] ]
«Snire Nnde Temnlates Pard SCM Nesinn Onbe 1 el 1 1 1 [

Where the hyperlink is used you can add a link to various file types. With the hyperlink displayed,
you can select the Execute Hyperlink command from the context menu where Pulsonix will attempt
to invoke the appropriate application to read the link. This will work the same as if you had selected a
link from your Windows Explorer program.

You can use filenames, such as Word and PDF files, and folders within the hyperlink name, or you
can use an Internet URL.
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Kepiacs rait..

Save Items To Library...
Edit Part In Library...

Edit Footprint In Library...
Move to Bin

= 2 Bt &

K

Execute Hyperlink
)
Create Signal Paths...

#.  Highlight Selection
<& Insert Attribute... Shift+A
|

pAd T -

You are prompted with a choice if the item has more than one hyperlink (multiple hyperlinks can be
defined in the Technology dialog and Attributes page).

B | Execute Hyperlink X

yperlink = les
Web_Link Lwwow. st com}
Local_Source {c:\designs\MNotes.doc}

Dynamic Attributes

Attribute values can be ‘plugged’ with values from other attributes. A special substitution character
introduces the name of another attribute in the value and also closes it off. The character must be
‘doubled’” when using it, e.g. %% NAME% %

When editing an attribute, you can easily create these using the Substitute Attribute button. Two or
more attributes can be added together to make a substituted attribute string.

Substitute Component Attribute Into Text x
Aftribute Mame: [Value v
Cancel

For example, you could create a new ‘dynamic’ attribute by combining two (or more) other attributes.
A Component with attributes of Vendor and Value, could be combined to create a dynamic attribute
called Insert. The entry in the Edit Attribute dialog would look like: % % Vendor% % % % Value
% % In the design, this would be displayed with the values from each attribute inserted, say Farnell
and 10K and respectively. Attribute display for this type of attribute is the same as any other attribute.
Note that a space (or any other character) can be used in between each pair of %% characters.

MNew Attribute >
Marne: | Bir_Mumber | v |
Yalue: [ zavendors® Zavalusss =

Substitute Attribute. ..

oK Cancel

To change the Attribute Substitution Character use Design Settings options and the General tab.
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Al Text Attributes
[ Adjust To Readable Orientation Substitution Char: E
{when doubled)
Banming Character: |:|
{when doubled) Matching Styles
System Font (®) By Name Only
[ Proportional Width Digits (O By Name And Value
CAM/Plat O By Value Only
[ Transform about design extents MNaming Rules

STEP Model Alignment [ Make named styles use naming rules

Snap by: Pad Exceptions
(®) Certre [ Mirror with Companent
() Origin

e e

You can also use attribute substitution in hyperlinks. You could use this for defining the folder path
and the filename as two attributes which could then be substituted to one hyperlink.

For example, attributes defined for a generic folder: %%c:\datasheets\%% and each unique datasheet:
% % AD8592%% and %%PIC16F%% produces (when satisfied):

c:\datasheets\AD8592 and c:\datasheets\PIC16F respectively.

Changing Attribute Properties

Once attributes have been added to a design, footprint or design item, all Properties of the selected
attribute can be changed; Value (not for system attributes), Position (X,Y position, Angle, Mirrored
status, Locked status), Layer and Text Style used, and Alignment.

B Properties: Component Attribute - Attribute O X

Atribute  Text Style  Component  Metson Pins  Comp Atrbutes  Variants  Vaul

Name:  |<Hyperdink: |
Usage: |A|'ﬁ’ ftem |
Value: |"-."-server"-ds"-.STI'v'I 32F103 pdf | =

Substitute Attribute...

Angle: [ Mimored:

Layer: |D0c:umentation w |

[ Locked

Text Alignment:

Q00
Q00 Bottom Left
®00

You can also select the visible attribute in the design and delete it. This removes the visible state of
the attribute, the attribute still exists on the item though. Use the Properties dialog to remove it
completely from the item.

If the attribute is not visible, select its owner item and use Properties from the context menu. Choose
the correct attributes tab, for example if picking a Component Pad on a net you have a Pad
Attributes tab, a Component Attributes tab and a Net Attributes tab. The above example shows a
selected Attribute for a Component. Note: system attributes are not editable from this list.
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If the attribute is not owned by the item, but owned by the Component’s Part or a Net for example,
the Edit... and Delete buttons will be disabled. To over-ride these attribute values with a local copy
on the item being edited, use the New... button to add an attribute using the same attribute name, but
different value. When this is done the Edit... button is enabled and the Delete button turns into a
Reset button to indicate it is a local value.

Use the Reset button to reset the attribute value back to the original value from the Part or Net.

Attribute Validation

You can define a wildcard validation string along with an Attribute name on the Technology dialog.
This is used to allow you to define specific values or contents for attributes up-front, and then for
Pulsonix to check and verify them.

For example, you could define the ROHS Compliant Attribute in the Technology dialog with a
Validation string of Yes. If this is then changed to No or another string, it will be flagged by the
Design Rules Check option.

Show | Show | Useas Use as Back I .
Mame =age EETIE Name | Value | ToolTip | Hyperlink | Annotate aldation REopien

HFE Any tem Al Designs

Y [HS1 Pad All De=igns

Any tem (Al Designs

Y[R
ROHS Any tem (PCB Design Onhy
Row Sparin~ Any fem Al Ne=inne

j| mmini|
JERIEIE
| |
10004
il mmimi|
JRIRIEIE]

Checking Validation strings

Attribute Validation is checked by Design Rules Check, the Attribute Editor and Attribute
Properties. If you attempt to change the value to one not matching the Validation characters, you are
presented with a warning dialog:

B Warnings X
C14 Attribute 'ROHS" - value ‘Mo’ does not match “es' E [n] 4 i
Cancel
Fepart...
Warnings On/OF ...
[ Da nat tell me again

Plotting and printing attributes

Sometimes you may wish to see attributes on certain layers on the screen for information purposes,
but don’t want these attributes to appear on any plots output. To switch off these attributes use the
following procedure:

Select CAM/Plot from the Output menu and select the appropriate plot from the list provided. Use
the Edit... button to enter the CAM Plot Wizard. On the Process stage of the wizard, select the
Exclude Items... button. You will be presented with a dialog titled ‘Exclude items From The Plot’.
Use this to move attribute names from the ‘Choose from’ list to the ‘NOT to be PLOTTED” list to
exclude them from the plot. Finish the wizard to apply the changes.
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The Pulsonix Vault

When setting up your design, you may choose to use the Pulsonix Vault to manage your Libraries,
Designs, Technology files, Profile files and Block files. This allows the vault to be used a Revision
Control and Management system for your Pulsonix documents.

Wl DdvVE M.

With the appropriate license enabled, the Vault management tool

Save Copy As... . . . . .
=opy is primarily situated on the File menu.

Save Restore Point...
Save Al

Check Qut From Vault
Check Into Vault
Uncheck From Vault

Copy From Vault

kP P OS

Vault Manager...

-ﬁ\ Data Transfer...
Import Design Data...
Import ECO...

+

Below is a brief introduction to the Pulsonix Vault. More detailed information can be found in the
Online Help and within the Pulsonix Vaults Users Guide.pdf file

Installing the Vault

By default, the Pulsonix Vault is not installed. Because it uses a separate database mechanism to save
and manage data, it must be installed as a separate process.

Everything required to install the Vault is provided in a self-contained file.

CD Install

If installing from the Pulsonix CD, browse to the Vaultserver folder and click on the
VaultAdminSetup.exe file to start the installation. This file contains everything required to install the
Vault.

Download/Web Install

If receiving Pulsonix via the internet, the Vault server installation is a separate download. This will be
located with the Double click on the VaultServerSetup.exe program to start the installation. Again,
this is a self-contained file containing everything required to install the Vault.

For either method, the installation is a three part process:

1. Install the PostgreSQL Server — this is the service that contains the Vault.

2. Create Vault Database — you must create a Vault database to use with Pulsonix.
3. Choose Data Folder — you must choose where Pulsonix will store Vault data.

As already mentioned, this is a brief overview of the Vault in this document. Refer to the Online Help
for more information.

Once installed, the Vault is managed from within the Pulsonix program.
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Vault Manager

The Vault Manager controls all aspects of the revision control and management of Pulsonix design

items:
B Vault Manager - Browser m} x
Browser | libraries to Vaut  Designsto Vault  Audit Trail
Vault Folders: Vaul kems: 430 v Search..
,'__:..a Vault ES Item ID Type | Folder Name Revision - Move...
{23 Design Contert 53550 | g Pat | \Lbrary ContenfiParts\AD | ADSB9R 10 Dote
23 Blocks 53551 gm Part :\Library ContentiParts\aD | ADSS4AD 1.0
-] Examples an  Part \Licrary Content\Parts\aD | ADSS5AD 1.0 Check Out...
a LED an Part :\Library Content\Parts\AD ; ADG00JN 1.0
a Pangls an Part {\Library Content\Parts\AD | ADGO0DJR 1.0
a Profile an Part :\Library Content\Parts\AD | ADS0ZIN 1.0
a Technology an Part \Library Content\Parts\AD | ADG0ZIR 1.0
a Library Conterit @ | Part :\Library Content\Parts\AD : ADS03AQ 1.0 o
<=3 Footprints
£ Parts ltem Details: | Audit Trail -
& am item 1D Type | Action Date Timestamp Revision | Action Type
a Actel 53554 an Part | 2016-11-01 00:43:59.374 | 2016-11-01 00:43:59.374 i 1.0 Added (with automatic referencing]
a AD 53554 an Part :2016-11-01 00:43:47.633 : 2016-11-01 00:43:59.374 : 1.0 Moved
{3 ADSP
45 Attera
a Altera2 < >
4] AlteraCyclone Preview Of:  [Part "ADS0DJR
423 AMP <Part Family>=AD&0
42 Assmann Description=
-3 Atmel - wa Mir=AD
a Pvago ﬂ p— o jf( & =
& e EeaaE
4= Boums
-2 Capactor
1000.0 thou
-2 CoilCraft e _—
Close Help

Key Concepts of the Vault

What can be stored in the Vault?

The Vault can hold the following types of ‘library’ data: Parts, Footprints, Schematic Symbols, and
Schematic and PCB Doc Symbols.

It can also hold the following types of file-based data: Schematic and PCB Designs, Schematic and
PCB Technology Files, Schematic and PCB Profiles, Schematic Block Files and PCB Panels.

The Vault is designed to provide you with a secure environment for managing your ‘published’ data.
You may still use locally-stored design files and native libraries for developing data, and release your
completed items to the Vault when you are ready to do so.

What is an ‘item’?

Each item that is placed into the Vault is given a unique item identifier, or “IID”. Each time that item
is saved to the Vault, a new version of the item is created, with this latest version having a new
version timestamp or “Version”. This is distinct from the “Revision”, which we will hear more about
in a moment. In this way, the Vault contains a full history of all revisions of an item.
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The IID combined with the Version uniquely identifies a specific version of an item. In this way a
Part for example can know which exact version of a Footprint it is to use. Not just any version of the
Footprint, only the specific version that is indicated by the IID and Version listed in the information
held along with the Footprint name inside the Part.

Other Vault item properties

In addition to each item having its own Item ID, every Vault installation has its own Vault ID. This
allows the application to clearly identify an item as belonging to the current Vault. This means you
cannot share items across separate Vaults, because there is no safe way of ensuring the uniqueness of
the item ID of items created in different Vaults. You can still take an item from one Vault and check
it into your own Vault as a new item, at which point it will be assigned a new item ID.

Cross References

Depending on the settings you use when publishing your data to the Vault, the application will
maintain cross-references between related items, allowing rapid access to information such as ‘Where
Used’ without having to resort to time-consuming compilation of reports.

Managing and updating Vault items

There are four basic actions which you can use to manage your Vault items. Your Permissions will
control which of these actions are available to you for the various types of item in the Vault.

Check Out

Check Out will “book out” an item from the Vault for you to make changes. This action will be
recorded in the Audit Trail, and the item will be marked as checked-out by you to prevent other users
from making changes to it at the same time. They will still be able to access the item, for example for
a Part they will still be able to use that Part in one of their designs, but they will not be able to check it
out to alter it until you have finished with it.

Check In

After modifying an item, Check In will “book it in” to the Vault to commit your changes. Another
record is placed in the Audit Trail, the item you are checking in is given a new revision, the ‘lock’ on
it is released, and the newly modified item is available for others to use.

You can also Check In an item that is not yet in the Vault, including newly-created items such as
Parts and Footprints.

Uncheck

If you have used Check Out to book out an item to change it and then change your mind, you can use
Uncheck to release your hold on that item.

Copy Out

If you need to use an item for something without actually changing it, then Copy Out can be used to
pull a copy of the item to be stored locally. You might want to use this for example to open a PCB
design to generate manufacturing data or run reports, actions that don’t actually change the design in
a way that you want to record.

Vault Admin Tools

The Vault admin tools on the Setup menu allows you to control and manage aspects of the Vault
system that are not directly related to revision control or data management.
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Vault Setup - Groups X
Signin Users Groups Revision Naming Attibutes  Options  Colours oK
_ Add Close

esigner
Copy Appl
Delete
Help

Save Changes

Discard Changes

Name: |admin |

Description: |De{aun Admin group |

Pemissions: |[]Read Parts ~ Al
Read Symbols
Read Footprints None

Read PCE Documentation Symbaols
Read Schematic Documentation Symbals
Read Packages

[#1Read Panel Nesians

Default

Adding Vault Items to a Design

There are a number of ways to add components to your design from the Vault. Primarily, you can use
the Insert component option or Part Browser bar.

B Insert Compenent *
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nt Height> = 8mm
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Chapter 5. Schematic Capture Editor

Getting Started

There are a number of ways of starting a new Schematic within Pulsonix.
®  You can start with the supplied Technology files and/or Drawing Profile. This is the preferred and
recommended method of starting a Pulsonix design.

®  You can start with an empty design, that is, no Technology files, and no Drawing Profiles. You
would add the necessary styles etc. to the design as you need them.

®  You can start by importing a design from another system using the import mechanism. Once the
Schematic has been imported, a Technology file can be made from it as can a Drawing Profile,
and libraries imported or created from the design.

The discussion below deals with the basic start, with and without Technology files and Drawing
Profiles. It then builds the design using the natural design flow as a guide, adding design items as they
are required, each topic deals with one feature of the process.

Starting a New Drawing with Default Files

Regardless of which active window is currently open in Pulsonix, you can start a new Schematic
design using the New option. This dialog can also be used for starting new designs (Schematics and
PCB), Library items, Technologies, Profiles and access to the Library item creation wizards.

- Schematic
Technol Fil % i i

Technology Fies | — Y A
Drawing Profiles |— 3¢ v

Block

] P |

Cp A | e

Block Page Block Page

Once you've decided to start the new schematic, you then need to decide whether you require a
Technology file and/or a Profile file.

The Technology file contains information such as the Styles, predefined Net Names, Attribute Names
and Colours. The Drawing Profile file can contain documentation items such as a Page Border. You
can start without either of these files and add them to the design later. It is better practice to start with
the Technology file at least, although the Drawing Profile file is also useful because it provides a
localised area in which to work and also is a guide to the printed page size for later on.
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P To start a new Schematic design

1. On the File menu, click New
It is better to start with a Technology file. The styles and values used in it will be the same as the
styles used in the supplied libraries. Although this is not too important, it makes it easier to
understand if you are just getting started with Pulsonix.

MNew

Designs | Technologies + Profiles | Wizards

[ PcB Desion

Sem Hierarchy Block
F'd Pce Footprint

[B PcE Doc symbal
Schematic Symbol
Schematic Doc Symbol
=g Fart

Panel Design

Technology:  [Defaut (Whte) v
Profile File: |[None] v|
[[]5et Units: Imperial: |thou Metric:  |mm

1 S

2. Click on the small 'down' arrow on the Technology drop down list

3. From the list of Technology files select Default (White).stf
This is one of the default files supplied until you create and save your own.

4. Leave the Profile File: entry as [None], unless you require a page border.
5. Use the Set Units to override the Units defined in the Technlogy file.

6. Click the OK button to start a new Schematic design.

Design Options for Schematic Design

Before getting started on the design itself, you should check that when you start adding design items,
the editor will behave as you expect or wish it to.

Many characteristics of design items are set up in the Design Settings dialog from the Setup menu
and in particular on the Defaults tab. Once you start editing the design and adding new items to it,
you should also check on the Options dialog from the Tools menu, to ensure that the Edit
Connection and Interaction tabs are set to your own preferences. Pulsonix is a very flexible system
and allows many of the options to be customised to suite your particular style of working.

The Defaults page sets up the styles and values used when adding new items to the design.
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In this example, the Bus Terminal defaults are shown:

Line Style: |Bus

v

Name Style: | Mormal

v

Bus Teminal Offset: (100,000

Bus Teminal Direction:
Up {on vertical bus segments)
Right {on horizontal bus segments)

In Diglogs - Apphy Styles to All Connected or Same Mame Busses

Unless an item is pre-selected, the default style defined in this dialog is used. If a similar item is pre-
selected, inserting a new item of the same type will inherit the style of the item. For example, if text is
added to a design and the text style then changed from say Normal to Large200 (Normal being the
Default), if the text remains selected, the next text item added will use the Large200 style even

though the default is Normal.

The Naming page in the Options dialog contains very specific information regarding the
characteristics of design items, items such as the leading character or symbol used for the default
system net names, e.g. whether NOOO1, or $1 is used (or another character).

Force To Upper Case
Component Names
[ Gate Names

[ Net Names

[ Part Names

1 Pin Names

[ Test Point Names

Default Met Names
Name Stem:

Mumber Width: D

Local Net Names

Defautt to local names

MNames Unique Across Design
Local Name Prefic: !

Owner-Net Separator: !

Owner Before Net Name

Net Pages Aftribute

ot -
Separator: l:l
Newline After: [I

[ Show Curent Page

Show Page Number
{instead of Name)

Page Link Attribute

O Show Page Number
{imstead of Name)

Name Options

[ Case Sensitive Fin Names

[ Mumeric Gate Names

Fillin Gaps In Mumber Ranges

MName Ranges

Range Start: D
Range End: EI

Range Separatar: El

tem Separator: I:I

Example: U1.U[3-6]

Fin Mames

Component to Pin
Mame Separator:

[ ]

Component Mames
Display Gate Name

Gate Separator: l:l

Display Connector Pin Name
Connector Pin
Separator: I:I

Part Names

0 Display On Each Gate On
Page



118 Chapter 5 — Schematic Capture Editor

Al Text
Adjust To Readable Orientation

Barming Character: l:l

{when doubled)
System Font
[ Proportional Width Digits
CAM/Plot
[ Transform about design extents

The General page in the Options dialog allows you to set up more general design items.

Attributes

Substitution Char:

{when doubled)

Matching Styles

() By Name Only

(@) By Name &nd Value
() By Value Only

Maming Rules

[ Make named styles use naming rules

Blocks
Allow Muttiply Instanced

Edit Defaults...
Schematics Top Level

Name: |

Schematics Implied Junctions
Display Implied Junctions

These dialogs are pre-programmed with built-in settings and should only be changed if you
understand what they do and need to change them. Some of the settings can only be changed before a
design is started where there are no design items in the design itself already. Some items can be
changed after the design is started but the system updates itself to adjust all the design items that
already used these settings, e.g. Default Net Name stem.

Saving Design Settings and Options

All Design Settings options are saved in the design, and so only effect the design you are editing.
Other parameters used in the Options dialog are saved to the system's Registry and so are set up for
every design that you subsequently create or edit.

The Design Settings options are saved with the Technology files and so, once your preferences have
been worked out, this allows for the same settings to be used when the Technology files is selected in
future Schematic designs.

When setting up Design Settings, you must also consider whether your design will use hierarchy and
what style that hierarchy might be, multiple-instanced or not. This is covered in more detail later on in
this chapter under Hierarchy.

Setting up your Technology

The concept of Technology files has already been discussed in a previous Chapter. This section
details specific uses of Technology with the Schematic design editor.

One other important consideration when setting up Technologies is the final process of translating to
the PCB design and how the PCB handles the items used in the Schematics. The Pulsonix PCB design
editor will use any Net Names, Net Class Names, Net Class Rules and Attribute Names used in the
Schematic when transferred.

Schematic Technology dialog

The illustration below shows the major styles used in components and Documentation Symbols,
Connectors and Testpoints. These are all accessed from the Technology dialog.
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R1
360K

Y
-
%]
-
[+

o< — —<

A
R2
360K

a Styl;s h Name Shape Width Length
.atc [ Cross Cross 1.524
Line — L junction Round 0.762
% Pin | Pin Cross 1E34
Text | Star Point Round 2.540
Connections — ¥ | Terminals Cross 1.524
Testpoint Round 1.524

Pin Styles are used to define the appearance of pins and junctions that connections are attached to.
These can be one of any of the shapes available, with a Width and for some shapes a Length. An
Offset value can also be defined for both X and Y offsets.

Name: Shape:
= | Iee

Thickness:
cres

Filled

This enables you to display the pin in an offset position from that of the actual connection point.
Connections obtain their Line widths from the Connections dialog.

The Line Styles dialog is used for the line widths of Symbol outlines, Blocks, Busses and all other
line items.

The Text Styles dialog is used for the appearance of Component Names, Pin numbers, Net names and
all other text items.

The Net Names dialog is used to list the user defined net names used in the Schematic. You can set a
nets Net Class name (see below) and whether the net is Local (i.e. only to be used on one page), or
Global, available to all pages of the design, e.g. VCC or GND.

The CAM Plots dialog allows plots and prints to be setup in advance. These are saved in the
Technology data along with the other design information. Plotting the design is covered in detail at
the end of this chapter in the section under Plotting The Schematic.

Other facets of the Technology are discussed as they are used in this manual.
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Rules

From within the Technology dialog you can also define Rules that will passed through from the
Schematic to the PCB design. Different levels of rules can be passed through during the Translate To
PCB phase. . For example, you can define rules for Spacings, Min and Max Track width, or Min and
Max Pin Lengths. These net classes are then applied to a net or multiple nets within the design.

All of this detail is then passed through into the PCB design where it can be used and checked again
on the physical design. This allows the engineer to define some of the critical electrical parameters of
the design that the board layout designer can then use.

In the example below, the Differential Pair rule is shown:

Enable Attribute Name Match Value Side Layer Area "I:lrl.l;::s Uze Spacing| Min Gap
I~ i<Differential Pair Name FMC* Inner | L 8.0
[+l i=Differential Pair Name= FMC* Quter [~] [] <Undefined=
[~] i=Differential Pair Name=  Diff1_% [] [] <Undefined=

Changing the Colours of the Schematic

All item colours within the Schematic design can be changed using the Colours dialog. The use of
this dialog has been discussed in a previous chapter, Setting Up The Design.

The illustration below shows how the design is constructed using different colours for the different
design items:

[ 7| Colours - Shapes

" Name Dis played

Connections

-« Bus
k Shapes
Sym. Shapes

—

Doc.Sym. Shapes
Block Sym. Shapes
Block Port Shapes
Callouts
oo Sym. Callc!uts i
T Construction Lines

w
2
@
1]

o T e e R
JRIRINN R

Embedded Views

Rl
[ # | Colours - Connect Points

T A
Name Displayed | Selec
N Sym. Pins Tl @
rd Doc. Sym. Pins [ :
Block Sym. Ping v W
Block Ports [7] ]
Junctions ] ]

From within the Colours dialog, Text categories are also available for (free) Text, Sym Text and
Doc Sym Text.

Grid colours are set up in the Grids dialog as discussed previously.
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Using a Drawing Profile (Page Border)

There are three methods of adding a page border to a Schematic design depending on whether you are
using predefined page border or are creating it from new. It is recommended that you use Drawing
Profile files for this purpose.

Drawing Profile file - predefined Drawing Profile files can contain page border outlines in various
sizes to start the design. These may already exist to be loaded into any Schematic page, or created
within a design and saved as a Drawing Profile file. The supplied Drawing Profile files can be edited
and saved to suite your own style required.

Created Interactively - using the Insert Shape and Insert Text options you can create the shape
outlines and add any text required (this can then be saved to a Drawing Profile file to be used with
other designs).

Documentation Symbol - Documentation symbols created and stored in the Documentation Symbol
library can be added to the design as 'ready-made' page borders to use, this method is used by many
other systems. If importing from another system these page borders will be converted to the Pulsonix
Doc Symbol library.

Adding a Drawing Profile File

Once created, Drawing Profile files can be added to the design like most other items. These can be
added at any time during the design process but it does make sense to add them early on to give you a
guide to the size of the page and the area you have to work in. Adding Drawing Profile files while
using the New option is the most efficient way of doing this, but they can also be added later by using
the following procedure.

» To add a Profile File

1. On the Setup menu, select Load Drawing Profile.

# 7 Load Profile m} X
| 0K |
[None] Cancel
C:AUsershPublich DocumentsiPulsonixtProfiles

A-Landscape
A2-Landscape
A3-Landscape

B-Landscape
C-Landscape
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2. From the list, select a Profile file from the list. This file should be one that suites your eventual
printing or plotting output requirements. The list of Profile files available is taken from the
path(s) defined in the Folders option.

3. Click OK to add the drawing profile file to the design.

4. The profile will be added to the design but remains selected for repositioning. Click in free space
to deselect it. If you wish to move it, select the outline and drag to the new location.

5. If a drawing profile already exists in the design, it will be replaced with the new one selected.

Resolving Styles during Insert Profile

When saving Drawing Profile Files, the contents of the file can contain Styles not defined in the
Technology you choose for the Schematics, it could also be that the Styles in the Drawing Profile file
and the Technology file match in name but not in definition within it.

When a Profile is loaded, any Styles used in the file will be used if they already exist providing the
name and the contents match. If they don't match, a new style is added to the Technology dialog.
Most important, is that the Style contents are maintained, the thickness and sizes etc.

When creating the Drawing Profile file, you should attempt to use the Technology file that will be
intended for use with the Schematic designs.

Adding Documentation Symbols

Documentation Symbols can be used to define Page Borders. This is covered in the chapter headed
Adding Documentation Symbols.

Creating Page Borders interactively

Page borders can be created interactively using the options provided within Pulsonix. Please refer to
the chapter headed Adding Shapes for more details.

Using the Component Bin

This section details how the Component Bin is used in the Schematic design editor. An overview on
how the Component Bin works generally can be found in the previous Chapter, Using Pulsonix.

The Component Bin in Schematics is used mainly as an off-page Bin for unused components and
connector pins. You would use it to hold components or Connector pins that are unplaced but that you
know you will need later on, or unused gates that form part of multi-gated component already used in
the design. When multi-gated components are deleted, the gates are put in the Bin until all of that
component’s gates have been deleted from the design.

Component Bin X
) 5 PLL1 5 6
D B (o S
.C
Rl-a 2 +50BX-107 £20

46@BX-102 682 pa 3

@ P &4 |[-F iz e

Gated-R
Rl_b H 5 CUI’]HEC[DIS.

~PL1[4]-D3F
4£28X-102 680 s
Pin?

Pir &
Pirn 3
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Schematic components can be added directly to the Component Bin during the Insert Component
operation as shown earlier in this Chapter. However, if you have components in the design that you
wish to move into the Bin temporarily while editing another area of the circuit you should be aware
that if connected at the time, the connections will be lost. Unlike the PCB editor that removes tracks
but retains the connectivity, the Schematic editor loses the connection. If you move a connected
Schematic Component into the Bin by mistake, use the Undo option to retrieve it.

Components, gates or Connectors placed in the Component Bin will not be transferred to the PCB
design during Translate To PCB unless they form part of an existing multi-gated Component already
used in the design. Any completely unused components etc. in the Bin will be ignored.

Adding Components

Once the Design Settings have been set and the Drawing Profile (Page Border) inserted, the
Schematic editor is ready for the design to be created.

One of the first processes to attempt is the insertion of Symbols into the Schematic design; Pulsonix
provides the Insert Component function for this purpose.

Part and Symbol contents are created and saved into corresponding libraries. The Part entry contains a
Part name, a Footprint (optional if translate to PCB isn’t required) and a corresponding Schematic
Symbol or multiple symbols if the Part represents a multi-gated Component.

Note: In Schematics, an instance of a Part used in the design is called a Component.

When using multi-gated components, in the Design Settings, Naming dialog, you can define whether
the Gate Name is displayed or not by selecting the check box. This displays gates like this: Ul-a, Ul-
b etc. The Gate Separator character can also be defined depending on how you want it to look, Ul-a,
U2,a, U3/a etc.

Force To Upper Case
Component Names
[] Gate Names

[ Net Names

[ Part Names

[ Pin Names

[ Test Point Names

Default Net Names
Mame Stem:

MNumber Width: D

Local Net Names
Defautt to local names
MNames Unique Across Design

Local Name Prefix:
Owner-Met Separator; !
Owner Before Net Name

MNet Pages Attribute

o ]
—

Separator:

Newline After: EI

71 Shrw Ciimant Pane

MName Options
Case Sensitive Pin Names
[ Numeric Gate Names

Name Ranges

Range Start: EI
Range End: El

Range Separator: l:l

ltem Separator: I:I

Example: 1U1,U[3-6]

Fin Names

Component to Fin
Name Separator:

[ ]

Component Mames
Display Gate Name

Gate Separator: l:l

Display Connector Pin Name
Connecteor Pin
Separator: l:l

Part Names

The creation of Parts is covered later on in the manual in the Chapter on Library Management.



124 Chapter 5 — Schematic Capture Editor

Using the Insert Component dialog

Using Insert Component will allow you to select the required Part from the appropriate library or
libraries.

B Insert Component *

Lok In: |[AII Libraries] v dd
‘which Parts:

C |

M atched: 50503 of 69125 [ Inchude Comnectars

Part: C {Generic} - Flirz: Find...

Desc: |Generic Capacitor | Family:|Generic:.-"EAF'

Eootprint:|C - |

1 =

[ Preview Schematic & PCE (] Atributes  [] Vault

Use Look In to choose the libraries you are going to search for the required Part. Normally [All
Libraries] will be used to search all libraries in the Library folder, otherwise, select the library name
or use [Current Design] to search components in the design. All other libraries available in the drop
down list will be shown using their own name.

Which Parts enables you to filter the search list to find specific Parts. You will notice that with no
filter information or * (any), the Matched: numbers may be uneven, e.g. 1654 of 2952, this means
that there are some Parts in the libraries that are PCB only Parts and as such, unavailable for
Schematics. The Filter box can take any name and wildcard characters.

Wildcards can be used to make the filter more efficient. (Wildcards are special characters that are
used to match any character rather than being specific, for example * and ? ). For example, 74LS*
More information about using Wildcards can be found in the on-line help.

The Pins box is used to limit the matching parts to those with a known number of pins (blank means
any pin count).

Once a Part or range of Parts matching the Filter selection have been found, the first Part available
will be shown in the Part list. This will display the full Part name (4608X-102 680) and the Library
from where it came, shown in braces, e.g. {Resistor}.

From the Part library entry, the available alternative Footprint entries will be loaded into the Part
drop down list, e.g. SIPS. These may be surface mounted alternatives or different packages available
for the Part. Choose the required Part and Footprint.

The Name box shows the default name stem for this Part (taken from the Parts library default
Component Name Stem entry) and the next available number in the sequence. Both the name stem
and the number can be edited if required.

Type in the name required of the Component. The default name presented will be constructed from
the Name stem taken from the Part in the library, e.g. R and a number to form a unique name as yet
unused in the design, change this if required.

The Gates entry is only shown if the chosen part has multiple gates and you are not adding to the
Component Bin (only whole components may be added to the bin).
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The default gate identifier is the next free gate of this type that is not yet used in the design. For
example, if Ul-a and Ul-b are already placed on a sheet in the design, then Ul-c will be the default
name. The list box will contain the names of unused gates on the Component using the typed name.

The Component Bin check box can be selected if you wish to add the Component(s) to the
Component Bin. These components can then be dragged from the Bin into the design at a later stage.
The Number Of Copies box allows you to add multiple parts to the Bin in one operation. Please refer
to the section below on Using Component Bin for more information.

The Preview check box opens the preview window allowing you to view the Component before it is
inserted into the design, this gives you chance to visually inspect it to ensure that it is the current one.
Checking the Schematic & PCB box will also allow you to preview both design views of component
selected. The Attributes button will preview Attributes associated with that component.

The Vault button will display information about the Part if it has come from the Vault (the Vault
must be installed and active for this button to be displayed).

e L

1=

Prewview Schematic & PCE [Jatributes [ vaul

TuF

200 thou 100.00 thou

Once you have the Part you require (shown in the Preview window) and its Footprint and Name are
correct, you can add it to the design using the Add button.

If you are not adding to the Component Bin, the Add button will dismiss the dialog from view and
will allow you to interactively add as many Parts of the type selected as you like to the design. If you
require a different Part you should cancel this process by pressing the <Esc> key on the keyboard.
This will immediately return you to the Insert Component dialog from where you can make further
Part selections. If you wish to cancel Insert Component completely, having finished this process,
use the Cancel button from the Add Component dialog.

Adding Multiple Components in Arrays

After selecting the Insert Component option, if you then right mouse click while the Component is
dynamic, you can select the Insert Multiple Items option from the context menu.

From this you are presented with the Insert Multiple Components dialog:
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Insert Multiple Components x
Step Offzet
» [7.620 | v [2540 | @®Distance O Grid Steps

Mumber of [tems
Es E - Y E =

Insert Order
(® Insert Bows () Insert Columns [ Reverse Order
[ Switch Direction at end of Fow/Column

Stagger Alternate Row/Column

Stagger Pitch: | 0.000 ® Digtance () Grid Steps
Itern Orientation

Angle: [ Mirrared
Conce

The Step Offset defines the distance each Component is offset from the previous one. There are
separate values for X and Y and they may be negative to step in the reverse direction.

The Number of Items defines the number of items in the X & Y directions. These numbers include
the original as the first item (so they start from 1).

Use Insert Order to define the order that the items are added. First select Insert Rows or Insert
Columns to specify the items are added in rows or columns, and check the Switch Direction box to
specify that the next row is started above the end of the previous row, or leave unchecked for each
row to be added in the same direction.

Press OK to add the multiple items. They will all be dynamically displayed on the cursor for you to
click in the required position. Use Insert Multiple Items again to alter the item counts or gaps
between them whilst placing the items. Set the counts to 1 to go back to adding a single item.

Interactively positioning a Component

Whilst using the mouse to add the Component or Gate, you can use the context menu to change its
angle and to mirror it, for example, or to change the size of the grid steps that the Component is being
moved by. This is explained in detail in the Chapter General Utilities under Moving Items.

Use the Next In Sequence option from the context menu to increment the Component name and gate
identifier to the next free Component or gate not used in the design. Click to position the Component
or gate at the required position.

siERIserEMURDRTRS Once in the design, components can be repositioned using the

Auto Weld Now Move option or by selecting and dragging them.
Show Track Length Limits

| Next In Sequence ., Shift+I |
by

[«] onine bre \

Z‘ Display Clearance
Ll Mnda »
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Using Decoupling Capacitors

Decoupling or bypass capacitors are frequently used in the design process. There are quite often equal
amounts of decoupling capacitors to integrated circuits, on large digital designs this can mean a lot of
work to add lots of these devices. Pulsonix has a short form notation for using one device to represent
many devices by using a simple naming convention.

When naming a single capacitor Component you can use the notation name[1-3] where 1-3 represents
the number range, e.g. C[1-3]. After Translate To PCB, this will become 3 individual capacitors of
the same Part type and will be named C1, C2 and C3.

The Name Range characters used are set up in the Design Settings dialog under Naming.

7 Names
Mame Ranges

Range Start: D

it Net Names Range End: D

e Stem: Range Separator: l:l
nber Width: D ltem Separator: l:l

Net Names Example: U1,U[3-6]

:st Point Names

The Range Start and Range End are the characters used to enclose the range numbers e.g. C[1-3].
The Range Separator is used to 'split' the number range, e.g. C[1-3] and the Item Separator is used
when there is more than one Component name or if the sequence is not sequential, e.g. C1, C[1-3]

| ‘ 1 c2 =
| - .-
CI1-31

Translate To PCB

Note: this naming methodology applies to other components as well, not just capacitors.

P To add decoupling capacitors
1. From the Insert menu, select Insert Component.
2. Click on the Name box and type the name range required, for example C[1-4]
3. The dialog will now recognise the name range and display the message Range of X components.

Part: C - Pins: Find...

Desc: |Generic Capacitor | Family:|Generic.fD'3«F' |

Eootprint:|C > |

Marne:  |C[1-4] | Fange of 4 components

5 =

P Alternative method for naming decoupling capacitors
1. Insert a capacitor Component into the design from the Insert Component dialog.

2. Click on the Component Name e.g. C1, right click and select Properties, Component page.
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3. Edit the Component Name to create the name range required, e.g. C[1-3]. This is verified with
the message Range of X components as shown above. If the name range has been defined
incorrectly, when you attempt to exit the dialog, it will tell you to correct the error first.

4. Click OK to accept the new name.

5. If the name range contains a name that has already been used, then a warning dialog will be
displayed when you attempt to exit and you will need to correct it before you can apply the range.

Note: As an alternative to using named ranges for decoupling capacitors, you can also use the Pin
Network option. Please refer to the Online Help for further information.

Adding Connectors

Connectors in Pulsonix are Parts that have a special ‘connector’ flagged set during the Part creation.
As a Schematic representation, they are usually pins on the designs that can be individually placed,
but which refer to one PCB Component. In Pulsonix you can create connector Parts like this, or as
one symbol containing many pins, again referencing one PCB footprint. Both methods are detailed
below:

In Pulsonix, the Connector can be represented in one of two ways:

® Asindividual connector pins that can be placed anywhere on the Schematic design, but that refer
to the same footprint using up to the maximum number of connector pins for that device e.g. PL1-
1, PL1-2 etc.

® The single Connector pin has special properties: it can be selected from the Insert Connector
dialog and placed anywhere on the Schematic. This means one pin could be used as an input pin
on one side of the design, and another could be used on the right side of the design as an output

pin.
The second method of using connectors:

® Like a ‘normal’ Component with single or multiple gates to show the Schematic representation,
and a PCB footprint. This is less flexible in the Schematic design as the Schematic pins cannot be
placed anywhere (unless you define multiple single pin gates). If you want this, create a proper
Connector Part.

Both have their uses. For this discussion the Connector Pins will be detailed. If you wish to use a

normal Component as a Connector you should follow the chapter for Creating Parts later in the

manual.

From the Design Settings dialog and Naming, use the Display Connector Pin Name check box is
used to decide if you want the pin number to be displayed as part of the Component Name.

Gate Separator: |- |

I:I Display Connector Fin Name
Connector Pi
dtor: l:l Sgggemtoorl:- } l:l
& Ater ,D_|
When naming Connector pins, Pulsonix uses the Connector Pin Separator character defined in the
Options and Designs dialog to distinguish between the Connector Name and the pin in the
sequence, e.g. PL1-1, PL1-2 etc.

iges Attribute

» To add Connector pins

1. Click the Insert menu, click the Connector Pin option.

2. Select the Parts library you wish to use using the Look In:.drop down list.
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3. A list of Connector Part Names will appear in the dialog. Only parts that were added to the
library, as connectors will be shown. Use the Filter to reduce this list to the parts that you are
interested in.

B Insert Connecter Pin X

Look In: | [ Libraries] | ~ | Add
which Parts:

Cancel
B[ Morms[ | [l

Matched: 15406 of 69125

Part: 28641006RF2 {MorComp} - Flirz: Find...
Desc: |E0nnect0r 2mm Receptacle Yertical 2 Row SMT 10 Pos | Famnily: |2884

Eootprint CON10_2<5_UU_2864 -]

Lo %

Symbal, [COMN Pin: [1 2 #ddta Comp Bin [

1 =

Preview Gchematic & PCE [ Attributes  [] Vault

J1

O—=

J1.1
28641006RP2

v

200 thou 8,000 mm

4. Choose which connector part you wish to add from the list of Parts: using the drop down list.
5. Change the pin number you want to add (if the default provided is not suitable) using Pin:

6. Choose to add the connector (or a number of copies of it) directly to the Component Bin, or to
add a connector pin interactively into the design using the Add button.

7. If adding to the Component Bin, you are returned immediately to the dialog, else follow these
next steps.

8. Using the mouse, move the connector pin to the desired position and click to place it into the
design.

9. Continue to place connector pins using the same Part. Each pin is auto incremented to the next
free pin number in the design, or, if all pins of the Component have been added, the Component's
name is auto incremented to the next free name in the design.

10. Press the <Esc> key, to return to the add connector pin dialog.
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You can also insert connectors using the normal Insert component dialog. Check the Include
Connectors switch to browse your connector parts as well.

B Insert Component X

Look In: | [&ll Libraries] | - | Add

Wwhich Parts: e
Filter: |* Ma. Pins: I:I Apply
Matched: B5309 of £9125 Include Connectars

Part: C {Generic} - Finz: |2 Find...

Reloading Parts

Once components have been used into the design, you may need to change the Symbol or the Part
definition in the library and then reload it into the design.

You should select the Component you wish to reload. From the context menu you are provided with
options to Reload From Library (once the Part and/or Symbol has been edited), Edit Part In
Library and Edit Symbol In Library to edit the actual Part or Symbol items.

Change Testpoint. ..

Reload From Library...
Replace Part...

Edit. Part In Library...
:;Eﬁ Edit: Symbol In Library. ..
P Mave ta EBin

B £8 oo

Disconnect Con End

Add Page Link.

If you select one of the two Edit options, you will be automatically placed into the Part or Symbol
editor with that particular Part or Symbol loaded from its library ready for editing and saving. You
should make your changes and save the updated library item. This is detailed later on in the Chapter
on Library Management.

Once the Part and/or Symbol item has been changed, you need to then reload it back into the design,
effectively 'swapping' out the existing item for the new one.

To do this, use the Reload From Library option. With the Component selected in the design, you
can use the option from the context menu, or the Reload From Library options on the Utilities
menu.

When Reload is used, all other components in your design using the changed Part or Symbol will also
be reloaded. You cannot have two different versions of the same Part or Symbol in a design.
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The Reload From Library option reveals a control dialog that enables you to selectively choose how
the Part will be reloaded. You can choose how items are loaded and which facets within them are
retained aor overwritten.

Reload From Library X

Only reload if different version
in the library

Reload control

[ Keep attribute styles [ Keep bond pad pasition/style overides
[ Keep attribute pasitions [ Keep pad pasition/style overides
[ Keep Jocal attibute values [ Do not reload footprint

[ Replace footprint with default
[ Replace pin netwarks
[ Re-apply name stem from part [ Keep lacal plane connect

[ Match position of the first pad

Cancel

Pressing OK takes you to the summary page for confirmation and also the ability to view a report of
the potential reloads before they are performed.

Reload From Library - Summary X

Reloading single part or symbal.

Selected for reload:

Part

Azzociated Parts
Symbol

Doc Symbolz

= =

Selected items to be reloaded:

Partz
Azzociated Parts
Symbol

Doc Symbolz

o—oo

Additional symbols to be reloaded:

(=]

Svmbols

Selected items NOT to be reloaded:
[Same werzion ag library)

Part

Azzociated Parts
Sumbalz

Doc Symbols

[=F=N=Trm

[ Include Component M ames In Repart

Wiew Repaort Perform Reload Cancel

Adding Connections to the Design

Connections are added to the Schematic design to make electrical connectivity between Component,
Connector and Documentation Symbol pins. You can add connections to other connections forming
junctions. You can also add connections to the design that do not connect to any electrical pins, these
are 'dangling' connections and are useful during the design process but should be resolved before the
translation to PCB process.
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As already demonstrated in the Technology section above, connections hold properties of the Net
name and Style. When translated to PCB, all connections using the same net name are joined together
to create the netlist from where the PCB is then created.

Information about the connection being added is shown on the Status bar.

Setting up Connection Options

Before any connections are added to the design you should setup the default values used and any
predefined Net Names or Net Classes to be used (setting up Net Names and Net Classes has already
been discussed in the previous section).

Default Connection and Net values are set up in the Design Settings dialog under Defaults.

Connection sets up the Style of the connection. This will provide the displayed and plotted width
when used in the design.

Net sets up the default Net Class that new connections will use during insertion. The Name Style will
be the default text style used if the Net Name is displayed in the design.
Inserting Connections

Once a connection has been started, each single click will add a corner until the destination has been
reached. The finish marker F will be displayed and a single click on that pin or electrical ‘landing
site’ will finish it.

Connections can be added to the design in a number of ways:

®  Using the Insert Connection option from the Insert menu or from the Schematic Toolbar, click on
the pin to start adding a connection, or;
® Double-clicking on a Component pin to start a new connection, or;

® 'Dragging' off an unconnected Component pin to start a new.

Tip: If the 'drag off pin' mode is enabled you may find it difficult to move components if you select too
close to a pin. To avoid this, select and keep pressed the Shift key, and the Component will be
selected and moved.

If you intend adding connections by 'dragging' off pins you must select the check box this first
through the Options, Select dialog. If unchecked, a drag moves the Symbol as normal.

Select Frame Select
Select Tight Groups [ 5elect f Completely Framed
Minimum Pick Tolerance [ Att Drag Does Frame Select
Enable Nudge [ Select Emor Markers
[ Do Met Pick Locked tems [ Select Construction Lines

Select Whole Components
Exceptions: [»] Select Component Attributes
Select Component Pads
Select From Popup List

Drag Double Click
Drag Along Shape Selects Path Between 2 Points [ Suppress Froperties On Double Click

| Drag Unconnected Pin Starts New Connectionl Double Click an Attribute to Edit Value
[ Drag From Pin Uses Sketch Mode [ Double Click On Fin Uses Sketch Mode

[~ Control Drag Does Duplicate
[ Control Drag Sig Ref To Copy Net Name
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You can use double-click or drag method to add connections but these are only 'one off and only add
a single connection. Once the connection is completed, you are automatically returned back into
Select Mode. The Insert Connection mode allows you to continue 'stitching' in multiple connections
until you exit this mode.

At any point you can change the characteristics of the connection. You can change its Style, the Net
Name and the Net Class Name.You can do this while adding the connection or after the connection
has been added by editing its Properties. These options are available on the context menu or as
shortcut keys as pre-defined.

+H2W

Cancel Insert Connection
Finish Here

Type Coordinate... =

4% Type Offset... Shift+=
Change Style 5
Change Met Fz

Changing the connection Style
The Style of the connection can be changed from that defined in the Design Settings, Defaults

dialog.
P To change a connection Style
1.  While adding the connection right click and select Style or press the <S> key on the keyboard.

Connection Style had

01d Style: |Conn 8 |

Mew Stule: |Eonn 10 v |

width: | 10.000 [ Apply Ta &l Segments

Corcel

2. Select the New Style name from the drop down list, or edit the new Width required and type the
new style name in.

If the Style name is left blank, you will be prompted with a default name (style! or the next available
name in the sequence) that will be added to the technology if OK is pressed.

The Apply To All Segments check box should be used if you wish the style change to be applied to
all segments on that connection.
Changing the net name during Insert Connection

While inserting a connection you may wish to change the Net Name, this can be done using the
Change Net Name option from the context menu or by clicking the <F2> key on the keyboard.
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Change Met X

Choose From All Metz In Design:

Met ﬂame:| CLE v |
Local Met
Met Class: |<N0ne> v|

[ Shaw Met Name

From the dialog displayed you can change the Net Name by typing in a new name, or by selecting an
existing name from the drop down list. The net names list will contain both Local and non-local
(Global) net names.

If you have typed in a new net name, the Local Net check box is available. Check this to force the net
name to only be used in the current scope. The scope is either all pages in the current block instance
or all pages in the design top level (i.e. all pages not in a block instance). Alternatively, make it a non-
local net, a Global net, (i.e. available to all pages of the design) by unchecking the Local Net box.
This might be a net name such as VCC or GND. If the selected net contains items connected to closed
busses (i.e. busses that have a closed set of allowed net names, these are explained later on) then the
list is limited to just the names allowed.

You can also change the Net Class by selecting a name from the drop down list provided it has been
defined in your Technology. A Net Class won’t be required if you’re using Net Styles.

Tip: While adding connections, you can press <F2>, followed by the signal name and <Enter>. This
will display the Change Net Names dialog, enter the signal name that you type and OK the dialog.

Net Names that are unused in the design but that may have been used previously or typed in
incorrectly can only be removed in the Net Names page of the Technology dialog. By pressing the
Delete button on a selected Net Name in this dialog, you can remove it all together. By doing this,
you will restore the Net Name to a system default net name using the next in the sequence.

The Show Net Name check box can be selected if you wish to display the net name on the net. You
can also set this status afterwards using the context menu of a selected net.

Start & ending on different design items

During the insertion of a connection, you can end the connection on a new, single pin design item, as
well as any existing electrical pin. This feature can also be used to start a connection on but you must
be in Insert Connection mode.

During Insert Connection, before starting the connection you can right click to use the Start
Connection On option from the context menu. After starting the connection you can right click to use
the End Connection On option on the context menu. You will be presented with the following menu
and sub-menu:
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LNange suyic 3
Change Met F2
Tt Mark Net H
| End Connection On >| Connector Pin
Signal Reference
Online ERC | 2
Editing Options » Netiabel
Testpoint
Segment Mode ] estpoin
Bi h Point
Change Segments » ranch Fain
. Page Link
Show Connection to MNet
Mone
Change Grid ]

Connector Pin is used to add a PCB Connector pin. This displays the Insert Connector Pin dialog
to choose the connector Part and which pin number to use.

Signal Reference is used to add a reference to a Net Name. This displays the Insert Signal Ref
dialog to choose which signal reference Symbol to add. Use this to add symbols to indicate the use of
the net, for example, a ground symbol, a cross-page reference, or a sheet label. This displays the
Insert Signal Ref dialog to choose which Net Label Symbol to add.

Net Label is used for attaching to a net to highlight a particular net.

Testpoint is used to add a Testpoint to the design. This displays the Insert Doc Symbol dialog to
choose a Documentation Symbol to use for the testpoint (unless a testpoint has already been added to
the design that it can copy). A unique testpoint name will be allocated by the system and attached to
the Documentation Symbol's pin. Use this to indicate that a testpoint needs to be added to this net
when Translate To PCB is performed.

Branch Point - if you have the Interactive High Speed option, you will also be able to end a
connection on a Branch Point. These are used in conjunction with Signal Paths and/or Sub Nets to
create specific branching points of a net so that additional parameters can be added.

Page Link is used to add an off page connector symbol. This is only available if you have changed
the Net to be a global net, i.e. available to other pages of the design. This first displays the Insert Doc
Symbol dialog to choose the Documentation Symbol to use (unless this net already has a page link
symbol it can copy). Then it displays the Add Page Link dialog to choose the page to link to.

None is used when no new item to start/end the connection from is required. This allows you to pick
an item from where to start/end the connection.

Once you have chosen an item to start/or end on, it is displayed at the end of the cursor for you to
place. Use a single click to place a start item, or a double click to place an end item.

Adding ‘Dangling’ Connections

A dangling connection in Pulsonix is a connection that starts or finishes in ‘free space’. This is
perfectly legal and can be useful if you start a connection and cannot decide its destination right now.
You can leave it dangling as unconnected at one end until a later stage. Once a connection is
dangling, to continue it, double-click on its end (to Edit it), or if using the Insert Connection option,
select its end and continue with the connection path.

1
LWP
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Starting Connections on other electrical points

You can start a connection on other electrical items such as junction points and other connections.
However, to do this you cannot use the Drag method, and the Double-click method only works in
some instances.

To start a connection on a junction point (the dot that indicates two or more connections connected to
each other), you may use the Insert Connection mode or double-click on the junction. From this, a
new connection will be started.

P

PLL1
LwF

If you wish to start a connection from a corner of an existing connection you should use the Insert
Connection option or double-click on the corner. The drag method will only move the corner. By
starting on a corner of a connection a junction point will automatically be inserted.

o
~
=
-

WF

N

If you wish to start mid-point on an existing connection you can only use the Insert Connection
method. Attempting to use double-click will edit the connection. Using the Drag method will move
the connection segment.

7

FLL1
1wl

by

By starting on the middle of a connection a junction point will automatically be inserted.

Changing Segment Modes

While editing connections you can change the 'mode’ of segment to enable different 'styles’ of editing
to take place. For example you can use the Orthogonal mode that provides you with two dynamic
segments on the connection being edited, or Angle that gives you a mitred corner when you change
directions.
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Change Met F2
797 Mark Net H

Disconnect Con End

Online ERC

Editing Options 3
| Segment Mode >| Free Angled
Change Segments 3 . Orthogonal
Show Connection to MNet COrthogonal [Mitre)
Orth 1 [Fillet]
Change Grid 3 ogonal [Fillet)

45 Angled
45 Angled (Fillet)
Curved

Restricted Movement

Free enables the connection to be added at any angle, and Curved works the same as Mitre except
that the corner added is curved.

In addition to the Segment modes, you also have the Editing Options. These provide you with
additional options for use during Insert Connection.

Cancel Edit Connection
Finish Here

5 Type Coordinate... =

2 Type Offset... Shift+=
Change Style 5
Change Met F2

797 Mark Met H

Disconnect Con End

Online ERC

Editing Options >| Auto Corner
Segment Mode 3 . Apply Segment Mode to Tail
Change Segments 3

Show Connection to Net

Change Grid 3

Auto Corner will automatically insert corners when any change of direction is made during Insert
Connection. This will use 90 degree corners if the Segment Mode is set to Orthogonal, or Mitred
corners if Mitre is set.

If Auto Mitre is set, when a change of direction is made, a Mitred corner will be added regardless of
what is set in the Segment Mode. The Mitre will be a fixed size using the setting in the Options, Edit
Connection dialog.

For both the Segment Mode and the Editing Options, you can either change these while editing or
inserting a connection, or before the session using the Options and Edit Connection dialog.
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This dialog is also used to set other options related to inserting and editing Connections.

Segment Mode: |Orthogonal ~ | [ Apply Seq Mode ta Tai
Interactive Mitre/Fillet [ Auto Comer
Size: []4ny Angle 100.0

Show Can Finish’ and ‘Has Loop’ Markers Remove Loops
Add To Bus Shows Net Name Auto Share Connections
Always Mark Net being edited
Clear Mark when edit complete
[ Show Connection to Nearest Node

Sketch Connection

Use Point To Point Mode [ Mitre: Result
[ Use Grid When Sketching [lgnore Text

Starting a Connection on a Bus

To start a connection from a Bus (Busses are explained in more detail later on in this chapter on
Using Open & Closed Busses) you must use the Insert Connection method. Click on the bus
you wish to start from and you will be presented with a dialog from where to choose the net

segment
name.

When using Insert Connection and adding to a bus, there are rules covering Open and Closed
busses that are adhered to. There are covered in detail in the chapter on Using Open & Closed Busses

later on.

B Choose Bus Net

Ul-a

Mame:
HCRTIG4AL

1

18 AT BN
2 muescLee
HW——{IN1-CLK1
et dnpom iz
s iz emiee
el Jras Tor

){? 10./_TH3
Y\ o | ok |
Er3 maghgthaiy ak. Cancel

N\
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Showing Junctions over Pins

If two connections are attached to a Component pin, a junction is only drawn if the Draw Implied
Junctions On Pins check box is checked in the Options dialog and Display.

The example below shows how the implied' terminal would look in the design:

il
A
3 vjok
B Ul-c
. 74,500
e, X
E
Ul-d
T 74500

This can be overridden on individual pins if required by selecting the pin and using Properties:

B Properties: Pin: UT.2 Pin m} X

Pin Pin Attrbutes  Componert  Mets on Pins  Comp Attributes  Net Net Attributes

[ Name: [ Logic Name: | |

Physical Details

Overide [J Allow Interactive Reposition

[0  Postion: |10575.0 Allow Implied Junctions
nn

M L

Changing the connection grid

While adding a connection, use the Change Grid option to ensure connections are placed on
predefined grid points as required. Connections will snap to the Working Grid or no grid if the Use
No Grid option is selected.

Lnange style 5
Change MNet F2
797 Mark Net H
End Connection On »
Online ERC
Editing Options 3
Segment Mode ]
Change Segments 3
Show Connection to Met
| Change Grid >| Use No Grid Shift=MN
Use Working Grid Shift=wW
. Use < Component> Grid
Display Grids G
Bl Grid step...
HE Grids... Alt=G

Inserting Components to split a connection

Once a connection has been added to the design, it is possible to move or insert a Component over the
connection to split the net. This is useful to add a capacitor or resistor into a section of circuit that
already exists.
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This situation can only occur with 2 pin components and where the connection is orthogonal
horizontally or vertically, the process is automatically exercised once Pulsonix detects this situation.

First the Component is selected or inserted and moved over the connection so that the Component
pins are in-line with the connection.

b

&

Once the Component has been moved over the connection, the weld markers are displayed (small
round blobs):

A warning dialog is displayed to show that the net is split into two, with one retaining the original net
name (if assigned):
Split Met "S7" X
The net haz been split inta bwo netz and the highlighted net will

take the new name supplied below. The unhighlighted net will
remain as the original net.

(®) Mew Met Name: |CLE

Remove From Met

Rename Other Half

The Component is then dropped in place with the original connection split.

1

Disconnecting Terminals

If you wish to disconnect a connection and put it on another terminal use the Disconnect Con End
option. This option is only available when editing a connection and can be found on the context
menu.
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Cz
|

Cl1
AI | Cancel Edit Connection
1u

Finish Here

- X

Tvpe Coordinate. .. =

4% Type Offset... Shift+=

Change Style 3

Change Met Fz
SEY Mark et H

| Disconnect Con End |

Online ERC

The end that is dynamic for editing will be disconnected when edited. This direction can be changed
using the Reverse Edit Direction option available on the context menu under the Change
Segments> option.

Add Connection Modes

Sketch Connection Mode

The Sketch connection path mode is available in the Schematic design editor. This allows you to
interactively make a connection between two points using a basic ‘sketching’ mode, or by using a
point-to-point mode. This is an alternative method to dragging off terminals or using Add Connection
mode.

Using the Sketch Connection mode from the Insert menu, you can add connections to the design.
Once in this mode, this is verified by the display of a modal cursor, a cursor which shows a mode.

+a4alts +aVolts

10 ‘MT 10 MT

12 WP wvee |a 12 W ovee |a
D Q 1 D a
1 5 11 5
CK N K NG
Ne oo [T QL "N oo [
139 7>L Utb 139 7>L Uth
GROUND GROUMD
L  — — ——
This picture shows the This picture shows the final result
approximate path that you after completion and tidy-up.

‘sketch’ in. The modal cursor

is also shown.
Immediately after using sketch mode, the tidy routine will snap the connection onto the grid and
remove all the rough edges for you. Once added, the connection path can be tidied up using normal
connection editing options.
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Context menu options

While using the sketch mode, you can select options from the context menu.

Cancel Sketch Connection

[ Exit This Mode

Finish Here

Change Style S
Change Met F2
Mark Met H

Sketch On Grid

[l

Sketch Point To Point

Show Connection to MNet

[«]

Show Finish Markers

Change Grid 3

Sketch on Grid should be used if you require the connection to be on grid, this mode is
recommended.

On the context menu, you can select Sketch Point To Point mode. This allows you to point and click
to add a connection path. After the mouse click, the path will be tidied back to the last click, this gives
you a ‘guided’ routing path which is automatically tidied as it goes along. This may be a preferred
mode of operation to the normal sketch mode.

Sketch modes can be pre-selected from the Options dialog and Edit Connection page.

Connection Options

The Options dialog and Select page allows you to use drag or double click to add a connection from
a pin on a net with no connection. This is particularly useful for reverse engineered designs. The
default is drag to sketch and double click to use normal add connection. The default sketch mode is
point to point.

Select Frame Select
Select Tight Groups [ 5elect f Completely Framed
Minimum Pick Tolerance [ Att Drag Does Frame Select
Enable Nudge [ Select Emor Markers
[ Do Met Pick Locked tems [ Select Construction Lines

Select Whole Components
Exceptions: [»] Select Component Attributes
Select Component Pads
Select From Popup List

Drag Double Click
Drag Along Shape Selects Path Between 2 Points [ Suppress Froperties On Double Click
Drag Unconnected Pin Starts New Connection Double Click an Attribute to Edit Value
[ Drag From Pin Uses Sketch Mode [ Double Click On Fin Uses Sketch Mode

[~ Control Drag Does Duplicate
[ Control Drag Sig Ref To Copy Net Name
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Naming and Renaming Nets

By default, any connection added to the design will contain a default net name. This name can be
changed during the addition of the connection or renamed afterwards.

Using default Net Name properties

Nets have a number of default properties - Net Name, Net Class and a local state. New Nets will
automatically be assigned a default Net Class and made global when added to the design (a global net
can be used throughout the design, for example +5V or GND). Nets that have previously been named
in the Technology file will already have a Net Class assigned to them, and be marked local or global
(local nets are considered to be page specific, for example, on a multi-sheet hierarchical design).

Naming Nets & Renaming Nets

At the addition of connections or the editing of connections you can name them using your own name
as an alternative to a system default net name. You can press the <F2> shortcut key this will display
the Change Net Name dialog. This option is also available on the context menu.

Change Met =

Choose From Nets On Closed Bus:
Netﬂame:|.~’-‘«DDD v|

Local Met

Met Class: | v|

Local and Global Nets

When designing your Schematic, by default, net names are considered global. That is, even when
using multiple pages, everywhere a net name is used, it refers to the same net. Items using the same
net name are connected to the same net.

It is possible to define a net name as local, which means that only items on the same page can be
connected to that net. The Local Net Names section of the Design Settings tab and Naming dialog
controls the creation of these local nets, and how their names are generated. This ensures they are
unique when producing netlists, or passed forward to PCB. These parameters can only be changed for
a new design that doesn’t already contain net names or for the Schematic Technology file.

Force To Upper Case Mame Options

4] Component Names [ Case Sensitive Pin Names

[ Gate Names [ Mumeric Gate Mames

] Net Names Fill-ln Gaps In Number Ranges
] Part Names

[ Pin Names

[] Test Point Mames

Mame Ranges
Defautt Met Names Range Start: D

Mame Stem: Range End: D
Number Width: D Range Separatar: l:l

Local Net Names ltem Separator: I:‘
[ Default to local names Example: U1,U[3-6]

Names Unii
MNames Unique Pin Mames

Local Name Prefic: ! Componentto Fin = ———
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Names Unique Across Design, when checked, ensures that the local net name is only used on one
page. So if 'Pagel’ has a local net called 'Net1', 'Page2' could not have any reference to a net called
'Netl'. When this option is unchecked, it is then possible for 'Page2 ' to also have a net called 'Net1',
but it is not the same net and they are not considered connected. Of course when such a design is used
in a PCB application these two nets must have unique names. This is where the other controls on the
dialog are used. To make the net names unique, the page name is added to them. The way this is done
is configurable. You can choose to have the page name before or after the net name, and also have a
prefix and infix. In our example, if we chose a Local Name Prefix of '$$', a Page Net Separator of '-'
with the Page Before Net Name, the nets would be named '$$Page1-Netl' and '$$Page2-Net1'.

If using these options, consideration must also be taken if the design is to contain hierarchical blocks.
See the section under Hierarchy for more information.

Defining Track & Vias styles in SCM and Translated to PCB

When working with Schematic designs, there are two methods for defining the Track and Via styles
in the PCB. The method used depends on how specific you wish to be up-front.

®  You can either use a Net Class on a net to create a collective of ‘similar’ nets that can have a
Track and Via style defined, that is, passed into the PCB and use Net Types with the same effect.
Net Types can also be used in the same way.

® The second method is to be more specific and to define net or groups of nets with Track & Vias
Rules. Rules can be defined generically, such as all nets or ADD*, or very specifically, such as
CLK uses XXX rule and SDQ_* uses YYY rule. Once in the PCB (and with the Design Settings,
Synchronisation switch set), defining them in this dialog means they are directly converted in
the Schematic into Net Styles in the PCB.

Setting the switch in Design Settings, Synchronisation in the PCB Design

A option in the Design Settings option under Synchronisation allows Net Styles in PCB to be
created from the Track & Via Size Rules in the Schematic. Use the Apply Schematic Track & Via
Size Rules to Net Styles switch to enable this feature. Without this switch enabled, this feature will
not operate.

[JPCBin Safe Mode
Mllew PCB Only single pin nets

Synchronised Design Mame

Mame: |Ann0uncer

Back Annotation
Enabled Clear History

Synchronise with Schematic
[ &pply Al Rules Stricthy
Apply Spacing Rules
Apply Footprint Changes
Apply Met Class Changes
] &pply Met Calours
| ] &pply Schematic Track & Via Size Rules to Net Styles |
Apply Schematic Title & Subject
[ lgnore Attibute White Space
] Mlow Update of Schematic to match PCB
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This means, where you need to specifically define Track and/or Via Styles in the Schematic, they can
be passed through into your PCB where they will be used in Net Styles. Both the Translate To PCB
and Synchronise Designs options will use this feature once the switch is set.

If Translating to PCB to create the initial design, your PCB Technology used must already have this
switch set in order to pass across the settings. Once set, use the Synchronise Design option to update
the design with these settings.

Design Settings Synchronisation

Once the Apply Schematic Track & Via Size Rules to Net Styles switch has been checked in the
PCB Design Settings Synchronise dialog, you can then define the Track & Via styles in your
Schematic design.

Defining Track & Via Size Rules in the Schematic

From in the Schematic design, use the Technology dialog and DFM/DFT Rules — Track & Via
Size Limit dialog. These should be defined in accordance to your requirements. They can be generic
such as all Net Names in the design, or more refined such as specifically named nets such as DQS*.
Other parameters can be selected from the drop-down list as well as Layers, Sides and Within
Areas.

Ainte: | BTN E
<Differential Pair Name:= o
Match: <Net Class Name: By

On Layers | <Net Type>
<Signal Path Name:>

Sidel <Sub Net Name: w

Layer: | ~ |

Within Areas: | w |

These are the rules that will be passed into your PCB design.

Attribute: | <Net Name:> | [ Alow Tracks
Match: |GND' v| *\ Track Width
ax: | J.
Side: |cﬁny> v|
Layer: | v|
Via Diameter
Vithin Areas: | ~| Min: [35.3 | Max:[445

Translate to PCB

During Translate to PCB, with this switch set in your PCB Technology file, this setting will be
initially applied to the new design and your Schematic Track & Via Size Limit Rules will be

defined in the PCB

If the Track & Via Size Limit Rules are applied to the PCB, it will add new Track styles and a new
Pad Style to the Technology. Two new Track Styles will be created based on the Min and Max
Track width defined. The Pad style created will use the Min and Max Via Dimeter to create a pad
of the Max diameter size with a drill using the Min Diameter value.

A new Via Pad style is added to the Pad Styles dialog:
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Name: Used: Shape: Drill:
Rnd44 5h35.3 Type: |Round ~|| shape: [Round v

Named by: () Typed (®)Rule (O)Template Viicth: ’r‘ | Width: |

<user<shape><width><dength:_>«dilled-h><n

44 0.0

n

For Uze By:

[ Through Hele Pads [ Vias Inner Diameter:
[~]5uface Mourt Pads [/ Micro-vias Offfset: Offset:
[+] Through Mounting Holes Hotation:

[ Surface Mounting Holes Plated Through-

New Track styles are added to the Track Styles dialog:

Name | Width
Signal (8) 20
|:> ¥ [Signalis5) 55
|:> Y [Signai@.9) 8.8

Matching settings in the Net Styles dialog for the nets requiring them will also be created using the
new (or matched) Track and Via Styles.

Attribute; |cNet Name:> ~ | For Nets of Type:

Match: |GND' ~ | X Within Areas: | ~
Define Default Track Styles [ Define Via Defaults
For Tracks:
For \ias with Layer Span: |<Amy> v
OnSide:  [<Any> v
or [vias Not Allowed
COn Layer: | w |
[[]Define Via Pratection: Delete f not Routed Reduce Span

Default Track Style:

[ Define Default Via Style

Mame:  |Signal(5.5) ~]

] Name: |Rnd445h353 v
Width: 5.5
Altemate Track Style:
Mame: [Signal(3.5) v 445 Dl
Wih: Plated

Fatten/Meck Min Length:

Electrical Rules Checking (ERC)

ERC Modes of operation

There are two modes of checking the electrical rules; Online and batch checking. The batch check is
more comprehensive and checks all rules set. The online checking option checks a subset of the full
batch checking option and is restricted to Pin Types only.

Online ERC

Online rules can be switched on and off in two ways; through the Options dialog and Online ERC,
and by use of the context menu during Insert Connection.

The Online ERC dialog on the Option dialog allows the mode to be switched on, and then as with
Online DRC mode in PCB, allows it to be continuous or enabled On-Drop or After Edit. You can
also opt to Add an Error Marker to the design on the detection of an error.
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Options - Online ERC

Design Backups [] Online ERC

Display

Edit Connection [10n Drop

Edit Shape [ Ater Edit

File Extensions ] Add Eror Marker

Find

General
Interaction Treat All Dangling Bus Connections As Unfinished
Macros
Mowve
Multi-Screen

» [T

Resolve Net Names

Colmrt

If you check the Treat All Dangling Bus Connections As Unfinished, any dangling connections
from a bus are flagged as unfinished when running the Dangling Nets or Dangling Connections
checks in the DRC option. With this left unchecked, the check is ignored for these connections.

Electrical Rules Checking Dialog (batch checking)

As well as the Pin Type Rules there are also additional rules that can be checked when the Electrical
Rules Checking option is run.

Electrical Rules Check X
Ein Type Rules Unfinizhed Connections [ Coincident Items O Different Mets
[ Mark Warnings [ unlabelled Mets [ 5plit Mets
Busses [ Unlabelled Met Pages [T1f Mat Linked By Doc Symbol
Hierarchy [ Bridged 2-Pin Component: [ Pine Mot On A Met
Unfinizhed Nets [ Unmatched Page Links ] Met Ping 'with Mo Cannection
[1'alidate Attributes [ Comman Pins Metz Only On Ungated Ping
Select Al Deselect &l
Acceptance Rule Set Error Markers Output Source
| Generate Bepart .
Load %Iear Locked nep @ Design
frors Feport Rules
Mot Checked Selection
Save Clear &l Errors e s Beg
Cloze Cancel

Different rules can be selected for checking in this design. The online ERC option will only check Pin
Type rules, the Electrical Rules Checking dialog contains additional rules for batch checking.

Acceptance Rule Set

The electrical rule switches that are shown in this dialog can be saved into the design to form the
acceptance rule set. This is the set of rules that should be checked before the design is to be accepted
as finished. Use the Load button to change the switches in the dialog to the acceptance set in the
design, and the Save button to change the acceptance set in the design to the switches in the dialog.
The summary at the end of the ERC report says if all acceptance checks were checked or not.
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Defining the Rules

The Electrical Rules Checking (ERC) mechanism allows pin type rules to be set, then checked on
components that have been allocated these rules. The checking is carried out using an online option,
or the batch option.

The order in which this process works is:
1. Define and add the Pin Type to the pin number in the Part editor.

2. Define the Pin Type Rules in the Schematic design or its technology. This is done using the Pin
Types and Pin Type Rules dialogs.

3. Add the Component(s) to the design, these must be components that have Part definitions with
Pin Types defined.

4. Enable the Online Electrical Rules Checking (ERC) and start adding connections to the design.
Errors found during this process will be displayed, or;

5. Use the Electrical Rules Checking option from the Tools menu, this is used to check all of the
connections and components in the design.

Pin Type Rules

You must set up two items within the Technology dialog: Pin Types and Pin Type Rules. One
defines the Pin Type Name and the other defines how each of the Pin Types react with each other.

Pin Types Dialog

The Pin Type name is added to the Pin Types dialog under Technology. By default, Pulsonix is
supplied with a list of industry standard names, there are no built-in Pin Types as such but a set
predefined for you. Any of the names can be edited but care must be taken if you do this, as the
names will potentially not match Part library Pin Type entries. This list also includes any user-defined

Pin Types.
Name | Type Allow on Block Port
Output [
Input []
Bi-Directional []
Open Collector ]
Or-Tieable ]
Tri-State []
Terminator []
Y | Power Power []
¥ | Ground Ground [ ]
Open Emitter ]
Mo Connect No Connect []
Passive []
Pch Connect Pch Connect []

Use the New button to create a new Pin Type name.

Any names added can be checked once they have been added to the Pin Type Rules definitions and
provided they have been assigned to a pin on a Part.

From the Pin Type dialog you can specify if a Pin Type is power/ground/no connect and if it is
allowed on block ports.

When a Pin type is defined as Power or Ground then when the Part is brought into the design, if the
design has more than one net name assigned to any power net classes then a dialog will prompt you
for the net name for which to connect to. A Pin type of No Connect will not allow any connection to
connect to it.
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The Allow On Block Port check box allows the Pin type to be used for Block Ports and applies
block port rules to block ports when using hierarchy. Block instance pins use the normal pin rules.

Pin Type Rules

The Pin Type Rules dialog is used to define how the Pin Types will react with each other when
connected together. The first column displays a list of all the Pin Types defined (taken from the Pin
Types dialog). The second list displays the rule against the corresponding Pin Type, these are colour
coded depending on the rule. Any text in blue is noting a Warning Rule with Red noting an Error
Rule.

A rule can be defined by selecting the Pin Type and clicking the Edit button, or by double clicking
the Pin Type name.

<Undefined:> Bi-Directional

<lndefined {Block Port} Input {Block Port} Eror Rule

Bi-Directional Cpen Collector Waming Rule Edit
[Ground Cpen Emitter

Input Output

Input {Block Port} Output {Block Port} Delgte
Open Collectar Power

Open Emitter Tri-State

Or-Tieable

Output Report
Output {Block Port}

Passive

Pcb Connect

Power

Teminator

Tri-State

The Edit dialog allows single or multiple selections of Pin Types on which to then apply a rule. The
Ignore status is the default and is shown in the normal text colour, only Warnings and Error rules
are displayed in the appropriate colour.

Ground - Ground Rule X

<Undefined: ®) lgrore

<Undefined> {Block Port} Cancel
Bi-Directional (D) whaming

[Graund I
Input (O Enrar
Input {Block. Paort}
Open Callectar
Open Emitker
Or-Tigable

Output

Output {Block Porth
Passive

Pecb Connect
Fiowaer

Termninatar
Tri-State

Pin Type Rules can be reported using the Pin Type Rules report found on the Qutput menu under
Reports.

An example report looks like this:

<Undefined>
<Undefined> {Block Port}

Bi-Directional
Ground Warning
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Input {Block Port} Warning
Power Warning
Output Warning
Output {Block Port} Warning
Ground Ground
Bi-Directional Warning
Open Collector Error
Open Emitter Error
Tri-State Error
Output Error

Load Technology Pin Types
The Load Technology option will load Pin Types and Pin Type Pair Rules if required.

The ERC Error Browser

When the design contains error markers (added when the ERC check is run and errors are found), you
can show a list of all the markers by displaying the ERC Error Browser.

The browser can be invoked when running ERC from within the dialog by using the Show Errors
Bar check box or from the View menu or from the Dockable Views toolbar.

You can select an error marker in the Errors Browser and highlight it in the design.

Viewing Errors

To view an error of a particular type, click on the box next to ERC Errors. This will then display all
the actual error types found in the design. Click on the box next to the error type that you want to look
at. This will then give a list of the pages that have this error. Click on the box next to the page name.
This will then list the position of all errors of this type on this page. If you then double click on one of
the positions in the list, the view centre of the page will move to this position. The error marker will
be drawn in the current highlight colour.

ERC Errors x Right clicking inside the ERC Errors Browser
- ERCerrors: 4 will display a context menu. From this there
=I+Fin fot On A et Error (PN) are menu items that allow various
complimentary options to be run.

0o, Floating

At
Akl
+-Pin Type Pair Error Docking

Unfinished fiet (N
¥ Unfinished Het Auto Hide

Hide

Find Error
Delete Error

Lock Error

[

Clear All Errors

Flash Errars

Electrical Rules Check...
ERC Errors Report
Toggle Sort Order

B9 3

World View w

L 3
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Documentation Symbols

Overview

As the name suggests, Documentation Symbols are typically symbols that have no real electrical
significance on the design but are used for annotation or documentation purposes.

These symbols could be used for design items such as Testpoints, Power & Ground symbols and
Cross Page Link Symbols etc.

The main difference between Documentation Symbols and 'ordinary' Symbols is that they have no
Part definition, and they reside in their own Documentation Symbol library. Most importantly, most
Documentation Symbols are not transferred to the PCB design when using Translate To PCB or
appear in any Parts Lists created. There are a couple of exceptions in that Testpoints and Mounting
Holes are ternsferred to PCB.

Schematic Documentation Symbols are used for several purposes. It is therefore necessary to specify
the purpose of each symbol when it is created. In this way, the program can ensure that the symbol
satisfies the requirements of its purpose (for example that it contains exactly one pin) and that you are
only presented with symbols of the correct type when adding them.

New Doc Symbol X

Symbel Type
() Block Port
(O Block Symbol
(C) Branch Paint
(O) Bug Reference
(®) Documertation Symbal
(O Mounting Hole
(O Net Label
(O) Page Link
() Signal Reference
() Star Point
() Testpoint

Cancel

There are a number of documentation symbol types:

Block Port is used within a block to connect with the enclosing level. It is a terminal used to connect
between hierarchical levels. A block port symbol must have a single pin, and can contain any shapes
you wish. To add a block port, use the Insert Block Port command.

Block Symbol is used to represent a block instance. When you create a block, you can nominate a
block symbol to represent that block. You can also choose the symbol when inserting a block. A
block symbol must have a pin for each Port in the block it is to represent.

Branch Point is a symbol used with the high speed option to create ‘branches’ within a net so that
specific rules can be defined using Signal Paths and/or Sub Nets.

Bus Reference is a symbol used to display the nets range on a bus. The symbol must contain a single
pin. Whilst adding a bus, use End Connection On from the context menu.
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Documentation Symbol can be used in many ways. For example, it could contain a logo. You can
add a documentation symbol to a design by using the Insert Documentation Symbol command.

Mouting Hole can be defined in the Schematic so that it can be assigned a net name when passed

through to the PCB.

Net Label are attached to nets to highlight the net name. These can be formatted with shaped and

coloured boxes.

Page Link is a symbol to represent a link to another page. When this symbol is used, it can be
associated with another page in the schematic. You can then 'jump' to the specified page using the
Jump to Page command, when the symbol is selected. Whilst adding a connection, use End/Start

Connection On from the context menu.

Signal Reference is a symbol used to represent a break or link on the net. The symbol must contain a
single pin. It would typically be used for a ground or power symbol. Whilst adding a connection, use

End Connection On from the context menu.

Star Point is a symbol used when multiple nets containing different names are to be connected

together at a common point.

Testpoint is a symbol used to represent a testpoint. The symbol must contain a single pin. Testpoints
can be added using the Insert Testpoint command. Whilst adding a connection, use End Connection

On from the context menu.

Using ‘general’ Doc Symbols

Documentation Symbols can contain any documentation shapes, electrical pins, text and attributes.
They can be created or edited using the Schematic Documentation Symbol editor. These would be
used for general documentation purposes, such as drawing borders, drafting notices etc. They are not

used for electrical notation such as power and ground labels.

You should add Documentation Symbols from the library to the design using the Insert
Documentation Symbol option.

Insert Doc Symbol X

I:ookln:|[A||Libraries] Vl | Add |
‘which Symbols:

Cancel
Matched: 17 of 17

Symbol: |Drawing Header v| Finz: El

Dirawn an: |This Page Only e |

[ Preview

This dialog uses standard Pulsonix functionality.

®  Set the Documentation Symbol library you wish to add from (Look In). A list of Symbol names
will appear in the dialog. Use the filter to reduce this list to the Symbols that you are interested in.

® Filter the name and/or the Number of Pins to refine the list.

® Choose the Documentation Symbol you wish to add from the list.

®  From th drop dwn list, select the Page or pages you wish the symbol to be Drawn On.

The Preview check box allows you to preview the symbol before it is add to the design.
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Block Ports

The Add button will dismiss the dialog from view and will allow you to interactively add as many
Documentation Symbols of the type selected as you like to the design. If you require a different
Symbol you should cancel this process by pressing the <Esc> key on the keyboard. This will
immediately return you to the Insert Documentation Symbol dialog from where you can make further
Symbol selections. If you wish to cancel Insert Documentation Symbol completely, having finished
this process, or use the Cancel button from the dialog.

Using Doc Symbols

Like components in the design, they can be selected and the symbol from the library edited using the
context menu. If modified in the library and already used in the design, they should be reloaded using
the Reload from Library option from the context menu, or the Reload options on the Utilities menu.

Doc Symbols can be placed in to the Component Bin for use at a later stage.
When using Doc Symbols in the design they can be connected to and added directly onto a
connection by releasing it on the connection itself.

Using the Next and Previous Symbol option

When adding Doc Symbols, from the context menu, you can select Next Symbol and Previous
Symbol. This will select the next (or previous) symbol in the list displayed in the Insert dialog. Any
filters created will also be applied.

Cancel Insert Doc Symbol
[ Exit This Mode

Finish Here
¥ Type Coordinate... =
o Type Rotate...

Change Angle To 4
0% Rotate By 90 R
<5 Rotate One Step Alt+R
5? Change Rotation Step...
00 Mirror M

Show Placement Origin
Previous Symbaol

Next Symbaol .
:I Show Track Lenb:jg_h Limits

Reposition Cursor Text

Move Horizontally
Move Vertically

Change Grid 4

These Doc Symbol types relate to hierarchical block use and are used to indicate lower level block
connections to the upper level.

Block Ports are added to the design using Insert Block Port and are only available if the system
detects that you are on the correct level of hierarchy. When creating Block Ports, the Pin Name
attribute is predefined for use. Shapes can be added to the symbol to annotate it.
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The use of these Doc Symbols is described further in the section on Hierarchy.

1

X

Block Symbols are used to represent hierarchical blocks that have been saved.

Block Symbols

When creating these Doc Symbol types the Block Name and Block Instance Names are added by
default.

1

pa
: kBloc@ane))- :

" {<Block Instance Name3}

You can add any number of pins to represent the connections to the lower level circuitry. These will
be available for selection for use during Insert Block Instance, Properties and Change Block.
Page Links

In Pulsonix a Schematics design can consist of multiple pages, each representing a separate sheet of
the final schematic.

You can add links between these pages enabling a page to refer to another page. These links enable
you to easily switch the current page you are editing to the page referred to.

{<Page Link>}
Page links are often used to join a global net connection leaving one sheet and entering another. These

are for documentation purposes only as all parts of a global net are always connected together when
creating a PCB design from the Schematic.
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‘implied' connection

Dac Zymbnal

Des=ign.sch

Met Mame1 —- 4l Met Namel
=Page Link= =Page Link=

Lt

=Page Link= =Page Link=
Page 1 Page 2 Page 3

Adding Page Links

Pulsonix page linking is performed using the special <Page Link> attribute. The attribute's value is
the name of the page that the link refers to. Double clicking the mouse when the cursor is over one of
these attributes will change the page currently being edited to the page the link refers to. This way
you can use the mouse to easily traverse the schematic's pages. There are two ways of adding a page
link attribute; using the Insert Attribute option and the Insert Page Link option.

» To add a page link

1.

Select the item you wish to add the link to, or select nothing if the link is to be added to the
schematics page itself. Right click the mouse to use the Add Page Link option from the context
menu. Choose from a list of names of the pages in the schematic, or type the name of a future
page to be linked to. The attribute will then be added.

Choose Page x

Page: |ADD1:HaIf Adder v|

The page link attribute may be visible, in which case you can use it directly to switch pages as
mentioned above, or it may be left invisible. If invisible, selecting the item the page link is on
will allow switching pages using the context menu.

Interacting With Page Links

P To use page links

1.
2.

Double click on a visible page link attribute name to switch pages, if the named page exists.

Select the page link attribute, or the item the attribute is on and right click the mouse to use the
context menu.

Use Jump To Page to switch to the page referred to.

Use Change Page Link to alter the name of the page the link refers to, or to change the visibility
of the <Page Link> attribute.

With nothing selected, right click the mouse to use the context menu. If this page is itself linked
to another page you will be able to use Jump To Page and Change Page Link, mentioned in the
previous section.

When To Use Page Links
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Documentation References

Often the sheet outline title block contains lists of the names of the other pages that make up the
design. Adding these names as page link attributes means you can also use them to switch pages.

Cross Page Signal References

Where separate pages are simply used to split up a complex design, you have the situation where a
connection leaves one page and enters another. This is usually done by ending the connection on a
symbol that represents an off- page connector, with the name of the page it is going to next to it.
Pulsonix handles this by ending the connection on a single pin documentation symbol that has a page
link attribute. The advantage of this is you can actually use these symbols to switch to the page that
the connection is going to.

To make it easier to do this, when adding connections on global nets, you can right click the mouse to
use the context menu to start, or end, the connection on a page link symbol. You simply have to
choose the name of the symbol to use and the name of the page to link to and an off page link will be
dropped into the design.

Signal References

Signal References can be used for a number of purposes but effectively they all have the same effect,
that of adding additional documentation to your schematic. They can take the form of cross sheet
signal references, power & ground symbols or simple signal references.

The Insert Signal Reference dialog from the Insert menu allows you to add any of the categorised
documentation symbol types and add them to your design. By using the Type drop down list, the Sig
Refs will be presented in the Symbol list using their category. You can use All to present all
documentation symbols regardless of category. Categories for these symbols would have been
specifed during their creation using the New dialog or when saving to the library.

Insert Signal Reference X
Look |n: |[E0NS] |v| I Add |
‘wihich Symbals: Cancel

Type:
Al

Matchers : Reference

Met Label

Fage Link
Signal Reference

Pirs:

Freview

Other special doc symbols, such as Doc Symbols, Testpoints, Branch Points, Moutning Holes,
Blocks, Block Ports and Star Points are all handled from their own Insert dialogs.
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Reassigning Sig Ref Symbols for other use

Existing Sig Ref symbols already in the library can be re-categorised by editing them and using the
Symbol Properties dialog from the Edit menu or by using Save To Library and choosing the new
type from the list:

Save To Documentation Symbol Library *

Library: | w |

M ame: | Mounting Hole2 |

Block Part
Block Symbal Cancel
Branch Point
Bus Reference
Croc Symbol

Met Label

Fage Link

Signal Reference
Star Point

T estpaint

Power and Ground Symbols

Power and ground symbols are often required in the Schematic to indicate a connection to a power
source. These symbols are required for aesthetic purposes and are not translated to the PCB. The
signals they represent are connected together at the translate stage by ‘implied’ connectivity.

O
1,

100nF
Ll
GND

The power and ground symbols themselves can contain inherent net name properties that are
automatically used when the Symbol is attached to the net.

Nets that are invisible in the design but that provide connectivity are generally referred to as ‘implied
nets’ because they are not directly visible but are translated to the PCB design where they become
connected together using their net names.

When creating Signal Reference symbols for use with power and ground nets you can be specific or
semi-specific in your use of the Net Class and Net Name matching that will be used in the design.

When in the Doc Symbol editor you can select the Symbol Pin and right click to get its Properties.
From this dialog you can opt to automatically Connect To Net when it is used in the design.

Connect To Net allows you to specify that the pin should connect to a net of the given net class type
(Power, Ground or Signal, or to a given Net Name). This is useful, for example, if you wish to
create a ground symbol that should obviously be connected to a Ground net. If the design only
contains a single net of the appropriate type, the symbol will be automatically connected to it. If there
is more than one net, a dialog offers you the choice. If there is no such net, a dialog offers you the
option of creating one. Similarly, for a given net name, if the net exists, the pin is automatically
connected.
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You can Connect To Net, provide the Net Type and/or Net Name.

Connect To Net
Net Type: Met Name:

| Power w | |+5V

» To add Power/Ground symbols
1. From the Insert menu click Insert Signal Ref
2. From Type: select Signal Reference from the drop down list
3. From the Symbol name drop down list, select the Symbol required
4. Once the Doc Symbol is dynamic on the end of your cursor, you can position it over a net.
5

When released a dialog is displayed (if applicable):

Select Signal for Pin +5V X
Met M ame: | +5 | ~ | I Usze for all net type Use for pin
Het Type: Unconnect all net type Uneonnect pin

Cancel

If only a Net Class Type has been specified when the symbol was created when you add the Symbol it
will automatically connect to the ground or power net in the design unless there is a choice, in which
case you are prompted to select one.

6. From this dialog, select the Net Name for the Doc Symbol.
7. The Net being connected to will now take on the net name specified. If the Net already has a
name, a warning dialog will be displayed requesting the net name to use.
Cross Sheet References

The principle described above for power and ground symbols also applies to normal signal references
used for inter-sheet or cross sheet notation. The main exception is that the pin used in the symbol has
no predefined Type or Net Name. The Net Name is applied to the pin when used.

When creating Signal References in the Doc Symbol editor, the Net Name attribute is predefined for
your use.

{<Net Name>}

X

A Signal Reference in the Schematic might look like this:

Clock D
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Page Link

Page Links are added through the Insert Signal Reference dialog. Wduring creation, the {Page Link}
and {Net Name} attributes are added along with a pin. When added to your design, it will ask you to
provide the page that the link refers to.

Choose Page X
Page: |F'age1 ~
Cancel

Pagel

Bus References

Bus References are similar to signal references and can be added to Schematic designs via the new
menu command Insert Bus Reference. These are attached to buses and used to label the bus. They
display the nets within the bus.

DIGT
DIG6
DIG5
DIG4
DIG3
DIG2
DIG1

DIGO

A bus can be started and ended on a Bus Reference. This can be configured within the symbol to
display various details of a bus, for example, the Net Name.

Testpoints

As with Signal References, Testpoint symbols are very basic. During creation in the doc Symbol
editor, the Testpoint Name attribute is pre-selected for use.

These will be used when the Insert Testpoint option is
selected and when a connection is selected to end or start

| {<Testpoint Name>) on a Testpoint.
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Star Points

Star Points or Delta Points as they are sometimes called, allow you to connect multiple named nets
together at a common point. This might be the GND and Digital GND nets for example, where they
have the same input point but need to be isolated from each other except for the source point.

Star points are used in both Schematic and PCB designs and are recognised by Translate to PCB and
Synchronise Designs.

The process of using star points in Schematics is straightforward. The Doc Symbol is defined as being
a Star Point type. This can have any number of terminals but the nets connecting to them remain
independent regardless of whether a single terminal or multiple terminals have been defined.

When translated to the PCB design, the first segment of the tracks only will not cause DRC violations
with each other. It is also recommended that in PCB you have the switch Allow Single Pin PCB Nets
set to off.

Branch Points

Net Labels

Branch Points are added to the design using the Insert Signal Reference option. These are connected
to a net to indicate the point at which a Signal Path or Sub Net would be defined to/from.

The illustration below shows how a branch point may be connected as an integral facet of the net
(Branch 1) or as an isolated standalone item (Branch 2):

= |8 L1
=
o«
- Branch2
2
TRIG Branchl
7 Friny
DISC ® o
3
ouT

Once these have been added you can then create a Signal Path or Sub Net to which these can be
referenced. They do not form and part of a net other than an indicator to a branch. These points are
translated to PCB when they can be positions.

Net Labels are used to 'hang' on a net to explicitly show the net name on your Schematic design.
Because it uses a special Doc symbol, it means you can customise how it looks and where it is
attached to. The symbol's net name is dynamic and will update as the name changes.

On creation, the symbol will contain a Pin and an attached Callout with the Net Name attribute
stored in the callout.
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You can add net labels by using the Insert Signal Reference and selecting the Type as All or Net
Label.

FRED_CLOCK

Mounting Holes

When used, Mounting Hole Doc Symbols can be added to an existing net to enable their net
connectivity in your PCB design. They might countain a Pin plus a Net Name attribute and some
documentation outline as required.

Following successful Translation to PCB, Mounting Holes are added to the PCB using the
Mounting Holes setting in the Design Settings, Defaults page. This setting will select the layer for
the Mounting Hole and Pad Style used.

Insert Doc Symbol X
Lok Ir: |[A|| Libraries] Vl I Add I
which Symbols: Cancel

Matched: 1 of 1
Symbol: |Mounting Hole {DocSymbolz} v| Fing:
Preview

50,0 thou
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Block Port and Blocks

These are disccused under the Hierarchy section below.

Using Busses

A bus is a shape that represents a collection of signals on the schematic design. This makes the
schematic less cluttered as many parallel connections running from one side of the drawing to the
other will not be required. You can add a connection from an electrical pin to the bus that carries the
required signal.

1

z

Blus Terminal i
\ ab S %

&

7

&

5

Bus — R

Closed Busses

A newly added bus is Open to carry any net names. You can Close it to only carry a closed set of
allowed names by selecting it and using Properties from the Edit menu.

Once closed, you can only add a connection to the bus if the connection is on one of the nets defined
in the bus's set of net names. When trying to connect to a closed bus, you will be presented with a list
of the bus's net names to choose from.

The set of allowed net names can be displayed next to the bus using a condensed range format. Select
the bus and right click to use Show Net Name from the context menu. Then drag the name range to
the desired position.

Bus Terminals

When a connection as attached to a bus segment, the end of the connection is bent at 45 degrees as it
touches the bus. This 45 degree segment is known as a Bus Terminal. The Bus Terminal takes its
colour and width from the Connection, but it is not part of the connection.

To set the default Bus Terminal length use Design Settings and the Defaults tab and change the bus
offset to the required value, and also its exit direction from the bus, Up (or Down unchecked) on
vertical bus segments and Right (or Left unchecked) on horizontal bus segments.

Line Style: |Bus v| UFI

Name Style: | Normal ) |

Bus Teminal Offset: 100000

Bus Teminal Direction:

Up {on verical bus segments)
Right {on horizontal bus segments)

In Dialogs - Apply Styles to All Connected or Same Name Busses Left nght

Dowen



Chapter 5 — Schematic Capture Editor 163

The bus terminal may not be initially added in the preferred direction, to alter this select it and use the
Rotate option to Flip between the allowed angles.

When the connection segment attached to the bus terminal is moved, the bus terminal moves with it to
the nearest place on the bus. When the bus segment is moved all bus terminals attached to it are move
with it to keep the bus together.

The net name can be displayed next to the bus terminal. Select the bus terminal and right click to use
Show Net Name from the context menu. Then drag the name to the desired position. Use the Options
and Interaction tab to enable automatic display of net name when connecting to a bus.

When a connection to a bus is deleted, the bus terminal is also deleted.

Bus References

A Bus Reference Doc Symbol can be added to a bus to indicate its use or for documenting the nets it
contains.

Translate To PCB

Busses are not important when translating to PCB; they are simply a way of simplifying the
Schematic using an annotation for multiple nets. All items connected to a bus will be joined to any
other items on nets of the same name.

» To insert a bus

1. Before entering Insert Bus, select another existing bus if you want to create a bus with the same
line width and allowed net name set.

2. Click the Insert menu and click Bus.

3. Click to pick the start position, and click to add each corner. Double-click the mouse button to
finish.

4. If required use Properties to add or change the allowed net names to the bus.

Changing Net Names on a Bus

The Bus tab is available when using the Properties option on one or more selected bus segment(s).
You should use this to change the selected bus line style and allowed nets.
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Properties: Bus - Bus O X

Segment Bus  Bus Atributes

[ Name: | | [ Locked

Apply the style to all connected or same name busses
Own Colour
Line Style: |Bus V| O

Width: 50.000| Length: 1275.000 g

Allowed Nets:

ADDD
ADDN
ADD2
ADD3 Bemove Met
ADD4
ADD5 Up Down
ADDE
ig Bé Remove All Nets
ADDS

Allowed Nets Range:
[~DD[0-9) v

Locked is used to lock the bus from future editing or moving. Once the bus is in its final position,
lock it to avoid accidentally altering it.

Choose the required Line Style for the bus from the list of line styles already defined in the design.
These can be altered using the Technology option from the Setup menu. The width for the selected
style will be shown in the edit box.

If you don't know the name of the style then type the required line width in the Width edit box. The
style that matches the typed line width will be selected from the list. If no line style in the design
matches the typed width then the line style name box will be left blank. Type the new name for the
line style, or leave blank for the system to assign a default name for you.

Listed here are the Allowed Net Names that represent the signals that the bus can carry. If any net
names are listed the bus is Closed, so only the listed nets can be connected to the bus. If there are no
names listed the bus is Open, so any net can be connected to it.

Add Net is used to add some net names to the closed bus. It displays the Add Net To Bus dialog that
allows you to select from net names already in the design, or add your own new net names (see below
on how to do this). If the bus was open (i.e. no names listed), and it has nets already connected to it
then you will be asked to add these nets to the list automatically. If the bus has default named nets
connected to it (e.g. NOOO1) you cannot turn it into a closed bus.

Remove Net is used to remove the selected net name from the Allowed Nets list. You cannot remove
names of nets that are already connected to the bus.

Remove All Nets is used to turn a closed bus into an open bus by removing all of the net names from
the Allowed Nets list.

Allowed Nets Range initially displays the list of Allowed Nets in range format. This is the string you
would see if you displayed the net name on the bus. Details of the range format are shown in the next
section on Decoupling Capacitors.

You can use this to type in the required closed bus nets directly in range format or select from a list of
name ranges used on other busses in the design. If the text is changed the Apply Range and Reset
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Range buttons are available. Apply Range allows you to apply the changed string to the Allowed
Nets list. Reset Range resets the string to match the current names in the Allowed Nets list.

» To add net names to a bus

1. From the Bus Properties dialog, click the Add Net button. This dialog is used to specify the net
names are allowed on the closed bus. Only connections on those nets can be attached to the bus.

B | Add Metto Bus x

GHD

BND ok |
WECALLS
WCCIO
WCCIoZ
WCCIO3
WCCID4

Cancel

New Nets
Name: | |t | | | addToList

2. This lists all the named nets that exist in the schematics design that are either global or local to
the page that the bus is on. Select one or more net names from the list that you want to add to the
bus.

3. If you want to add new net names to the bus that are not in the list, use the New Nets box at the
bottom of the dialog. Type the name of the new net into the Name: box. If adding a range of net
names, type the first name into the Name: box and the last name in the range into the to: box.

4. Click Add To List to add the new net names to the above list. These names are selected ready to
add to the bus. Note: New net names added using this method are always added to the design as
global nets. If you want to change them to local nets, use the Technology dialog and Net Names
facility.

5. When you have selected the names, use OK to add these names to the allowed net names list on
the bus.

Auto-weld Connections to a Bus

You can also drag a Component in the Schematic design so that when the pins of the Symbol are over
a bus segment it will weld it to the bus.

ADDRESS BUS

ADDO — scL SDA b=
ADD1 —
— A1

— AQ

ADD2

ADD3

24-C32pP
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For Closed Buses

Move a Component or Gate (Symbol) so that the pins are coincident with the bus, ensure the pin grids
and bus grid are the same:

ADDRESS BUS

Cc1

SCL SbAb—
A2

Al

L]

AOD

24-C32P

Weld Markers between the bus and Component pins are displayed indicating the component can be
welded:

ADDRESS BUS

When a bus is closed (i.e. with named nets), a dialog will be presented to choose the net names from
the bus for each of the pins:

B Choose 4 Bus Nets

*
Bus Mets: Pin Order:
IC1.6
IC1.3 Cancel
IC1.2
IC1.1
Reverse
Chasen Nets: [ADDI03] v]

When choosing nets to add to the pins, it will always select the first matching number of nets/pins.

However, the Bus Nets can be individually changed by picking them from the list, the Shift and Ctrl
keys can also be used to aid selection.
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Moving the symbol away from the bus will show the connections and bus terminals clearly.

ADDRESS BUS

IC1

SCL T
A2
Al
A0

24-C32pP

Open Bus

If the bus is an open bus you cannot pick from net names on bus, but can type the required net name
range (or pick an existing closed bus name range from a drop down list).

B Choose 4 Bus Nets X
Bus Mets: Pin Order:

IC1.6

IC1.3 Cancel

IC1.2

IC1.1

Reverse

Chazen Nets:| V|

If other closed buses are defined within the design, you can choose the nets using the drop down list
using Chosen Nets:

Bus Names in PCB

Bus Net Names are translated to the PCB and can be used in options that have an interest in them,
such as the Bus Routing option. These can be used to easy select bus net names for bus routing. More
information about this function can be found in the Online Help Bus Routing Usage.
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Hierarchy

What is hierarchy and why use it?

Hierarchy in Pulsonix is the ability to add ‘blocks’ to a design that in-turn can contain circuitry.
Blocks are simply shapes that represent a lower level of the design, these are often used to declutter
the schematic or to reuse existing blocks of know good circuitry.

=<
e

> <
e P |

There are two, not unrelated, reasons for using hierarchy.

® To allow a schematic design to be structured, so that it can be broken down into its functional
elements. This promotes Top Down design; break down a problem into functional elements, then
define the detail of each element.

® To facilitate the re-use of commonly used circuit elements. This promotes Bottom Up design; use
predefined elements to build a solution.

In practice, you may want to use a combination of both Top Down and Bottom Up design.

Overview of Hierarchy

Blocks

A block should be a functional element that has a well-defined purpose and interface. In design terms,
a block is a special schematic design that describes the implementation of its function; it also has a
symbol associated with it that represents the interface.

A block can be instanced in a schematic design (or another schematic block design). The symbol
representing the block is placed in the circuit, and can be connected to, in a similar way to a
component. However, as well as the symbol being added to the design, all the pages of the block
design are also added. Component and net names are resolved so that there are no conflicts.
Connecting to the symbol pins joins the nets with those defined in the block instance.

In many respects, a hierarchical schematic design is no different to a normal multi page design. The
net lists would be the same, and the drawings are largely the same. However, it is easier to navigate,
because you can Push into the pages representing the block instance, from its symbol, and Pop out of
the block instance, back to the symbol. It is also possible to update the contents of a block instance,
from the original block design.
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Top Down Design

To work top down, that is, from an ‘upper’ level schematic sheet, you can add an existing block or
generated a block instance for each part of the design that is, as yet, undefined. At a later stage, you
can Push into the block instance to edit or define its circuit. From the top level, you can then connect
to the block instance using Insert Connection (or Insert Bus), either connecting to an existing pin on
the block symbol, or adding a new one by clicking anywhere on the symbol outline.

Bottom Up Design

You may want to create libraries of commonly used blocks, such as power supplies or signal
converters. You can do this by taking an existing Schematic design and creating a Schematic
Hierarchy block design from it. This is saved into one of the nominated Schematic block folders.
When creating a Schematic Design it is then possible to insert a block instance of one of these saved
blocks.

Navigating a Hierarchical Design

To navigate up and down in the hierarchy of a design, use the Push and Pop commands. To Push
into a block instance, select any part of the block and select the Push into block command from the
context menu. To Pop out of a block instance, back up a level, select the Pop out of block option
from the context menu. You do not need to select anything it is sufficient that the active page is part
of a block instance.

Push/Pop to and from blocks

Once the block has been added to the design, you can move down into the block by using the ‘Push’
command. This is available on the context menu once the block is selected, or by using the <PgDn>
key on the keyboard.

At the lower level, you ‘Pop’ back up into the hierarchical block using the option from the context
menu or by using the <PgUp> key on the keyboard.

If you have the Workbook mode switched on, the blocks can be navigated using the tabs at the
bottom of the screen. You can also use the Design Browser Window.

Once you’ve pushed into the lower level you can now add your circuit and Block Ports.

Using the Design Browser and Hierarchical Blocks

The Design Browser in the Schematic editor supports and shows Hierarchical blocks. It also shows
the lock status of the block indicated with a small padlock symbol. This is discussed later in this
section under Multiple Instancing.

Design Browser x
Designl g]-u I“tEI"

Blmer - Top Level
gy - {8} &3 [Block1]
FPagel

El pin netwark,
apsk

& RoutingDema?

Pagel
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Connecting Through Hierarchy

Using Connections

Instancing hierarchical blocks gives you the internal connectivity of the block, but you will want to
connect these nets up through the hierarchy. There are two ways to do this.

If the net in a block is defined as not local (global), then it may be used anywhere in the entire design.
So the same global net name can be used inside and outside a block instance, and the attached items
will be connected together. This is fine, but you will want to define connectivity inside a block
instance that cannot be connected to outside the block instance. This is achieved by using a local
name. Net names are defined in the Technology file.

To connect a local net to items outside the block instance, you will need to use a Block Port inside
the block. This will match with a pin on the block instance symbol. The mapping between the two is
defined in the Block Properties.

When a connection is moved over a block, the ‘F’ Finish marker is displayed to indicate that you can
automatically connect to the block using a block port when a block port would be legal.

i
k

f
k

PSU Block

If the block has no defined ports on the lower level then a new block pin is added without prompting.
If the lower level has spare block ports defined, you will be prompted with the Select Block Port
dialog. Use this to select or type the name of the block pin. When OK is clicked, the connection will
be attached to the block with a block pin.

Select Block Port x

E ) T

Connecting a Bus to Hierarchy using ‘Bus Pins’

Like connections connecting to a block, you can also connect a Bus to a Block Pin. When editing a
Bus, move it over the Block Pin in the same way you would a connection and the the ‘F’ Finish
marker will be displayed. Any Net Names within the Bus will be carried into the hierarchical block
via this Bus Port. A corresponding Block Port added on the lower level will also contain these Net
Names and can be connected to using a Bus.
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Setting up your design for hierarchy

When starting a Schematic design there are settings that you should check in order to use hierarchy.
Settings appropriate to hierarchy are defined in the Design Settings option, General page and
Naming page.

Allowing Multiple Instanced Hierarchy

Multiple Instanced Hierarchy is the ability to take one hierarchical Block use it multiple times on the
design but to have all instances referenced back to one ‘master’ block. For example, an RGB channel
of three identical blocks or a sound mixing desk of many multiple channels.

If you want to use multiple instancing of blocks you must enable the Allow Multiple Instanced
within the Design Settings option under General and Blocks. If using this for the first time or if
unsure, leave it unchecked.

Al Text Attributes
Substitution Char:

Adjust To Readable Orentation {when doubled)
Baming Character: .
fuhen doubled) |- | Metching Styes

() By Name Only
System Fort (®) By Name And Value
[ Proportional Width Digits (O By Walue Only
CAM/Plot Blocks
[ Transform about design extents [ Allow Mutiply Instanced

Schematics Top Level

Blocks which share the same definition and edits on one instance can be applied to the other
instances. Without this, each instance is completely independent. This needs to be set before any
blocks are added.

The Schematics Top Level Name is used in hierarchical schematic designs. It is the name of the top
level owner scope and is applied to net names local to the top level (i.e. not in a block instance), using
the naming rules.

Multiple Instanced Properties

Once this has been selected, the block can be multiple instanced, without this selected, the Properties
of a block will show the Can Be Multiple Instanced greyed out and you will not be able to instance
it: If Locked Instance is checked, it prevents the contents of this instance from being edited. This is
used in conjunction with the Can be Multiply Instanced property, to control which instance can be
edited.

Description is the description defined on the block. It can be edited on an unlocked block instance.
The check box alongside the name shows if the description is currently displayed on the block
instance symbol.
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B Properties: Block Instance - Block O X

Block  Block Ports  Block Instance  Block Instance Attributes  Vautt

Name: |32 |

[ Block: |Block1 | Change...
Generated Block

[ Description:

Can be Multiply Instanced

Locked Instance

Locked To Vault

Once a block has been instanced, it is possible to edit them independently so that they diverge from
the original definition. More likely, you would want to keep the definitions in step, either with the
original block design, or with each other. This can be achieved, by using Reload Block and updating
from the original block design, or by applying changes from one instance, to all the others.

A block instance also has a Locked instance property that prevents the contents of the instance from
being edited or changed in any way. This ensures that it remains a copy of the original definition. A
block instance also has a Can Be Multiple Instanced property. By enabling this, multiple instances
of the block are locked together. Only one of these instances can be unlocked and edited. They can be
brought back into line using Update Multiple Instanced Block

The function Unlock Multiply-Instanced Block appears on the context menu when selecting a block
instance, or with nothing selected when editing on a page in a locked block instance. This option
allows you to unlock the block for editing. Within the Design Browser you can see the lock status of
blocks (see below).

With the Multiple Instance enabled and the block allowed to be multiple instanced, once copied
there are other additional options on the context menu that are displayed.

Use Update Multiply-Instanced Block to apply changes made to the design to all other instances of
the block.

Revert block option. If you have unlocked and made changes to a block that is a multiple instance
you can revert it back to look like the locked copies using this option.

If you unlock a block instance and switch off Can Be Multiple Instanced from Properties, you will
not be able to apply the instancing back to the block.

Net Names on Blocks

The Design Settings should be checked so that the program handles the Blocks and Net Names
correctly. Under the Naming tab you should set the way in which Local Net Names are used. Set
Default to Local Names and Name Unique Across Design to on (checked). This will ensure that net
names used within each hierarchical block will be local (and not Global) and that net names across
the design will be unique.

Local Net Names Example:
Default to local names Pin Names
Names Unigue Across Design ﬁg‘;ﬂog:;
Local Name Prefic:
| Componer
Owner-Net Separator: !
i Displa

(Owner Before Net Name
Gata Sa
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In summary, the Design Settings should be like this:

For Hierarchy but not multiple-Instanced:

Allow Multiple Instance Off
Default to Local Names On
Name Unique Across Design On

For Hierarchy but using multiple-Instanced:

Allow Multiple Instance On
Default to Local Names On
Name Unique Across Design Off

Folders and Schematic blocks

All previously saved blocks are located under the Schematic Blocks search path defined on the Setup
menu and Folders option. Change this if you wish to add a user location or network drive.

B Folders - Schematic Blocks O X
General
CAM/Plot Folders and Search Order:
Colour Files [Vautt] Add. . Up
Design Backups C:\UsersPublic'\DocumentsPulsonix " Blocks

Design Reports =0
Format Files

Libraries
Library Reports
Macros

Profile Files

[ Schematic Blocks Files Found: 3

Script:

S'CI'EE I;I del C:\Users'\Public\Documents'\PulsonicBlocks\CharacterLeds blk
odels . C:\Users'\Public\Documents'\PulsonicBlocks\Full Adder bl

Technology Files C:\Users\Public\Documents'\PulsonicBlocks'Half Adder blk

Creating a new block to add to your design

Starting with Top Down design means you will start with a new block and after pushing down into it,
will add the circuitry.

The process for creating a new block from the top down is as follows (and this assumes a new block
rather than an existing block will be used):
» To add hierarchical blocks using Generate New Block
1. Itis assumed that you have adjusted the Design Settings accordingly.
2. From the Insert menu, use Insert Block Instance to add a block to the design.

3. Select Generate New Block.
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Insert Hierarchical Block Instance X
(O Use Existing Block, Add
[&ll Folders] Cancel

Wwhhich Blocks:

|:> (®) Generate Mew Block

4. If the number of ports (input and output pins) is known then these can be set. If not set it to zero
(0) and adjust it later on.

EBlock Mame: |Block2 |

Description: | |

Sumbol | <Generated Elock Symbals O Fram Library Change...

(®) Generated Symbal | Specify...

Instance Mame: [ tultiply I rstanced
Ol Previevt

Apply

5. The bottom section of the dialog is the Preview area. This allows you to preview the block before
it is added to the design.

Prexview

X

a
>e

=}
>e

X

El

6. Press OK to add the block to the design.

7. Double-click on the block outline to Push down into it, or right click and select Push Into Block
from the menu. On a selected block, you can also use the shortcut key <Page Down>

8. Once pushed into the lower level block, create the circuit or copy and paste it from another
design.

9. At the lower level you add Block Ports to the design (using Insert Block Port) to create
interface links back to the upper level. There will always be a direct 1:1 relationship between the
lower Block Ports and upper level Pins of a hierarchical block.

10. From the Insert menu, select Insert Block Port

11. Block Ports are added from the Doc Symbol Library and are defined as Block Ports during their
creation. Use the Insert Block Port option to add Block Ports to the design.
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Insert Block Port x
Look In: |[A|| Libraries] V| I Add I —
‘wihich Sumbols:
Cancel Fin Number
e fece |[]
Filter: Mo, Pins: pply 1

Matched: 3 of 3 Pln Type: 2

. 3

Symbok [INFUT FORT ~]  Pins: /< 1
Part Name: |B | Pin MNurmber: ——

[ Preview |c
d

b Pin Type: | EEEEE]

£

12.

13.

14.

15.
16.

17.

18.
19.
20.
21.

The Insert Block Port dialog allows you to specify the Libraries to be searched in and the
Name of the Symbol.

When adding Ports, if the number of pins was typed in during Generate Block, then the Port
Name and Pin Number will match this number, e.g. if 4 pins were requested then a, b, ¢, and d
will be available for Port Names and the Pin Numbers will show 1 to 4 and 5 <new> as the next
new pin number. Port Names are automatically created and incremented. You can type a name
into the Port Name box for use. The next Port added will then be incremented using this name
plus one, e.g. the name Port] is incremented to Port2 etc.

You can also specify the Pin Type for the Block Port. By default this list is artificially restricted
to Input, Output and <Undefined>. If you wish to use more Pin Types then they must be
enabled through the Technology dialog under Pin Types. Checking any of the pin types in the
Allow on Block Port column will enable them to be listed.

Insert the required number of block ports.

Connect your circuit to the Block Ports. Any next names used will appear on the upper level
block. Block Ports can be left unconnected if you wish to come back to them at a later time.

Pop back up to the upper level using the Pop command from the context menu or you can also
use the shortcut key <Page Up>

Now you need to add Block Pin to the block.
For this example, we’ll add block pins to the block automatically.
With the block still selected, right click and select Regenerate Block Symbol

It will now automatically add the corresponding number of Block Pins to lower level Block Ports
(regardless of whether they are connected or not).

The block now has a circuit at its lower level, each of the ports at the lower level match the number of
ports at the upper level. This is the basic hierarchical design.

Saving Blocks

An auto-generated block can be subsequently saved for use later in another sheet or design. To do
this, right click on the block and select Save To Block File.
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From the Save As dialog, type a name and press Save. This block will be saved in your pre-selected
Folders.

When you need to use this new block, from the Insert Block Instance dialog, select Use Existing
Block and choose the Block Name: Your new block will appear by name in the drop down list. With
the Preview box checked, you can also preview it to check it is the required one.

Blocks, Pin Types and ERC

Pin types and Blocks

If you wish to use more Pin Types within your block they must be defined and enabled through the
Technology dialog under Pin Types. Checking any of the pin types in the Allow on Block Port
column will enable them to be listed.

B " Technology [Default (white).stf] - Design - Pin Types

=3 Spacing Rules
Name Type Allow on Block Port
Met Class Level
. Output
Match Pair I._e\rel nput W
Check 5pacing Values Bi_Directional
2 Styles Open Collector ]
Hatch Or-Tieable []
Line Tri-State ]
Pin Terminator ]
Ted Power Power ]
. Ground Ground []
Connections : o
Open Emitter
= NEtS_ ) ] No Connect Mo Connect []
Differential Pairs Paszive ]
Net Classes Pcb Connect  Pcb Connect ]
Met Names

The Block Ports dialog on Block Properties allows you to change the Name of the pin, the pin
Number sequence on the block and the Pin Type (used in the Electrical Rules Checking option).
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B Properties: Block Instance — Block Ports O *

Block Block Ports  Block Instance  Block Instance Atributes  Vaul

Number Name Pin Type Net Local To E Add i
1 SUM Input
2 CLK input Delete
3 GND Input
4 out Output
Up
Down

The Up and Down buttons enable the order of the ports to be changed so that they physically change
on the block symbol. These buttons are only enabled if the pin is not connected to a net.

Electrical Rules Checking

All Block Port and Block Pins with Pin types defined are checked using the Electrical Rules
Checking option and Pin Type Rules.

Using an existing Hierarchical Block in the Design

The process for ‘Bottom Up’ design is much the same as Top down but you use existing blocks that
have been saved to the library to build the circuit. Common blocks can be used and reused to create
circuits making the design process much easier.

P To add hierarchical blocks using an Existing Block
4. From the Insert menu, use Insert Block Instance to add a block to the design.

5. Select the Use Existing Block radio button.

Insert Hierarchical Block Instance X

(®) Use Existing Block, Add

Look In: | [l Folders] - | Cancel
Which Blocks:

Matched: 3 of 3

(O Generate Mew Block.

Block Mame: |CharacterLeds {Blocks} v | Pins:

Description: | |

Sumbol: LED_Black (®) From Library Change...
Gererated Spmbaol | Specif..

Instance Mame: Fultiply | rstanced

[ Presiews

6. You can select which folder to looking or select <All Folders> (from the folders defined and
enabled in the Folder dialog).

7. Choose the Block Name: from the drop down listed presented.
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(®) Use Existing Block, Add
Look I |[AII Folders] v| Cancel
Which Blocks:
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(O Generate Mew Block

Block Marme: |[EEEE
Ch.

. aracterleds {Blocks)
Description:  (Full Adder {Blocks}h
Half Adder {Blocks}

[T P Sr | (@) From | ihrary Chanae...

8. With the Preview box checked, a preview of your block will be displayed for verification.

ITEELrIGE Hdle. De FAulbiply Instanced
Preview
a
CHARACTER
LEDS
B2

9. Click the Add button to add the block to your design.
10. The block in your design can now be navigated using the Push and Pop commands.
11. The inserted block can also be modified (the Block shape, number of Block Pins and lower level
Block Ports and the actual circuitry). This can then be updated and resaved.
Creating a Hierarchical Block from an existing Schematic Design

Below is a brief description of when you have an existing Schematic design and want to create a
block from it.

P To create a block file from an existing Schematic

1. From within the open design, in free space, right click and select Save To Block File
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2. From the Save As dialog, choose a block name and press Save.
3. This saved Block will now be available when you select Use Existing Block from within the
Insert block Instance option.
Cutting an existing Schematic Circuit to a block
If you need more space in the design or wish to save a section of the circuit to reuse at another time or
in multiple instanced, you can ‘cut’ a section of a circuit out to a block.
P To create a block from an existing section of circuit
1. From within the open design, from the Edit menu, select the Cut To Block option.

2. With the Cut To Block modal cursor displayed, either draw a frame around the required circuit to
make the selection or right click to display the context menu.

%% Cancel Cut To Block

c3
Frame Select
AI |7 Polygon Select

1auF Chanae Grid 3

| I3

1uF 1uF

3. From the context menu you can choose to make the selection using a Frame Select or Polygon
Select depending on which mode is appropriate to your required selection. You can also Change
Grid to make the selection more accurate.

4. This selection can also be pre-defined and changed using the Frame Select switch setting under
the Options option and Interaction tab. You have the option for Frame Select to Select If
Completely Framed or open selection if left unchecked.

5. Draw your selection around the required circuit.
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6. In the above example you will see that a section of the design will be cut out and pasted to a
lower level block.

7. The block will be created and the appropriate number of Block Pins added to it. Connections
around the cut block can be edited and repositioned.

L by A E

B3T g

0 ¥ CARRY

-c
74508

8. The resultant lower level now looks like this when the block is pushed into:

a d
U2-b
74LS04
U2-a
74LS04
o~ ©

o
IS

A 6 €

Ul-b
741508
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9. There is no repositioning of lower level Block Ports, they are added in exact relative positions
from when cut. However, they are a direct 1:1 relationship with the block pins added to the block
above, this also includes Net Names.

10. You can see that where connections existed, these have been terminated to the upper level using
block ports. The block ports have been automatically named.

11.
12. Block Ports can be suitably repositioned and the Schematic circuit edited.

13. The modified block can then be saved here using Save To Block File. At this point, the block
hasn’t been saved, just simply created.

TF Select Al

[} Auto Select

Paste Ctri+v
g Reposition Design...
Add Page Link

| Save To Block File...
Insert Attribute... Shift+A
B Nacinn me- sae

14. Where the design contains multiple sheets, these will also be saved to the block file.

15. This block is now available to use again using Use Existing Block from the Insert Block
Instance dialog.

Editing a block shape

Once a block is used in the design, its shape can be edited. There are some points to note if doing this:

If the port has no block ports and you use the Regenerate Block Symbol option from the context
menu after adding block ports to the lower level, the shape will be replaced with another
automatically generated block symbol.

The modified shape is saved with the block in the Block Library.

After selecting the block, there are various options available for use from the context menu.

o Sew@

& Lock

¥ Reload Block...
Save To Block File...
Regenerate Block Symbol

Edit Symbal

&

Auto Weld Selection
Add Page Link

& Push Into Block Pgdown
#.  Highlight Selection
Tneart Attrihita Shift - *

Reload Block will reload the block with the one saved in a block file. If a block file has not been
saved for this block then it will not allow you to reload.
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If the Block was Generated when it was added (i.e. it was not read from an existing Block file), then
the block name which was specified at that time, may not exist and the reload will fail. A warning
message is given when this is the case.

Save To Block File will allow the block (and its lower level contents) to be saved to a block file, to
be used at a later date.

Regenerate Block Symbol will automatically generate a new symbol based on the current number of
pins or block ports. If the Edit Symbol option has been used and the shape not saved, then this will be
lost and overwritten with an automatically generated one.

Edit Symbol allows you to edit the current symbol. If you use this you can also save this symbol to
the Doc Symbol library using Save To Library to be used and modified later on. If you save the
Symbol (using Save) from this mode, the block will automatically load this Symbol by name from the
library.

Naming/Renaming blocks

Blocks can be named, and once named, can be renamed. This helps you identify then by their
functionality perhaps, i.e. Memory, PUSE etc. Initially the block can be named by typing its name
when using the Insert Block Instance dialog.

Once in the design, it can be renamed by selecting it and using the Properties dialog and Block tab.
Name is the block instance name, i.e. B1, B2 etc. (the same block can be instanced multiple times),
and Block is the block file name (if multiple instanced, this will be the same block name in all
instances, the Name will change though). You can also add a Description if you wish.

B Properties: Block Instance - Block O X

Block  Block Ports  Block Instance  Block Instance Attributes  Vault

Name: |32 |

[ Block: |B|0c:k1 | Change...
Generated Block

[ Description:

Can be Multiply Instanced

Locked Instance
Locked To Vault

Details from this page can be exported to a report using the Report Maker option.

Changing blocks in the design
On the Properties of a block instance, the Block page has a Change button.

Name: |32 |

[ Block: [Blockt | Change...

Generated Block

Use this button to change the block using a different block file from the block library. You have the
choice whether to replace the symbol or not. The Change Symbol button means that the block can be
changed with or without changing the Symbol that is saved with that block.
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Once OK has been pressed, the Reload Block confirmation dialog is displayed.

Reload Block 'Full Adder' =
FReload Syrmbol Match Fins
Ty bo preserve design net name (®) By Pin Mumber c I

atce
() By Pin Name

Check the Reload Symbol box if you want the top level symbol to be reloaded at the same time.

Check the Try to preserve design net name box if you want net names to be as similar as possible to
the nets in the existing block. This obviously depends on how much the connectivity has changed
within the block.

Working with Multi-Instanced Blocks

A block instance has a Locked Instance property which prevents the contents of the instance from
being edited or changed in any way. This ensures that it remains a copy of the original definition. A
block instance also has a Can be Multiply Instanced property. By enabling this, multiple instances
of the block are locked together. Only one of these instances can be unlocked (Unlock Multi-
Instanced Block) and edited.

391 Main Met n

B4 Reload Block...
Save To Block File... i(
Unlock Multi-Instanced Block

;

Reload From Library... LED=

Save Items To Library...
Edit Symbol In Library...
Edit Block...

& % e

Auto Weld Selection
Add Page Link

Push Into Block Pagdown

L=

They can be brought back into line using Update Multi-Instanced Block. If you unlock one instance
of a block and make edits to it you can throw away these edits to make it the same as the other locked
blocks using the Revert Multi-Instanced Block option from the context menu.
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Use the Update Multi-Instanced Block command from the context menu to cause all multiply
instanced copies of the block to become the same as the unlocked instance (only one unlocked
instance is allowed).

Adding More Pages to the Design

Once the design has been started as a single page, you may need to add new pages as the design
grows, or modularise the design into logical blocks of circuit functionality.

To add new pages to the design, you should use the Insert Page option that is available on the Insert
menu. From this dialog you can name the page that will be added to the design:

Insert Page *

Mame: |Page? | I Ok I

Cancel

Or you can use the right click option within the Design Browser window.

Design Browser ®
Job2022
Floating
Display Dacking
= TOP
+- B CTRL [Controlles
=1 L1 [7 Segment Hide
Pagel
=¥ LDz [7 Segment Open Page
Pagel Close Page
= LD3 [7 S k
E P[ag:lgmen Delete Page
- LD4 [7 Segment Rename Page
+- {4 LS [7 Sedment Move Page Up
+- i LDG [7 Segment
5 % LD7 [7 Segment Move Page Down
+- i LB [7 Segment Mew Page
& Jobz022
B Close
#0 warld Wiew e

Once the new page has been added, while it is still selected, you can rename it.
You may also subsequently use the context menu to Rename or Delete the page.

Any page can be opened for editing, or closed using double-click on its name in the Design Browser.
The new page will not be saved into the design until a Save or Save As has been completed.

The Design Browser is recommended for use if using multiple pages as it will allow you to navigate
through the pages by simply double-clicking on the one required.



Chapter 5 — Schematic Capture Editor 185

Combining Schematic Pages from other Designs

There may be a requirement to work with other engineers who have Pulsonix or another Schematic
capture system, and to combine all the Schematic sheets into one master design to create a single PCB
design.

There are two different methods depending on where the Schematics is taken from.

Adding a Pulsonix Schematic design

If adding an existing Pulsonix design to an already populated Schematic page in another design, you
should use the Copy and Paste options from one to another. To ensure that the complete design is
selected, you should use the Select All option from the context menu (or use the keyboard shortcut
Ctrl-A). For specific areas of circuitry to be copied, use the Frame Select or Polygon Select options
also available on the context menu.

During the Paste, any duplicate Net Names will be highlighted by the Resolve Net Names dialog for
you to resolve. This will allow you to combine net names as required, for power and ground nets, for
example. Any duplicate Component Names will automatically be resolved without warning but will
be incremented, if the name already exists, to the next available in the sequence. Components can be
renamed at a later stage manually or by using the Component Rename option.

If you wish to add the design page to create a new page in the existing Schematic, you should add a
new page first and then Copy and Paste the contents into it. Again, any duplicate net names will need
to be resolved and the Component names will automatically be resolved as before. All Schematic
pages under a design are checked for duplicate net and Component names.

Adding another system's Schematic design

If taking the Schematic Design from another system, you must first import it. In brief (this procedure
is described in more detailed later on in the manual), use the Open option from the File menu. Locate
and select the Schematic design and click OK. The Pulsonix Import filter will automatically detect
the format and import it into Pulsonix. If you are familiar with the Data Transfer Wizard, you can
also use this mechanism for a more guided import approach. Once in Pulsonix, the Schematic will
behave as if it originated in Pulsonix itself.

The procedure then for combining this imported Schematic and the existing Schematic design is as
already discussed above in Adding a Pulsonix Schematic Design.

Building up the Design using Copy and Paste

Now that the design has components, Busses and Connections added it, a fast way of building it up is
to use Copy and Paste or the Duplicate option, to copy sections of circuit to use elsewhere on the
page or other sheets. Cut and Paste can also be used successfully to move sub-circuits to other pages.
Copy and Paste are detailed in an earlier Chapter on General Utilities, but we will deal here with
naming issues when pasting to an existing Schematic design.

Resolving Net Names when using Paste

During a Paste or Duplicate operation, Component and Connector Names are automatically
incremented to use unique names but net names need user interaction to resolve.

The Resolve Net Names dialog shown below is displayed. This allows you to choose the nets that are
to be connected to those already present, and that are to be renamed so that they do not join existing
nets.
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Nets that are unchecked in the list have a Rename applied to them based on the Rename criteria
chosen.

P The resolving net names process

1. The first step is to identify those nets that need to be connected to existing nets. This is done by
‘checking' the names of those nets in the list.

2. To do this, you can either click on each of the checkboxes directly, or use the Select Items filters
to help you quickly select and then check/ uncheck whole groups of nets in one go.

3. The next step is to define the Rename criteria to be applied to the net names left unchecked in the
list.

4.  When you have chosen how you wish the nets to be resolved, press OK and the Paste or
Duplicate operation will continue. The current settings for the Rename criteria will be preserved
and used next time the dialog is displayed.

Using the resolve net names dialog

The Don’t Ask Me Again check box is used to switch off this dialog after making a selection. The
warning can be switched back later on using Options dialog and Warnings.

Net Names shows the net names being duplicated or Pasted that are already in the design. Nets can be
checked/unchecked from this list directly by picking or by using one of the Select Item methods.
Checking them to merge with existing nets, or by leaving them unchecked, the rename criteria is
applied.

Auto Number applies an automatically generated default net name to the unchecked net (or nets).
The number used is the next available in the default net name sequence, e.g. AO could become
N0027, where N0027 is the next unused default net name available in the sequence.

Auto Increment is used to increment the unchecked net name to the next available unused net name
in the sequence, e.g. A0, Al and A2 becomes A3, A4 and AS respectively.

Prefix - this radio button is used to direct the rename to use a predefined prefix at the start of the
existing net name. E.g. C10 becomes ZC10 if the Prefix is set to Z. This Prefix is applied to all
unchecked net names.
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Suffix - this radio button is used to direct the rename to use a predefined suffix at the end of the
existing net name. E.g. A10 becomes A10_B if the Suffix is set to _B. For all the rename types, it will
continue to increment the resulting name until it finds one that does not already exist in the design.
This suffix is applied to all unchecked net names.

Select Items is used to select the net names in the nets column based on selection criteria. Once
selected, use the Check or Uncheck buttons to check or uncheck the selected nets.

All selects all names.
None deselects all names.

Named allows you to type in a name or string with wildcards to make the selection, i.e. A* will select
every name starting with A, e.g. A0, A1 etc. More refined selections can be made by increasing the
characters to filter, e.g. A2*

With Class allows the Net Class associated with the nets in the list to be used as the selection criteria.
This enables you to select nets using Net Classes of Power for example, which in-turn can be checked
for connecting to an existing named nets.

The Check/Uncheck buttons are used to check or uncheck the selected nets in the nets names list.

Using Testpoints
Testpoints are used for a number of reasons on a Schematic design:

® To annotate a theoretical testpoint that an engineer might use on the PCB to ‘probe’ a given
electrical statistic or measurement. This may be on a particular Component pin, or added
separately using a documentation symbol to indicate that a particular net is to be tested. These are
passed through to the PCB design during Translate To PCB. They do not appear in the design’s
net or part lists.

® To define a physical testpoint part on the PCB, that is added as a Component on the Schematic by
the engineer and is again passed through to the PCB design during Translate To PCB. These parts
do appear in the design’s net and part lists.

Pulsonix provides an Insert Testpoint option, on the Insert menu, for adding each of these types of
testpoint. Alternatively you can select a Component pin and use the Change Testpoint option from
the context menu to mark the pin as a testpoint.

Testpoints are Doc Symbols with the property of Testpoint, defined during their creation. See the
Doc Symbols section previously.

» To Insert a Testpoint
1. Click the Insert menu and click Testpoint.

2. Right click to use the context menu to choose whether to Insert Testpoint Part or Insert
Testpoint Doc Symbol.
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3. Use Change Testpoint Symbol from the context menu if a different symbol is required. Note
that if a symbol has not been setup yet, you may enter the Change Symbol dialog automatically.

4. Right click to use Change Name from the context menu to change the default name supplied
(shown on the status bar). The default testpoint name stem is taken from the testpoint Defaults in
the Design Settings dialog.

5. Select an item on the net to be tested. A testpoint part or doc symbol will appear at the end of the
cursor for you to move into the correct position. It is connected to the picked item.

6. Click to drop the testpoint in place and either add another or press the <Esc> key to exit this
mode.

Doc Symbol Testpoints (not Parts) translate to the PCB design as floating test lands (PCB Doc
symbols) ready for the PCB designer to place in appropriate positions on the net to be easily probed.
The point of adding these to the schematic is to indicate to the PCB designer the nets need to be
probed.

Testpoints added directly to a Schematic symbol pin are translated into the PCB design. These are
added automatically to the corresponding pad of the Component. The pad is made into a testpoint (as
you would if you selected the pad and used Properties,| Testpoint to add it).

Adding Shapes

Within the Schematic design, shapes are sometimes required. You can use the Insert Shape option
from the Insert menu to add documentation shapes. These shapes can be Open or Closed, Filled or
Unfilled and Hatched or not. You can also change the Style of the line (when using non-filled
shapes) to be dotted or dashed in appearance.

The default shape used when adding documentation shapes is taken from the Design Settings and
Defaults dialog. As well as the Line Style of the shape, the Hatch Style can also be defined provided
the Closed, Filled and Hatched check boxes are selected.

Once a shape has been added to the design, you are able to use the Insert Cutout option to cut shapes
out of the existing shape.

» To add documentation shapes
1. Click on the Insert menu, click Shape
2. Draw the shape onto the design using a single click to insert corners.
3. Atany time you can use the context menu to change options of the shape, e.g. Style, Closed etc.
4

While inserting the shape or editing it, you can also select Common To All Pages from the
context menu. This will put the shape onto all pages within the current design, e.g. if it represents
a page border.
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Use of Attributes in Schematic Capture
This section details specific attributes associated with Schematic Capture. The general process of
adding attributes has already been covered in the Chapter under Setting Up The Design.
Displaying Attributes

All attribute names in the design are available in the Colours dialog. These can be set to be Displayed,
Selectable and to have their individual colours changed. All system attributes are shown in brackets
e.g. <Component Name>, <Date> and user defined attributes shown without brackets e.g. Cost.

B Colours - Attributes

shapes Name Displayed | Selectable | True Width| Colour

<Block Author=

Connect Points

<Current WWariant Description=
<Current Variant=
«[atabase Field=

ol o ol

Text- <Block Description= [] [] [~

% Attributes <Block Instance Name= [~ 7] [~]
Highlights <Block Name= [] [ ]
Others <Block Original Name= [~ [] ]
Nets <Branch Point Name= ] ] [
Differential Pairs <Component Height= k] /] ]
Signal Paths ECORRET: Name> Z z Z
Sub Nets <Component Variant Id= i : :

e e e

System Attributes

There are a number of system attributes that present themselves in the design as part of Components
and Nets and other used design items. Attributes such as Component Name, Gate Modifier, Part
Name, Part Description, Net Name etc. are used throughout.

There are some attributes that can be used to add design-level information that changes dynamically
as the design is updated. For example, Date, Last Save Date/Time and Design Author are a
selection of the available design-level attributes.

User Defined Attributes

New attributes can be added to any design item within Pulsonix. These user defined attributes can be
extracted using the Report Maker output. In Schematics, attributes would generally be used for
showing Costs, Preferred Manufacturer, or simulation parameters such as Model Name etc.

Attributes on components that have their attribute names marked as being 'both' design types (PCB
and Schematic) will be copied to the corresponding PCB Component when Translate To PCB is used.

Translating the Schematic to PCB

The final process before starting on the PCB design itself is to translate the Schematic design into the
PCB design environment.

With the concurrent checking and procedures that Pulsonix Schematics adheres to, by the time you
translate to PCB there should be very few warnings or errors to resolve before the design is
acceptable to start design the PCB with.

Before starting this process, you should check that there are no components in the Component Bin
that should be translated. Any components in the Bin are not translated unless part of a multi-gated
device already used in the Schematic.

When you are in a position that you wish to go-ahead with this transition, you should use the
Translate To PCB option from the Tools menu.
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This dialog provides you with the option to name the new PCB Design although a default name
matching the Schematic design name is provided. If you decide to use this, it will make it easier later
on when you use the Synchronise Design option, or Cross Probing, as both options use the same
Schematic and PCB Schematic design names as default.

The Technology box allows you to choose a PCB Technology file to use. The technology defines the
layers, power planes, pad styles, track styles, etc.

The Profile box allows you to choose a PCB Profile file to use. This will give you a jump-start,
because you can have your board outline and other general annotation predefined. You can also have
critical components pre-placed in the profile, e.g. edge connectors.

Check the Unplaced components to bin option if you want to use the Component Bin, otherwise
components are stacked in the design area or around the board outline if one is available.

You can opt to Show Bin if you have selected the option to place unplaced Components into the bin
and wish it to open automatically to view its contents.

Libraries

Parts from the Parts library have already been used in the Schematic design, these will have the
corresponding PCB Footprint symbol associated with them. When the translate process begins, the
Parts used in the Schematic are extracted and used in the PCB design along with its footprint.

If any Part used has more than one entry in any other Parts library within the Libraries search path,
the first entry found will be used.

The Path for the libraries is defined in the Folder option located on the Settings menu.

Doc Symbols

During the Translate To PCB process doc Symbols are not translated. These are retained in the
Schematic design for documentation purposes only.

Predefined Signals

Normally, you would not display all the Power and Ground pins on gates in your Schematic. Instead
these are added as Net names on the appropriate pins within the Parts in the Parts library. These
Power pins will be automatically connected when the Schematic is translated to PCB. Predefined net
names on pins that are not on a gate in the Schematic will not be added when translate to PCB is
performed.

PCB Footprint Selection

You may edit the footprint name on a Component in the Schematic, or leave it blank to use the default
on from the Part definition. Translate to PCB will try to use the supplied name, but will use the
default name if it cannot find it.
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Interpreting messages during Translation
There are three types of messages displayed during Translate To PCB:

® [nformation
®  Warnings

® Errors

Information in the report will inform you of what has been completed and whether it is successful or
not. It will also provide you with other related information such as the time and date translated, the
file name, folder etc. This may be required for any quality procedures or audit trails.

Warnings are non-fatal messages that inform you of automatic changes that the program has done
during the translation. All warnings should be read and noted. You may wish to correct warnings
before continuing with the PCB design. Any corrected design should be re-translated to use the
corrections. The warnings could also be for items, such as Attributes or Net Classes that exist in the
Schematic design but not in the PCB Technology File. These are automatically passed through and
added to the PCB design. The warning will inform you that they've been added and to check and edit
them in the PCB design.

Errors are displayed where the program finds illegal data. For example, a Part used in a Schematic
that no longer exists in the library because it has been removed, renamed or not available from the
folders path defined. All errors must be checked and corrected to ensure the full integrity of the PCB
design against the Schematic.

Once any corrections have been made to the Schematic, the translation process must be undertaken
again. On any subsequent translation, ensure that all warnings and errors are verified and if necessary,
resolved.

Exporting Netlists

From Pulsonix you can output a netlist from your Schematic design in ASCII format specific to other
systems using the Export Netlist option located on the File menu.

During the output, a netlist is collated and written in a PCB format suitable for import into other
system's PCB design editor. This means the netlist contains unique Component names and net names
that are fully resolved with all associated names connected e.g. power and ground and busses etc.

The netlist is written in an ASCII format, in the format of the target system that you choose from the
drop down list box.

Export Pcb Metlist %
Metlist Format | Orcad PCE Il Metlist >
Metlist
Design?. net Browsze. ..

] Neutral Met Names
[ Meutral Part Marmes
|Use Part Mapping
Design?.map

Create... Browse. .. Edit...

Carcel
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The export list is not exhaustive but does cover all of the commonly used and widely accepted file
formats.

The netlist required for export should be chosen from the drop down list available under Netlist
Format. By default, the netlist will be written to same location as the design, use the Browse button
to change this location.

Dialog Options

Options on this dialog allow you to create a file with Neutral Net Names or Part Names. If you are
sending the file to an external company, this will help you to preserve your IP.

Using Part Mapping Files

If using the Pulsonix Schematics system and another vendors PCB system, you may find that the Part
names used in Pulsonix are different to that in the other system. Instead of editing the Parts in one of
the libraries to match, you have the ability in Pulsonix to use a mapping file. This mapping file is
generated automatically and contains the Pulsonix Part name and Footprint name, and mapped
equivalents that would be used in the other system.

Exporting Spice Netlists

As well as the Pulsonix-Spice option, you can also export Schematic designs in Spice netlist format.

Most of the integrated simulation features available in Pulsonix are specifically designed for use with
the Pulsonix-Spice simulator. For example, Random Probing, Bias Annotation and Multi-Step
Analysis. If you do not have this simulator, you can still prepare components for Spice output and add
circuit stimuli and fixed probes, and generate a Spice netlist.

To set the Spice Netlist Type

Before running a Spice netlist, you must choose the type to export to, each one has its own ‘flavour’
of Spice. Select the Set Netlist Spice Type from the Simulation menu in Schematics.

First choose the Spice Netlist Type from drop down list for the simulation file. The simulator
commands in the netlist file will be formatted to suit the chosen simulator.

Set Netlist Spice Type *

Spice Metlist Type: | LTspice R |

B asic Spice

Run Simulator | PSpice
Fulzonix-Spice

Frogram: Browse. ..
|

Command-ine switches:

Befare the output file: |-big

Reset...

After the output file: |

Cancel
If available, you can choose to use the Run Simulator check box to specify whether you can directly
run a simulator as well as producing the Spice netlist.

Use the Browse button to locate the program to be run on your computer. Where possible we have
added filters to this dialog to suggest a possible simulator program name.
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Add any command line switches that are needed to run up the simulator, either before or after the
output filename. Initially these will be set to default values for each simulator type. If you change
them you can use the Reset button to revert back to the default values.

Press OK to accept the change. If Run Simulator is checked you will be able to use the Simulate
Design option to pass your Spice netlist directly to your simulator.

Outputting a Spice Netlist

To generate a Spice netlist in the format you have chosen, If the Program has been previously set up,
use the Run Simulation option from the Simulator menu. If this has not been set up, you have to use
the Create Spice Netlist File> (from the Simulator menu), then choose one of the page options and
the location using the Save As dialog.

Reverse Engineer

From within a PCB design, it is possible to take your PCB and reverse engineer it back to create a
new Schematic design. Other than the PCB option to initiate the Reverse Engineer, all the
functionality of this option is within the Schematic editor. In PCB, the Reverse Engineer dialog on
the Tools menu allows you various options and selections to be made when the option is run.

Reverse Engineer x

Design: | DesignkB |

Techhalagy: |Default [white]

Profile File: |[None]

T ake Parts From Library
Position Components:

() &)l Companents Ta Bin
Tools| Qutput Window Help

Show Bin
]‘;5 Design Rule Check...
o . . (®) Place Components to batch PCB
g Synchronise Designs...
v . .

@ Reverse Engineer... | S T E 7] EMEISERD
&, Design Revision Analyser... (O Autaplace Companents

Opfimise Nets 4

Route Connections
Auto Router 4

Components can be added to the Component Bin in the Schematic design. The bin is divided

between unused and used gates; you should place all the used gates onto the Schematic pages to
complete the design.

Component Bin x

C1

-- U1 - SN74AC00D
Gate b - TI-155
Gate c - TI-155
Gate d - TI-155

Used Items:

C]-c

-- U1 - SN74AC000
Gate a - TI-155
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Components in the PCB design that are flagged as PCB Only Parts are not reverse engineered. If you
wish to reverse engineer Components, they need to be edited in the Part editor and Schematic
symbols added, then use the Reload option to reload those updated Parts to the design. After this you
can use the Reverse Engineer successfully.

For components that don’t have a Parts library entry (because they came from an external source for
example), these components will be reverse engineered but the Schematic Symbols will be
automatically created for you. The shapes of these Symbols will be generic boxes and not the real
shapes.

Schematic Routing
When the All Components to bin check box is not selected, components are placed in the design
using their relative PCB design positions and using suitable placement spacing (or Autoplaced using
the other radio box selection).

() &l Companents Ta Bin

Show Bin
(®) Place Components to Match PCB
Spread Out: E % arid steps

() Awtoplace Components

Boute Connections

Having the All Components to bin check box unchecked enables you to also select the Route
Connections check box. Once the design has been placed in the Schematic the connections can be
automatically routed using the Schematic connection router.

Printing and Plotting the Schematic Design

When you wish to obtain a hard copy of your design, there is a choice of two methods for outputting
prints and plots from Pulsonix:

®  The Print option from the File menu that will print the current design exactly as it appears on the
screen. It will output to the selected Windows printer and will be automatically fitted to the paper
size.

® The CAM Plot option from the Output menu to Print or Plot a user defined output to a selected
device using defined parameters. This allows you to also choose not to include some design item
types. Using this method, Pulsonix plots everything in the design on a per page basis unless
excluded from a plot. The control over the size, scale, position and contents can be defined using
the tools provided.

Using the Print Option

The print option is a quick and easy method of generating a print of the Schematic using your default
Windows printer.

When selected from the File menu, the Windows printer dialog is displayed.
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Print X

Printer

Mame: Brother HL-L52000%W series Prin
Paper Size: |44, 210 % 297 mm

Orientation: [Portrait Frint Setup...

IRt Tl [ &0 Colours Black. Auto Rotate

(®) Whole Design ToFit
O Curent Yiew Scale: |1.000000
Selection
O Aleages Close

From this dialog you can select the number of copies to be made and select the print range.

This dialog also gives you access to more advanced printer specific options allowing you to change
settings such as Colour/Black & White, paper size and orientation of the print. You can also force the
print to All Colours Black and the Print Contents.

If a more specific and consistent print is required, independent of the screen view, the CAM/Plot
option on the Output menu should be used.

The CAM/Plot option is a fully configurable single 'shot' output mechanism that allow you the full
flexibility to output the plot(s) required.

Using the CAM/Plot option
The CAM/Plot output option is available on the Output menu.

The CAM/Plot set up parameters are defined in the Technology, if they are not available the first time
you try and enter this option (or the first time you enter the Technology and CAM/Plot tab) you are
presented with a dialog to request auto-generation of the parameters.

Pulsonix

o Mo CAM Plots are currently defined,

would you like to generate some plots now?

Yes Mo

If you click No to this, the CAM/Plot mode is entered ready for you to create the parameters
interactively. If you click Yes, the Auto Generate CAM/Plots dialog is displayed:

Auto Generate CAM/Plots X

A default zet of Cak/Plots will be generated bazed on the
current contents of pour design and the zelections you
make in thiz dialog. Any existing Cak Plots can alzo be

deleted befare the new set is created. Cancel

For each Page: FDF| ~

Gerber

[] Delete Existing Plats First HP-GL Penplat
indows

POF /&
Format File
Mothing
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From this, you can select the default plot mode for each page or block of your design.

Once in the CAM/Plot dialog, you can select other print or plot types for any page. You can also opt
to have a Windows and Pen Plotter output for each page if required. As well as defining plots or
prints, you can also output reports from the format files created.

Overview of the CAM/Plot dialog

The dialog itself is split into three sections with a panel at the base of the dialog used to run the plots.
This panel is available during the use of all three dialogs.

¥ Generate Plot - CAM Plots

CAM Flots  Plot Settings ~ Plot Preview
Name Enabled | Device | Process | Scale Rotate Mirror Position Area
Page1 [] PDF Page1 Auto Fit : Auto Rotate ] Auto Shift <Design Ext
B1:Page [] POF B1:Pagel1 :Auto Fit :Auto Rotate ] Auto Shift <Design Exte
B2:Page1 [] PDF BZ:Pagel Auto Fit :Auto Rotate ] Auto Shift <Design Exte
B3:Pagei [] PDF B3:Pagel iAuto Fit :Auto Rotate ] Aute Shift <Design Exte

Plot Preview is used to display a preview of the final plot. This should provide you with an idea of
what the plot will look like before it is plotted or printed.

CAM Plots is used to set up the characteristics of the plot, the scale, rotation, plot type etc.

Plot Settings is used to set up the plotter or printer. This dialog also contains a location for the
destination of the plot output if a file is being output.

Run is used to start any plots that are enabled and to save the current settings. Cancel is used to exit
this dialog and Apply is used to save the current settings but not run the plot. The Close button is
displayed instead of Cancel once the Apply button has been pressed, this closes the dialog also.

Plot Preview

The Plot Preview dialog allows you to select the page required to preview.

B Generate Plot - Plot Preview

CAM Flots  Plot Settings  Plot Preview

Outputs To Be Generated Preview Design Position of plot /output on paper/table

Fits |Enabled (Plot Name

Ves Pagel

\\\ e
T T Iﬁ F
.
. I — I
- -~
e -
— \\ r/ -
- -
Flot  Pagel To [POF e -
Fits Yes Style:  |rtwork \\_>{,r-/
Position: [futo Shift Scale:  [1.000000 e “s.\ I
-
Width: [11.7718+" Mimored: [No /’ \.g_\
Height: [B.2795+" Rotated: [No // >
4 — .
Registration Poirt: [Auto Shift /_,/ "_’:ﬁ:
Plotting Area Width: [11.7118+" /,/ " -
Floiting Avea Height:[8.2795+" i 1 |
- .
£ ne 1

Apply Help
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The page is represented using a Plot Name defined on the CAM Plots dialog; this also helps identify
the type of plot being output if a sensible name is used. The Enable check boxes will allow you to
select which plots will be output when the Run button is pressed. This means you can opt to run all
plots required in one single button press regardless of the plot type or even if mixing plot types.

The Fits column will display an X if the plot does not fit the paper. Most times you will be able to see
if the plot will fit but if marginal, this acts as positive confirmation that it will or won't fit.

The preview window displays the plot selected in the list. It shows two main boxes (shown with a
'cross' in each to help identify the centre). The first is the plot bed (the paper extents or the bed size),
this is the large box shown in Red. The second is the design extents shown in Blue. Also shown are
elements of the design to give you an indication of the orientation and the scale relative the paper.
The preview window can be switched off by deselecting the Preview Design check box.

All other information shown in this dialog is confirmation of the CAM Plots dialog settings.

CAM Plots

The CAM Plots dialog is used to set up the plot for output and how the plot will appear relative to the
paper being used.

If a standard plot is required, the plot can be almost completely defined used the Auto Generate dialog
when you first enter the option. The only setting you may need to adjust is the plotter type for
Windows or Pen Plotter or the Exclusion of items not required in the plot.

The grid matrix displays the options selected for each plot. Each of these can be edited interactively
or by using the Plot Wizard once a row or item on a row is selected. The Plot Wizard is enabled once
the row is selected by clicking on the Edit button.

If no plots exist or you require a new plot, you can use the New button that will use the Plot Wizard
to complete this task. This will lead you through the plot type generation process to create a new line
in the plots table. If you have a plot selected, New copies the properties of this plot into the Plot
Wizard.

B Generate Plot - CAM Plots O X

CAM Plots  Plot Settings  Plot Preview

Name

|Enabled Device | Process | Scale Rotate Mirror | Position Area Step Repeat | Exclusions Mew...

Page1

PDF Page1 Auto Fit { Auto Rotate |:| Auto Shift <Design Ext |:| Y

Auto Gen...

Report..

The Edit button displays the first page of the Plot Wizard. Each of the pages of the plot wizard will
allow you to set up facets of the plot to be output. See later on in this section for an overview of the
Plot Wizard.

The Delete button is used to remove any unwanted plots from the grid.
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Add To Plot is used to combine plots and is more relevant to the PCB Design editor. When selected,
it displays the Process page of the Plot Wizard from where to choose a process to add to the plot
selected. The Add To Plot option will add the plot to any other plot selected. If it gets added to the
wrong plot by mistake, select it, and use the Delete button to remove it.

If when you started this option, you clicked No to Auto Generate the plot type, you may now use the
Auto Generate option to create a set of plots ready for use. This can be an alternative to using the
New plot option.

The Reports button is used to generate a summary report listing the plots and their settings, in case
you need to keep this for future reference. This is in addition to any reports generated at the time of
actually running the plots.

Step & Repeat is used to create ‘panelled’ designs. See the later section in this chapter on Step &
Repeat.

Using the Plot Wizard

The Process page defines the Name of the plot and the Schematic Page to be output. The plot name is
for reference only to identify the plot and if left blank will be automatically completed using the Page
name.

The Output selection is used to define the device used for the plot. In Schematics this will be
Windows, Gerber, Format file, HP-GL Pen Plot or Nothing. Nothing would be selected if the plot
type was undetermined at that time.

CAM Plot Wizard - New Plot *
Start -
= Choose a name for this plot and choose the type of
p! P
M Process output
OQutput Define the name which will be used to identify this plot in dialogs and reports.
. Also choose the type of output.
Size
Design Position Demes |PlDﬂ |
W Finish Plot Group: |Wind0ws w |
Flot String: | |
Qutput To: |Windows w |
Printer Name: |cDefau|t Printer: w |

The Style of the plot can be either Artwork or OQutline. Artwork will give you the true width of all
items whereas Outline will only output the item as a centreline unfilled shape.

Size

Design Position

-’ Finish

Process: Pagel - Exclude ltems...

Has Excluded tems

Style: Artwarke -
Mimar:
The Mirror check box enables you to select whether the plot is mirrored or not.

If output to Format File has been selected, you can choose a format file form the drop down list
presented.
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B Design Pasition Dancs Plat1
M-’ Finish Plot Group: -
Qutput To: Format File -
Format File: Parts List Csv.rff [in "Ch\Users'..\Formats"]

Parts List C5V Output

Qutput Location: CAM Plots Folder -

From this page you can also select which items to Exclude from the plot. If nothing is selected in this
dialog, all items visible in the design are plotted.

B Exclude Items from Plot *

Choose from: MOT tobe PLOTTED

Bitmap Al addss |[Fin
Buz = Aftribute: <Fin MName:
Connection << Delete W

Doc 5 haie

Testpoint
Text

Text Callout
Altribute: <Block Authar Reset
Aftribute: <Block Description: -
Altribute: <Block Instance Mame:
Altribute: <Block MName>
Attribute: <Block Original Mame»
Attribute: <Branch Point Mame:
Aftribute: <Component Height >

Attribute: <Component MName::

Attribute: <Caornponent V ariant |dx

Attribute: <Current Variant Descriptions
Attribute: < Current W ariank:

Altribute: <D atabase Field:

Aftribute: <D atabaze Key:

Altribute; <D atabase Status>

Altribute: <D atabase Table> ]

Cancel

The Size page uses selections to define the Scale and Rotation of the plot. For Scale, the choice on
the drop down list is Auto Fit and 1.00 (a scale of 1:1). You can also type in your own scale choice.
The Rotation drop down list allows you the choice of Auto Rotate, No Rotation or Rotate 90
degrees (forcing the rotation to 90 degree from its original position).

W Uesign rosion

M-’ Finish

Scale 1.000 [~

Rotate: Mo Rotation -

The Design Position page defines the position of the plot relative to the plotter type being used.

The Design Position provides a number of options from where to move the design on the plot. The
design location specified here is aligned with the location on the paper or plotter table specified in the
Device Registration Point. This is set in the Settings tab of the Qutput dialog. This allows accurate
and repeatable registration of plots to be achieved if the correct combination of values is chosen.

LT3Ny 1 udiaun

M-’ Finish

Design Posttion: Centre |L]

Area: <Design Exents> R

Step & Repeat [

For example, if both Position and Device Registration are set to Origin, the design origin is aligned
with the origin (0,0) on the plotter.
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If either the Position specified here or the Device Registration Point are set to Auto Shift, then the
plot is positioned as best as possible on the output device.

The Step & Repeat button indicates that the plot can be duplicated on the same sheet. This must be
used in conjunction with the Step & Repeat option on the main CAM Plot dialog.

The Finish page provides you with a summary of the options selected in the Plot Wizard. Once the
Finish button is pressed, the plot type is generated and added to the plot grid.

Plot Settings

The Plot Settings page is used to set up the printer, plotter or output device, such as Windows or
PDF and the location of the files output.

B Generate Plot - Plot Settings O x

CAM Plots  Flot Settings  Plot Preview

Qutput Device: Folder For Output Files:
PDF - B |This Folder below design file: ~
- - 3
New Delete | %{PlotDevice)
Save To File... | |Load From File... Browse
Cutput File Names Template:
PDF
Registration Point: Centre |S[DesignName}S[PRE}Sll‘u"ariard}S[PRE}[S[PID{Name}}S[POS'I'} 3

Additional Print Margin: 10.000 mm

Colour Style: Colour - Background is White
Combined Plots: Yes

View PDF after Generation: Yes [ Change Output File Name:
Embed Fonts in PDF File: Yes
Bookmarks: Yes

Component Details: Yes

Block Details: Yes
Symbol Details: Yes Plot Repart Create A Report

Eﬁihri:toN@;ceI;:: :ZZ View When Run (@) Save With Output Files
[ Append To Existing () Save To Reports Folder

From the Output Device section of the dialog, you can view and change the settings for each kind of
output device available. Use the drop-down list to choose the output device you wish to look at, and
the current settings will be displayed in the large text area below.

If you need to change any of these settings, press the Setup button to access the Setup dialog for the
output device. The actual dialog that is displayed is different for each kind of output device
(Windows, HP-GL Pen etc.).

The Folder For Output Files section defines where the output files are written. You can choose from
three different settings by selecting from the drop-down list.

Design Folder: output files will be written to the same folder as the design file.

This Folder: you specify the folder where all output files are written. The same folder will be used
for all output files generated.

This Folder below design file: you specify a folder name that will be appended to the folder in which
the design is stored. For example, if your design is stored in "C:\My Projects\Board 6\Revision
2.pcb", you can set the output folder name to "Plots" and all the output files will be written to the
folder called "C:\My Projects\Board 6\Plots".

File Names Based On
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This section allows you to choose the way your output files are named. You can choose from three
different settings by selecting from the drop-down list.

Design Name: output file names will be based on the name of the design. A number will be added to
the end of the name to generate a unique name for each file generated in any one plot "run".

Plot Name: the output file name will be derived from the Layer/Span/Page name of the plot. For
example, a plot file that is generated by processing Layers will be named according to the layer name
being plotted.

Design Name + Plot Name: plot files will be written to a file using the design name followed by the
plot name (in brackets) and using the default extension for the type of plot. e.g. "MyDesign (Top
Electrical).hp"

Change Output File Name

Use this if you want all output files to be based on a specified name. A number will be added to the
end of the name to generate a unique name for each file generated in any one plot "run". If you leave
the file extension off, the default extension for the type of plot being generated will be added. If you
just type a file name with no directory, the mentioned above folder will be used.

Leave unchecked to use the above mentioned default plot file name.
Plot Report
Create a report use this switch to elect whether to write the CAM Plot report or not.

View When Run: You can choose whether the plot report that is written at the end of each run will
be displayed on the screen after it has been generated.

Append To Existing: The plot report will normally be overwritten each time press Run. Check this
option to append (add) to any existing report, instead of overwriting. You will then need to scroll to
the end of the report to view information about the latest plot.

Save With Output Files: Use this to direct the plot report to be saved with the output files.

Save To Reports Folder: Use this to direct the plot report to the reports folder.

Outputting a plot

Once the Auto Generate dialog has been used, the bulk of the work to create a plot has been done
apart from 'fine tuning'. The Auto Generate dialog has been designed so that any rotation, any scale
plot to fit the page will be specified by default. This means the plot will fit the paper if the Run button
is pressed. Obviously, you can use the CAM Plot dialog to redefine the plot as required.

Check that the plot is as required using the Preview dialog, and press Run.

Printing to Active PDF

The plot to PDF output is used to write PDF format file with active annotation. Once the PDF file is
created, you can hover your cursor over design items and properties of that item will be displayed.

In a Schematic design, all pages in the design and hierarchy are plotted (including lower level
hierarchical blocks).

Writing the PDF files

Within the CAM Plot option, the PDF output is additional to the standard Windows driver and you do
not need to install a separate driver for it. If you have a PDF Windows driver already installed, you
can still use it. The Pulsonix PDF driver has the added ability of the active annotation which your
standard PDF output will not have.
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The PDF output is accessed through the CAM Plot dialog and New or Edit when you create a plot.
Simply select PDF from the drop down list of available output types.

CAM Plot Wizard - New Plot

X
W Start .
Choose a name for this plot and choose the type of
M Process output
W Output Define the name which will be used to identify this plot in dialogs and reports.
. AMso choose the type of output.
Size
Design Position flame |P|°ﬂ |
M- Finish Plot Group:  [PDF v
Qutput To: [PDF] v
Format File
Gerber
HP-GL Penplot

MNathin:
PDF/A |
Windows

Once the PDF file has been created and it is open, you can hover your cursor over design items, such

as Components or connections. A small context menu is displayed from which you can view entities
of the item chosen.

Using the PDF file once created

P—

—] T““MF
R0

Component: 4

—% Attributes: <Footprint Mame »=R0805

Yalue=470
Bin_MNo=xBZ341

Manufacturer=Farnell

WWatbage=0.125

Tolerance=1%

] o

4
—L
]
—
i Obsolete=Mo
m
i {sece -
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Setting up the PDF output
You can configure the PDF output using the device Setup option from within the CAM Plot dialog.

CAM Plots = Plot Settings | Plot Preview

Output Device:
FDF] v [ sew
New... Delete
Save To File... | |Load From File...
PDF

Registration Point: Auto Shift

Colour Style: Black & White - Background is White
Combine All Plots: Separately

View PDF after Generation: Yes

Embed Fonts in PDF File: Yes

Bookmarks: Yes

Component Details: Yes

Block Details: Yes

Symbol Detalls: Yes

Fush Into Block: Yes

Link Met Names: Yes

Flot and Combine Schematic and PCE Flots:No

Folder For Output Files:

This Folder below design file:
%(PlotDevice)

[]Pack output files into a ZIP

Remove individual files afte

Output File Names Template:

%(Variant)3(P RENS{Plot Name)

[]Change Output File Name

Plot Report
[ View When Run [ON
[JAppend To Existing ()¢

Include In ZIP

Setup PDF Qutput X
Output Area
Units:
[[] Define Qutput Area Cancel

Registration Point

Auto Shift ~ 0.000 0.000

Print Margin Print Across Multiple Pages
0.000 o
Options

Colour Style: |Black & White  ~
Combine Plots: | Separately ~

Background is White
View PDF after Generation
Embed Forts in PDF file
Bookmarks
Component Details
Block Details
Symbol Details
Push Into Block
Link Met Names
Plot and Combine Schematic and PCB

Run Close Apply Help
4

Two settings are of note for Schematic plots; the first is for combining or not combining plots. By
selecting your requirements in Combine Plots, you can export invidual plots for each Schematic
page. This setting allows All plots to one PDF document and plot Groups as well as Separately.

The second setting to note is for combining both the Schematic design pages and the PCB design to

one PDF plot file.

When running a combined plot, the program will either use the same name as the ‘other’ plot or will
use the design name defined in the Design Settings, Synchronise, Synchronise Design Name

option.
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Chapter 6. PCB Design Editor

Getting Started with the Design

There are a number of ways to start a new PCB layout. The way in which you start will depend on,
whether you have a Pulsonix Schematic design, a netlist or a sheet of paper with a Schematics design
on it.

® Using Pulsonix Schematic Capture as the 'front-end' to the PCB system. The nets and components
are translated to PCB in the integrated environment.

® Using a netlist that is derived from another CAE or Schematic system.

® Using the Pulsonix PCB design editor interactively creating the design on the fly. This means
without an initial netlist just adding connections and components as you design the PCB.

This chapter will guide you through the different options that will enable you to build up the design in

the order that you naturally progress the layout with.

Starting a New PCB Layout with Default Files

Regardless of where you start the PCB design from, you are required to provide basic information at
the starting point. This would normally be the name of the Technology file and the Profile file you
may wish to use, both of these files are optional and can be loaded at a later stage if required.

Obviously, how you start the PCB layout will be determined by how you intend entering the
Component lists and netlist.

For the process of this discussion all methods will be explored but we start with the New PCB design.

P To start a new PCB layout
1. Click the File menu and click New.

MNew

Designs | Technologies + Profiles  Wizards

[ o ]
Schematic Design
Sem Hierarchy Block
['q pc Footprint
Bl Pc Doc symbol
Schematic Symbol
Schematic Doc Symbal
=g Fart

Panel Design

Technology: |4 Layer (White) ~ |

Profle Fle: [ [None] v]

[]5et Units: Imperial: |thou Metric: | mm

1 -
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2. Click PCB Design

3. You will also be able to select the name of a Technology file in the drop down list box. There are
a number of choices available as supplied with Pulsonix, each of which represents a different
type of design technology, e.g. Double Sided, 4 Layer, etc. If the Technology file required does
not match one of these you can select [None] from the list.

If you are unfamiliar with this style of drop down list, select the small arrow on the right hand side of
the technology file name and then click on one of the names presented to select it.

4. You can also select the name of a Profile File from the drop down list box. The Profile file can
contain your board outline or drawing blank etc. If you do not require a profile file or wish to add
one later, select [None] from the list.

5. The Set Units check box enables you specifically select the units for your new PCB design. This
overrides the Technology file units and will be subsequently used in the design. Choose from
Imperial or Metric and select the precision required.

6. Click OK to start a new PCB design session.

The PCB editor is now ready with a Technology file loaded and optionally, a Profile ready for use.
From here you may add a netlist (from another non-integrated system) using one of the supported

netlist formats. Alternatively, you may wish to create the design on-the-fly adding Connections or
Tracks and components directly.

At any point, you can load a full or partial Technology file, and load a Profile file. Partial Technology
files enable you to mix and match technologies or to create Technology files of individual
technologies, such as layer stacks or Spacing classes for SMD, BGA designs etc.

Later on in this chapter, methods for using the Translate from Pulsonix Schematics and using a netlist
are discussed in more detail.

Design Setup for PCB Layout

Before getting started in the design itself, you should check that when you start adding design items,
the design editor will behave as you expect or require it to.

Many of the characteristics of design items are set up in the Design Settings dialog and in particular
on the General, Defaults and Naming tabs.

The Defaults pages set up the Layers, Styles, Testpoints and other feature options used when adding
new items to the design. Access these pages through the General/Defaults page and Edit Defaults
button.
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Side: | Bottom

Name Layer: |F’in Names

Name Style: |TextSiyie35.0-3.0

Neme Stem

Testpoint Type:

O Part Name: |Testp0int

(®) Doc Sym Narne:|Star Paint (25}

() Free Pad  Style: |PadSty|e1

OVia Style: | PadStyle1

Unless an item is pre-selected, the default style defined in this dialog is used. If a similar item is pre-
selected, inserting a new item of the same type will inherit the Layers and style of the selected item.

The Naming page contains very specific information regarding the characteristics of design items,
items such as the leading character or symbol used for the default system net names, e.g. whether
$001 or NOOOL1 is used (or another leading character). Pulsonix uses $ as its default leading character.

Force To Upper Case
Component Names
[ Gate Names

[ Net Names

[ Part Names

[ Pin Names

[ Test Paint Names

Default Net Names
Name Stem:

Number Width:

MName Options

Case Sensttive Pin Names

[ Numeric Gate Names

[ Case Sensttive Dl Size ldents

Name Ranges

Range Start: D
Range End: EI

Range Separator: I:‘

tem Separatar: I:‘

Example: 1J1,U[3-6]

Fin Names

Component to Pin
Name Separator: l:l

This dialog is set with built-in settings and should only be changed if you understand what they do.
Some of the settings can only be changed before a design is started, where there are no design items
in the design. Some items can be changed after the design is started but the system updates itself to
adjust all the design items that already used these settings, e.g. Default Net Name stem.
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Segment Mode: 5 Angled ~| [ Apply Seq Mode to Tail

Interactive Mire/Fillst

Sige: [ Any Angle

Show Can Finish’ and "Has Loop’ Markers

Show Legal Completion Path
[ Always Mark Net being edited

[ Clear Mark when edit complete
Show Connection to Nearest Node
Show Dynamic Connections Only
[ Optimise After Edit
[]Mext Layer - Use Bias

Double Click Operation

(®) Complete Track
() Finish Here

() Finish On Via
() Swap Layer

Track Pushing

Spring Back ] Push Vias
[ Pull Tight Flough
Auto Comect Track

Mitre: Resutt

Auto Necking
Auto Neck
Pad Auto Neck

[ Auto Comer
2.5400

Remove Loops
Auto Share Tracks
Allow Nets to be Joined
] End On Via - Adds Protected Via
[ Use Style From Picked Track
[N 0bstacle Avoid
[ Auto Finish
Change Layer - Retum To Previous Layer

Add a Differential Pair Track Using:

(O Single Track Mode
(®) Mimror Mode
(O Pairing Start Mode

Sketch Track

[ Use Paint To Point Mode
[ Use Grid When Sketching

Mitre: Resut
[ Use Any Layer

Track Hugging
Always Uses Minimum Gap
Hug Method: () Shielding

(®) Routing () Gridded

Area Based Styles

(®) Stop at Border Until Clicked
() Automatically Change Style at Border
(O)Change Style at First Comer

Setting up a PCB Technology

The Default and naming options are
saved in the design, and so only effect
the design you are editing. Other
options are saved to the system's
Registry and so are set up for every
design that you subsequently create or
edit. They can be set up in the
Technology files. Once your
preferences have been worked out, the
Technology files should be changed so
that these options are then used for
future PCB designs.

Once you start editing the design and
adding new items to it, you can also
check the Options dialog under the
Tools menu to see if the Edit Track,
Move and Interaction tabs are set to
your preferences. These can be changed
interactively during the tools use from
context menu options. Pulsonix is a
very flexible system and allows many
of the options to be customised to suite
your particular style of working.

Unlike Design Settings, Options are
stored in the registry and are therefore
machine or login specific, these are
normally user preferences rather than
design preferences.

The concept of Technology files has already been discussed in a previous Chapter. This section
details the specifics of Technology data with the PCB Layout editor.

The most important considerations when choosing a Technology file or setting up your technology
data is the final manufacturing process that your manufacturer can handle. A consideration to make
when design your PCB is the cost of the technology you intend using. Changing your track styles
from 8 to 6 thou for example, could have significant costs implications. You should always check that
they can actually make the board you propose as well. For example, if you use blind and buried vias,
not all manufacturers can make these in-house.

PCB Technology dialog

Styles

The PCB technology data contains a number of styles that define the appearance of PCB design
items, (components/Documentation Symbols, Connections, Net Classes, Tracks, Copper,
Names/attributes and Text).
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The illustration below shows the major styles used in components and Doc Symbols, Connectors and
Testpoints. Generally speaking, each symbol is made up of a collection of the same type of styles but

in some cases not all of them.

K XXX

R1

o ot — ||
A A
R2 1
A A A
B Technolog | [1 - Styles - Pad

= Spa;lng Rules Name Layer Shape Width
esign Level &l Rectangle 0.76200
Net Class Level Mounting Holg1 Round 381000
Match Pair Level v | Pad (0.5mm) Octagon 0.43260
Check Spacing Value: | PadStyled - Round 152400
29 Styles | PadStyle2 Round 1.52400
Hatch Y | PadStyle3 Sguare 1.52400
Line PadStyled Round 177800
PadStyles Round 317500
¥ E_ PadStyle21 Oval 152400
[ Rect (0.2mm x 1.5mm) Rectangle 0.24994
Track | Rect (0.2mm x 1.5mm}1 Rectangle 019980
23 Layers Y | Rect (0.6mm x 2.2mm) | Rectangle 0.60000
Layers Rect (0.7mm x 2.2mm} Rounded R 0.66040
Layer Spans Rect (0.7mm x 2.4mm} Rectangle 0.70000
Layer Classes % [ Rect (0.8mm x 0.9mm) Rectangle 0.20000
Materials [ Rect (0.9mm x 1.4mm) Rectangle 0.50000
23 Nets Rect (1 x 1.1mm} Rectangle 0.20000
Differential Pair | Rect (20x20) Rectangle 0.50800
| Rect (80 x 110) Rectangie 304200
Net Classes Rect (100 20) Rectangle 127000
Net Names — v | Rectangle (0.8mm x 1.4 Rectangle 0.85000
Signal Paths | Via (18) Round 0.45720
Sub Mets v | Via (40) Round 1.01600

Pad Styles

Pad styles are used to define an electrical point of contact for nets and tracks but also as a physical
pad for the Component. These can be any one of the predefined shapes available, and are defined a
Width and Length, but can also include a Drill Hole if used as Through hole pad along with the drill
hole Plating status.

User Defined Pads will show a shape of Special as they have been specially created. These are
discussed below under the heading User Defined Pad Shapes.

The Name can be Typed by you as required or it can be defined from the Pad Naming Rules
(defined in Technology under Naming and Pad Style Naming). Template is used to match a single
rule for one pad style.
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Name: Uzed: Shape: Drill -
[via (18) | Type: [Round [v]  Sshape: [Round [v]
Named by: (@ Typed ()Rule (C)Template VWidth: [0.25720 Widih: |0.25400

Via (18)
For Use By:

I Diameter: |0.00000
[AThrough Hole Pads  [»]Vias rner Hiameter
Surface Mount Pads Micro-vias Offset: |0.00000 0.00000 Offset:  |0.00000 0.00000
[ Through Mounting Holes Rotation:

[#1Surface Mourting Holes Plated Through: 0.20000 mm

The Shape of a drill can be defined to provide slotted pads. Pads of Round are considered normal
drill holes.

An Offset value can be defined for both X and Y offsets for the pad position. This enables you to
display the pad in an offset position from the actual connection point of the pad.

An Offset value is also available for the Drill position. This enables you to define the position that
the drill is located within the pad.

Vias are included in the Pads Styles dialog and are defined in the same way as normal pads.

For Use By enables you to preselect the refinement of the pad styles for when they are used. For
example, creating a style used specifically for vias, such as Via (18) and choosing Vias from the list,
this pad style will only be available for pad styles and not when adding pads or moutning holes.

Slotted Pads

If you wish to define a slotted pad style, you can do this using a User Defined Pad, or preferably,
using a slotted pad style defined in the Pad Styles dialog. When editing a pad style, you will need to
edit the Drill style to be an Oval, Rectangular or Rounded/Chamfered Rectangular drill style. This
makes your ‘drill’ hole a ‘slotted’ style rather than a drilled style.

MName: Used: Shape: Diill:
Slotted Oval (50 x 70) | Type: |Chamfered Rectangle | | Shape: [Oval v||

MNamed by: (@ Typed () Rule () Template Width: [1.2700 Width: |0.4572
Slotted Owal (50x 70
Length: (1 77 Length: |1.1430
[ Through Hole Pads A Vias Comer Radius: |0.0000 Inner Diameter: |0.0000
Surface Mourt Pads Micro-vias Offset: |0.0000 0.0000 Offset:  |0.0000 0.0000
[+] Through Maurting Hales Rotation:

Surface Mourting Holes Plated Through: 0.9000 oo

When in the CAM/Plot dialog, this pad style would be (generally) machined using the Excellon NC
Drill output but would have a separate drill run for slotted pads, these would be milled rather than
drilled.

On the Process page of the CAM Plot Wizard, the Non Round Hole Shape would be selected for
output. You may have two separate outputs for Plated and Non-plated Slotted pads.
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CAM Plot Wizard - Editing Plot '<Through Holex'

Start .
= Choose what is output
M Process Define the appearance of the output.
B Output Choose the data to be output, then it's style and quality.
Size Variant: <Master Design “ |
Design Position Plot Unfited: [
- Finish Process: |La=,fer Span <Through Holex V| Exclude tems...
Style: (it v
Mimor: O
Dl Type: [Unplated [~]
) Hole Shape: |Non Round v| |
Line Styles

The Line Styles dialog is used for line widths of Component outlines, Placement outlines, Areas,
Templates, Copper, Arrows, Thermal Spoke Widths and Board outlines.

Connection Style

Connection Line widths are taken from a system value and cannot be changed.

Track Styles

The Track Styles dialog is used to define the thickness of tracks. These styles are used when defined
as a rule in the Net Styles dialog

The Net Names dialog is used to list the user defined net names used in the PCB. You can set a nets
Net Class name using the Net Class dialog (see below).

User Defined Pad Shapes

User defined pads can be used where the standard Pulsonix pad shapes do not represent the actual pad
shape required. A pad style editor is provided that is run from within the Pulsonix PCB design editor
itself. This means you can create a special pad shape by drawing the actual pad shape and drill shape
required. This mode may be used to create new pad styles or edit existing ones.

The Define Pad Shape mode is entered using the option from the Setup menu. This editor is similar
to any other Pulsonix editor mode, such as the Footprint Editor. Obviously, it has limited functionality
relative to creating pad shapes. When the pad shape editor opens, various shapes are shown, these
represent the following:
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Pad Shape
Exception

€ Drill Shape

-€— Pad Origin

Pad Shape

Edit an existing pad style in the Pad Shape Editor and you can delete, resize, move or edit the red
circle drill shape. You are able to delete it first then add a new shape (a Rectangle, for example) to
draw in a slotted pad. If you then select it, you can use Change Layer to select a new special layer of
<Drill Shape>, this specifies the shape to be the drill hole.

To add a Pad Exception to your user defined pad shape (a different pad shape on another layer),
simply add a new shape and use the Change Layer dialog to define its layer.

Change Layer x
Old Layer: | Inner 2 |
MNew Layer: | - |

Silkscreen T DE

Solder Mask Top
Paste Maszk Top
Inner 2

Inner 3

Bottom

Silkscreen Bottom
Solder Mask Bottom
Paste Mazk Bottom
<Default Shape:
<Dl Shape>»
<Micro-via Entry Pad:
<Micro-via Stop Pad:

The <Default Shape> entry shown means that the selected shape will appear on all the layers in the
layer stack unless changed to a specific layer.

Once the pad shape has been defined, from the File menu, use Save to save the shape and exit.

Define Pad Shape - Multiple Shapes Allowed

In Define Pad Shape, you can add multiple shapes for on a Non-Electrical layer. For example, to
define multiple glue spots. This can be done by adding the extra shapes and changing their layer to an
appropriate one.
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Define Pad Shape now contain Text, Dimensions and Callouts

When using the Define Pad Shape editor you can also add Text, Dimensions, Construction Lines
and Callouts. Properties, Technology Styles, Defaults and Colours are available to support these
documentation items.

Saving Documentation items for reuse

You can save all of these items within the Pad Shape so that they can be recalled for use on future
edits. Effectively, for special Pad Shapes that have this additional information you will create a set of
Pad Shapes in your library. To save these Documentation items, you must save the Pad to a PCB
Doc Symbol in a library. If you choose not to save the Pad to a Doc Symbol then the additional
information will be lost. Not saving the Pad Shape will still mean it retains any user defined shapes as
before.

When saving back to a style in the PCB design, if the Pad Shape is in a library or if the Pad Shape
contains documentation items, you are asked if you want to save to a Doc Symbol library.

Pulsonix

documentation items which will not be saved to the pad style

o The pad shape "Rectangle (0.9mm x 1.4mm)" contains
in the PCE design.

Do you wish to save the complete pad shape to a PCE
Documentation Symbol Library?

Yes

1=
=]

Choosing Yes will display the Save To Documentation Symbol Library dialog:

Save To Documentation Symbol Library *

Librany: | uzer ~ |

MNarne: |F|ec:tang|e [0.9mrm  1.4mm) |

Carcel

This can also be accessed from the File menu using the Save To Library option.

Choosing No will exit the Pad Shape editor, save the pad shape defined but will not save any of the
additional documentation information, this will be lost.

User defined pad shapes can be added to the Vault as well as your PCB Documentation Symbol
Library.

Saving a Pad Shape as a Doc Symbol will be saved as a new symbol type, Pad Shape. These can be
edited the same as any other Doc Symbol and accessed from the PCB Doc Symbol Library
Manager.

Load Pad Shape From Library

When editing PCB pad style, from in the Footprint Editor for example, if you wish to use a Pad
Shape that has already been saved as a Doc Symbol, then for a selected pad, you can use Load Pad
Shape From Library from the context menu.
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If the pad style name is already in a library or vault you will be asked if you want to load it when first
editing the style.
ILI Crduie nuuyge
Type Coordinate... =
Type Offset... Shift==
O Scale
Lock
Change Layer... L

Load Pad Shape From Library...

Toggle as Layer Class Shape
Toggle as Spacing Shape
Resize Shape...

Add Corner

Edit Segment

Hatch Styles

Hatch Styles is used to provide a mechanism for hatching Closed and Filled areas, e.g. Copper or
Shapes etc. Hatching is an alternative to a solid and can be defined as either Hatching using a single
line, or Cross Hatching using diagonally opposing lines.

Hatched Cross Hatched
Name Angle | Coverage (%) | Cross Hatched | Width Percent | Offset Percent
Cross Hatched  45.0 50 100.00 0.00
Hatched 4510 50 ] 100.00 0.00
Mame: Used:

-

[Cross Hatch .90, 0.90.0.0.0.0,
Mamed by: @ Typed (O Rule O Template Coverage () IE% ,:‘:.:‘:‘:‘:’.

ross Hatcl Width (2): IE% . ”’.""”’

*
S¢S

/
(4

Ange: [450 |
:nsls Hatched: Offset (1): E% . ’A.G’.’AQA’A’A‘

The Name can be Typed by you as required or it can be defined from the Hatch Naming Rules
(defined in Technology under Naming and Hatch Style Naming). Template is used to match a
single rule for one pad style.

The Angle specifies the angle of the hatching. 0 is horizontal, 90 degrees is vertical. Cross Hatched
causes a second set of hatch lines to be added, orthogonal (right-angles) to the first set. Coverage %
specifies the percentage of the area covered by the hatch lines. This dictates the distance between
hatch lines, which will be related to the thickness of the line style used and if it is Cross Hatched. A
Cross Hatched area will have a greater line separation than a singly hatched area with the same
Coverage.
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For coverage where the spacing between the lines and the line thickness are the same, you should use
a 50% coverage. Where a larger spacing is required, use a smaller % coverage. Where a smaller
spacing is required, use a larger % coverage.

Offset (%) gives the offset of the hatch lines, given as a percentage of the line separation. Must be
between 0 and 100%.

As the hatch style is edited, the preview window is updated automatically to show the style.

The Hatching or Cross Hatching will be created using the Copper Line Style. Thus if you change the
Copper Line width where hatching is used, the proportions of spacing to line width will automatically
change to reflect the current % coverage.

Style Naming Rules Pages in the Technology Dialog

Style Naming Dialog

As a switchable option, you can opt to have Pulsonix automatically create style names for you. This
means that, for example, when creating new pad styles, you could use the auto-naming option to use
the IPC naming convention.

Style Naming is available for all Styles within the Technology dialog. Each page works like any other
Rules page within the Technology except that generally speaking, you’d only ever have one or two
rules for each naming style.

Line Pattern Match Line Width Line Width Template String

Solid [l [0.00 Line <pattern> <width>

The edit portion of the dialog is used to define specific naming items, this varies for each item style.
The right side of the edit pane defines the Rule that will be created. Once the rule has been defined
using keywords selected from the Field: drop down list, use the Insert button to add it to the Rule.

Line Pattem: |cAny> v|
Rule: |Line ewidth:><metric:»
[IMatch Width Field Keyword
Less Than or Equal To: 0.00 cwidtho> Insat
<width nsel
Field: [Line Width v
Preext: | |

Buttons on the Navigation bar under Replace All: enable you to add a rule to the rules pane replacing
any existing rules. A button on all pages (Basic Set), is used to set up a basic rule for you to use. This
can be edited to your own style if required. On the Pad Style Naming page, an extra button (IPC Set)
is used to define a more complex string for the IPC naming rule.

Basic Set & IPC Set Buttons

On each of the pages is a button named Basic Set. On the Pad Style Naming page, there is an
additional button for the IPC Set. These buttons are under the heading Replace All: and are used to
create you a basic style naming rule tailored for each of the particular styles. As it says, using this
button will add you one style naming rule to the grid and will remove all other rules defined. The rule
won’t be applied until the Apply or OK buttons are used at the bottom of the dialog.
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Settings

Replace All:
Basic Set

IPC Set
kY

Note: When using the IPC Set button, this also sets up the Settings dialog as well as the rule
definition. The IPC rule is a combination of both the rule and pad style/usage mappings.

Style Naming Settings Dialog

Each of the Style Naming dialogs has a Settings button. Each one is the same except for Pad Style
Naming which has additional settings that can be used. The Settings dialog defines the Units and
Units Text for the Style Naming. This is independent of the main Design Units dialog and is only
used for Style Naming.

The Pad Style Naming Settings dialog also enables additional Mappings for Shapes and Pad
Usage. This is used where specific styles require mapping so that can be correctly defined, the [PC
naming style for example.

Pad Style Naming Settings x
Shape Name Mappings Maming Units
Shape Label Default to: () Imperial
Annulus c (®) Metric
Huet g Imperial
Chamfered Rectangle :r p
Diamond u Hhi | thou Y
ECTEIQU" : Unit Text: Trailing Zeros
va
Pointer u Predsion: | 1 =
Rectangle r i
Reisi . Decimal Character: l:l
Rounded Rectangle r Metric
TR = Unit: | mm b |
Target u
Triangle u Unit Text: Trailing Zeros

Predsion: | 2 5
Pad Use Mappings

Decmal Character: l:l
Pads Intended Use |Label
Through Hole
Surface Mount

Via v
Micro-via v
Any

All

Cancel

Technology Styles Dialog

In addition to the Style Naming dialog for each of the styles, the actual Style page has been modified
too to enable the naming.

Under each of the Name: fields for the style, there are now three additional radio buttons to define
how the style will be Named by: There is a choice of Typed (manually named), Rule (using the new
Style Naming rules for that style item) and Template (which is a hybrid, a combination of both Rule
and Typed).
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Mame: Used: Shape: Dirill:

|M0uming Hole | Type: |R0und b Shape: |R0und

Named by: @) Typed (O Rule () Template Width: Width: 11430

Mounting Hole e
For Use By: b.ww

I Diameter:
[~] Through Hole Pads rner Liameter [

Surface Mount Pads Offset: (0.0000 Offset:  |0.0000
A Vime Dimtbinm: [0

Technology General/Defaults Dialog

From with the Technology dialog and Design Settings, General/Defaults page, there is an additional
switch related to Style Naming called Make named styles use naming rules. When selected, this
will force the addition of new named styles use the naming rules. Leaving it unchecked enables a

Typed rule to be defined.
Al Text Attributes
Adjust To Readable Orientation Substitution Char: E
{when doubled)

Barming Character: l:l

{when doubled)

Matching Styles

System Font () By Name Only
[ Proportional Width Digits (®) By Name And Value
CAM/Plot O By Value Only

[ Transform about design extents

STEP Model Alignment

MNaming Rules
Make named styles use naming rules

Snap by: Pad Exceptions
(@) Centre [ Mirror with Component
() Origin
Use Adjustment Attibutes

Spacing Rules

The Spacing Rules dialog is used to specify the minimum clearances required between different kinds
of electrical design items. The spacings you set up in this dialog are used by the Design Rules Check
to calculate whether or not any of the electrical items in your design are too close together.

Using the Spacing Rules dialog

The spacing values are presented in a grid, allowing you to easily change the values directly.

Design
Track Pad SMD Pad via Micro-via | Testpoint | Mounting | er Text
Design Hole
Track 5.0 5.0 5.0 5.0 60 5.0 6.0 5.0 6.0
Pad 80 80 60 80 60 80 60 60 60
SWDPad |60 &0 50 80 &0 80 80 80 &0
Via 80 80 50 80 60 80 60 60 60
Microvia  |6.0 &0 50 &0 &0 80 80 80 &0
Testpont  |6.0 80 50 80 &0 50 60 60 60
Mounting Hole | 6.0 80 50 50 &0 50 60 50 60
Copper 80 80 50 80 &0 80 80 50 60
Text 51 80 50 50 &0 50 80 50 50
Board 500 O 00 500 500 500 E00 500 )

Click on the text of the value you wish to change, and edit the text to show the required value. You
can also take the value from one cell and apply it across the whole row, down the whole column, or to
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all the cells of the whole grid, by right mouse clicking and selecting the required option from the
context menu.

As an additional ‘lower’ level of spacings available, Net Class Level Rules enable you to specify
spacing rules based on Net Classes. You also have the ability to specify rules based on Net Name and
Net Attributes using the Match Pair Level Rules spacing. This dialog enables you to define Layer
and Area based rules as well.

Special Design Level Rules

Design Level Rules contains additional tabs for specific items spacings.

Additional Design Level Spacings and Rules:

Board Bond And Die Pad Component  Copper  Drill Pad Track Enclosures

Component to Component Space Component to Board Space
Minimum: 000 Optimum:
Optimum:  |1.275

[INo Same Component Pad to Pad Ermors

Component rules defines the Component to Component spacing. This is used as the minimum
space is used by the Design Rule Check option to look for overlapping components. The Optimum
space is used when using Push Aside whilst manually moving components, in order to space the
components out a little. The spacing rules value is applied to the boundary extents of the Component.
It is more efficient, and easier to manually place, any components that contain a placement outline
defining its boundary. This boundary would be defined at the Footprint creation stage and would be
drawn using an area shape.

Match Pair Level Rules

These Rules are similar to the Net Class Level Rules, except they only apply between two net items.

Itemn 1 Item 2
Side | Layer Area
Attribute Name Match Value Aftribute Hame "\:gltﬁz g
<MNet Name> HS* <MNet Name> =
=MNet Name= Sig* =MNet Name= * Inner
ltem 1:
Adtribute: |:Net Name: v|
Match - <Net Name>=3ig*
Match: | Sig* IS -
| | Match - <Net Track Pad Via Testpoint (Cemiy Copper Text
X Name>=* Hole
tem 2: Track 3.00 5.00 3.00 5.00 3.00 5.00 10.00
Attribute: |CN81 MName:= V| Pad 8.00 &.00 8.00 8.00 8.00 8.00 10.00
Via 8.00 .00 8.00 5.00 8.00 5.00 10.00
Match: v| K| [Testpont .00 B.00 .00 8.00 8.00 3.00 10.00
Mounting Hole | 8.00 8.00 8.00 8.00 8.00 8.00 10.00

On Layers: Copper 200 £00 800 E00 800 & 100

Side |Inner v| Text 10.00 10.00 10.00 10.00 10.00 10.00 10.00

or Board 10.00 10.00 10.00 10.00 10.00 10.00 10.00

MName: | |V|
Within Areas: | v| Minimum Spacing: {except for explicit smaller net class value)

The mm check box at the bottom of the dialog enables you to set the units to mm or thou (Mils)
within the dialog only and overrides the main Design Units.
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To use this dialog, you must define the Net Item the rule applies to. To do this, press the New button.
You should select the two Net items, you can also use a wildcard string to match several items.

You can also specity if the rule applies to electrical layers. These can be defined as Top, Bottom or
all Inner/QOuter electrical layers. Rules can also be defined for an area(s).

For example, if you have net classes called Ground, Power +5 & Power +12, you could define a rule
pair between Ground and Power#*, so the rule would apply between Ground nets and all Power nets
(but does not say anything about rules between Power +5 & Power +12).

The rules are applied in the order they are shown looking down the list, so if more than one matches,
only the first match will be used. You can use the Up and Down buttons to move the selected rule
pair up and down the list. The Delete button deletes the selected rule pair.

Colour Coding For Match Pair Spacing Grid

The grid is colour coded to show what values apply:

Black shows values inherited from Design Level
Green for Minimum Spacing
Blue for an explicit value

You can change a Spacing value back to the default by selecting the value in the grid and deleting it.
An explicit value can be removed by deleting it.

Import Spacings Rules using CSV Format Files
From within the Net Class dialog, you can import Net Class names and Class to Class Spacing
Rules into the Schematic or PCB design Technology using a CSV file.

Using the Import CSV feature

The Import CSV button appears on the Spacing Rules dialog along with Match Net Class Pair rule
level pre-selected.

ltem 1
Attribute: |<Met Name: v|
Match - <Net Name>=Sig™
Match:  |Sig™ || i
‘ | * Match - <Net Track Pad Via Testpoint [EETIiTy Copper Text
Hame>=* Hole
tem 2 Track 3.00 3.00 8.00 3.00 3.00 3.00 10.00
Attribute: |<Net Name: V| Pad 8.00 8.00 8.00 8.00 8.00 8.00 10.00
Via 8.00 8.00 8.00 8.00 8.00 8.00 10.00
Match: |* v| K [Testpont 8.00 .00 B.00 .00 .00 2.00 10,00
Kounting Hole | 8.00 8.00 &.00 8.00 8.00 8.00 10.00
On Layers: Copper 5.00 8.00 8.00 B.00 800 800 10.00
Side: ‘Inner v| Text 10.00 10,00 10.00 10.00 10.00 10.00 1000
ar Board 10.00 10.00 10.00 10.00 10.00 10.00 10.00
Name: ‘ |V|
Within Areas: | |v | Minimum Spacing: {except for explicit smaller net class value)
|:> Import CSV... Close Apphy Help

When selected, the Open CSYV file dialog is displayed. You will be prompted to select the CSV file to
import. The File of Type drop-down list is set to *.CSV.

Note: If you have been editing your spacing rules in Microsoft Excel for example, you will need to
save the rules into a CSV file format. To do this, when using the Save As option select CSV (Comma
Delimited) (*.CSV) format from the File of Type drop-down list.
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File: name: net spacing matrix, xlsx v
Save as typel | Excel 2007 Workbook (*.csv) |v-
—nicode Text (*.bxt) -
Microsoft Excel 5,0/95 Workbook (*,xls)
?.

Iicrosaft E

Microsoft Excel 3.0 Worksheet (*.xls) [

Select the file required from the dialog and press Open. The Import Class To Class Spacings CSV
Data dialog is displayed. This dialog allows different styles of CSV files to be imported. Currently,
this accommodates a number of format ‘styles’ that have been seen within our development
department.

Import Class Te Class Spacings C5V Data X

Add new net classes

Keep existing class to class spacings

Update to new spacing value

Clazs to class spacings table

Met class names:  row: colurr;

Contains default spacings for each net class:  [Jrow [ column
Add defaults as net class spacings

S pecific table specification

[JEach net class contains twa extra columns for pad spacings

Units for spacing values: mm w
Decimal point character: l:l

Field separation character: l:l [ Usze tab

Apply imported class to class spacings to:

On Layers
Side; |<Any> ~ |
ar
M arne: | ~ |
‘within Areas: | V|

Add new net classes — If new net classes need to be added because they exist in the import file but
not in the design, checking this option will allow this. With this not selected, new net classes are not
added and any class to class spacings using them will also not be added.

Keep existing class to class spacings — If the design already has class to class spacings, you can
choose whether to remove them all and add just the spacings from this import file, or to keep the
existing ones. Uncheck this option to remove them all.

If keeping existing spacings the following check box becomes enabled for you to use to decide what
to do if the import file contains class to class spacings that already exist in the design.

Update to new spacing values — If during the import, the option detects an existing class to class
spacing but the value is different, then you can choose to keep the existing value or update it with the
new value. Unchecking this box will mean only new class to class spacings will be imported.
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Class to Class Spacing table

You can tell Pulsonix how to treat the imported data. It is assumed that the spacings table is a grid
with net class names in the top row and down the left most column. This spacings table can appear
anywhere in the CSV spreadsheet and so the user will have to supply its position. The first option tells
the importer which rows and columns contain the net class names. For this, you define the Row name
and Column name.

Net Class names Row Column — enter values like 1 for Row and A for Column names. If for
example, you had a title at the top of the page on row 1, the net class name may then appear on Row
2, you would then enter Row 2 instead. You can use either numbers, where 1 is the first, or letters,
where A is the first and AA and AB are 27" and 28™ etc.

Contains default spacings for each net class Row Column — Some spacing tables contain a special
row below the net class names row, or a column to the right of the net class names column, or both,
containing default spacing values for each net class. These values do not form part of the class to
class spacing values grid, and so the importer needs to know about them so it can skip them, or read
the default values from them, to reach the main spacing values grid. Check the row and/or column
boxes if you have these values in your table.

If either box is checked the following check box becomes enabled to use to decide what to do with
these default net class spacing values.

Add defaults as net class spacings — Check the box if you want to add these default values for each
net class they are defined for to the design spacing rules at the Net Class rule level. Leave the box
unchecked to ignore them.

Specific table specification

The basic spacing table supported will contain values in each cell to be used for all spacings between
the net classes defined by its row and column. Usually there will only be values defined for one
diagonal half of the grid to avoid duplicating the data, but a full grid of values can also be read.

In order to import a variety of spacing table formats, a section has been included in this dialog to
include check boxes for the user to choose any of the specialised table considerations we have been
made aware of.

Each net class contains two extra columns for pad spacings — Some spacing tables we have seen
from a specific customer contain two extra columns after each net class containing special spacing
values to match their manufacturing requirements, the maximum of which is used for the Pad to Pad
and Pad to Copper spacing value. Check this box if this matches your spacing table. If checked, the
import report will show this special pad spacing in brackets after the main class to class spacing
value.

Units

Units for spacing values — select the units used in the CSV file from the drop-down list. You can
specify different units to those in your design and used during import. If different in the CSV file,
Pulsonix will convert the imported data into your design units during the import. Only spacing values
that are numbers will be imported, blank fields and fields containing text will be ignored.

The Import CSV Report

The Report button on this dialog can be used before running to inform you of what will be imported
and a report will be created after import to tell you what has been imported. You can also run it a third
time to verify the original file against the current Spacing contents, to check for differences. This way
you can use this feature to check for any different values from the original spacings spreadsheet.
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DFM/DFT Rules

Further tabs contains rules for functionality for: Copper Pour, Footprint rules, Teardrops, Test
Points and Thermal rules. These are considered DFM/DFT rules (Design For Manufacturing and
Design For Test).

Copper Pour

Copper pour rules are using to ‘pour’ copper into a Template shape. This would be used in
association with the Thermal Rules dialog also.

Attribute: <Nt Name> -] [Hatched

Match: |V— W | =~ Avoid Same Net

Cross Hatch

Isclated Islands o o

Remove:
Minimum Island Size o o o o
1.6130 mm sq.

Squared Pad Comers:
Use Template Centreline: [_]

Export CSV... | | Import CSV... mm Cancel Apply Help
. Avoid Same| Min Island Squared Use Isolated Islands Hatched Copper
Enable| Afttribute Name Match Value Net Size Pad Centreline | Make
Corners emove Non-Connecting Is Hatched | Hatch Style
¥ L] {<Net Name= o V- ] 1.6130 1] L | 1+ L | L | Hatch
[~] i<MetName= E1 [-] 1.6130 [ [] [~] [] [] Hatch
[~] i<Met Name= * [] 1.6128 [ ] [] [] [ ] L] Hatch

For the Copper Pour area, the Avoid Same Net check box causes tracks and copper on the same net
as the Template to be avoided, so the only physical connections to the poured copper are through the
pads. Otherwise, the copper will flood over such items. The Minimum Island Size is in the current
design units squared, this defines the minimum area of a piece of copper generated by Copper Pour.
Remove Isolated Islands means that each piece of generated copper must be connected to the
designated Net. If no connection is possible, the island will be deleted.

You can define a Hatch Style to be used with each piece of copper generated.

Teardrop

Use the Teardrop options to change the shape and size of new teardrops to be added.

C

N

You have a choice of teardrop shapes depending on your requirements - Triangle, Curved Triangle
and a customised length Triangle. The V-Angle allows you to define the length of the teardrop
based on its angle between the two items. A 60 degree angle is set as the default but can be changed
as required. By adding Length, you can extend the ‘V’ to elongate it.

Teardrop

Once the teardrop has been added, the Shape and V-Angle can be interactively changed using
Properties on the item. You should select the teardrop(s) first and then select Properties to change
this value.
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CAM Plot

Layers

Thermal

The Thermal Pads parameters are used when copper pouring any areas of the design and when using
the automatic power plane generation in the CAM/Plot option.

The Isolation Gap is the gap between the Pad and Copper plane creating the isolation. The Spoke
Style is the small copper line connecting the Pad to the Copper area. This value is taken from the
Line styles entries in the Technology and is presented in the drop down list, this then displays the
Spoke Style width. A value can also be typed in if preferred.

The Number Of Spokes connecting the Pad to the Copper area.

L — Spokes

Isolation gap  Spoke ‘Width

The First Spoke Angle is in current angle units (other spokes will be relative to this first spoke). The
Number Of Spokes will be the total number added to each pad. A number of 4 or 5 is normal but this
will depend on your manufacturer. The Minimum Spokes value is set if you really do have a
minimum number required. If the minimum number cannot be reached, then no spokes are added to
that pad. You should run the Net Completion Report to ensure that all pads are connected to the
plane.

Testpoint

The Testpoint rules are used during the Testpoint Analysis when using Auto Insert Testpoint and
Insert Testpoint.

The Probe Side under Test Points allows you to select Top, Bottom or All. These are used during
the manual inserting of Testpoints and when using the Design Rules Check option. The Side can also
be extracted using the Report Maker for reports of a specific testpoint side.

The CAM/Plot pages and dialog are covered in detail in the Chapter on PCB Manufacturing Tools.

The Pulsonix PCB design system supports an unlimited number of layers in any combination of
Electrical, Non-electrical, Wire, Construction and Documentation layers. These layers are used to
detail the physical 'make-up' of the manufactured printed circuit board.

A typical default layer configuration

Below is an illustration of a typical 4 layer PCB showing the 4 electrical layers, 2 outer layers - Top
and Bottom and the inner power plane layers - Ground and Power. As well as electrical layers, you
may also need non-electrical layers for additional manufacturing processes that are not constructed as
physical layers. A typical requirement for this type of layer might be a Silkscreen layer that is printed
on top of the Top electrical layer.

For additional information that is not a manufactured process, you may require an additional layer;
this can be added as a Documentation layer. This layer might contain the board build information for
example that is used by the manufacturer to inform him how to build the board itself.
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Silkscreen Top
Solder Mask Top

Y —— Pgate Mask Top
Top
Ground
Powver
Bottom
j — Paste Mazk Bottom

Zalder Mazk Bottam
Silkzcreen Baottam

Documentation

Pulsonix also supports a more advanced layer structure where the actual construction layers are
defined as well as the basic layers. Layers such as the fibreglass board (FR4) or the copper attached to
it, can be defined, as can their thickness and materials. You can also specify Wire layers for jumper
wires and die pads (when using the Chip Packaging toolkit option).

How to set up layers

If using one of the supplied default technology files the layers are already defined for you, these can
be edited or modified though as you require. If you wish to check or edit the layers on one of the
boards, you can do so using the Layers tab on the Technology dialog. Once Layers have been
changed, you can save these to a new Technology file or you can overwrite the original Technology
file.

The Layers dialog allows you to position the layers in the order that they appear in the finished PCB.
These are easily positioned by selecting the layer first and then using the Up and Down buttons, it is
advisable to use the build order for the layers in this dialog as it makes it easier for anyone else
reading the Layers dialog to understand the layer construction. The layers must be grouped by 'side’,
so all the 'Top' layers are first, followed by the 'Inner' layers, then 'Bottom'.

Name Associated Layer Class Side Bias Net Material | Thickness New...
Y Silkscreen Top Silkscreen Top None 0.0000
Y |Top Electrical Top X Copper 1oz 0.0350 TEEY
Solder Mask Top Solder Mask Top None Mask (0.025) 0.0250 -
Paste Mask Top Paste Mask Top None 0.0000 Delete Unused
Y Pin Names Mon-Electrical Top None o.0000
Prepreg A Construction None Prepreg (0.11 0.1100 Up
Prepreg B Construction None Prepreg (0.11 0.1100
Y |Inner 2 Electrical Inner e 0.0000 Down
Substrate Construction None FR4 (1.0} 1.0000
Y |Ground Power Inner Power Plane :Gnd Copper 1oz 0.0350 Reflect
Prepreg D Construction None Prepreg (0.11 0.1100 =
Prepreg C Construction None Prepreg (0.11 0.1100
Power Power Inner Power Plane VCC Copper 1oz 0.0350 View Layers...
Inner 5 Eledr?cal Inner X 0.0000 Only Show
Y |Bottom Electrical Bottom Y Copper 1oz 0.0350 DUsed Entries
iy Silkscreen Bottom Silkscreen Bottom None 0.0000
Solder Mask Bottom Solder Mask Bottom None Mask (0.025) 0.0250 Physical Copper
Paste Mask Bottom Paste Mask Bottom None 0.0000 Layers:|g
o Pin Names (Bottom) Non-Electrical Bottom None 0.0000
Board Board None 0.0000 Board Thickness
Construction Lines Documentation None 0.0000 |1_63-1}|] |
Documentation Documentation None 0.0000
Drrill Drawing Drrill Drawing <Through Hol:Mone 0.0000
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Name: |T0p Blectrical Details:
Used: Routing Bias: |* ~
Class: |Elec1rical |v|
Type: Physical Copper Layer
Layer Association: Construction Details: Usually Plotted
Material: |C0pper 1oz v| In Layer Stack Preview
(@) Top Facing Side: New Material__ Suppress Unconnected Lands:
(O) Bottom Facing {Mimor Components) [Thickness: |0.035000 On Pads

[ Allow Normal Components [ Allow Buried Components Embedding: []0n Vias Outer

[10n Micro-vias | |Outter

This dialog enables you to add new layers or edit existing ones in the design. Not all of the items in
this dialog are mandatory, but the following are: Name, Class, Side and Bias. These describe the
layer Name to identify it, how the layer will look and plot, which side of the physical board the layer
resides and the routing bias or usage of the layer.

Each grid cell is editable or has a drop down list that contains selections of relevant information.

When a Power Plane layer is specified (by selecting Powerplane in the Bias box) you should
associate it with a power net, such as GND. Use the Net drop down list to choose the net name.

The Colour box allows you to change the default colour for that layer. Once set the colour can be
edited using the Colours dialog.

The Material and Thickness of the layer allows you to complete the board for manufacturing
purposes, but is not essential.

Layer Classes are used to define the type of layer that will be added. Pulsonix is supplied with
predefined Layer Classes, but you can add your own if required.

Layer Classes

Layer Classes contain information about how the layer will appear on the screen and when plotted.
By using these, it allows you to define additional characteristics of any new layer added to the design,
or to change existing ones by simply changing to another Class. It also provides a mechanism for
defining the items which are plotted when using the CAM/Plot output.

Name |

Aszembhy

' | Board

| Construction
| Documentation
Drill (Nen Plated)
Drill (Plated)
Electrical
Non-Electrical
Faste Mask
Power
Silkscreen
Solder Mask
Wire Link

=<|=<|=|=[<|=<|=
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Name: |Solder Mask Reset To Default
Used:
Layer Type:  Mon-Electrical [|Essential For Manufacture
Pad Oversize: Pad Types: Pad Condition: Areas Visible Break Shapes Layer Mask
01270 [~]Compenent Pads ] 5urface Mount Component [Break Around Pad Min Mask Width:
(®) Absolute Size Doc Symbol Pads Through Hale: Body [Break Around Text 0.1000
7| Bond Pad [ Plated [AClearance Break Comp
@] Percent of Pad e - DShapes #t Board Min Mask To Track:
Size [~]Eree Pads [[IMon Flgted [0thers :
[~ Mounting Holes [1Only i Testpoirt Gap: |D'DDDD | |D'1DDD |
Min Undersized Pad: ) [+ Design
[~ Comp Mourt Holes [JExeeption Only
0.0000 [AVias Board Cutouts Variant Components Panel
Micro-vias Draw/Plot Appearance [Unplated m ttems Visible In Al DCheck ltems
[(]Board Visible Pad Land [Piated Variants Outside Board
- B T y Draw Shapes in
Merge Cutouts ]l Hole Use Variart Style IjPaneI Design

Materials

The Layer Class Edit dialog contains information about the visibility of Pad items on the layer and
the type of pad (Pad Condition) that appears e.g. SMD or through hole. This dialog is also used to set
up the plotting over or under size when the layer is used for such types as Solder Paste Mask or
Solder Resist.

The Layer Type is always one of five types: Construction, Electrical, Non-electrical, Wire or
Documentation and cannot be changed, (Electrical layers are used to hold Electrical items such as
tracks, copper etc. These are checked during Design Rules Checking). You have to always specify
one of these layer types from the choice in the drop down list. The Layer Type will be selected based
on its use in the design. The sample Technology files supplied already have these defined as a guide
to their use.

If a Footprint contains items on an Essential layer, it cannot be added to a design which does not
contain a matching layer. Similarly, items on non-essential layers will not be added to a design
without a matching layer, but the Footprint itself can still be added. This can be useful for
construction lines, dimensions or alternative outlines. Use the Essential For Manufacture button to
enable this.

Activated from the Layers dialog, the Materials dialog is used to specify the material type that the
layer is made of. For example, a construction layer could be made of FR4 fibreglass material, or the
'glue’ layer used between two FR4 laminates could be a Prepreg 2125 material.

Hame | Thickness | Electrical Conductivity | Dieleetric Constant (Er) Special Use
Copper 120z (0.018) 0015 595900
% |Copper 1oz (00351 0.035 595900
W |FR4(0.2) 0.200 4.3
FR4 (0.3) 0.300 4.3
FR4 (0.4) 0.400 4.3
FR4 (1.0) 1.000 4.3
W |Mask (0.025) 0.023
Plating 0.030+ 595900 Hole Plating
Y |Prepreg (0.11) 0110 4.2
Thin Plating 0.020+ 495300 hicro-"ia Hole Plating
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Name: [FR4 (0.2)

Used:

Thickness:
Electrical Conductivity: l:l S4m
Dielectic Congtant [Er]:
Special Use:

This is used by Pulsonix to create a fully documented layer structure for documentation purposes and
also for the Design Calculators. For normal Pulsonix use, this level of detail is not mandatory.

Pulsonix is supplied with different Technology files containing different layer configurations. If,
when using a technology file, you find that it does not contain the layers required, you can edit the
existing technology to add more layers, or use the Load Technology option to load a different
technology file, that does have the correct number of layers.

You can also import Materials (as well as Layers, Layer Classes and Impedance rules from an
IPC-2581 Layer Stackup file produced by 3™ party products, such as Polar Instruments. This is
available from the Technology page and Layers dialog using the Import button.

Layer Spans

A Layer Span defines the possible layers a Via can penetrate through the board. Often these are right
through the board, from the Top to the Bottom Electrical layer. You can also have Blind vias (where
the via goes from the Top or Bottom to an Inner layer), and Buried vias (where the via goes between
two Inner layers). As these require an additional drilling process during board fabrication, you should
consult your manufacturing house to check if they can handle it and the cost, as it can be an expensive
process.

Layer spans are also used for board outlines to create Flexi-Rigid Boards, and for Board Cutout
Areas to create Board Cavities and also areas spans if you have the Advanced Technology option.

» To set up through-hole layer spans

Layer Spans are setup using the layers already defined in the Layers dialog, these are used to define
spans used for Vias and Micro-vias. Under normal circumstances, the <Through Hole> technology
spanning the complete design, regardless of the number of layers, would be defined using the <Top
Side> and <Bottom Side> layer spans. This would encompass any layers used in the design.

Hame | From Layer To Layer Type

% | <Through Hole= <Top Side= <Bottom Side= Through Hole

Blind Top = Inner 2 =Top Side= Inner 2 Blind from Top
Blind Bottom = Inner 5 :Inner 5 <Bottom Side= Blind from Bottom

To create a layer span if not already defined in the technology file, use the New button.
Choose the From Layer and To Layer spans from the Layers available in the drop down list, this
dialog will not allow duplicate layer spans to be created. It will allow overlapping spans but will warn
you when you press OK and when you exit the Technology dialog.

P To set up blind and buried layer spans
For more advanced PCB technologies, blind and buried vias can be defined in the design.

Again, using the Layer Span Edit dialog the layer spans can be defined for blind and buried via
technologies.
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In the diagram below, the <Through Hole> technology has been set up as a system default (denoted
with the brackets < > ). The dialog shows a 4 layer example of 2 outer layers and 2 inner power plane
layers. The span Blind Top - Ground has been set up to allow vias to be placed between the Top
layer and the Ground power plane. This example would be used for connecting surface mount devices
through a stub route to the power plane using a via.

Name | From Layer To Layer Type

¥ | <Through Hole= <Top Side> <Bottom Sidex Through Hole

Blind Top = Inner 2 <Top Side= Inner 2 Blind from Top
Blind Bottom = Inner 5 Inner 3 <Bottom Side> Blind from Bottom

This example is manufacturable and would look like this as a cross section of the finished PCB:

SHD Thro' Hole

Top
Ground
Paweer
Buottom

SMD

If an extra 2 layers in-between the Ground and Power layers were introduced, these could be
connected together through a layer span and could only be connected to other layer spans if
subsequently manufactured in a specific order. There would be layer combinations using these layers
that would not be manufacturable but they are allowed under warning. The dialog will check for legal
layer spans and warn you if un-manufacturable.

Displaying Layer Stacks

You can view the Layers, Via stacks and layer spans by selecting the View Layers button from the
Layers, Layer Spans and Back Drill Spans dialogs (Back Drills when using the High speed option).

Layer Stack Preview x

Solder Mask Top (Mask | m}
Top (Copper 1oz 0.035mm}

Prepreg A (Prepreg (0.11) 0.110mm}
Prepreg B (Prepreg (0.11) 0.110mm)}
Ground (Copper Toz 0.035mm)

Substrate A (FR4 (0 300mm}

Inner 3 (Copper 1oz 0.035mm}

Prepreg C (Prepreg (0.11) 0.110mm)
Prepreg D (Prepreg (0.11) 0.110mm)
Inner 4 (Copper 1oz 0.035mm}

Substrate B (FR4 (0.3) 0.

Power (Copper Toz 0.

Prepreg E (Prepreg (0.11) 0.
Prepreg F (Prepreg (0.11) 0.110mm}
Bottom (Cepper Toz 0.035mm)

Solder Mask Bottom (Mask (0.0
Paste Mask Bottom:

Silkscreen Bottom

Top - Ground
Through Hole=
nner 3 - Inner 4

Use the Print button to print a copy of the Layer Stack Preview.
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SIRERRENEN

This can also be added to your design using the Insert Layer Stack option.

Silkscreen Top
Top {Copper 1oz 0.0350mm)

Solder Mask Top (Mask (0.025) 0.0250mm)
Paste Mask Top /
Prepreg A (Prepreg (0.11) 0.11 l.‘l)mm]/

Prepreg B (Prepreg (0.11) 0.1100mm)
Inner 2
Substrate (FR4 (1.0) 1.0500mm]/

Ground (Copper 1oz 0.0350mm)
Prepreg D (Prepreg (0.11) 0.11 DDmm]//
Prepreg C (Prepreg (0.11) 0.1100mm)— |
Power (Copper 1oz 0.0350mm)—}

\mp L2
‘-\,\\Top - GND
L2- GND

[——<Through Hole>

PLZ ==

Silkscreen Bottom:
Solder Mask Bottom (Mask (0.025) 0.0250mm)
Paste Mask Bottom:

Inner 5
Bottom (Gopper 1oz n.casornrn]—\i‘\

Changing the Colours in the PCB

All entities of the PCB design can have their colour changed. Each layer based item can have a
different colour on each of the layers defined in the design. So, for example, you can differentiate
between Copper on the top of the board from copper on the other side. Colours are accessed from the
Setup menu Technology and Colours, or from Setup and Colours. They both go to the same
location.

Layer Selectable
Assembly Top
Silkscreen Top
Paste Mazk Top
Solder Mask Top
Top

Ground

Power

Bottom

Solder Mask Bottom
Paste Mask Bottom
Silkscreen Bottom
Assembly Bottom
Construction Lines
Population
Reference

Profile
Documentation

Displayed

TrueWidlh| Colour |

LN | KN N NN RN N KN EN [ KN AN KNI ENTEN | BN EN T ES
RN | RN N NN RN N N EN [ EN RN ENTENTEN BN EN T ES
LN | RN N NN RN RN [ EN RN N ENTEN | BN EN TS

The PCB Colours dialog is been divided into two grids for Layers and Multi-Layer Items (such as
pads) that appear on the Top Side, Bottom Side and Through Board layers.

Multi-Layer Items

Multi Layered ltems | Displayed | Selectable | True Width Colour
<Through Board= [] [~] [~]

<Top Side> [] [] [~

<Bottom Side= [~] [~] [~

The three special layers, that represent groups of layers; through the board (<Through Board>) and
sides (<Top Side> and <Bottom Side>) are in a separate table at the bottom. These layers only
become visible if one of the layers in the group it represents is also visible. For example, pads on the
<Top Side> would be visible if the Top electrical layer were made visible and the <Top Side> were
also visible. A special case for this is when all the layers in the top table are not visible, in which case
you can view the special layers alone.
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Translating from Schematics

An integrated element of the Pulsonix Schematic/PCB design environment is the option to translate
the Schematic design to a PCB design without using a netlist or other commands. The Translate to
PCB option is available on the Tools menu. When selected, you are presented with the following

dialog:
Translate to PCB >
Design: | Designl |
Technalogy: |4 Layer v|
Profile File: |[N0ne] w |
All components ta bin Show bin
Cancel

This dialog provides you with the option to name the design although a default name matching the
Schematic design name is provided. If you decide to use this, it will make it easier later on when you
come to use the Synchronise Design option, or Cross Probing, as both options by default use the
corresponding Schematic design names.

The Technology box allows you to choose the PCB Technology file to use. The technology defines
the layers, colours and other aspects of the ‘make-up’ of the overall PCB design, this includes power
plane layers, pad styles, track styles, etc.

The Profile files box allows you to choose which PCB Profile file to use. This will give you a jump-
start, because you can have your board outline and other general annotation predefined. You can also
have critical components pre-placed in the profile. If the Schematic uses the same Parts, the critical
components will be taken from the Profile.

Check the Unplaced components to Bin option if you want to use the Component Bin, otherwise
components are stacked in the design area if no board outline exists, or around the board outline if
one is available.

The Show Bin option is available if you have selected the option to place unplaced components into
the bin, use this to display the Component bin automatically.

Once run, a new PCB design session will be started using a New PCB design containing a
Technology file loaded (if selected), a Profile file loaded (if selected) and a netlist loaded containing
all the nets and components from the Schematic. The components may be placed in the Component
Bin or around the board profile outline depending on whether the Unplaced components to Bin
check box was selected. If no Profile file was specified, and the Component Bin not used, the
components and nets will appear in a 'stacked' column within the design area.

At this point the design is ready for Component Placement and Routing.

Importing a Netlist

Pulsonix can import many ASCII netlists from other systems in different formats if you decide to use
a different CAE application to create your schematics or if your netlist source is external. You can use
this mechanism to start your new PCB design. During import, it will expect a collated netlist with all
duplicate Net and Component names resolved. It will check these on import anyway and reject the
netlist if errors are found.
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Use the Import Design Data option on the File menu. Select the format required using the Files of
Type: drop down list box. Select the file to import and press the Open button.

LPEF Lesign N
KCBSLK100 v
Mew Libraries v <€ 3

File name: v| Orcad Edif Metlist (*.edn) ~

You can optionally choose to map the part names used in the other system to the part names that are
used in Pulsonix.

QrCAD *

|Jse Part Mapping

C:ADocumentsiDesignet Al map

Create... Browse...

Unplaced components to bin Show bin

] 3 Cancel

During the import, the Parts used in the netlist will be loaded from the existing Parts/Footprint
libraries. If these Parts don't exist, an error will be displayed. All errors must be corrected to ensure
100% accuracy of the imported netlist.

If a Pulsonix Profile file has been used when creating the new PCB, you will need to either remove
any components first before loading the netlist or use the Import ECO option after, to check the
original netlist against the design and make any changes necessary to bring the two into line.

For details on importing netlists from other systems please refer to Chapter 12 under the section
Importing Netlists into Pulsonix PCB.

Creating a Board Outline

The board outline is an outline that defines the extents of the manufactured printed circuit board.
There are two methods to create a board outline in Pulsonix. You can create a board outline on-the-fly
using Insert Board, or you can load an existing board Profile file. You could also import and extract
a board outline from another PCB system or create it from an imported DXF file or STEP file.

Insert Board

The Insert Board option is available from the Insert menu.

Insert Board allows you to interactively create a board outline by drawing it into the design. This
mode allows you to a add board outline using one of three shape styles provided: Rectangle, Circle
and Polygon. Board outlines would normally be created using an unfilled shape that is non-
intersecting and that has a closed start and end point. While adding these shapes they can be
carefully added to create the exact shape, or edited in more detail after being added.

Board outlines are not layer based items, therefore they appear on all layers as <Through Board>.

If creating designs that use multiple board outlines, e.g. flexible circuits, these can be added to the
design but you cannot add additional board outlines to act as cutouts. If you require cutouts, use the
Insert Cutout option to add ‘real’ cutouts within the board outline.

The Board outline default shape is taken from the Design Settings dialog and Defaults page. The
Line style used is defined in the Technology dialog under Line Styles.
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For more complex shapes, use the Construction Line feature. This provides advanced drawing
capabilities from which you can then create the board outline.

» To insert a board outline

1. On the Insert menu, click Board shape.
By default, the Board Polygon shape is available on the PCB toolbar as pure rectangles or circles
are rarely used.

2. Click to start the first corner. Move the mouse to create the first segment of the outline. By
moving the mouse you will notice that orthogonal segments are added, one horizontal, one
vertical but moving together in synchronisation with each other and stretching dynamically. By
clicking the mouse you will insert corners into the outline.

3. On each subsequent cursor move and click, more corners will be added to create a polygon shape.
The length of each segment can be seen on the status bar at the bottom of the Pulsonix window
(dx and dy). An example polygon might look like this:

l [ A

4. Double-click the mouse to finish the polygon. If during the insert, you decide that you wish to
cancel, press the <Esc> key on the keyboard.

During the creation of the board outline, clicking the right mouse button you can open a context
menu. This has additional commands applicable to this mode of operation. For example, Curved
corners and Angled segments through the Editing Options, as well as line style and grids.

From the context menu for a selceted board outline, you can also choose to Type the Coordinates
and/or Type the Offset of the shape being added.

Cancel Edit Polygon

Finish Here

Type Coordinate. .. =
% Type Offset... shift+=

Change Style... 5

Follow Construction Lines

Snap To Ikem

It is recommended that you create the board outline away from the edge of the design area and
starting on a grid point to make it easier to edit later on.
Importing DXF and STEP Files

Both DXF and STEP mechnical CAD files can be imported though the Import Designs option on the
File menu. This is explained further in Chapter 9.
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Using the Shape Information Bar

The Shape Information Bar (previously described) can also be used to create and edit board outline
shapes. This will enable complex shapes to be created using coordinates or lengths.

Shape Information x
=& | Paints ~ P2l
Auto
e

Layer: | <Through Board:

Locked[ ] Closed Filled

Type X Y ~
Start Point 63.2860 38.8520
Clockwise To 65.7860 41.3520
With Centre At | 65.7860 38.8620
Clockwise To 68.2850 38.8620
With Centre At | 65.7860 38.8520
Line To 131.5720 36.8620

Insert Mounting Holes

Mounting holes are used to support the board within an enclosure or other mounting device.
Mounting holes can also be included in the Footprint library used for mounting components when
used on the PCB.

Insert Mounting Hole is used to insert a mounting-hole pad into the design from the range of pad
styles defined in the Technology file under Pad Styles. The mounting hole may have a net name
connection in exactly the same way as any other type of pad in the design.

ol

o]

_ (]
Mounting holes

Wumuuuuuﬂuuuummuummuum—@
Though there are similarities in the way pads and mounting holes are regarded by the system there are
some important differences:

Mounting holes do not appear in the pad count when creating footprints and do not appear in the
overall pad count when creating Parts. They must be added using Insert Mounting Hole for this rule
to be active.

They are regarded as unnamed pads that do not appear on the Parts List output. If you need them in
the Parts list you should create the equivalent Part.

The system recognises that the drill hole size in the mounting hole may need to remove the whole
copper area of the pad, hence You will warned of this when creating the Pad Style used.
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Like ‘normal’ pads, mounting holes can be defined on the Top, Bottom or Through Board layers. The
layer can be changed while adding them or afterwards.

The mounting hole is recognised as such by the system and has its own Spacing Rules defined in the
Technology under Spacing Rules

During the Insert Mounting Hole operation, the default pad style selected is defined in the Design
Options dialog and Defaults.

P To insert a mounting hole
1. Click on the Insert menu, click Insert Mounting Hole

2. The default Mounting Hole shape as defined in Design Settings, Defaults will then be visible,
positioned at the end of the cursor. You may then place the Mounting Hole at the required
position in the design. Click the mouse to complete the Mounting Hole positioning operation.

» To change the mounting hole pad style
1. Select the mounting hole pad and right click.

2. From the context menu, select either Change Styles or Item Properties. The styles available
have been defined in the Technologies dialog under Pads. From the context menu you can also
add new styles.

Mounting Holes and the Schematic Design

Mouting Holes can be defined in your Schematics and attached to a Net if required. This is then
passed into the PCB during Translate to PCB as a PCB Doc Symbol.

Using Profile Files

Board Profiles are stand-alone design files that contain data describing standard board types that you
can use as a starting point when designing a PCB board of that type. They can be used as an
alternative method to using the Insert Board Outline option.

Profile Files can contain the Board Outline that has the shape and size required for manufacturing as
well as documentation (Text) and annotation required (Dimensions and Shapes). They can also
contain Mounting Holes, components (such as standard connectors along the edge of the board) and
Documentation Symbols. Origins, Copper, Pouring Templates, Areas and Attributes can also be
included in Profile Files to make them as ready as possible to start a new design.

Board profiles can be designed in Pulsonix or extracted from a design previously converted from
another system. Once in Pulsonix PCB the board profile information can be saved as a Profile design
file in its own right.

Even if a PCB design is completely finished, the profile data within it can be extracted into its own
file using the Save Profile option on the Setup menu.

Pulsonix is extremely flexible in that it can save and load individual entities of a design, even when
the design has originated in another design system.

There are examples of predefined industry standard board profiles for you to use, these can be located
in the Pulsonix\Profiles folder by default.

Loading Profile Files

The Load Profile option allows you to load an existing board outline as well as other design based
information, such as a page border or assembly/mechanical information. These files can also be used
along with Technology files as your starting point when using the New PCB Design option.
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P To load a profile file

1. On the Setup menu, click Load Profile. You are presented with a dialog containing a drop down
list from where to make a choice of profile files.

B Load Profile m} X
| 0K |
[None] - . . Cancel
C:AUsershPublich Documents\Pulsonixi Profiles
A-Landscape

A2-Landscape

A3-Landscase

B-Landscape
C-Landscape
eurob4B4z
eurob464s|
PCl-LongCard3-32
PCl-LongCard3-54
PCl-LongCard5-32
PCl-LongCard5-E4

2. Select the file required from the list and click OK.

3. For other profiles that may be located outside the immediate search path defined in the Folders,
Profile Files path, you will need to add the Profile File location to the list of search paths in order
to be able to load them.

The Profile will be added to the design but remains selected for repositioning. Click in free space to
deselect it. If you wish to move it, select the outline and drag it to the new location. The picture below
shows one of the supplied Profile files.

of

Any Technology file items that are used within the Profile file are automatically resolved during the
insertion into the design. Style items that match existing styles in the design are mapped to the
existing style. Styles of the same name but different contents are added using a new style name.

Once created Profile files can be added to the design like most other items. These can be added at any
time during the design process but it does make more sense to add them early on to give you a guide
to the size of the board and the area you have to work in.

A range of standard Profile files is supplied as part of the Pulsonix installation.

Component Pre-placement in PCB

When Loading Profile files as part of the Translate to PCB mechanism and when using the Load
Profile file option from the Setup menu, if the Profile file contains any pre-placed components
(connectors for example) then the following happens:
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® [f the Schematic or Profile file contain a Component of the same Part as that used in the PCB
design, the Component placed in the Profile file will be used.

® Component names used in the Profile file will be changed to match the ones used in the
Schematics. Any components in the Profile that do not match components in the Schematics will
be discarded.

Loading a Page Border

Page borders can be loaded using the Load Profile option. Alternatively, you can use a
Documentation Symbol or create a border interactively using the Insert Shape option.

Setting the Design Origin

The design origin is called the Coordinate System Origin in Pulsonix. By default this is located at an
absolute co-ordinate of 0,0 or the bottom left hand corner of the working area.

The origin can be changed at any time using the Design Settings option and Coordinate System tab.

Coordinate System Origin:  [0.00 | |D.E‘D |

(Cffset from the lower left comer of the design area)

The Coordinate System and Relative Origins can both be changed using the appropriate options on
the context menu of a selected item, i.e. a Pad. The Set Symbol Origin and Set Relative Origin
commands are located on the Select> sub context-menu for a selected item.

Add To Met...

|® Set Symbal Origin |
) Set Coordinate Qrigin
& To Mounting Hale

Insert Attribute. .. Shift+4

It is better, and more consistent to change it at the start of the design process. The process to change
the design origin has been discussed in Chapter 5, Setting Up The Design.

Inserting Components

One of the first processes to attempt once the Technology file and Profile files have been loaded is the
insertion of components into the design. Pulsonix provides the Insert Component function for this
purpose. This process would only be used if a Pulsonix Schematic or netlist from another system has
not already been loaded.

You can also use the Part Browser or Parts toolbar options to load Parts, these have been discussed
in a previous chapter.

Part and Footprint contents are created and saved into corresponding libraries. The Part entry must
contain a Part name, a Footprint and a corresponding Schematic Symbol or multiple symbols if the
Part represents a multi-gate Component. In PCB, an instance of a Part used in the design is called a
Component.

The actual creation of Parts will be covered later on in the manual in the Chapter on Library

Management.

Using the Insert Component dialog

Insert Component is a dialog driven option that allows you to select the required part from the
appropriate library.



Chapter 6 — PCB Design Editor 237

B Insert Component X

Look In: | [&ll Libraries] w Add
Which Parts:

Cancel

Matched: B5204 of £9125

Part; C {Generic} - Fira: Find...
Desc: |Generic Capacitor | Family: |Generic.f’D‘lF'
Eootprint:|C ~ |

#dd to Comp Bin  []

1 =

[ Preview Schematic & PCE [ Attributes  [] Wault

Use Look In to choose the libraries you are going to search for the required Part. Normally [All
Libraries] will be used to search all libraries in the Library folder, otherwise, select the library name
or use [Current Design] to search components in the design. All other libraries available in the drop
down list will be shown using their own name.

Which Parts enables you to filter the search list to find specific Parts. The Filter box can take any
name and wildcard characters. Use the Apply box to use any filter wildcards entered.

Wildcards can be used to make the filter more efficient. (Wildcards are special characters that are
used to match any character rather than being specific, for example * and ? ). For example, 74HC*
More information about using Wildcards can be found in the on-line help.

The Pins box is used to limit the matching parts to those with a known number of pins (blank means
any pin count but you can also use * for any).

Once a Part or range of Parts matching the Filter selection have been found, the first Part available
will be shown in the Part list. This will display the full Part name (74HC00) and the Library from
where it came, shown in braces, e.g. {74}.

From the Part library entry, the available alternative Footprint entries will be loaded into the Part
drop down list, e.g. DIP14. These may be surface mounted options or different packages available for
the Part. Choose the required Part and Footprint.

The Name box shows the default name stem for this Part (taken from the Parts library default
Component Name Stem entry) and the next available number in the sequence. Both the name stem
and the number can be edited if required.

The Symbol box lists the symbols that can be used to represent the component or gate in the
schematic design. If an alternative to the default is required, select it from the dropdown list. If the
part has multiple gates the symbol selection applies to the currently selected (and highlighted) gate.

The Component Bin check box can be selected if you wish to add the Component(s) to the
Component Bin. These components can then be dragged from the Bin into the design at a later stage.
The Number Of Copies box allows you to add multiple parts to the Bin in one operation. Please refer
to the section later on Using The Component Bin for more information.

The Preview check box opens the preview window allows you to view the Component before it is
inserted into the design, this gives you chance to visually inspect it to ensure that it is the current one.
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Preview Schematic & PCE Attributes [ Vault

<Spice Devicer =C
Category = Generic/CAP

C22 Walue = PuF

]
PuF ]

200 thou 100,00 thou

Once you have the Part you require (shown in the Preview window) and its Footprint and Name are
correct, you can add it to the design using the Add button.

If not adding components to the Component Bin, the Add button will dismiss the dialog from view
and will allow you to add as many Parts of the type selected as you like to the design. If you require a
different Part you should cancel this process by pressing the <Esc> key on the keyboard. This will
immediately return you to the Insert Component dialog from where you can make further Part
selections. If you wish to cancel Insert Component completely, having finished this process, you
can select any option button from any Toolbar and Insert Component will be immediately cancelled.
If already in the Insert Component and you wish to exit, you can again select <Esc> from the
keyboard or use the Cancel button from the dialog. You can also exit the Insert Component mode by
clicking the Select button on the toolbar (the Select button is the small 'Windows' arrow button).

Interactively positioning a Component

Whilst using the mouse to position the Component, you can use the context menu to change its angle
and to mirror it, for example. This is explained in detail in the Chapter General Utilities under
Moving Items and more specifically for PCB components later on in this Chapter.

Optimal Position

Optimal Rotation Use Mo Grid Shift+MN

Loicetvedan Use Toals Grid Shift =W

w[<]

1= Optimise Selected Mets Shift+L Use Tools Companent Grid

Auto Weld Now Use Toals Track Grid

[]

Cancel Move Show Track Length Limits

Use Tools Via Grid

Finish Here Reposition Cursor Text Use Toals Testpoint Grid
5 Type Coordinate... = Use Dynamic Align
4% . Use Track Grid
4y Type Offset.. Shift+=

Online DRC A Use Working Grid

o
T)'DE Rotate... i i R
Continuous Gnline D Use 0.5mm Grid

HRRE

Change Angle To 3 Display Clearance Use Via Grid
D_él Rotate By 307 R Allow Checking of Multiple [tems Use Component Grid
&) Rotate One Step Alt+R Push Mode ' Use Testpaint Grid
%9 Change Rotation Step.. [T EEs T ' Use Panel PCB Instance Grid
1 Mirror M Spring Back Use Text Grid
Show Placement Origin Move Horizontally Display Grids Ctrl=G
vi4 Show Dynamic Cans Only Mave Vertically = Grid step... G
Optimisation Mode 4 T i .| HE Grids.. Alt=G

Mintimal Pacitinn
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Once in the design, components can be positioned to their required location using the Move option or
by selecting and dragging them.

Further detail of moving components and the options available is discussed later on in this section.

Reloading Parts

Once components have been loaded into the design, you may need to change the Footprint or the Part
definition and reload it.

You should select the Component you wish to edit. From the context menu you are provided with
options to Reload From Library (once the Part and/or Footprint has been edited), Edit Part In
Library and Edit Footprint In Library to edit the actual Part or Footprint items.

If you select one of the two Edit options, you will be automatically placed into the Part or Footprint
editor with that particular Part or Footprint loaded ready for editing and saving. You should make
your changes and save the updated library item. This is detailed later on in the Chapter on Library
Management.

Once the Part and/or Footprint item has been changed, you need to then reload it back into the design,
effectively 'swapping' out the existing item for the new one.

To do this, use the Reload From Library option. With the Component selected in the design, you
can use the option from the context menu, or the Reload From Library options on the Utilities
menu.

Note: All other components using the changed Part or Footprint will also be reloaded. You cannot
have two different versions of the same Part or Footprint in a design.

Performing the Reload

When the reload process is started, if you did not use the Browse method of starting it you will be
presented with a confirmation dialog:

Reload From Library *

Only reload if different version
in the library

Reload contral

[ Keep attribute styles [ Keep bond pad positiondstyle overides
[ Keep attribute pasitions [ Keep pad position/style overides
[ Keep local attibute values [ Do not reload footprint

[ Replace footprint with default
[ Replace pin netwarks

[ Re-apply name stem fram part [ keep lacal plane connect
[ tatch position of the first pad
Cancel

Check the 'Only reload if different version in the library' box if this is required. Leave it
unchecked if ALL chosen items are to be updated even if their version is the same as in the library.

The system will then analyse the design and work out what items will be updated. When this is
complete you will be presented with a summary dialog in order to decide whether to go ahead with
the update, or just produce a report at this stage.
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You are prompted with a summary page detailing the status of the Parts and Symbols within the
design or the selection.

Reload From Library - Summary X

Reloading single part or symbal.

Selected for reload:

Part

Azzociated Parts
Symbol

Doc Symbolz

= =

Selected items to be reloaded:

Partz
Azzociated Parts
Symbol

Doc Symbolz

o—oo

Additional symbols to be reloaded:

(=]

Svmbols

Selected items NOT to be reloaded:
[Same werzion ag library)

Part

Azzociated Parts
Sumbalz

Doc Symbols

[=F=N=Trm

[ Include Component M ames In Repart

Wiew Repaort Cancel
From this you can view the report (View Report) of the changes to make, and then once satisfied
with the proposed changes, can Perform Reload to actually make the changes.

If using the Reload From Library option from the Utilities menu, you can Browse the Parts,
Symbols and Documentation Symbols to change.

Reload From Library/Vault X
Parts:
_DK

[CJHCPL-31504#300

[CIHCPL-315) Cancel

Check Al

Agsociated Parts: Uncheck Al
Footprints:

[]508Gw350

[]50u16-37012

Documentation Symbols:
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Only refoad if different version Reload From:
in the library/vault Library [ ault
Reload contral
[ Keep attibute styles [ Keep bond pad pozitionstyle override:
[ Keep attibute positions [ keep pad position/style overides
[ Keep lacal attribute values [ Da not reload faotprint
[ Replace foatprint with default
[ Replace pin netwarks
[1Re-apply name stem from part [ Keep local plane connect

[ Match position of the first pad

This dialog allows you to make a more refined selection based on the name of the library item rather
than its selection or a general ‘reload all’ option.

By using the Reload All option, and 'Only reload if different version in the library' switch, you
can use the View Report button to get a report of the library items used in the design have been
updated in the libraries since you created the design.

Press Perform Reload to carry on with the reloading. If you had errors detailed in the summary
dialog, but did not notice you will be presented with a warning. Press Yes to perform the reload on
the parts and symbols that can be found in the libraries. Press No to abort at this stage.

Connected Components

If your Component were connected, it would normally be reloaded with a component with the same
number of pins in order to not affect the nets. The connections or tracks will be attached to the pads
with the matching pin name in the new part.

If you reload a part with more pads, the extra pads will remain unconnected in the design. If you
reload a part with less pads than on the component, any connection to a pad that does not exist on the
new part will be removed, and any track in the same situation will be disconnected and left dangling
for you to sort out in the design later.

For schematic components, as well as pins being matched up, gates are matched so that if you reload
a four gate Component with a single gate Part, only pins on the first gate of the original component
will retain their connectivity. All connections to pins on unmatched gates will be disconnected and
left for you to sort out later.

Using the Component Bin

This section details how the Component Bin is used in the PCB design editor. An overview on how
the Component Bin works generally can be found in the Chapter Using Pulsonix.

The Component Bin in PCB is used for holding unplaced components to free up the design area while
placing other components. This makes the design area less cluttered, especially on dense complex
designs.
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Moving Components to/from the Bin

Components can be moved to the Bin using a number of methods:

® By dragging the Component to the Bin from the design

® By using the right mouse button and the Move To Bin option
®  From the Insert Component option

® From within the Auto Place option using Move To Comp Bin
® By using the Translate to PCB option within Schematics
Dragging Components to the Bin from the design

The most practical method of placing components into the Bin is by clicking and dragging the
components from the design. Multiple components may be selected and dragged into the Bin also.

If the Component is connected with connections only, the connections remain in-tact when the
Component is moved into the Bin but are not displayed until the Component is brought back into the
design. Electrical connectivity and total design integrity are maintained at all times (even though the
connections may not be displayed). This principle is for PCB only, the Component Bin Schematics
editor works differently.

If tracks exist to a Component, a warning dialog is displayed if a Component move is attempted to the
Bin. You can at this point select to discard all tracks to the Component by clicking Yes, or returning
to the design by clicking No or Cancel.

Confirm Move To Component Bin X

& Component "U21" has routed tracks.

Moving it to the component bin will unroute them. Continue?

TES Mo Cancel

If you click Yes, when the Component is replaced into the design the tracks are not rebuilt, and the
Component remains unrouted. At this point only Undo can restore the tracks if you've made a
mistake, provided you have enough Undo levels set to get back to the point where the Component
was routed!
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During the move of components to the Component Bin, if components are locked, a warning dialog
will be displayed.

Operation on Locked ltems =

Befare performing the operation, what do you want ta do
with the locked items?

Dezelect thern (DO NOT perfarm oparation on ther,
() Unlock them [Perform operation on them |

(®) Keep locked [Perform operation an them]
Perform Operation Cancel

This provides you the opportunity to confirm the move of the components but is an additional safety
feature for critical components that may have been deliberately locked.

From the context menu

Another method of moving components to the Bin is by selecting the components and right clicking.
On the context menu, from the Components/Symbols> sub menu, the Move To Bin option will
allow you to directly move any selected components to the Component Bin.

This context menu option is also available if a frame select has been executed, even if it includes alien
objects such as board outline, copper or free text etc.

Change Testpoint...

Add To Met...
| ComponentsfSymbols >| LEI Reload From Library. ..
Auto Weld Selection Gef Replace Part...
Edit Park In Litw
Execute Hyperlink 'ﬁ - Fart In Lhrary
i Edit Footprint In Library. .
Highlight Selection |IoEl Move to Bin

Insert Attribute. .. Shift+4
Add To Favourites

I Properties,.. I

Again, the same rules apply for routed components losing their tracking information when placed in
the Bin as before.

From Insert Component

Insert Component provides a check box and Number Of Copies entry to send components directly
to the Bin ready for placement.

Eootprint:| C ~ |

Heme

Add to Comp Bin

Murnber of Copies: |1 o

Freview Schematic & PCE [ atibutes [ Wault

From Auto Place

Another quick method for moving all components from the design to the Component Bin is to use the
Auto Place option located on the Tools menu. Within this dialog is a selection to move the
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components to Component Bin. By selecting this, all unlocked components in the design will be
moved to the Bin.

Auto Place All =
Componetits Ta Place ‘where To Place
Dutside Board [ Inzide Board Fram Bin Compaonent Bin
Selected Orly [ Board Selected Board Only
[ tvea

[ Include Locked Components

rAarn

From Translate to PCB option within Schematics

Within the Translate To PCB option in the Schematics editor, you have the option to send all
Unplaced Components to Bin during the translation process.

Profile File: |[N0ne] ~ |

All companents ta bin Shaw bin

Moving Components from the Bin

Components can be moved from the Bin using a number of methods:

® By dragging the components out of the Bin into the design

® By using the right mouse button and the Move From Bin option
® By using the Auto Place option

Dragging Components from the Bin

The Component Bin is designed to be an interactive tool for fast ‘drag & drop’ usage. To place
components in the design from the Component Bin, you select the Component required in the Bin or
in the Preview window, and drag it into the design.

Note: during move the drag may be cancelled by dropping the Component back into the Bin, by
pressing the <Esc> key, or once released, by using Undo (Ctrl-Z).

Once in the design the Component can be moved until released.

Using Move From Bin from the context menu

From within the design and with nothing selected (and outside the Component Bin), if you right click,
the option Move From Bin is available.
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Enable Select Mask

Frame Select

Line Select

Polygon Select

Select Path

Select All Visible Ctri=A
Select All

% & HF ¥ =

Auto Select

ETR 4

Reverse Layer Order Alt+P

Paste Ctrl=V

Repaosition Design...

HoeB1#ahh @b

Move From Bin

Save [tems To Library...

Reload From Library...

Fetch Component...

Find XY...

Insert Attribute... Shift+A
Design Properties..,

Place Coordinate Crigin

Place Relative Origin

Place PCE Panel Origin

This will move the currently selected Component in the Bin into the design ready for positioning.
Once the Component has been released, the next Component available in the Bin will be moved into
the design ready for positioning.

Placing Components around the Board Outline

To aid placement, there are a number of placement options that Pulsonix provides. Each option will
depend on the designers’ own preference and design practices but Pulsonix is flexible enough to
allow any of them to be used when required. You have Place Around Board, Auto Place, Place
From Component Bin and Manual Place.

Following a the Translate To PCB process, if the components are not sent to the Component Bin and
no board outline exists or a Profile file has not been specified, the components will be placed in an
orderly row in the design area (away from the 0,0 origin). If a board outline exists or a Profile file
specified, Place Around Board is automatically used.

As it suggests, the Place Around Board facility is used for fast placement of components around the
outside of an existing board outline. This placement methodology is an alternative to the 'stacking'
method and is often preferred by designers. The Component Bin placement facility is another
alternative and will be generally preferred overall for users manually placing designs.

The Place Around Board option is used when you require the components to be 'stacked’ close to the
working area and around the board outline ready for manual placement.

When run, it places the components, grouped by Part Name, spiralling around the board outline. If
there are many components in the design and the board outline is too small, the spiral will continue
again around the board continuously until all the components have been placed.

Components that are already routed or locked will not be placed.
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P To place around the board outline
1. From the Tools menu, click Place Around Board
2. The components will be placed around the board outline.

You may need to press the <A> key (Frame All) to see the whole design after placement but you will
notice that the components have been stacked around the board outline. This feature uses the Part

name for its selection criteria, stacking components of the same Part name in columns around the
board outline.

On-line Design Rules Checking (DRC)

Pulsonix supports On-line design rules checking (On-line DRC) for use during any interactive
activities, such as Manual Placement, Manual Routing, Insert Text, Move etc. Each of these options

will be discussed throughout this chapter of the manual, where the On-line DRC process will also be
detailed.

With the checking enabled, all interactive modes will be continuously checked to the Spacing Rules
defined in the Technology Spacing Rules dialog. See previously in this chapter for more details.

From the Options dialog and Online DRC page, if the On-line DRC box is checked, some level of

design rule checking will be performed during manual editing of the items in the design. The depth of
this checking is determined by the following options:
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Online DRC
Checking

Continuous ~ {Avoids emors during some interactive operations)

On Drop (Check changed data after interactive operations)
Check Attached Tracks & Wires On Drop

After Edit (Check item after having its properties edited)

Add Emor Marker fto show first emor)

Continuous On Drop Only
Check Poured Copper Check Via In Pad
Check Comp To Comp

Check Same Net Via To SMD

[ Show Design Rule Clearance
On All kems
Refine Within Distance

(®) Within Set Distance: (0.0000

() Within Grid Steps: 2

Show Clearance On Breakouts

Allow Checking of Multiple tems

Continuous is used to automatically avoid creating design rule errors during some interactive
operations. Generally it is used if the operation involves editing a single item on an electrical layer.
For example, whilst adding a track it will not be able to cross other items on the same electrical layer.
Moving a Via will not allow you to place it on top of any tracks on layers it spans. A Component is
regarded as too complex to use continuous checking on as it would be too slow to check every layer
for ‘“Through hole’ pad violations on the fly.

On Drop is used to automatically check the changed items in the design after any interactive
operation. If an error is found, you will be asked if the error is allowed, or if the operation should be
reversed.

Pulsenix

"Pad to Pad Error (P-P)".

Finishing here would result in this design rule error.
Do you wish to finish here anyway?

Yes ] Mo

For example, if you drop a Component on top of another (during Move) you are warned of a Pad to
Pad error. You may then leave the Component in error, or carry on moving it to find a legal location.

The Check Attached Tracks On Drop option is used when moving or rotating a Component that has
dynamic tracks attached, it is difficult to drop the Component in a location where the tracks do not
violate other design items. Generally, these tracks would be tidied up at a later stage. Uncheck this
box to avoid getting errors reported for these tracks.

After Edit is used to automatically check the changed items after editing when using Item
Properties. If, when applying the changes in a Properties dialog, an error would occur you will be
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asked to confirm if the error is allowed. If not, the changes are not applied and you are returned to the
Properties dialog to amend the change.

If using On Drop or After Edit and you wish to continue even though the change will result in an
error, use the Add Error Marker switch to automatically insert an error marker into the design. This
is a visual reminder of the error so that you can fix it at a later stage.

Show Design Rule Clearances

To aid the On-line DRC mechanism, from the Options and Online DRC page, there is also the Show
Design Rule Clearance option that is used to automatically display the clearance around static items
during some interactive operations.

[ Show Design Rule Clearance
On All kems
Refine Within Distance

(®) Within Set Distance: |0.0000

() Within Grid Steps: 2

Show Clearance On Breakouts

Allow Checking of Multiple tems

Generally, it is used if the operation involves editing a simple single item on an electrical layer. The
clearance shown is set to the size of the allowed spacing between the static item and the item being
interactively edited. This clearance shows how close the item can be placed to another without
violating it. As the dynamic item moves within the allowed clearance gap, the clearance will change
colour to indicate that the moving items is in error.

AL

When checked, there are three modes of operation available; On All Items, Within Set Distance and
With Grid Steps.

With On All Items selected, as you start the interactive operation, all the electrical items that are
visible on the same layer as the item being edited will have the clearance drawn around them. This
will be cleared when the operation has finished.

Within Set Distance set, when the item being edited comes within the entered distance of another
static item on the same electrical layer, the static item will have its clearance drawn around it to warn
you that you are getting close. The clearance will disappear as you move away from the static item
again.

Within Grid Steps set, when the item being edited comes within the entered number of grid steps of
another static item on the same electrical layer, the static item will have its clearance drawn around it
to warn you that you are getting close. The clearance will disappear as you move away from the static
item again.

This mode can also be switched on or off from the context menu during some interactive operations.
On the context menu, this option is shown as Display Clearance.
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Change Segments 3

arline DRC |
Display Clearance

Push Mode 4

Change Grid 3

The Clearances colour can be set up in the Colours dialog on the Highlights tab. You should choose
a contrast colour to make it visible against other design items.

Name Displayed | Colour
Attached Dimensions/Callouts ]
Branch Point Via ]
Bus Tracks ]
Clearances
Component Pad 1
Differential Pair Path
Differential Paired Tracks
Highlight
Highlight “Fail’
Highlight ‘Pass’
Highlight "Unchecked
Highlight "Warning'
Locked Track Segments
Marked Net
Not Fitted
Onling DRC
Selection
Signal Paths
Star Point
Sub Nets
Test Points (Al
Test Points (Top)
Test Points (Bottom)
Unconnected Pads
Unfinished
Variants
Weld Spot
Weld Spot (Direct Hit)

<l

|

&

10

[IENENIEN]

K

Placing Components interactively

There are many advanced features within Pulsonix for placing components in the design. However,
the basic operation of moving components is very straight forward following basic Microsoft
standards.

The Component Move mode is activated by using the Move option or by dragging the Component
(using a pick and drag action). When any Component is placed in the design, from Insert Component
or out of the Component Bin for example, it remains ‘dynamic’ on the end of the cursor ready for
placement.

Individual components or groups of selected components can be moved at any time. Using this
method, anything else selected by mistake will also be included in the move as part of this transient

group.

Overview of Component placement options

During Component Move you have a number of features available, you can:

® Rotate and Mirror a Component

® Optimise connections that are attached to the Component during Move
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®  Show the optimal position of the Component using a ‘Force Vector’
® Free dynamic tracks segments attached to the Component to make the placement clearer

®  Push other components out of the way, and Spring other components back to their original
positions Place or Rotate the Component in its Optimal position

® Change the Placement Grid of the Component
As part of the Component interaction, you also have facilities that can be accessed during the

selection of a Component, these are in addition to the options available during Component Move:
® Cut, Copy, Paste, Delete and Duplicated the selection
®  Enable the Move mode

® Optimise nets attached to the selected Component

® Lock or Unlock the Component

®  Unroute tracks attached to the Component

® Automatically route nets attached to the Component
® Edit the Component in the Footprint or Parts library
® Reload any changed components

® Move selected components to the Component Bin
Setting up the options

Most of the options available during Move can be pre-defined ready for use using the Move tab on
the Options dialog. You can also access all of these options from the context menu when moving a

Component.
Auto Weld Component Pushing
Allow Weld To Split Tracks
Push Direction:  |Baoth " Cancel Move
Show Weld Spots Finish Here
[ Spring Back ¥ | Type Coordinate... =
Snap To Construction Lines 4% Type OFfset... Shift+=

Show Force Vector

(O Within Set Distance: | 0.0000 Change Angle To 3
(® Within Grid Steps: Show As: @ Long Amow (O Compass 0% Rotste By 90 R
Include Power Net | Rotate One Step AR
Oil) Mirror M

Optimise: Include Ground MNet

|C0ntinuous - | Shaw Placement Origin
Y Optimisation Mode 3
Full Cptimisation On Drop [[] Dynamic Align P
Optimal Position
Large Net: nodes  CHIEEIOTER TSRS REEE . Optimal Rotation
Exterts Original Position Farce Yector
Pads Vias ool Optimise Selected Mets Shift+L

[] Show Placement Crigin ko Weld How

Move C Ta Pl nt Origi
[[IMove Cursor To Placement Origin Push Mode 4

Rotate/Mimor About Centre

[ Show Invisible Attached Tracks/Connections
[ Free Angle Adicining Segs

Preserve Attached Segments

Constrain Orthogonal Segment

[ Auto Rotate Bond Pads

Fush Direction

[J Auto Ratate Components (on polar grid) ‘ v

Spring Back

[ Show Dynamic Connections Cnly
Always Move All Vias In Composite Span

Move Horizontally

Move Vertically

hange Grid
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Options available on the context menu

There are modes of operation that can only be accessed from the context menu.
Change Angle To> - Select from the list of angles, 90, 180 and 270 degrees.

Rotate by 90 - This is a manual rotate feature using a 90-degree step. If you wish to use the Rotation
Step defined in the Options dialog on the Interaction tab, use the shortcut key <Alt-R>. Rotation
steps are always defined and implemented Anti-clockwise (counter-clockwise).

Mirror - Mirror will flip the selected Component(s) to the other side of the board. This will mirror all
the pad positions and any associated text e.g. Component name Ul etc. and silkscreen outlines
automatically. All pad stacks are automatically mirrored as well, although with SMT devices pads
will only be defined on the top or bottom electrical layers anyway and will mirror to the opposite side.

Optimisation Mode (Connections) - When moving items that are on nets, the dynamic items are
connected to stationary items. Where these connections are not tracks, unrouted connections are
drawn from the moving items to the static ones. You have the choice of how these unrouted
connections behave using the Optimise parameter as follows:

Continuous - The nets attached to the moving items are continuously optimised dynamically on-the-
fly to show the minimum unrouted connections required to connect to the moving item at its current
position.

Never - The unrouted connections are not optimised. They stay connected to the same stationary item
that they were originally connected to.

On Drop - The unrouted connections are not altered whilst dynamic, but as soon as you release the
Component into its new position, all nets attached to the moving items are optimised.

Whilst moving items on nets, you can right click the mouse to use the context menu options Optimal
Position and Optimal Rotation to take the items to the position pointed to by the force vector.

Optimal Position

By selecting this option, the Component selected will move to the position the system calculates as
the optimal placement. This is the most balanced point in the design relative to its attached connection
length and the number of connections attached to its pins.

Optional Rotation - Like the Optimal Position option, the Optimal Rotation option will determine
the best rotation based on a balanced assessment of the Component, its attached connection lengths
and number of attached connections. The mirror axis is taken around the Footprint origin.

Force Vector - The force vector is a visible indicator that shows you how far, and the direction to
move the dynamic items to their 'optimal’ position.

This position is where the nets attached to the moving items would be balanced to reduce overall
connection length and avoid very long and very short connections. In other words to place the items
where they are not too close nor too far from other stationary items on the same nets. If you consider
the connections from the moving items to the stationary ones as springs, the optimal position is where
the moving items would come to rest if you 'let go'.
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The force vector is drawn using the Highlight colour defined in the Colours dialog on the Highlight
tab. There are two types of indicator available as follows:

Long Arrow - An arrow is drawn from the centre of the moving items to the optimal position.

Compeass - A circle is drawn centred on the moving items with a small arrow on it pointing towards
the optimal position. Another filled circle is drawn inside this circle to indicate how far away the
optimal position is. The filled circle gets smaller as you get closer to the optimal position.

Optimise Selected Nets - Optimise is completed based on the current selection.

Free Angle Adjoining Segs - If a routed Component has tracks exiting its pads orthogonally, the Free
Angle Adjoining Segs option will allow the track end segments to become free angle segments
loosing their orthogonality. To subsequently restore the free angle segments to 90 degree segments,
the tracks must be edited and the segments reinstated.

| Tpal | ] ]

—-— ] .

r— -_l__ mmm  Start position of

] % mmm tracks with 90

— -—l__ == degree corners

—-— —-— ]

|y ] ]

| Jpal | —-— —-—

—-— —_— —-—

—-— —-—

—-— ] ] —-— ] ]

] ] | | ] ] |

|| - ] ] —-— —-— ]

e ] ]

] ]
] ]
] ] ]

New position of
orthogonal tracks
after Component

Move

New position of
tracks after Component
Maove with Free Angle
Adjoining Segs mode enabled

Auto Weld Now - With the Auto Weld option switched off in the Options dialog, you can weld
items on command.

Push Mode - Whilst moving components, the option is available to push other components out of the
way in order to make room for the moving Component. Components that are locked will not be
pushed, and components will not be pushed outside of the board outline.

The following parameters govern the Push Aside characteristics:
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Continuous - Stationary components are continuously pushed out of the way whilst moving
components.

Never - No push aside is attempted when this is set to Never.

On Drop - You can move the components and when dropped, any components in the way will be
moved aside to make room for the dropped ones. The direction they are pushed is controlled by the
Push Direction.

During Push Aside, the Optimum Component to Component spacing defined in the Design Rules
page on the Technology dialog is used in order to space the components out. The outer boundaries of
the Component are defined as the maximum extents of any Placement or Silkscreen outlines, and
Pads/Mounting Holes.

Additional Design Level Spacings and Rules:

Board Bond And Die Pad Component  Copper Dl Pad Track Enclosures

Component to Component Space Component to Board Space

Minimum: | 0.000 Optimum: | 0.000

[ No Same Component Padto Pad Emors

Following placement, the Minimum Component to Component space is used by the Design Rule
Check option to check for overlapping components, again, using the Component boundaries for
checking. Boundaries are taken to mean the Component Body Area or Component Clearance Area if
defined in the Footprint. If these haven’t been defined, the option will use the maximum extents of the
component bounding box as its boundary. Additional rules apply to component body and clearance
areas when placed alongside each other.

L 1
I::>I_I
I

In the diagram above, figure @ shows Component Move being initiated by the Component at the
front. At this point, the components still have their original placement position and spacing. @ shows
how, during the pushing sequence, each Component ‘butts’ up against the next using the Component
To Component spacing. ® As the components are pushed, they now start to move together, adhering
to the Component spacing rule.

Push Direction — enables the direction that the stationary components will be pushed to be defined —
the choice is Horizontal, Vertical or Both. The example below shows how the Component would be
pushed in the vertical direction if Vertical was selected.
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Component move starks

Spring Back — With this switch selected it will enable a Component that has been pushed out of the

way, to return to its original position once the pushing Component has passed or cleared the position.
It is only relevant when Component Pushing is enabled. When the Push mode is set to Never, Spring
Back is disabled regardless of its switch setting.

Component #2 iz pushed
out of the way in the
wvertical direction

From the Change Grid option you can change the grid to use during Component placement when
using Move, and get to the Grids dialog from where the grids can be changed. Once a Grid has been
selected, each time you come back to move components they will use that grid.

Farce Yeckar

%af3 Optimise Selected Mets Shift+L
Auto Weld Mow Use Mo Grid Shift+r
Push Mads N Use Working Grid Shift+i
P e 5 Use Component Grid

Spring Back. Use <Track: Grid

Use <¥iax Grid
Move Horizonkally =5 <Hia= G

Use Testpoint Grid
Move Yertically 58 Testpoint tari
Display Grid ChrHG
| Change Grid ’| isplay Grids 1l
B Grid step...
B arids... b+

From this menu, you can switch the Screen Grid on or off. It is quicker to use the default keyboard
shortcut for Display Grids of <Ctrl-G>.
Component placement features available on ‘select’

These features are available when a Component is selected but not in Move mode or being moved.
Lock/Unlock

This provides the ability to fix a Component in place so that it cannot be moved. A lock status will
also disable other functions being performed on it until unlocked, e.g. Move to Bin etc.

If you attempt to move a Component that is locked a dialog is displayed.

Operation on Locked Items x

Before performing the operation, what do vou want to do
with the locked items?

Deselect them  [D0 MOT perfarm operation on them’
() Unlock thern [Perform operation on thern |

(®) Keep locked [Perfarm aperation on thern)

Perform Operation Cancel
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This provides you with the option to perform the option anyway, to cancel or to deselect the
Component.

Nets>> Optimise Selected Nets - With any components selected a single Component optimise can be
performed. The nets attached the selected Component will be reconnected to the nearest node points
to create the shortest connection length.

Nets>> Unroute Selected Nets - Any tracks attached to selected components will be unrouted back
to connections for the complete net, including any changes to layer and vias. Care should be taken
using this option as the complete net will be removed back to connections, including connections
spanning any number of components.

Nets>> Autoroute Selected Nets - when used on a selected components all nets attached to the
Component will be routed automatically using automatic routing properties.

Reload From Library will reload the Component instance on the design with one from the library. A
small dialog is displayed that provides you with a selection of switches to define how to reload the
Part from the library. This option would also be used if the Edit Part in Library or Edit Footprint
in Library options have been used.

Edit Part in Library - The system will look for the Footprint with the same name as the Footprint
the selected Component uses in the available footprint libraries. These libraries are defined using the
Library Folders facility. If the Footprint is found it is read from the library and opened for you to
edit.

This is just the same as if you used the Library Manager to edit the footprint. The Technology File
used for the footprint will be the current selected Technology file from the Library Manager PCB
footprint dialog.

Edit Footprint in Library - The system will look for the Part with the same name as the Part the
selected Component uses in the available Parts libraries. These libraries are defined using the Library
Folders facility. If the Part is found it is read from the library and opened for you to edit.

This is just the same as if you used the Library Manager to edit the Part. The Technology File used
for the Part will be the current selected Technology file from the Library Manager Part dialog.

Move to Bin enables you to send any selected components to the Component Bin. Components that
are locked will not be sent to the Bin. Components that have tracks attached can be sent to the Bin but
the tracks are lost, the tracks are returned to connections so the connectivity is not lost (it is unusual to
send routed components to the Bin unless performing design modifications). In any case, a warning
dialog is displayed for you to confirm the removal of the tracks before sending them to the Bin. If you
press OK but mistake, Undo can be used to recover the situation.

Using the Properties option to move components
When a Component is selected the Properties option displays information about the components.
B Properties: Component - Component O X

Component  Nets on Pins Comp Attributes  Variants  Vautt

Bt OLocked

[ Variant Id: l:l Allow Automatic Changes:
Position: 128.01600 | |98.04400 Auto Footprints
Angle: 180.0 [ Mirored

Layer: | <Top Side= |

[ Part: [PIC16F54-X_S5G | | change..
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Fields that are not editable are displayed greyed out. This dialog enables you to change Component
Names and their position using the co-ordinates displayed. This dialog also enables you to change the
components Rotation, Mirror and Lock status as well as the Part type, and Footprint.

Adding Connections

Connections are used in Pulsonix to indicate the point-to-point connectivity of the netlist. When using
Pulsonix in 'interactive’ design mode and designing PCBs on-the-fly, the ability to add connections or
tracks directly is essential to create the netlist. This design practice is easy to accommodate using
some basic modes of operation.

PCB Safe mode

However, Pulsonix also features a design setting to allow or not allow the PCB netlist to be modified.
The PCB in Safe Mode of operation would be used when a ‘master’ Pulsonix Schematic or external
netlist is being used. This would mean that with the switch checked, no modifications can be made,
including addition or removal of connections. By default, this switch is set Off (unchecked) so that
modifications can be made.

If using the PCB design as the ‘master’ (rather than the Schematic), you should uncheck this switch
so that PCB modification, like adding connections or Parts, can be made.

The PCB in Safe Mode switch is located on the Design Settings dialog under the Synchronise tab.

[JPCB in Safe Mode

Allow PCB Only single pin nets

Synchronised Design Name

Name: |Announcer

Back Annotation

Enabled Clear History
Synchronise with Schematic

[ Apply All Rules Strictly

[ Apply Spacing Rules

Apply Footprint Changes

Apply Net Class Changes

[ Apply MNet Colours

[ Apply Schematic Track & Via Size Rules to Net Styles
[ Apply Schematic Title & Subject

[ lanare Atribute White Space

[ Allow Update of Schematic to match PCE

Connection Properties

Connections or Nets carry a number of properties that give its characteristics. These are:

® A user defined Net Name or default Net Name
® A Net Class that itself contains: Track style, Via style, Guard Spacing

® Attributes (if applied to the Net)

These properties have been discussed in detail previously in this Chapter under Setting Up A PCB
Technology.

Connections can be connected to a number of electrical items:

® Pads, Free pads and Mounting Holes, Testpoints, Vias
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® Tracks

®  Copper, Copper Pouring Template areas

For most of these items the attaching of connections is straightforward and obvious in use. For some
though they require more explanation:

Vias — connections can be attached to an existing via. Once routed, the track will then ‘copper share’
the existing tracks.

Tracks — a connection can be added anywhere on a track that means that it will ‘copper share’ the
existing tracks or nets back to the connection node. Once routed, this connection will act as though it
has been created as a track but overlaid on an existing track of the same net and following the same
routing path. This situation may be created to form a ‘T’ route.

Copper — connections can be attached to copper items so that the copper is attached to a particular
net.

Templates — by attaching a net to a Template, when poured the copper will inherit the net name. This
means that when the shape is poured, it will automatically associate itself with the attached net name.

There are also ‘Wire’ items in the Pulsonix product, these are not the same as connections. Wires are
used as ‘jumpers’. These are discussed later on.

Default Connection values

When adding a Connection to the design, the default values it uses for Net Class, Name Layer and
Name Style are defined in the Design Settings dialog under the Default Tab and Nets.

The Name Layer and Style are used when Show Net Names is enabled.
Inserting Connections

P To add connections using Insert Connection
1. From the Insert menu, click Insert Connection.

2. Click on the first pad to start the connection, click on the second ‘target’ pad. A connection will
be made between the pads.

3.  Move the cursor to the next item and click to make another connection. The insert connection
mode works in 'daisy' chain from one point to the next until released.

4. Press <Esc> to end Insert Connection mode.

During Insert Connection you can also use the context menu that allows additional options:

Cancel Insert PCE Connection

[ Esit This Mods

% | Type Pin Mame =

Change Met Fz
SHY Mark et H

Show Finish Matkers

Type Pin Name allows you to start a connection on a pad or add to the next pad by typing it’s name,
for example, click to start the connection and then type in IC2.9 in the Type Pin Name box to connect
to the IC2 pin 9.
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Change Net allows you to add or change the existing Net Name of the connection. The standard
Change Net dialog is displayed. This is discussed in the next section, Managing PCB Nets. This
option is available during the Insert Connection operation.

Mark Net is used to highlight the complete net so that you can view the complete net path within the
design. This switch toggles the Mark Net option on and off. This is very useful and is also assigned to
the shortcut key <H>.

Show Finish Markers switches on and off the finish markers and is directly linked to the Options
dialog.

Once added to the design, if you select the connection and right mouse click, the context menu
displays a number of options:

[y Lock.

[ he Y] Changs Met. .. Fz
Edit Segment Shltihet

9% Mark Net H

Complete As Track

R Fi Met
% Highlight Selection emove From fe

31 Add To Favourites Fo shiow Met Mame

Properties. .. 1 :e|§ Optimise Selected Nets Shift-+L
}nﬂ Display Selected Met Connections

"'-'-|§ Auko Route Selected Mets

The Select option displays a number of Selection and De-selection options as well as Select Next and
Select Previous. This will allow you to select the next item under the current cursor position,
likewise, will allow you to select the previous item. This is used when the cursor is above a number of
connections in a tight area.

The Edit option opens to the standard Cut, Copy, Paste and Duplicate options.
You can apply a 'Lock’ status to a connection that disables it from being Optimised or Deleted.

Nets will reveal the options Change Net, Split Net, Mark Net, Optimise Selected Nets, and Route
Selected. Split Net is discussed in more detail in the section below, Managing PCB Nets.

Edit Segment - once the connection has been added you can double-click on it or use the Edit
Segment mode from the context menu to start routing it.

Remove From Net is used to remove any connections from the selected net.

Show Net Name this displays the net name on the selected net. The Style of the text used for the net
name can be changed once displayed by selecting it and pressing the S key for Style.

Properties displays the characteristics of the Connection, Net and Net Attribute. You can have any
number of net attributes that can hold characteristics for other purposes, e.g. routing, simulation or
Guard Spacings for additional spacing clearances on that net.

Managing PCB Nets

By default, any connection added to the design will contain a default net name. This name can be
changed during the addition of the connection or renamed afterwards.

Setting the default net name suffix

Pulsonix is installed with pre-defined. Obviously, these settings can be changed if not suitable but
care should be taken when changing them. You should only change them if you know what you're
doing. Use the Design Settings and Naming dialog to do this.
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Farce To Upper Case
Component Names

Name Options
[ Case Sensttive Pin Names

[ Gate Mames [ Numeric Gate Mames

[ Met Names Fill-In Gaps In Number Ranges
[ Part Names [Case Sensitive Drill Size Idents
[ Pin Names

[ Test Paint Names
Name Ranges

Range Start: D
Range End: EI

Range Separator: I:I

ltem Separator: l:l

Example:  1U1,U[3-6]

Default Net Names
Name Stem:

Number Width:

Pin Names

Component to Pin
Name Separator:

[ 1]

When you add a new net to the design, it is assigned a default name. This can subsequently be named
if you so wish, but this part of the dialog is concerned with the format of the default names. The
default name consists of an optional stem followed by a number (that are allocated sequentially). The
name stem is specified in the top Name Stem control. The Number Width control specifies the
minimum width of the number that will be padded to the left with leading zeroes.

For example, a name stem of 'Net' and a number width of '2' gives net names of the form 'NetO1'. You

can change these values after you have begun designing, but this will result in nets being renamed that
could be undesirable.

Using default Net Name properties
Nets have a number of default properties - Net Name, Net Class and a Connection Width.

Nets that are not named will automatically be assigned a default Net Class and display width when
added to the design. As previously described, these values are taken from Options and the Defaults
dialog.

Nets that have previously been named in the Technology file will already have a Net Class assigned
to them, and subsequently will also have a connection thickness.

Naming Nets & Renaming Nets

At the addition of connections or the editing of connections you can name them using your own name
as an alternative to a system default net name. You can press the <F2> shortcut key that will display
the Change Net Name dialog. This option is also available on the context menu.

Change Met =

Choose Fram All Mets In Design:
Netﬂame:|HS4 v|

Met Class: | v|

From the drop down list you should type the name of the net into Net Name: or select its name from
the drop down list presented. Using this dialog, the Net Class can also be selected from the drop
down list.
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Splitting Nets

Use the Nets and Split Nets options from the context menu when a net is selected. This allows the
net to be split in ‘two’, creating two nets from the original one. A dialog presents the options from
which to choose:

Split Met "H4" s

The net haz been split inta bwa nets and the highlighted net will
take the new name zupplied belaw. The unhighlighted net will
remain a3 the original net.

(®) MNew Met Mame: | $050

() Remove From Net

Rename Other Half

[ Include Connections in Sub Mets

Cancel

The original net name is displayed at the head of the dialog and the new name displayed in the New
Net Name box. A default net name is displayed, this will be the next available in the sequence and
will be unique, you can type in your own net name as required.

The Remove From Net button is used to remove the split net instead of renaming it. All connections
and tracks in the split net will be removed and all remaining items in the split net will be removed
from being on a net.

You cannot split a net when the removal of the selected PCB connection or Track does not result in
the net being split into two. For example, when the connections form a loop and one is removed, or
when the selected item is not on an isolated part (subnet) of it's net. In these two instances, an error
message will be displayed.

Use the Rename Other Half button to swap the names of the two nets. The two nets alternate
between being highlighted. Use this to show where the two nets are, and to choose which net remains
as the old net name.

Deleting Nets

As discussed previously, the Delete option cannot be used to remove nets from the design. You must
use either Split Net or Remove From Net.

Select the net and use Remove From Net from the context menu. When a Connection or Track is
selected, it will be deleted and the items that were at each end of it will be removed from the net only
if they do not have any other tracks or connections attached.

Back annotating name changes

The Back Annotation of design information to the Schematic is covered in more detail later on in this
Chapter under Back Annotation to the Schematic Design.
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Optimising Nets

Optimise will create a connection pattern which represents the shortest distances between
unconnected subnets in a net. A subnet is a collection of items on the net that are already physically
connected. You would normally want to route all these connections, so that there are no longer any
connections in the design.

There are three Optimise options available from the Tools menu, All Nets, Browse and Selected
Nets.

Optimise All Nets is used to perform optimise on all the nets in the design in a single operation.
Optimise Browse Nets will only perform optimise on the nets you select from a browse dialog.

Optimise Selected Nets will only perform optimise on the currently selected nets in the design. This
option is also available on the context menu for a selected Component or for any selected net in the
design.

You can use the Optimise Nets option in a Latched Mode, this means that you select the option first,
and then interactively select design items on nets you wish to Optimise. This continues until you
deselect the option or select another option.

Once any nets have been optimised, the overall connection length can be checked by running the
Connection Length Report from the Reports option on the Qutput menu.

Manual Gate and Pin Swapping

Gate and Pin Swapping are the processes for exchanging (Swapping) Gates and/or Pins of like
devices either between Parts or between gates and pins of the same device to shorten the connection
length between them.

Gates are the internal ‘packages’ within a device that make up the complete Part. For example, a 7400
is made up internally of 4 identical NAND gates.

These gates are the same and therefore could be swapped if allowed and defined in the Parts library.

e Ead
U1-A U1-A
S >
U1-B u1-B
Before Gate After Gate
Swapping Swapping

Gate Swaps

This is used to swap all connections between two equivalent gates. Two gates are equivalent if they
are in components that have the same Part type and are in the same swap group in the Part data.

When used, the gate swap is recorded in the Back Annotation data used for updating the
corresponding Schematic design.

The Back Annotation data can be viewed using the Back Annotation Report available from the
QOutput menu and Reports option.
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» To swap Gates
1. First select the Swap gates option on the Utility menu.
2. Choose the first gate on the component.

3. Use the mouse to move the cursor over the component pads in the design. If a pad is part of a
gate that can be swapped, all pins on that gate are drawn in the select colour whilst the cursor is
over them. The name of the selected gate is reported on the status bar.

4. Click on the selected gate that you wish to swap.

5. After the first gate has been selected, all equivalent gates that can be swapped will have their
pads drawn in the highlight colour.

6. Choose the second gate by clicking on the selected pad to choose the second gate for the swap.

7. As soon as two gates are selected the connections are swapped between the corresponding pads
on them and the swap is recorded in the design's back annotation data. All gates are then de-
highlighted and deselected ready for the next set of gate swaps.

Swap Rules

The following rules restrict the swapping of Component gates:-

® A gate can only be swapped if all pins have no routes attached.
® The two gates must be on components of the same part.

® The two gates must be in the same swap group in the part data.

If no swaps can be performed because the Part's swap data is not set up, use the Part Editor option to
add the swap data to the Part in the library. Once completed, use the Reload From Library option to
update the components in the design.

The contents of the Parts library and how to create this information is discussed in detail in the
Chapter on the Library Management Tools.

Pin Swaps

This is used to swap all connections between two pins. There are two modes of operation.

® Normal operation is to only allow the swap of two pins that are equivalent.
Equivalent pins are on the same gate, within the same Component, and in the same swap group.
In this mode the swap is recorded in the Back Annotation data used for updating the
corresponding schematics design.

The Back Annotation data can be viewed using the Back Annotation Report available on the

Outputs menu under Reports.

®  The other mode is to allow swap of any pins in the design.
In this mode the swap is not recorded for back Annotation. This may be useful in some cases, but
is not recommended as it could lead to synchronisation problems with the Schematic design.

» To swap Pins

1. First select the Swap Pins option on the Utility menu. If Swap Any Pins mode was last used,
you will asked to confirm to continue in this mode.

2. Use the context menu Swap Any Pins option if you wish to disable the normal swap mode. You
must select a pin on a Component before this is available on the context menu.
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3. Choose the first pin.
Use the mouse to move the cursor over the Component pads in the design. Note: if a pad can be
swapped it is drawn in the select colour whilst the cursor is over it. Click on the selected pad that
you wish to swap.

4. After the first pad has been selected, all equivalent pads that can be swapped will be drawn in the
highlight colour. If allowing Swap Any Pins no pins will be highlighted as all pins can be
swapped.

5. Choose the second pin.
Move the cursor over the highlighted pads in the design. Click on the selected pad to choose the
second pad for the swap.

6. As soon as two pads are selected the connections are swapped between them and, if the normal
swap mode, the swap is recorded in the design's back annotation data. All pads are then de-
highlighted and deselected ready for the next set of pin swaps.

Swap Rules

The following rules restrict the swapping of a Component pin:

® A pin can only be swapped if it does not have any routes attached.
The following rules apply when using the normal swap mode:

® The two pins must be on the same Component.
® The two pins must be on the same gate within the part data.

® The two pins must be in the same swap group in the part data.

If no swaps can be performed because the part's swap data is not set up, use the Part Editor option to
add swap data to the part in the library. Use the Reload From Library option to update the
components in the design.

The contents of the Parts library and how to create this information is discussed in detail in the
Chapter on the Library Management Tools.

Swapping Routed Gates & Pins

When attempting to swap routed gates and pins you have two options Swap Routed Pins and
Attributes Must Match.

The Swap Routed Pins option exists on the context menu when using Swap Gates or Swap Pins.
Check it to allow selecting of pins that have routes attached. The track segment attached to the pad
will be unrouted prior to swapping.

' % Cancel Swap Gates
Swap Routed Pins
Attributes Must Match

The Attributes Must Match option command exists on the context menu when using Swap Gates.
Check it to only swap gates between components that have the same attributes (this is how version 4.0
worked), or leave unchecked to ignore attributes.
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Manually Routing the Design

Manual routing is the process of adding copper tracks in Pulsonix. This can be done by ‘converting’
connections into tracks, or by adding tracks directly into the design.

Pulsonix allows you to work using one of three fundamental 'modes' when creating a PCB and
subsequently routing the design (and this excludes the automatic routing process for now). You can
start a PCB design starting:

1. With a netlist, from an external source to Pulsonix, or from a Pulsonix Schematic design
translated into the Pulsonix PCB design editor, the routing would be edited in by converting the
connections to tracks.

2. From within the PCB design directly and adding in the connections on-the-fly to create a PCB
only netlist. From the connection based netlist, the connections would be edited into tracks. This
would be used in preference to 3) below if a full or mainly complete netlist is required for
checking before tracking has commenced and differs from 1) in that because the netlist is derived
on-the-fly it is more prone to errors unless carefully checked. Using the known netlist allows
system options to do the checking for you, as well as correcting any synchronisation problems
between the PCB and the master schematic.

3. By adding in new tracks directly without a netlist. A design created truly ‘on-the-fly’ but no less
as accurate as with a connection-based netlist (the tracks actually provide an underlying netlist).

In addition to manual routing methods, you also have the automatic routing option that can be used to
accelerate this task. The auto router is discussed in the Advanced Features Users Guide supplied as a
PDF file in this installation.

Starting to route tracks manually

To start editing connections (and subsequently convert them to tracks) you can:
Double-Click on a connection, or;
Select the connection and right click, select Edit from the menu, or;

Select Insert Track from the Insert menu. Select the connection or track to add the track to.
If adding tracks into a PCB design without any previous netlist or connections you can use the Insert
Track option or double click over a Component pad to start the track.

.

1l iii |
i
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i i i

Before After
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The two illustrations above show the how the design looks before manual routing has started, and
how it looks once a connection is edited. Also shown are the Display Clearances around each object.

Overview of the basic modes of routing

The basic commands for editing tracks are:

Single-Click, once editing, will insert a corner and enable you to change direction.
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<L> (Change Layer) followed by <Enter> will enable a layer change to the opposite side of the
design.

Ctrl-Click will add a via and change layer while routing.

S (Change Style) followed by <Enter> will enable the style of the track to be changed to the
alterative track style defined in the Net Class. If this is thinner than the current style, a ‘necked’ track
will be started.

Double-Click while editing a track will activate a Route to Finish, the double-click functionality can
be user defined in Options and Edit Track. It will add a track directly from the last corner inserted to
the end target pad, it will not add any corners or layer changes. If a layer change is required to finish
for a surface mounted pad for example, a via will be automatically inserted.

Shift-Click will always force a corner on the track. This is used when a track is over another item and
the Finish Here ‘F’ marker is being shown, Shift-Click will insert a corner and not finish until
required.

As with most features in Pulsonix, there are multiple ways of entering a mode of operation. This
section will concentrate on the methods that are the most productive for use.
Setting up the options

Most of the options available during manual routing can be pre-defined ready for use using the Edit
Track tab on the Options dialog. You can also access all of these options from the context menu

when routing.

Segment Mode: 5 Angled -

[ Apply Seq Mode to Tail

Interactive Mitre/Fillet

Size:

Show Can Finish' and "Has Loop’ Markers

Show Legal Completion Path
[ Always Mark Net being edited
[ Clear Mark when edit complete

500 [ Any Angle

[ Aute Comer

Remove Loops

Auto Share Tracks

Allow Nets to be Joined

[] End On Via - Adds Protected Via

Cancel Add Track
Exit This Mode

Finish Here

Show Connection to Nearest Node [] Use Style From Picked Track % | Type Coordinate... =
Show Dynamic Connections Only [JObstacle Avoid 4% Type Offset.., Shift+=
[ Cptimise After Edit [ Auto Finish Finish On Via
[ Next Layer - Use Bias Change Layer - Retum To Previous Layer Complete As Track
Double Click Operation Add a Differential Pair Track Using: Change Layer L
(®) Complete Track (O Single Track Mode Next Layer
() Finish Here (® Mimor Mode Previous Layer
() Finish On Via () Pairing Start Mode Change Style E
(O Swap Layer Change Net Fz
Sketch Track 3| Mark net H

Track Pushing

[ Use Point To Point Mode
[ Use Grid When Sketching

Mitre Result
[ Use Any Layer

Change Default Yia Style

Spring Back ] Push Vias End Track On
[Pl Tight Plough Track Hugging Start: Track Hugging
Auto Comect Track (A Always Uses Minimum Gap Editing Cptions
Mitre Resutt Hug Method: () Shielding (® Routing () Gridded Segment Made

Auto Necking
Auto Neck
Pad Auto Neck

Area Based Styles
(®) Stop at Border Until Clicked
() Automatically Change Style at Border
() Change Style at First Comer

Change Segments

Online DRC
Display Clearance

Push Mode

Change Grid
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Track Segment Modes

This defines the default restrictions on the orientation of segments when creating or editing a track.
You can change the Segment Mode at any time whilst creating or editing a shape by using the
Change Segments option on the Edit Track context menu.

Free Angled
—1

—1

Any-angle segments can be used when editing a track with no restrictions to the segment orientation,
this creates a free angle track segment.

Orthogonal

—F

—1

Only 90 degree segments are inserted using two trailing segments to create the angle using alternate
vertical and horizontal segments.

Orthogonal (Mitre)
—1
—1
Alternate shape segments are vertical and horizontal lines with the corner being a 45 degree mitre.
Orthogonal (Fillet)
—1
—1

Alternate shape segments are vertical and horizontal lines with the corner being curved.

45 Angled

—F

T o
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Alternate shape segments are orthogonal and 45 degree lines. A 45 degree angle is inserted when a
corner is added. When the mouse is being moved horizontally and vertically, 90 degree tracks are
added.

45 Angled (Fillet)

—F

—F

Alternate shape segments are orthogonal and at 45 degrees with the corner filleted.

Curved

—7F

—1

Alternate shape segments are orthogonal and 90 degree curve. Like the 45 degree mode, where
corners are required a curved corner is added.

Pull Tight

—1

N
Pull Tight is a special mode which will produce a minimal orthogonal and 45 degree pattern. This
mode will automatically add corners to wrap or ‘hug’ around obstacles using the shortest distance

possible, pulling tight all the time. In this mode you can automatically remove any corners that have
been added by re-tracing the cursor back over the track.

Restricted Movement

—7F ~
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Restricted Movement is a special mode which will restrict the movement of the current segment by
snapping its angle to 45 or 90 degrees in whichever direction you are predominantly moving the
cursor. Clicking the mouse adds a corner.

Segment Mode on Context Menu

Alternatively the segment type may be selected on the context menu using Segment Mode and
selecting the mode type to be used.

LHS €U iiee e iiack End

Start Track Hugging
Match Pin To Pin Length

Editing Options ]

| Segment Mode » Free Angled
Change Segments » Orthogonal

ZI Online DRC \ Orthogonal [Mitre)

Orth I [Fillet]
ZI Continuous Online DRC oganal (Fillet)

45 Angled
ZI Display Clearance nLiE

45 Angled (Fillet)

Push Tracks
Curved
Change Grid 4 Pull Tight
Restricted Movement
Enter Angle...

Enter Length...
Grid the Length

Orthogonal Mitre (Auto Mitre) and Curved Mitre

During track editing, the completion of an individual segment within the overall track is determined
by a single click, normally followed by a change in track direction. With Orthogonal Mitre (Auto
Corner) set, a change in direction with the cursor will indicate that a corner or angle should be
automatically inserted.

With orthogonal routing it may be desirable to mitre the 90 degree angles and with Auto Mitre set a
mitre is automatically inserted at each 90 degree intersection.

If this option is checked, this defines the size and shape of mitres that are added when the Segment
Mode is Orthogonal. Mitres differ from the Angled (45) and Curved (90) Segment Modes because
the mitres are of a fixed size that is specified in the Size edit box. The Size is the orthogonal width
and height of the mitre not the distance across the mitre segment. The mitres can be a 45 degree
straight line (Mitre) or 90 degree curve (Fillet).

Mitre

—r

—

Mitre gives fixed size 45 degree angled segments.
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Fillet

—

Fillet gives fixed size 90 degree curved segments.
Auto Corner

This is an advanced editing feature that allows tracks to be drawn without having to click the mouse
at each corner. (Note, this feature does not operate in Free segment mode).

You must define a Tolerance, this is the distance the cursor must move away in a perpendicular
direction from the first segment you are adding before a corner is added. You can still click at any
time to add a corner. It is recommended that the Tolerance is larger than any grid and mitre size you
are using.

—1

e

In the example above, the cursor is at the bottom of the second selected segment (shown as a lighter
colour). As you move right the first selected segment gets longer. When you move down so that the
second selected segment is longer than the auto corner tolerance, a corner is added and the first
selected segment is complete.

Apply Segment Mode To Tail

When checked from the Options dialog or selected from the context menu under Editing Options>
Apply Segment Mode To Tail, this mode applies the same segment mode to the lead and trailing
segments when editing an existing track segment.

et g e e

Disconnect Track End

Start Track Hugging

Editing Options >| Auko Corner

Segment Mode 3 | Apply Segment Mode to Tail

h. S 1§
e Obstacle Avoid

Online DRC §
No Seg Mode To Tail Apply Seg Mode To Tail
—1 —1 —1 —1

Trailing segment is at a free angle. Segment mode is applied to the trailing track segment.
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Show Finish Markers

These take the form of Modal Cursors or, if Modal Cursors not enabled through the Options dialog
and General tab, then dynamic markers are drawn in the highlight colour. They appear at the cursor
position to indicate that clicking would do something different from just the normal add corner. The
following 3 Markers exist: Can Finish Here, Can Finish On Via and Remove Loop

Can Finish Here

g

—

This will display the ‘F’ finish marker when nearing the terminal node on a single track route. As you
get close to an electrical connection point for the track you will see an F appear on the cursor, this is
the finish marker. As soon as the F appears on the cursor then a single left click on the mouse will
command the system to finish the final connection and attach it to the item underneath the cursor.

Can Finish On Via
-

o .

Control Click whilst this marker is shown will result in the track being finished on a via through to
the item underneath the cursor.

Remove (Track) Loops
jy —

@ —

This is used to allow loop removal when tracks are finished. This is the normal mode, but
occasionally you may want to create loops in tracks. If this mode is not checked, the loop removal
marker is not used. Loops will only be removed within the track path, not anywhere on the net. Loops
may be required on specific nets such as power or ground, or on nets that are required to create
‘rings’. Left click whilst this marker is shown will result in a loop in the track being removed from the
track.

Auto Share Tracks

This is used to automatically remove overlaid tracks after finishing editing or moving a track. A
junction will be created where the overlaid tracks end. If this option is not checked, any overlaid
tracks will remain overlaid. You can use the Share Tracks option to remove all overlaid tracks in the
design at a later stage.

Allow Nets to be Joined

Allow Nets to be Joined will give you the ability to join nets with different net names. With this mode
switched off, you will not be allowed to join any different nets together. The overriding switch on this
is the Can Alter PCB Netlist switch on the Design Settings dialog under the General tab. If this
switch is uncheck to not allow changes then the Allow Join Nets switch is inoperative.
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Always Mark Net Being Edited
Use this to show the net currently being edited in the Marked Net highlight colour.
Show Connection to Nearest Node

Use this when adding tracks to show a line (connection) between the moving cursor and the nearest
item that you can finish on the same net. With the option selected, the connection is shown to the
nearest node. This may not necessarily be the original target pad but will be the closest node to make
a legal track end. This will also allow you to connect to track segments, copper items, vias or
testpoints.

When editing a connection you get two lines from the cursor, one to the nearest node and one to the
original connection end.

—1

=R

Double Click Completes Track

Check this so that when adding a track, double click attempts to finish the track to the end of the
attached connection. It will use the current segment mode to complete the track. If On-line DRC is
enabled in Continuous mode and there is an obstacle in the way of the attempted finish path, a more
intelligent routing algorithm will be used to try to complete the track. Uncheck it to let double-click
finish the track in space.

Setting up Default Values
There are default track settings for Tracks in Design Settings dialog on the Defaults tab.

Layer 1 and Layer 2 define the swap layer pair used during routing. When routing you can swap
between these layers when using Change Layer.

Track Style is used to define the style used when adding a track directly into the design without using
a connection. In this mode, the track will also pick up the default Net characteristics also defined on
this tab. The actual track thicknesses are set up in the Technology dialog under Track Styles.

Options available on the context menu

There are modes of operation that can only be accessed from the context menu during Insert Track.
These are discussed below, where functionality is common this will have already been discussed
above.
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e woiaUll Wia slyie

End Track On 3

Start Track Hugging
Match Pin Ta Pin Length

| Editing Options >| Auto Corner

3
segment Mode Show Dynamic Cons Only

3
GIENEE I Show Connection to Net

Z| Online DRC \ [+] show Legal Completion Path
ZI Continuous Online DRC [ ] Show Finish Markers
Display Clearance Remove Loops

Push Tracks Auto Finish

Change Grid N Allow Join Mets

Obstacle Avoid

Zl Auto Neck

[+] Pad Auto Neck

[+] show Track Length Limits
Reposition Cursor Text

Cancel Add Track - This exits you from this option completely without saving the routing.

Finish Here - Finish Here will finish the editing of the track from the current mouse position and will
leave a 'flying' connection back to the end pad.

Complete as Track - At any stage during insert track mode you may command the system to
complete the single track route automatically. In Insert Track mode use the context menu and click
Complete As Track. The system will attempt to finish the route. This function does not use the
standard autorouter and should not be seen as a replacement for this, a more sophisticated product.

Changing Layers
To change layer, in insert track mode use the Shortcut Key <L.> or the Change Layer option.

Change Track Layer x

0id Layer: | Tap |

MWew Laver:  |Bottom P

[ Apply To &ll Segments

The required layer may be selected from New Layer. If track segments are already placed, then in
switching to a new layer a via will be inserted at the default size. A quick way to use this option is to
set up the swap layer pair in the Options dialog and Defaults. When the Change Layer option is
selected, you will automatically be presented with the alternative swap pair layer. By pressing
<Enter> you will automatically insert a via and swap layers. This means you can swap layers very
quickly by pressing <L> <Enter> without looking at the dialog.

Another useful shortcut is Ctrl-click will add a via and change layers while routing. This will switch
tracks to the bottom of the board and hence this shortcut is not suitable in a multi-layer design where
in inner layer is to be selected.

Changing Track Styles (or Track Widths)

To change track styles during Edit Track mode, right click the mouse and select Change Styles or
use the Shortcut Key <S>.
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Track Style X

Old Style: | Track [15] |

New Styls: |Signal [8) [~]
Wwidth: ] &pply To &0 5 egments

A New Style may then be selected from those predefined in the Technology dialog. In the Width box
a size may be inserted that is not currently defined in the Technology file. A new style name will be
offered and this new style will be included in the Technology. You can also type in the name of the
new style.

A quick method of ‘necking’ a track (the process of changing the track from a fat width to a thin
width, or vice versa) can also be obtained using this dialog.

By default the New Style offered will be the alternative style defined for the track in the Net Class
dialog. This is defined in the Technology dialog under Net Classes.

If using a thicker width, and by default the style used will be the Nominal style (Nom. Track) defined,
you can instantly get to the thinner style (Min. Track) by pressing S followed directly by <Enter>.
So as with changing Layers, you can select the alternative Style by pressing <S> <Enter> without
looking at the dialog.

Change Net

This is used to change the net of the net being edited. This has been described in more detail
previously in this Chapter under Managing PCB Nets.

As a shortcut, it is quicker to use the default shortcut key of <F2> to get to the Change Net dialog.
Mark Net

Mark net is used to highlight the current selected net using the Highlight colour. A predefined
shortcut key <H>, enables you to toggle the highlight on or off quickly.

Change Default Via Style

This allows you to change the default via style set in the Net Class setting for this Net Class name. If
a name is typed in and is not in the existing Styles dialog for vias, you are prompted to add it in or
keep the style local.

End Track On

The system may be commanded to end the track on a Via or a Testpoint Via. In track insert mode r/h
mouse menu and select End Track On. A menu opens with the following options:

Via - This will add the net class default via style to the end of the track.

Testpoint - This will add a testpoint to the end of the track segment

None - No via or testpoint is inserted on the end of the track segment

Editing Options

These are the track editing options (Auto Corner, Auto Mitre etc.) already discussed above.
Change Segment options, Next, Previous etc.

Segment Mode options (Free, Angled, Orthogonal etc.) have been discussed above.
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Edit Segment

When editing track segments, these modes give the opportunity to 'back-track' to predefined locations
along the current track segment without exiting the edit and starting at the location required on the
same track.

First - The first segment of the track, default shortcut key Home.

Previous - The previous segment to the one being currently edited, default shortcut key Num sub (-)
[keypad -].

Next - If you have moved from the end segment, Next takes you forward one segment, default
shortcut key Num plus (+) [keypad +].

End - This takes you to the end track segment, default shortcut key End.

Flip Dynamic

Use it to swap the type of the dynamic segments you are currently editing e.g. from Orthogonal XY
to Orthogonal YX. Note: this is not available when the segment mode is Free as this is single
segment editing.

Before Flip Dynamic Segments After Flip Dynamic Segments

1 g -1 g

Adding orthogonal X segment followed by Now adding orthogonal Y segment
orthogonal Y segment. followed by orthogonal X segment.

Flip works for each segment mode as follows:

Orthogonal
Before: X Line followed by Y line.
After: Y Line followed by X line.

Angled
Before: Orthogonal line followed by 45 degree line.
After: 45 degree line followed by orthogonal line.

Curved
Before: Orthogonal line followed by 90 degree curve.
After: 90 degree curve followed by orthogonal line.

Free - Not applicable.
And vice-versa.

Delete Segment this will delete the current segment back to the previous corner, shortcut key
Backspace.

Online DRC (On-line Design Rule Checking)

Online DRC will constantly monitor the spacing limitations as set in the Technology data during
manual track insertion or track edit, and will prevent spacing error violations being introduced.

To set the Online DRC, in insert track mode right click and select Online DRC from the menu.
Online DRC will operate either Continuously, meaning as the track is moved close to the
unconnected item the system will prevent tracks from being placed, or On Drop, meaning the Online
Design Rule Checking is only invoked as the track is finally connected.
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To switch between Continuous and On Drop, select Options from the Tools menu and the Online
DRC tab. Here you may select Continuous and/or On Drop.

Orline DRC
Checking

Continuous ~ {Awvoids emors during some interactive operations)

On Drop (Check changed data after interactive operations)
Check Attached Tracks & Wires On Drop

Mter Edit (Check item after having its properties edited)

Add Emor Marker to show first emor)

Continuous On Drop Only
Check Poured Copper ] Check Via In Pad
Check Comp To Comp

Pulsonix has the facility to Display Clearances around items during track edit mode or full Online
Design Rule Checking to prevent design spacing errors being introduced.

To set Display Clearances, in insert track mode right click and select Display Clearances from the
menu. During track insertion as you move close to an unconnected item a warning colour will appear
around the item:

N
Display Clearances

shown here —» _:_
o

The orange outline (shown as the lighter ring around the pad) indicates the track is at the boundary
point for placement of unconnected items.

If the track continues to be placed closer to the item then the colour will change to red (shown as the
darker ring around the pad):

_:_ This pad highlight as in error

-

This clearly indicates that the track is too close to the item and the spacing limitations as defined in
the Technology have been violated, (fortunately, with the use of bright colours on-screen, this is
clearer).

Display Clearances

The Display Clearances parameters may be modified by selecting Options from the Tools menu,
and select Online DRC. With Show Design Rule Clearance checked the parameter On All Items
may be checked. This will show a continuous boundary around items in the design indicating the
nearest that a track may be placed without causing a design rules error.
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Within Set Distance is the minimum distance in units from the item before the warning boundary
colour comes on. Alternatively, Within Grid Steps will cause the boundary colour to come based on
the number of Grid steps around the item.

The default colour for nearest point is orange and violation of spacing rules in red. These colours may
also be modified by going to the Setup menu and Colours. Under the Highlights tab are shown the
colours for Clearances and Online DRC.

Push Mode

Track pushing is available on this menu. The settings for pushing are defined in the Options dialog
and Edit Track page.

(_J) Swap Layer
Track Pushing

Spring Back Push Vias
CdPulTight  [JPlough

Change Grids

The track grid may be defined by selecting Grids from the Setup menu. Select Tracks from the drop
down list, here the track grid size may be determined. During insert track mode, the track will snap to
a grid point defined by this Track grid, or to Gridless or Working Grid if switched.

Changing to Gridless

At any point in the track insertion process you may switch to gridless routing by right mouse clicking
and selecting Change Grid from the menu. You then have the choice to switch to Gridless, Working
Grid, or back to the predefined Track grid.

Use Mo Grid Shift+r

Display Clearance
A Use Working Grid Shift+

Push Tracks
Use Track Grid
Change Grid >|

Use <iax Grid

Use <Component = Grid
Use <Testpaint > Grid

Display Grids ]
B arid step. ..
HE arids... alt+G

Options available by selecting a track segment

These features are available when a track segment is selected (selected and not being moved or
edited).
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The picture below shows the full context menu broken into two halves.

Select 3
) *{- Trim or Extend Segment
Edit 3
Arc 4
% Cross Probe
=4 Edit Mitre
=]
& Move Auta Carrect Track
x f =
¥ Type Coordinate... = .J)K Auta Mitre Selection
& Type Offset.., Shift-+= ) Unmitre Selection
& Lock &+ Smooth Selected Tracks
Change Laver... L 2 Pull Tight Selection
Change Style. . 3 BIB Fatten/Meck Selection
Met 3 Al Serpentine Selected Segments
Use Default Track/Via Style
Auko Weld Selection
Unroute Track Segments u

Add Corner
Unroute Track Path
Mitre Corner

Fillet Corner Highlight Selection

Unmitre Carner Add To Favourites

Edit Segment Propetties. .. 1

The Select option displays a number of Selection and De-selection options as well as Select Next and
Select Previous. This will allow you to select the next item under the current cursor position,
likewise, will allow you to select the Previous item. This is used when the cursor is above a number
of connections in a tight area.

The Edit option opens to the standard Cut, Copy, Paste and Duplicate options.

Move will put you into Move mode. The segment can be moved until the mouse button is clicked,
this will release the segment in its new position.

Lock/Unlock

This provides the ability to fix a track segment in place so that it cannot be moved. A lock status will
also disable other functions being performed on it until Unlocked, e.g. Move, Edit, Auto Routing,
Optimise or Deleted etc.

Net>> will reveal the options Change Net, Split Net, Mark Net, Optimise Selected Nets, Unroute
Selected Nets and Route Selected. Split Net is discussed in more detail in the section below,
Managing PCB Nets.

Edit Segment - once the track has been added you can double-click on it or use the Edit Segment
mode to route it.

Arc>> there are several modes where the selected segment can be edit to create an arc. There are
predefined options and options to allow the Radius or Diameter to be entered.

Remove From Net is used to remove any connections from the selected net.

Show Net Name this displays the net name on the selected net. The Style of the text used for the net
name can be changed once displayed by selecting it and pressing the S key for Style.

Optimise Selected Nets will optimise the selected net only as a ‘one-off” operation.
Unroute Selected Nets will unroute the selected net back to a connection.

Route Selected will automatically route the selected net. This option is only available if the Auto
Route option is installed.
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Unroute Track Segments

This will only unroute the current selected track segments. This option is a way of controlling the
amount of unrouting or the selection of unrouting to be done.

Unroute Track Path

This will only unroute the current selected track path. Again, this option is a way of controlling the
amount of unrouting or the selection of unrouting to be done.

Properties displays the characteristics of the Track, Net and Net Attribute. You can have any number
of net attributes that can hold characteristics for other purposes, e.g. routing, simulation or Guard
Spacings for additional spacing clearances on that net.

Options available by Editing a track segment

There are some options only available during the Editing of existing tracks.

Disconnect End Track this option will enable you to remove the track from one electrical item and
connect it to another. If this is the only connection point to that item, the item will become isolate
from the net.

Reverse Editing Direction this is used to swap the direction of the segment you are currently editing
from the shape.

Before Reverse Direction After Reverse Direction

— — +

Editing from the square pad to the round pad. = Now editing from the opposite direction

Miscellaneous items associated with editing tracks

When a item shows a butterfly connection marker this is an indicator that that item can only be
connected to a power plane (that uses the same net name) using a via.

% %

] | ] |
% i

Typically a surface mounted pad, as shown above, will contain these markers if a connection to the
power plane is required. These would normally be routed using ‘stub’ routes.

Adding Stub Routes

Stub routes are small track segments that stem out of a surface mounted pad, although they can
emanate from any electrical item Generally, they are used to connect to a power plane layer but can
also be used on dense designs where a short track is required to exit the surface mount pad to make
more space for other tracks and vias.
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l }

The image above illustrates how short track segments are extended from the surface mount pads and
connect directly to a via that in-turn connects to the power plane (assuming that the net name and
power plane net name are the same).

P To add stub routes for connection to a power plane

If you have lots of stub routes to do then change the default setting of the Track Editing Double
Click Operation option under the Options dialog, Edit Track. You can make the default double
click setting to be Finish On Via.

Double Click Operation Sketc
(®) Complete Track Jus
() Finish Here [Jue
() Finigh On Via
() Swap Layer Track

A

[ I

1. Edit the connection from the surface mount pad that you wish to create into a stub route. You can
also insert a track from the pad to start, if using this method.

2. Drag the mouse out of the pad to draw a small track segment, click once to confirm the segment
or add a corner.

T

i

I

3. Double-click the mouse to add a via.

qj

e 1

!

4. You are exited from this option and the stub with via is added.

+

I

l
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P To add stub routes to connect to other layers

1. Edit the connection from the surface mount pad that you wish to create into a stub route. You
can also Insert a track from the pad to start, if using this method.

2. Drag the mouse out of the pad to draw a small track segment, click once to confirm the segment
or add a corner.

3. Right click and select Change Layer, or click <L> to Change Layer.

4. Select the required layer and click OK or <Enter> to accept the default layer change, this layer
will be your default swap layer.

5. You can now continue routing on the new layer.

Adding additional vias to tracks
Once the track has been added you can add additional vias to it without changing the layer for the
track segment. This could be used if a power track also requires multiple entry points, using vias, to a
power plane even though it is routed fully. This method can also be used for copper areas or suchlike
but will be discussed in context in the section on Inserting Copper.

» To add additional vias to tracks

1. From the Insert menu select Insert Via. This will present you with a free standing via that can
be placed on the track.

2. The Via can be positioned anywhere until released. Once released it is truly connected to the
track and will move if the track is moved.

uhin

Changing via sizes and via spans

Once a via has been added to the design its style or layer span can be changed to something other than
that that is specified in the Net Class.

Both the style and layer span of the via can be changed using through the Properties dialog.

» To change the via style and layer span
1. Select the via or any number of vias.

2. Select Properties from the context menu, alternatively select the via and press <I> (for
Properties).
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B Properties: Via - Via O X

Via Branch Point = Test Net Net Attributes

Postion: [ Locked
e

Layer Span: |CThr0ugh Hole> w |

Type: Through Hole

Allow Automatic Changes:
Delete if not Routed Reduce Layer Span

Via Style:
Name:  [ViaRnd50.0n30.0 |

50.0 pil: [0 | & [D |
[ Plated

Power Plane Connection: Attached on Layers:

Top <Track:=
Bottom <Track:>
Attached Tracks: Highest Layer: Top

Lowest Layer: |Bottom

The Layer Span list box is used to choose between all of the suitable layer spans defined in the
Technology dialog. A layer span is available in the list if it includes the connected span of the
selected via.

Allow Automatic Changes - Normally, just as vias are automatically added by layer changes, they
can be deleted by swapping layers of attached tracks back so that they are no longer required. You
can stop this deletion from happening by unchecking the Delete If Not Routed switch. This will lock
the via from automatic deletion.

Similarly, if you have multiple layer spans defined in your technology, vias will have their layer span
automatically reduced if possible to the 'best fit' span. This again will happen with a track layer
change. To stop this from happening uncheck the Reduce Layer Span switch.

The Via Style is used if you want to change pad style of the Via. You can change it to another
predefined Pad Style by selecting one from the Name drop down list.

You can alternatively change it to a new Pad Style by defining alternative parameters. This can be
done by changing the Width and or Length, or the Drill size, or by changing the Shape drop down
list. If there is no Pad Style to match these parameters then a new Pad Style will be added with the
name that you want to call it.
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Track Breakouts (Fanouts)

Breakouts (fanouts as they also called) are used to create predefined or potential track patterns for use
where the pads are restricted on a Footprint. Typically these patterns would be used where routing is
very dense on a surface mounted device, and where ‘human’ intervention is the most sensible option.
The breakout patterns are more suited to designs where automatic routing will take place. They often
give the router more solutions to what may appear a ‘fixed” option. For instance on a surface mounted
QFP where all the pads are on one side of the design, by using breakouts and breakout vias, the pins
then become accessible to all layers if the vias are defined as <Through-Hole>.

vt TQTQTOT

hivon

Breakouts can be used on SMD and through-hole pads.
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In Pulsonix, breakouts are generated and stored in the Footprint definition. This means that the
definition always knows about the breakout and can apply or reapply the original breakout pattern at
any time.

The process of using breakouts

The ‘flow’ for using breakouts is as follows:

® (Create the breakout pattern in the footprint using the Footprint editor and save it.
® In the PCB design the breakout guide will be displayed.

® FEither edit a track/connection to the breakout that will be a legal finishing point and will be
shown as node point on the net. The breakout automatically gets converted to a track, or;

® Select the breakout or Component and from the context menu select Hide Breakout or Convert
Breakout To Track.

Breakouts in the Design

Once a Footprint is used in a design, the breakout is a self-contained item, at this point it is not a track
or via but a ‘guide’ to the final track pattern when connected.

For breakouts to work the pads to which they are attached must be on a net. If a single (or multiple)
breakout is required on an unconnected pad then the pad must have a net name. A single pin net name
can be assigned in the Schematic design so that the Synchronise Designs option doesn’t rip out any
single pin net in the PCB.

To differentiate breakouts from ‘normal’ vias or tracks they have their own colour slots in the
Colours dialog. Under the Vias tab you have Breakout (vias) as a Layer Span, and under the Track
tab, you have Comp Breakouts. By default in the supplied Technology files these items have their
own colours so they are visible when tracks and vias are used in a design.

To use breakouts that exist on Footprints you have a number of options, all available on the context
menu for selected Footprint entities: on a selected Component(s), on individual pads on a Component
that have breakouts and on the whole design (but the design must have breakouts on at least one
Component): Hide Breakouts, Show Breakouts, Convert Breakouts To Tracks. .
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Hide and Show Breakout will allow the breakout to be hidden or shown on a Component. If the
breakout has already been converted to a track it can still be shown even though it may be redundant.
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The example above shows a track that has been connected to a breakout. The breakout has been
converted to a track and the breakout via removed. Automatically the breakout is switched to
‘hidden’. If you need to see the breakout pattern, for confirmation purposes of its original direction
for example, you can then select the pad and from the context menu select Show Breakout.

P
WU

.

The example above shows one side of the IC routed to the pads without using the breakouts. One pad
has no connection and still shows the breakout.

U1

N

The example above shows the whole Component with the breakouts hidden. Connections can still be
seen to the Component, as these must still be routed.

If converted to a track or if the breakout is left unrouted, you can select Remove Redundant
Breakout Tracks to remove them.

If a track is completely unrouted thus also removing the breakout path, the breakout can be
‘regenerated’ by right clicking on the pad and selecting Show Breakouts.

While editing a connection that is attached to a pad with a visible breakout, if a breakout is at the end
of the connection you have picked, an initial track will be created from the breakout.

If a breakout is at the other end of the connection, the connection will be re-drawn to end at the end of
the breakout. Using Complete As Track option in this situation will use the breakout path for its
completed track.
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Also, double click in select mode on a visible breakout in a PCB design will add a new track that uses
the breakout path from the selected point back to its pad. You will then be in Insert Track mode to
complete the track.

Plotting breakouts

You cannot output breakouts directly through the CAM Plot option, they must be converted to tracks
and vias first. Remember, Breakouts are transient objects in the design to highlight possible track
paths when applied.

Create Breakout Pattern (BGA Fanout) in PCB

Within the PCB design, there is also a command available in the Tools menu called Create Breakout
Pattern. This is used to create breakout (fanout) patterns within the design without the need to create
a Breakout pattern in the footprint first. To use the option, select a component or a pad on the
component and use the Create Breakout Pattern option on the context menu. A dialog is displayed
from which to choose the pattern required:

Create Breakout Pattern X

Offset

.
]

= R adiate from centre
- [ Fram syrmbal origin

Apply to Selected Pads Only

Track Style
Mame: | Track [6) [~]
Wia Style:
Mame:  [Via [18) [~]

width:  [0.45720 | Shape:
000000 Dl [0.25400

Plated

The dialog will only create a pattern for components that have at least one pad that is on a net and
does not already have a routed connection. Applying a pattern will not delete or edit any existing
tracks that are attached to pads on the component (no changes will be made to these pads).

When applying a pattern, a DRC check will be performed. Selecting No will remove the inserted
pattern. You cannot use this option if the selected component in your PCB design already has
breakouts.

Using the AutoDim option

The Dim Other Layers option is only relevant to layered designs in PCB, and as a consequence of
using Fast Redraw, making it feasible to draw the layers other than the current layer in dimmed
colours. This makes it much easier to see obstacles on the current layer, but at the same time, not
losing sight of items on other layers. Selecting the All Dim in One Colour option means all the other
layers dimmed are one colour and not their layer-dimmed colours.

To switch this option on, select the Dim Other Layers check box from the Options dialog and
Display tab. You must also have switched on, Fast Redraw and Draw Current Layer On Top so
that Dim Other Layers is available.
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B " Options - Display

Design Backups Fast Redmaw
E Display| )
Edit Shape Schematic
Edit Track PCB
File Extensions Draw in Layer Order
Find Draw Cumert Layer On Top
General Dim Other Layers
In-Place Names [ Al Dim in One Colour
Interaction
Macros
YR,

Unrouting Tracks

You may sometimes have a requirement to unroute part or all of the design. Unrouting is the process
of removing tracks back to their connection or net paths. Pulsonix contains a number of options that
allow varying levels of unroute to be accomplished:

The Unroute Nets option is available through the Tools menu. The three options available control the
amount of unrouting allowed.

All Nets is used to unroute all nets in the design regardless of any nets already selected.

Browse displays the browse dialog for a net selection. Individual nets can be selected by using the
pick and Ctrl-Shift pick methods.

Selected Nets will enable you to choose the tracks to be unrouted from the design. You can choose
single or multiple tracks or individual track segments.

The Delete key from the keyboard can also be used to unroute tracks but is not recommended.

The Unroute Track Segment and Unroute Track Path options are also available from the context
menu when a net is selected.

Using Shapes and Cutouts

Shapes

Shapes are used in Pulsonix for a number of design items. For ease of use and clarity, the shape types
have been separated into their own options. This makes the selection for the tool and the
characteristics of the shape easier to understand when adding to the design.

Shape Types

You can add shapes for:

® Board

®  Copper

®  Documentation (shapes)

® Areas

® Copper Pouring (Templates)
Shape Properties

For each of the shapes there are properties that give it its characteristics. All shapes can be Open or
Closed and Filled or Unfilled (unless shown otherwise below) in addition to unique properties:
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Board - Used on <Through Board> layers (or specific layers or layer spans if you have the Advanced
Technology option), cannot be an Open shape, Filled or Hatched.

Copper — Used on electrical layers, can be Hatched and can have a Net Name.
Shape — Used on non-electrical layers, can be Hatched.

Area — Used on any electrical layer and layers of <Through Board>, <Top Side> & <Bottom Side>,
(or specific layers or layer spans if you have the Advanced Technology option), cannot be an Open
shape, can be Hatched, also has Keep In/Keep Out characteristics for Copper, Tracks, Vias, Micro-
vias, Testpoints and components.

Template — Used on electrical layers, cannot be an Open shape, can be Hatched, can have a Net
Name, used for pouring copper into.

Splines, Ellipse, Waves — used for creating special shapes.

All shapes (except Open shapes) can also have a cutouts inserted into them. Cutouts are discussed in
more detail later on in this section.

The Shapes Available

There are different types of shapes available and others can be made from these:

® Polygon

® Rectangle and Square
® Circle

® Triangle

®  (Straight) Line

®  Spline
® FEllipse
® Wave

Each shape is access from the Insert menu under their respective shape types. The example dialog
below shows the Insert Copper shape sub-menu but not all Insert Shape dialogs are the same format:

Palygon
Rectangle
Circle
Triangle
Line
Spline
Spiral
Wave

m el & 6L E]

From these three shape types you can create any shape required in the design, including straight lines
using Insert Line or an Open Polygon shape. Each of the different types of Shapes is also available as
shortcut commands and as buttons for the toolbar. A basic shape toolbar containing a selection of the
most used tools is supplied by default although this can be modified to suite your requirements.

Shape Styles
Shape styles are defined on the Design Settings dialog under Defaults.



Chapter 6 — PCB Design Editor 287

For each shape type (Area, Board, Copper, Doc Shape and Template) its default status as added to the
design can be determined using the shape selection. The dialog above shows the Copper defaults.
Copper is the most complete shape in terms of what can be predefined with the other shapes using
some of these choices under their own default.

Each shapes default Layer can be defined. For each of the shape types the layers allowed will be
relative to the type of shape being added, e.g. Board can only be added to <Through Board> layers,
Doc Shape only added to Documentation layers etc.

When the shape is added, the default Style of the shape added can be selected using Line Style. This
can be changed during or after the shape is added.

Some shapes can be an Open shape. This means that the Closed button would not be checked. If the
shape cannot be Open, the Closed button will be greyed out and checked.

Shape doesn’t ‘finish’ and
doesn’t have a Closed status

The example above shows an Open shape where the start and end point don’t coincide.

Note: Having a start and end position coincident isn’t enough to make this a closed shape. The shape
must also have a ‘Closed’ status as well.

If the shape was Closed it would look like this where the outline would be one continuous shape:

If a shape is defined as Closed, it can also be Filled and Hatched, but it cannot be Open and
Filled/Hatched. Likewise, a shape cannot be Unfilled and Hatched.

Cutout

Filled Shape

A Filled shape could also have any number of cutouts added to it. Cutouts are discussed further on in
this section.

Solid or Hatched Filling might be used give a shape more emphasis or in the case of Copper for
specific electrical purposes.
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Hatched Cross Hafched

The style of the Hatching can be defined using styles setup in the Technology dialog under Hatch
Style. The style can be Hatched or Cross Hatched.

Inserting Shapes

P To insert a shape

1. On the Insert menu, select Insert Shape then select the shape as required. The shape may then
be created in the design.

2. For a Rectangle or Circle drag the mouse to create the required size. For a Polygon, single click
to start, single click at each corner point required and double click to finish.

3. If Inserting a Rectangle but a Square is required, right click and select Square.

Cancel Edit Rectangle
Type Coordinate. .. =

4% Type Offset... shift4=
Change Layer. .. L
Change Style... s

Filled Shape
Square

Define From Centre

Snap To Item

Orline DRC §

Display Clearance

Change Grid 3

4. During Insert Rectangle and Circle, you can use the Define From Centre option on the context
menu to drag the shape from the centre rather than the edge.

5. During Insert Triangle you can create a triangle in a number of modes; Free Movement allows
uneven lengths of sides, the Equilateral Triangle mode allows all sides to be equalised. After
the first corner has been added, the context menu displays the following options:
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Cancel Edit Triangle
Finish Here

¥ Type Coordinate... =

% Type Offset... shift+=
Change Layer... L
Change Style... 5
Filled shape

Free Movement

Equilateral Triangle

Snap To Ikem

Change Grid 3

6. Using this mode you can create a proper triangle without calculating the angles and side lengths
to make the correctly formed triangle. After the first side has been added, Orthogonal mode
snaps the moving segment side to a 90 degree triangle or to the centre to create two other equal
sides of the triangle with a 45 degree angle. With the triangle corner dynamic, a right click will
enable the triangle to be snapped into the Equilateral Triangle mode to fix this corner.

7. Atany time you can right click and select an option from the menu. Each of these is discussed
below.

Shapes and the Technology dialog
The Technology dialog is used to initially create the styles used for the shapes and their defaults.

Layers, the Layer Class and Layer Type determine which layer the shape will be used on,
depending on the layer type is selected: Construction, Electrical, Documentation and Non-Electrical.
Only particular shape types will be allowed on these layers when added to the design.

Line Styles defines the overall outline width of the shape and the thickness of the hatch lines when
used in Hatch styles. The Line Style entry contains a single thickness value in the current design units
and a style name for the line.

You can also make line styles dotted and dashed and various combinations as well as solid. This
applies to doc shapes and unconnected copper. There are various dot and dash line styles available -
dotted, dashed, dot/dash, and user defined dot/dash spacing. Each of the standard line styles is
available from a drop down list.

B Properties: Doc Shape - Line Style O *

Segment Shape Lne Style  Doc Shape Attributes

Style: | Line Dashed - |
Width: 5,00
Line Pattem

Long & Short Dashed w

=
=]
=

Gap:

Dash: [40.00

Dash2: [10.00 |
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The diagram below shows how the entries in the dialog relate to the actual dashes and gaps produced
in the design.

D T s
|j| || |
Gap Dash Dash?

Hatch Styles will define the Hatch style and whether it is Hatched or Cross-Hatched. The line style
used to create Hatch or Cross-Hatch will be the line style used to define the shape outline.

Name | Angle Coverage (%) | Cross Hatched | Width Percent| Offset Percent
Cross Hatched 45.0 50 100.00 0.00
Hatched 450 50 ] 100.00 0.00
Hatchcode 80480 © 90.0 10 100.00 0.00
FigureHatching 50.0 16 100.00 0.00
LowCoverage 45.0 50 50.00 20.00

The entry defines the Name of the Hatch Style, the Hatch Angle in degrees, the Coverage %
meaning the percentage of copper that will be in the copper filled area